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INTRODUCTION

Thank you for choosing this Icom product. This product is designed and built with lcom’s state of the art technology
and craftsmanship. With proper care, this product should provide you with years of trouble-free operation.

This product combines traditional analog technologies with Digital Smart Technologies for Amateur Radio
(D-STAR), for a balanced package.

ABOUT THE CONSTRUCTION OF THE MANUAL (As of November 2021)

You can use the following manuals to understand and operate this transceiver.
@ If necessary, you can download a glossary of HAM radio terms from the lcom website.

TIP: You can download each manual and guide from the Icom website:
https://www.icomjapan.com/support/
Enter “ID-52A” or “ID-52E” into the Search box on the site.

Basic manual (Comes with the transceiver) Cl-V Reference Guide (PDF type)
Instructions for the basic operations and precautions. Describes the control commands used in remote
D-STAR GUIDE that explains registering your call sign control operation (serial communication using CI-V).

to a gateway repeater and D-STAR’s basic operations

is also included. About the DV Gateway function (PDF type)

Advanced manual (This manual) Instructions for the system requirements or operations
to use the DV Gateway function.

+ Attaching accessories

* Using a microSD card

+ Battery charging

* FM Radio operation Instructions for the steps to update the repeater list.

» D-STAR operation (ADVANCED)

* GPS operation (ADVANCED)

« VOICE TX function Using the GPS Logger function (PDF type)

» Recorder function

* Memory operation

» Scan operation

* Repeater and duplex operations

* SET mode

* Bluetooth® operation

» Share Pictures function

+ Other functions

» Updating the firmware

» Options

Updating the repeater list (PDF type)

Instructions for operating the GPS Logger function
that saves location data from a GPS receiver onto a
microSD card as a log.

TRADEMARKS

Icom, Icom Inc. and the Icom logo are registered trademarks of lcom Incorporated (Japan) in Japan, the United States, the
United Kingdom, Germany, France, Spain, Russia, Australia, New Zealand, and/or other countries.

The Bluetooth word mark and logos are registered trademarks owned by the Bluetooth SIG, Inc. and any use of such marks by
Icom Inc. is under license. Other trademarks and trade names are those of their respective owners.

Adobe, Acrobat, and Reader are either registered trademarks or trademarks of Adobe Systems Incorporated in the United
States and/or other countries.

APRS® is a registered trademark of Mr. Bob Bruninga in the U.S.A. and other countries.

Microsoft and Windows are trademarks of the Microsoft group of companies.

Google, the Google Logo, Google Play, the Google Play logo, Android, and the Android logo are trademarks of Google, LLC.
IOS is a trademark or registered trademark of Cisco in the U.S. and other countries and is used under license.

iPadOS is a trademark of Apple Inc.

App Store is a service mark of Apple Inc.

All other products or brands are registered trademarks or trademarks of their respective holders.




INTRODUCTION

FUNCTIONS AND FEATURES OF ADOBE® ACROBAT® READER®

The following functions and features can be used with Adobe Acrobat Reader.

+ Keyword search

Click “Find” (Ctrl+F) or “Advanced
Search” (Shift+Ctrl+F) in the Edit
menu to open the search screen.
This is convenient when searching

File Y View Window Help

for a particular word or phrase in this (s

manual.

® The menu screen may differ,
depending on the Adobe Acrobat
Reader version.

Click to open the find or
search screen or advanced
search screen.

* Printing out the desired pages.

Click “Find (Ctrl+F)” or “Advanced Search
(Shift+Ctrl+F)” in the Edit menu to open the search

screen.

This is convenient when searching for a particular

word or phrase in this manual.

® The menu screen may differ, depending on the Adobe

Acrobat Reader version.

N
@

Select All Ctrl+A

Deselect All Shift+Ctrl+A

Copy File to Clipboard

Take a Snapshot

¢ Find screen

Previous Next

¢ Advanced search screen

Search -

Arrange Windows

Where would you like to search?
(@) In the current document
) All PDF Documents in

{h My Documents v

What word or phrase would you like to search for?

[JWhole words only
[] Case-Sensitive

[Clinclude Bookmarks
[include Comments

Search

Check Spelling 4
Q FEind Ctrl+F
Advanced Search Shift+Ctrl+F
Protection L
Accessibility 4

* Read Out Loud feature.

this PDF.

Refer to the Adobe Acrobat Reader Help for the

details.

(This feature may not be usable, depending on your
PC environment, including the operating system.)

® Select the “A4” size to print out the page in the original

manual size.

[ Edt View Window Help

B Open...

Create PDF Online...

Save As...

Save as Other

Send File

Close
Properties...

E Print...

1

Ctrl+0O

Shift+Ctrl+5

3

3

Ctrl+W

Ctrl+D

Ctrl+P

Rotate View 4
Page Navigation »
Page Display 4
Zoom b
Tools »
Show/Hide 3
Display Theme r
[%] Read Mode Ctri+H
|:| Eull Screen Mode Ctri+L
E(‘ia Tracker...
Read Out Loud 4

® The screen may differ, depending on the Adobe Acrobat Reader version.

o

The Read Out Loud feature reads aloud the text in

x




INTRODUCTION

ENTERING AND EDITING TEXT

Controls used for text entry

! [DIAL] (Rotate)
Selects a character

S N

Selects the character

|- Clears
u\\?@u n/Iov.es the cursor to
k : MC@ the right
N

Cancels -l

Moves the cursor
to the left

[ENT] Opensthe Opens the Entry
Sets character  Select window

» To insert a text, move the cursor to a place to enter,
and then rotate [DIAL] or push D-pad(!t).

* To clear a character, push [CLR].

+ To consecutively clear characters, continuously

hold down [CLR].

To change the character type

1.

2.

When not selecting text, or an entered text is
selected, push [QUICK].
Rotate [DIAL] to select the character type, and

then push [ENT].

Character | Selectable characters and Character
type symbols conversion
ABC AtoZ,0to 9, (space) Ala

abc atoz,0to 9, (space) Ala

123 0to 9, (space) -

P !“#$%&’()*+,-./:;<=> -
?7@I[\]1"_"{]}" (space)

TIP: When the character type is “ABC” or “abc,” and
while entering a character, push [QUICK] to select
upper case or lower case letters.

EIBCONVERT  ABC

AV Push[QUICK]

EIRBCONVERT ABC




INTRODUCTION

USABLE CHARACTERS

The usable characters and symbols and the maximum characters differ, depending on the item.
See the following list for details.
® The usable characters and symbols for each character type are described at the bottom of the page.

Maximum .
Category Item Character type characters Information
) Group Name [ABC] [abc] [123] ["#] 16 -
FM Radio Memory
Name [ABC] [abc] [123] [!"#] 16 -
Group name [ABC] [abc] [123] ['"#] 16 -
Memory CH
Name [ABC] [abc] [123] ["#] 16 -
Call CH Name [ABC] [abc] [123] [!"#] 16
) Name [ABC] [abc] [123] [1"#] 16 -
Your Call Sign -
Call Sign AtoZ,0t09,/, (space) 8 -
Group Name [ABC] [abc] [123] [I"#] 16 -
Name [ABC] [abc] [123] [!"#] 16 -
Repeater List Sub Name [ABC] [abc] [123] ["#] 8 -
Call Sign AtoZ,0t09,/, (space) 8 -
GW Call Sign AtoZ,0t09,/, (space) 8 —
Unproto Address [ABC] [abc] [123] [!"#] 56 ?fggg”égfgf{acwrs
The number of characters you can
Comment [ABC] [abc] [123] ["#] 43 enter differs, depending on the data
GPS TX Mode extension and altitude settings.
Object Name/ "
ltem name [ABC] [abc] [123] ["#] 9 -
GPS Message [ABC] [abc] [123] [!"#] 20 -
Group Name ABC] [abc] [123] ["# 16 -
GPS Memory p [ABC] [abc] [123] [I"#]
Name [ABC] [abc] [123] [I"#] 16 -
P-Scan Edge Name [ABC] [abc] [123] ["#] 16 -
Program Link Program Link name [ABC] [abc] [123] ["#] 16 -
UR AtoZ,0t09,/, (space) 8 -
CS screen R1 AtoZ,0t09,/, (space) 8 -
R2 AtoZ,0t09,/, (space) 8 -
My Call Sign Call Sign AtoZ,0t09,/, (space) 12 (+1) Lnnccliu,\cﬁfm/) f?;;ween the Call sign
My Station TX Message [ABC] [abc] [123] [!"#] 20 -
DTMF Memory DTMF code 0t09,A,B,C,D, " # 24 -
Save Setting [ABC] [abc] [123] [I"#] 23 }"_e_gchfaraCterS:
SD Card III. : oharactors.
Export [ABC] [abc] [123] [I"#] 23 | o9a characiers:
Bluetooth Device Name [ABC] [abc] [123] ["#] 9 Excluding “ICOM BT”
Direct Input (UR) AtoZ,0t09,/, (space) 8 -
DR screen -
Direct Input (RPT) AtoZ,0t09,/, (space) 8 -

[ABC]: Ato Z,0t0 9, (space)
[abc]: ato z, 0 to 9, (space)

[123]: 0 to 9, (space)

PH: NV #3%& () +,-./:;<=>2@[\]1"_"{|}" (space)




INTRODUCTION

HOW TO ENTER TEXT

Example: Entering “Calling” as a Memory name.
[MENU] > MEMORY > Memory CH

1. Push [MENUI.
Select “MEMORY” on the second page of the
MENU screen.

3. Select “Memory CH.”

4. Select a channel group where the memory
channel you want to edit is listed.

5. Rotate [DIAL] to select a Memory channel.

11.

Rotate [DIAL] to select a character, then push [ENT].

INAME |

C

01: »
02: (Blank)»

00: 146.010 FM »
01: 440.000 FM »
02: »

Push [QUICK].
Select “Edit.”

No

Insert
Delete (next CH mov

* The Edit screen is displayed.
8. Select “NAME.”

NAME: .

FREQUENCY:

440.000.00”
TS: ,
25.0kHz |

EIMCHAR TYPE  ABC

. Push [QUICK].
10. Select the character type.

® To enter symbols, select “I"#.”

EECHAR TYPE ABC

® Information

» To move the cursor forward, push D-pad(—).

» To move the cursor backward, push D-pad(+).

» To insert a character, move the cursor to a place to
enter, then rotate [DIAL].

To clear a character, push [CLR].

» To consecutively clear characters, continuously hold
down [CLR].

* When the character type is “ABC” or “abc,” and while
entering a character, push [QUICK] to select upper
case or lower case letters.

12. Repeat steps 9 ~ 11 to enter a name, and push [ENT].

INAME |

Calling

@IRBCHAR TYPE  ABC

* Returns to the Edit screen, and the entered name is
displayed.
13. Select “<<OverWrite>>.”

TONE: N
OFF

» A confirmation dialog is displayed.
14. Select “YES.”

TAONE-
[\ Overwrite?

NO

v

1LGROLIP 0N

Completed.

440.000

Calling

EIER00-01

057

* The Memory name is overwritten.



Section 1

ATTACHING ACCESSORIES

Attaching the antenna............c.ooooi
Attaching and detaching the battery ...
Attaching and detaching the belt Clip............cooeeiiiii e,
Attaching the hand strap............ciiiiiii e
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1 ATTACHING ACCESSORIES

Attaching the antenna Attaching and detaching the battery

Insert the antenna into the base of the SMA antenna To attach or detach the battery pack or battery case,
connector and tighten the antenna. see the illustrations below. See page 3-8 for battery
case details.

® When attaching the battery case, slide it, and press firmly
until it is fixed with both latches.

® When detaching the battery case, turn OFF the
transceiver.

TIP: Third-party high gain antennas may increase
transceiver performance. The optional AD-92SMA
antenna connector adapter enables you to use
antennas with a BNC connector. (p. 17-2)

To attach To detach

BT B

Battery pack or
battery case

NOTE:

» Even when the transceiver is turned OFF, a small
current still flows in the transceiver. When not
using the transceiver for a long time, remove the
battery pack or case to prevent the batteries from
becoming exhausted.

» The battery protection function automatically
reduces power to Low1 power (0.5 W) when the
temperature is around 0°C (32°F) or below. In
addition, High, Mid, and Low2 power selections
are disabled.

1-2



1 ATTACHING ACCESSORIES

Attaching and detaching the belt clip

To attach or detach the belt clip, first remove the
battery pack or case, if it is attached. (p. 1-2) See

the illustration below.

To attach the belt clip, slide the belt clip in the
direction of the arrow until the belt clip locks in place,
and makes a ‘click’ sound.

To detach the belt clip, lift the tab up (@) and slide the
belt clip in the direction of the arrow (@).

To detach
To attach

Battery pack or
battery case

1-3

Attaching the hand strap

Slide the hand strap through the loop on the top of the
rear panel, as illustrated below.

Hand strap

/A WARNING! NEVER swing the transceiver by
holding the hand strap. This could cause injury to
yourself or others.



Section 2 USING a microSD CARD

NOTE: See the Basic manual
Section 6 for details on how to
insert or remove a microSD card
and precautions.

About data saved on a microSD card..........cccoeuiieiiiiiiiiiiiin 2-2
Saving settings onto a microSD card ..........ccccceeviiiie i 2-2
O Saving as @ NeW file ..o 2-2
Saving with a different file name............cccoociii i 2-3
Loading the saved files on the microSD card........c.....ccoeevccviviiiieeeneeennn. 2-4
Backing up data saved on the microSD card onto a PC ..........ccccce...... 2-5
< About the microSD card’s folder...........ooviiiiiiiiiiie e 2-5
< Making a backup file on your PC........cccvviiiiiiee e 2-6
Importing or exporting a CSV format file ..........ccccceiiiiiiiiie, 2-7
Q IMPOMEING e 2-7
RO {0 To 1 1] o PSSP 2-8
About the SD Card MOde .........ceevviiieeeiiiieeeee e 2-9
Check the free space and the recording time on the microSD card.....2-10
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2 USING a microSD CARD

About data saved on a microSD card

The following data can be saved onto the card:

» The transceiver’s settings

« Communication/receive log and contents

» Automatic answering voice audio in the DV mode
* Voice audio for the Voice TX function

* Voice recorder

» Captured screens

* Memory channel contents

* FM Radio memory

Your (UR) call sign memory

Repeater List

GPS memory

Position data from the GPS receiver

Pictures for the Share Pictures function
Transmitted and received log of Share Picture
Pictures for the Opening Picture setting

Saving settings onto a microSD card

The Memory channels, settings on the MENU screen,

and the Repeater List can be saved on a microSD
card.

Saving data on the card enables you to easily restore

the transceiver to its previous configuration, even if
you perform an All Reset.

You can save settings data as a new file, or you can
overwrite a current file.

< Saving as a new file
[MENU] > SET > SD Card > Save Setting

Push [MENU].
Select “SD Card” in the “SET” menu.

N~

2 Time Set
© Bluetooth Set
E3 Others

»
1

v v

3. Select “Save Setting.”

Load Setting
Save Form
Import/Export
Opening Picture
SD Card Info

v v v |w
<

4. Select “<<New File>>."

<<New File>>

» The file is named in the following format:
Setyyyymmdd_xx
(yyyy: Year, mm: month, dd: day, xx: file number).
® To change the file name, see page 2-3.

5.

Push [ENT].

Set20211101_01

@TBCHAR TYPE  ABC

» The confirmation screen is displayed.
Select “YES.”

IFILENAME |

Ca+dND11101 N1

Save file?

NO

EINCHAR TYPE  ABC

» While saving, a progress bar is displayed. When saving
is completed, the SD CARD screen is displayed.

@ To exit the MENU screen, push [MENU].

Overwriting a current file:
To overwrite data in a current file, select the file you
want to overwrite in step 4 to the left.

<<New File>>
Set20211101_01

TIP:
+ Data is saved in the “icf” file format. You can copy the icf

data on a PC and edit it using the CS-52 PROGRAMMING
SOFTWARE.

If “Save Form” is set to the earlier firmware version, the
confirmation window is displayed after step 4. To save
the data in the earlier firmware version, select “YES.”

2-2



2 USING a microSD CARD

Saving with a different file name

[MENU] > SET > SD Card > Save Setting

1. Push [MENU].
2. Select “SD Card” in the “SET” menu.

7 Time Set
© Bluetooth Set
Others

- IR

v v

3. Select “Save Setting.”

Load Setting

Save Form

- R

Import/Export
Opening Picture
SD Card Info

v | w v ¥
[«

4. Select “<<New File>>."

<<New File>>

5. Hold down [CLR] to delete the characters.
FILENAME |

@IBCHAR TYPE  ABC

6. Enter a file name, and then push [ENT].
[FILENAME |

MY DATA_

@IBCHAR TYPE  ABC

® See page iii on how to enter characters.
7. Select “YES.”

AV DNATA
& Overwrite?

NO

EMRCHAR TYPE ABC

« While saving, a progress bar is displayed. When saving
is completed, the SD CARD screen is displayed.
® To exit the MENU screen, push [MENU].



2 USING a microSD CARD

Loading the saved files on the microSD card

The saved Memory channels, settings on the MENU 6. Select “YES” or “NO.”
screen, and Repeater List can be copied to the
transceiver.

This makes it easy to copy Memory channels or the
Repeater List, to another ID-52A/ID-52E and operate
with the same data.

Keep 'SKIP' settings
in Repeater List?
YES

NO

NOTE: Saving the current data is recommended
before loading other data into the transceiver.

* YES:
Example: Loading all the data in the The_skip settings of the Repeater List are
“Set20211101_01" file ;‘le(t;med.
[MENU] > SET > SD Card > Load Setting The skip settings of the Repeater List are
1. Push [MENU]. cleared.
2. Select “SD Card” in the “SET” menu. 7. Select “YES.”
2 Time Set Y
% SD Card u Load file?
© Bluetooth Set »
Others »

3. Select “Load Setting.” « Starts checking and loading the data file.

* After loading, “COMPLETED!” is displayed.

Load Setting

Save Setting
Save Form

-

COMPLETED!
Import/Export Reboot the ID-52.
Opening Picture

SD Card Info

v v v v | w
o

4. Select a data file to load into the transceiver.

8. Restart the transceiver to operate with the new

5et20211101_01 > setting.

5. Select the loading content.

ALL
Except My Station

Repeater List Only

« ALL:
Loads all Memory channels, settings on the
MENU screen, and the Repeater List into the
transceiver.
Except My Station:
Loads all Memory channels, setting on the
MENU screen except MY call signs, and the
Repeater List into the transceiver.
* Repeater List Only:

Loads only the Repeater List into the transceiver.

2-4



2 USING a microSD CARD

Backing up data saved on the microSD card onto a PC

A backup file enables easy restoration, even if the
data on the microSD card is accidentally deleted.

< About the microSD card’s folder

The folder in the microSD card contains the following:

OO O

ID-52 Capture GpsMemory
-0
Csv MemoryCh
- (D
RadioMemory
g
RptList
- -0
Gps YourMemory
pim)
OpeningPicture
O -0
Picture Private —|: Rx
- e
Qsolog Tx
-
Reply
-3
RxLog
-
Setting
-+
Voice yyyymmdd
-2
yyyymmdd
T
VoiceRec yyyymmdd
-0 -0
VoiceTx yyyymmdd
+ ID-52 folder

The folders created in the transceiver are contained

in this folder.

» Capture folder
The captured screen data in the “png” or “bmp”
format.

» Csv folder
The Repeater List, Your (UR) call sign memory,
GPS Memory folders, and so on.

2-5

GpsMemory folder
The GPS Memory in the “csv” format.

MemoryCh folder
The Memory channel contents in the “csv” format.

RadioMemory folder
The FM Radio memory contents in the “csv” format.

RptList folder
The Repeater List in the “csv” format.

YourMemory folder
The Your (UR) call sign memory in the “csv” format.

Gps folder
The GPS logging data in the “log” format.

OpeningPicture folder
The pictures in the “bmp” format that are used for
the Opening Picture setting.

Picture folder
The pictures in the “jpg” format that are used with
the Share Pictures function.

Private folder
The RX Picture History and TX Picture History.

Rx folder

The RX Picture History in the “dat” format.
® The RX Picture History contents are not displayed on
the PC.

Tx folder
The TX Picture History in the “dat” format.

® The TX Picture History contents are not displayed on
the PC.

Qsolog folder
The QSO log data in the “csv” format.

Reply folder
The automatic reply data in the “wav” format.

RxLog folder
The RX record log data in the “csv” format.

Setting folder
The transceiver’s setting data in the “icf” format.

Voice folder
The recorded QSO audio date folders.

VoiceRec folder
The recorded Voice recorder audio date folders.

yyyymmdd folder

The recorded QSO audio data and the recorded
Voice recorder audio data is saved in the “wav”
format.

VoiceTx folder
The recorded voice audio data for the Voice TX
function in the “wav” format.



2 USING a microSD CARD

Backing up data saved on the microSD card onto a PC

< Making a backup file on your PC

Windows® 10 is used for these instructions. 5. Open a folder to copy a backup file, then right-

click, and then click “Paste.”
» Copies the card data onto your PC.

1. Insert the microSD card into the microSD card (Example: Copying into the “Backup” folder on the

drive or a memory card reader on your PC.

; p . S C drive
2. Click the “Open folder to view files” option to )
access the card. M [ =1 Bckup
Home Share View
Removable Disk (H:) < v » ThisPC » Local Disk (C:) » Backup
Choose what to do with removable drives 3+ Quick access Name
Configure this drive for backup 4@ OneDrive
File History
) [ This PC View >
m (t:.rjﬂ‘g-xfre storage settings I Desktop Sort by >
[E] Documents Group by >
Open folder to view files . Refresh
File EBxplorer D — 4 Downloads
E Sl Click b Music Customize this folder..
. Take no action = Pictures T | Cllck
Videos Paste shortcut
%, Local Disk (C:) Undo Rename CtrleZ
- 'ID-52 folder is displayed. = Remeveble Disk Share with >
3. Right-click “Removable disk.” - RIE;:“‘E”““" New >
4. Click “Copy.” e Propertes
& B E= Drive Tools  Removable Disk (H
Hons P Mew [ Mo 6. To remove the card, click the remove media icon
Tim o fommthieiB y (‘i in the screenshot shown below) in the
3t Quick access N taskbar. Then, click “Eject Removable Disk.”
¢ OneDrive 102
B This pC 5 Open Devices and Printers
I . . USB3.0 Card Reader
@;‘ Right-Click - Eject Removable Disk (H:) ¢——Click
N Open AutoPlay... e 7
Open in new window
& Homegiot  pinto Quick access
Share with >
Open as Portable Device
il ey i 7. When “Safe To Remove Hardware” is displayed,
Pin to Start
Format.. remove the card.
Fject
Cut
E3E Click
1item Rename

Mew >
Properties

TIP: When “USB Connect” is set to “SD Card Mode,”
and the transceiver is connected to the PC through a
USB data cable, you can directly access the microSD
card that is set in the transceiver from the PC.
(IMENU] > SET > Function > USB Connect)




2 USING a microSD CARD

Importing or exporting a CSV format file

Read this section before importing or exporting a 6. Select the CSV file to import.
Comma Separated Values (CSV) format file from the
microSD card.

You can import or export the following data:

* Memory CH

* FM Radio Memory

* Your Call Sign

* Repeater List

* GPS Memory

Your20211101_01

» The confirmation dialog is displayed.

< lImporting TIP: When importing a Repeater List, “Keep
NOTE: ‘SKIP’ settings in Repeater List?” is displayed.
« Before importing, make a backup file of all the See step 6 on page 2-4 for details.

transceiver’s data to the card in case of data loss.

» The transceiver cannot display files that have a file
name 24 or more characters. If necessary, rename
them using 23 characters or less. When exporting CSV
format files using the CS-52, BE SURE the names are
23 characters or less.

~

Select “YES.”

Import file?

NO

Example: Importing the Your Call sign memory.
[MENU] > SET > SD Card > Import/Export > Import

« Starts importing.
1. Push [MENU]. * After importing ends, “COMPLETED!” is displayed.

2. Select “SD Card” in the “SET” menu.

M
3 COMPLETED!
2 Time Set » Reboot the ID-52.
% SD Card »
© Bluetooth Set »
Others »

8. To complete importing, restart the transceiver.

3. Select “Import/Export.”

Load Setting
Save Setting
Save Form
Opening Picture
SD Card Info

- RARARS

v | v
[«

4. Select “Import.”

A

CSV Format

5. Select “Your Call Sign.”

Memory CH

FM Radio Memory
Repeater List
GPS Memory

-~ RAR4

v v

2-7



2 USING a microSD CARD

Importing or exporting a CSV format file

< Exporting 6. Select “<<New File>>"

Saving as a new file:
Example: Exporting the Your Call sign memory.

[MENU] > SET > SD Card > Import/Export > Export

1. Push [MENU].
2. Select “SD Card” in the “SET” menu.

2 Time Set  Displays the FILE NAME screen.

® The file is named in the following format:
© Bluetooth Set Your*yyyymmdd_xx

- R

v v

@8 Others (yyyy: Year, mm: month, dd: day, xx: file number).
* When you select the other items, each file is named
4 as shown below.
3. Select “Import/Export.” Memory CH: “Meh™
FM Radio Memory: “Radio
: Repeater List: “Rpt”

Load Setting ' GPS Memory: “Gps”

Save Setting »

Save Form ! ® See page iii on how to enter characters.

7. Push [ENT]

Opening Picture » ' '

SD Card Info |l
4. Select “Export.” Your20211101_01

Import »

CSV Format > EMECHAR TYPE  ABC

» The confirmation dialog is displayed.
8. Select “YES.”
5. Select “Your Call Sign.” 20211101 N1
Export file?

Memory CH

FM Radio Memory NO

Repeater List EEDCHAR TYPE ABC

GPS Memory + Exports the setting data.
® To exit the MENU screen, push [MENU].

Overwriting the current file:
When you overwrite data in a current file, select the
file you want to overwrite in step 6 to the left.

<<New File>>

Your20211101_01

2-8



2 USING a microSD CARD

About the SD Card mode

When “USB connect” is set to “SD Card Mode,” and
the transceiver is connected to the PC through a USB
data cable, you can transfer the files between the
micoSD card set in the transceiver and a PC.

You can back up the setting data and recording data
saved on the microSD card to a PC, and save the
image data for the Share Pictures function and the
firmware data to the microSD card without inserting or
removing it.

[MENU] > SET > Function > USB Connect

1. Connect the transceiver to a PC using a USB
cable.

2. Push [MENU].

3. Select “Function” in the “SET” menu.

4. Select “USB Connect.”

VOX »

cl-v »

USB Connect 4

USB Serialport Functi »
Heterodyne »
Battery Pack Select i

5. Select “SD Card Mode.”

Charge Only
Serialport

SD Card Mode

» The confirmation dialog is displayed.
6. Select “Yes.”

@ * 5012:00
After connecting to
the PC, it stops
transceiver functions. i

OoK?
I
NO L
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NOTE: Before connecting the transceiver in the SD

Card mode to a PC with a USB cable, a microSD

card must be inserted.

@ If the microSD card is not inserted, insert it with the
transceiver turned OFF, and then reconnect the USB
cable.

TIP: In the SD Card mode, the transceiver works

not as a transceiver but as a data storage device. It

temporarily stops some functions as follows:

+ Stops recording

» Pauses the GPS Logger function and the RX History
Log function

» Disconnects a Bluetooth device

+ Disables the Auto Power OFF function

To exit the SD Card mode

@® This instruction manual is based on Windows 10.

1. Click “[” in the task tray.

2. Click “Eject Device.”

3. After “Safe to Remove Hardware” is displayed,
remove the USB cable from the PC.




2 USING a microSD CARD

Check the free space and the recording time on the microSD card

[MENU] > SET > SD Card > SD Card Info

1. Push [MENU].
2. Select “SD Card” in the “SET” menu.
3. Select “SD Card Info.”

Load Setting »
Save Setting »
Save Form »
Import/Export 4
Opening Picture »

SD Card Info »

Free space:
T
14,549.3MB
(REC: 264h51m)

Capacity:
14,785.5MB

» The free space and the recording time on the
microSD card are displayed.
® To exit the MENU screen, push [MENU].
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3 BATTERY CHARGING

Battery information

< Battery life

The approximate battery life (operating time) as

shown below is calculated under the following

assumptions:

» Power save setting: Auto (Short)

* Duty cycle: TX : RX: Standby=1:1:8
(based on operating style)

The approximate battery life:

Battery pack FM mode
BP-271 4.25 hours
BP-272 7.25 hours
BP-307 12 hours

® See page 3-8 for the optional BP-273 battery
case battery life.

NOTE: BE SURE to replace the battery pack with

a new one approximately five years after purchase,
even if it still holds a charge. The material inside the
battery cells will become weak after a period of time,
even with little use.

The estimated number of times you can charge the
pack is between 300 and 500. Even when the pack

appears to be fully charged, the operating time of the

transceiver may become short when:

» Approximately five years have passed since the
pack was manufactured.

» The pack has been repeatedly charged.

TIP: Keep the battery terminals clean. It's a good
idea to clean them occasionally.

3-2

< Battery icon

The “@0)" battery icon is displayed when the battery
pack is attached to the transceiver.

Battery status

The battery is being charged.

The battery has sufficient capacity.

The battery is exhausted a little.

o
BBEERS
=

The battery is nearing exhaustion.
(green)

The battery is almost fully exhausted.

® Immediately charge the battery pack.
Otherwise, the icon will soon start
blinking, “LOW BATTERY” will be
displayed, and the transceiver will
automatically turn OFF.

red

—~~
~

When an external DC power supply (12
V DC) is connected, the battery is not
being charged because:

» The battery is completely charged.

+ “Charging (Power ON)” is set to “OFF.”

No icon

® The battery icon for the BP-273 cannot display the
capacity of the alkaline batteries. The battery icon always
displays “f@8,” and it does not reflect with the true battery
capacity.

To display the correct battery status

Select the attached battery pack in the following
item. (Default: BP-271/BP-272)

(IMENU] > SET > Function > Battery Pack Select)

To display the Battery Pack Select dialog every time you
attach the battery pack, set the following item to “ON.”
(IMENU] > SET > Function > Battery Pack Confirmation)




3 BATTERY CHARGING

Charging information

NOTE:

* Prior to using the transceiver for the first time, the
battery pack must be fully charged for optimum
life and operation.

* BE SURE to turn OFF the transceiver while
charging with the supplied battery charger.
Otherwise, the battery pack will not charge.

® While charging, the charging icon “8&&” and
“Charging....” are displayed.

® The icon and “Charging....” disappear when the
battery pack is fully charged.

< Charging through the [DC IN] jack

The approximate battery life (operating time) as
shown below is calculated under the following
assumptions:
* When using the optional CP-12L or OPC-254L, the
battery pack can be charged with the power ON.
(p- 3-7)
® To connect, see the illustration below.
» The BP-273 battery case has no charging capability
or socket.

Approximate charging time
« BP-271: 3 hours
« BP-272: 5 hours
« BP-307: 8 hours

~

BC-167S*"

To a cigarette
[ lighter socket

. |
ST (12V DC)
DC IN]
- OPC-254L
Toa12VDC

Turn OFF*2
T ;
& Black: &

White:®

~

power source

To charge the battery pack:

» Use the supplied battery charger or optional cable.
» Use a USB cable (User supplied). (p. 3-4)

* Use the optional rapid charger. (p. 3-6)

Charging note

» CAUTION: BE SURE to attach the battery pack
before connecting the DC cable.

» Turn OFF the transceiver when using the BC-167S.

» DO NOT charge the fully charged battery pack.
This may cause a shorter battery life.

*1 The shape is different, depending on the version.
*2 When using the BC-167S, turn OFF the transceiver.



3 BATTERY CHARGING

Charging information

< Charging with a USB cable

You can charge the battery pack with a USB cable (micro B type) while operating the transceiver.

USB cable

NOTE:

BE SURE to attach the battery pack to the transceiver.

To use a mobile device or a PC as an external power

source, set the following item to “ON” (default).

(IMENU] > SET > Function

> USB Power Input (Phone, Tablet, PC))

The battery pack is used as a power source while

transmitting, even when an external power source is

connected.

Therefore, you cannot transmit if the battery pack is

exhausted.

You may not be able to charge:

- Depending on your USB cable or power adapter.

- When using a USB hub or connecting to a low output
USB port.

Charging time may differ, depending on the USB port.

The S-meter may appear, or the noise may occur, due

to the influence of the USB power supply’s noise.

In that case, unplug the USB cable to disconnect the

transceiver from the USB power supply.

When operating the transceiver while charging, the

charging may not be sufficient, and the battery pack

may be consumed, depending on the power adapter.

> —

To a USB port

3-4

Power adapter
—> or external battery
(User supplied)

PC,
Mobile device

TIP:

* When a USB cable is connected, the charging is
stopped when the battery is fully charged.
After that, the charging will resume when a certain
amount of capacity is consumed while connecting the
USB cable.

* You can change the operation when the transceiver is
connected to a PC through a USB cable.
(IMENU] > SET > Function > USB Connect)




3 BATTERY CHARGING

Charging with the BC-2021P2 optional rapid charger

The optional BC-202IP2 rapidly charges a battery Charging note

pack. /A DANGER! NEVER use a battery pack that is not
® When about 90% of the battery capacity is charged, manufactured or approved by Icom.

the BC-202IP2 stops charging and the charging « CAUTION: DO NOT connect anything to the

indicator lights green. Therefore, the battery life
will be a little shorter than when charging with the
transceiver.

Approximate charging time

* BP-271: 1.5 hours

* BP-272: 2.5 hours

* BP-307: 4 hours

® These are the time when the battery is exhausted, and
charging with the transceiver power off.

The following item is required.

* BC-123S (L-shaped type plug)
(A different type, or no power adapter is supplied,
depending on the charger versions.)

[DC IN] jack or the [USB] port on the side of the
transceiver when placing the transceiver to the
rapid charger. This may cause the charger’s
malfunction. If the charging indicator blinks
orange, disconnect the power adapter from the
charger, and then reconnect it.

BE SURE to turn OFF the transceiver. When the
transceiver power cannot be turned OFF because
of the battery exhaustion, detach the battery pack
from the transceiver. Then charge the battery pack
by itself.

The BC-202IP2 RAPID CHARGER can only charge
the BP-271, BP-272, or BP-307 Li-ion BATTERY
PACK. Other types of rechargeable batteries, Ni-

Cd, or Ni-MH cannot be charged.

« If the charging indicator blinks orange, there may
be a problem with the battery pack or charger.
Contact your dealer if you have problems charging
a new battery pack.

Transceiver + battery pack

Battery pack
BP-271, BP-272, or BP-307

(Self-tapping screws: 3.5 x at least 30 mm)
Purchase separately. Using screws is

BC-123S recommended to secure the charger.

(L-shaped type plug)

e

The CP-23L or OPC-515L BC-202IP2  Charging indicator
can also be used instead + Lights orange: While charging
of the power adapter. « Lights green: Charging is completed.
« Blinks orange: A charging error has occurred.
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3 BATTERY CHARGING

Charging with the BC-202IP3L optional rapid charger

The optional BC-202IP3L rapidly charges a battery Charging note
pack. /A DANGER! NEVER use a battery pack that is not
® When about 90% of the battery capacity is charged, manufactured or approved by lcom.
the BC-202IP3L stops charging and the charging « CAUTION: DO NOT connect anything to the
indicator lights green. Therefore, the battery life [DC IN] jack or the [USB] port on the side of the
will be a little shorter than when charging with the transceiver when placing the transceiver to the
transceiver. rapid charger. This may cause the charger’s
. . . malfunction. If the charging indicator blinks
Approximate charging time orange, disconnect the power adapter from the
* BP-271: 2 hours charger, and then reconnect it.
* BP-272: 3 hours + BE SURE to turn OFF the transceiver. When the
* BP-307: 5 hours transceiver power cannot be turned OFF because

® These are the time when the battery is exhausted, and

. . . of the battery exhaustion, detach the battery pack
charging with the transceiver power off.

from the transceiver. Then charge the battery pack
by itself.

The BC-202IP3L RAPID CHARGER can only charge
the BP-271, BP-272, or BP-307 Li-ion BATTERY
PACK. Other types of rechargeable batteries, Ni-
Cd, or Ni-MH cannot be charged.

If the charging indicator blinks orange, there may
be a problem with the battery pack or charger.
Contact your dealer if you have problems charging
a new battery pack.

The following item is required.
* BC-1238S (straight type plug)

Battery pack
BP-271, BP-272,

Transceiver + battery pack
or BP-307

AC outlet

BC-123S
(straight type plug)

® The CP-25H can also be
used instead of the power
adapter.

) @ To connect the power adapter to the
charger, remove the charger’s left cover.
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3 BATTERY CHARGING

Connecting BC-202IP3L together

External DC power operation

You can connect up to 6 BC-202IP3L together.
1. Remove the charger’s right cover. (@)
2. Snap the DC power plug to the another charger’s

DC power jack. (@)

/A WARNING! NEVER connect more than 6
chargers together. It may result in an electric shock,
cause a fire, overheating, or damage the chargers.
/A WARNING! NEVER use other than the BC-228
AC adapter when connecting multiple BC-202IP3L
units. It may result in an electric shock, cause a fire,
overheating, or damage the chargers.

Operating note

* DO NOT connect over 16 V DC directly into the
[DC IN] jack of the transceiver. The power source
voltage must be between 10.0 V ~ 16.0 V DC.

* DO NOT transmit at high power for a long period
of time. The transceiver becomes hot, and it may
cause a burn.

* Use the optional CP-12L or OPC-254L when using
the external DC power.

» Confirm the correct polarity of the OPC-254L
supply connection. Connect the OPC-254L to an
external power source (user supplied).

* Use an external DC-DC converter to connect the
transceiver through the optional CP-12L or OPC-
2541 to a 24 V DC power source. Ask your dealer
for details.

* When the external power is used, the Power Save
function (p. 12-18) is automatically turned OFF.
Depending on the external power voltage,
the battery pack may be used to operate the
transceiver, and the battery pack capacity is
consumed.

TIP: The battery pack can be charged even if the
transceiver is ON when “Charging (Power ON)” is
set to “ON” (default).

This operation may generate certain spurious
signals, and the S-meter may appear, or noise may
be heard.

When you operate the transceiver while charging,
and if you cannot receive signals correctly, set
“Charging (Power ON)” to “OFF.”

(IMENU] > SET > Function > Charging (Power ON))
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To a cigarette
lighter socket
(12 vV DC)

OPC-254L

Toa12V DC
power source

White: ®

CAUTION: BE SURE to attach the battery pack
before connecting the DC cable.

® The BC-167S cannot be used for external DC
power operation.



3 BATTERY CHARGING

About the optional battery case

The BP-273 uses three AA (LR6) size alkaline
batteries.
1. Remove the battery case top, as shown below.
2. Install three AA (LR6) size alkaline batteries.
@ Install only alkaline batteries.
® BE SURE to observe the correct polarity.
3. Attach the battery case. (p. 1-2)

Batteries cautions

* When installing batteries, confirm that they are all
the same brand, type, and capacity. Do not mix
new and old batteries together.

* DO NOT incinerate used battery cells since the
internal battery gas may cause them to rupture.

* DO NOT expose a detached battery case to
water. If the battery case gets wet, BE SURE to
wipe it dry before using it.

+ DO NOT use batteries whose insulated covering
is damaged.

» Keep the battery terminals clean. It's a good idea
to clean them occasionally.

* Remove the alkaline batteries when the battery
case is not used. Otherwise, the installed alkaline
batteries will be exhausted due to the built-in step-
up converter.

TIP:

* A built-in step-up converter in the BP-273
increases the voltage to 5.5 V DC. Approximately
100 mW of output power is possible using the
case. Also, the transmit output power selection is
disabled.

» The transceiver meets IPX4 requirements
for waterproof protection when the BP-273 is
attached.

» The batteries may seem to have low capacity
when used in low temperatures, such as —10°C
(+14°F) or below. Keep the batteries warm in this
case.
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< Battery life

The approximate battery life (operating time), as

shown below, is calculated under the following

assumptions:

* Power save setting: Auto (Short)

* Duty cycle: TX : RX : Stand-by=1:1:8
(based on operating style)

The approximate battery life:
FM mode
4.5 hours

® The battery life may differ, depending on your
operating style, or the installed alkaline batteries.

< About the battery replacement

When the alkaline batteries are almost exhausted,

“‘LOW BATTERY” is displayed, and the battery icon

starts to blink. After 10 seconds, the transceiver power

is automatically turned OFF. In that case, replace all 3

batteries with new alkaline batteries.

® The battery icon for the BP-273 cannot display the
capacity of the alkaline batteries. The battery icon always
displays “@8,” and it does not reflect with the true battery
capacity.



3 BATTERY CHARGING

Specifications for the battery charger and battery packs

<& BP-271 Li-ion BATTERY PACK (optional)

 Voltage: 7.4V

+ Discharge Capacity: 1150 mAh (minimum)

» Usable temperature range: —20°C ~ +60°C, —4°F ~ +140°F

» Charging temperature range: 0°C ~ 40°C, 32°F ~ 104°F

+ Storage temperature range: —-20°C ~ +50°C, —4°F ~ +122°F (within a month)
—20°C ~ +35°C, —4°F ~ +95°F (within 3 months)
—20°C ~ +20°C, —4°F ~ +68°F (within a year)

* Dimensions: 58 (W) x 86.9 (H) x 9.1 (D) mm, 2.3 (W) x 3.4 (H) x 0.4 (D) inches
(projections are not included)

<O BP-272 Li-ion BATTERY PACK (supplied)

* Voltage: 7.4V

 Discharge Capacity: 1880 mAh (minimum)

» Usable temperature range: —-20°C ~ +60°C, —4°F ~ +140°F

» Charging temperature range: 0°C ~ 40°C, 32°F ~ 104°F

» Storage temperature range: —-20°C ~ +50°C, —4°F ~ +122°F (within a month)
—20°C ~ +35°C, —4°F ~ +95°F (within 3 months)
—20°C ~ +20°C, —4°F ~ +68°F (within a year)

» Dimensions: 58 (W) x 86.9 (H) x 14.2 (D) mm, 2.3 (W) x 3.4 (H) x 0.6 (D) inches
(projections are not included)

<& BP-307 Li-ion BATTERY PACK (optional)

* Voltage: 7.2V

+ Discharge Capacity: 3050 mAh (minimum)

* Usable temperature range: —-20°C ~ +60°C, —4°F ~ +140°F

» Charging temperature range: 0°C ~ 40°C, 32°F ~ 104°F

« Storage temperature range: -20°C ~ +50°C, —4°F ~ +122°F (within a month)
—20°C ~ +40°C, —4°F ~ +104°F (within 3 months)
—20°C ~ +20°C, —4°F ~ +68°F (within a year)

* Dimensions: 58 (W) x 86.9 (H) x 22.4 (D) mm, 2.3 (W) x 3.4 (H) x 0.9 (D) inches
(projections are not included)

<& BC-202IP2 RAPID CHARGER (optional)

» Power source requirement: 12V ~ 16 V DC or the specified Icom power adapter

» Charging temperature range: 10°C ~ 40°C, 50°F ~ 104°F

+ Weight: Approximately 105 g, 3.7 oz (without power adapter)

* Dimensions: 88.0 (W) x 47.5 (H) x 72.5 (D) mm, 3.5 (W) x 1.9 (H) x 2.9 (D) inches
(projections are not included)

<& BC-202IP3L RAPID CHARGER (optional)

» Power source requirement: 12V ~ 15V DC or the specified lcom power adapter

» Charging temperature range: 10°C ~ 40°C, 50°F ~ 104°F

» Weight: Approximately 120 g, 4.2 oz (without power adapter)

» Dimensions: 106.5 (W) x 52.5 (H) x 78.0 (D) mm, 4.2 (W) x 2.1 (H) x 3.1 (D) inches
(projections are not included)
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4 FM RADIO OPERATION

Basic operation

<O Description

You can listen to FM Radio broadcasts.

While using the Dualwatch function, you can still listen
to the FM Radio on the pop up window.

Up to 500 FM Radio Memory channels can be
separately stored in the 26 groups for easy memory
management.

You can standby listening to FM Radio. Also, the
transceiver has the exclusive FM Radio mode, where
only the FM Radio functions. In this mode, the other
functions are disabled.

TIP: The FM Radio Memory channel contents,
described in this manual, may differ from your
transceiver’s preloaded contents.

The frequency range for the FM Radio

FM: 76.0 MHz* to 108.0 MHz

* The usable frequency range differs, depending on the
transceiver’s version.

< Turning ON the FM Radio

1. Push [QUICK].
2. Select “<<FM Radio ON>>"
» Returns to the standby screen, and the FM RADIO
window is displayed.
« “g@ is displayed.

Band Scope 4
<<REC Start>>

<<FM Radio ON>>

<<FM Radio Mode>
<<GPS Logger Only>

v
@[] <=====—"Displayed when the FM
Radio is ON.
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TIP:
To turn OFF the FM Radio
Push [QUICK], and then select “<<FM Radio OFF>>""

To listen to the FM Radio while monitoring the
A/B bands

Push [CLR] to close the FM RADIO window.

* You can standby listening to FM Radio.

[iamn] =1 RS 12:00]
[MAINIZY] L]

146.010

PSKIP
VFO

FM

440-000 PSKIP

VFO

® To open the FM RADIO window again, push [QUICK],
and select “<<FM Radio>>.”
00

Band Scope 4
<<REC Start>>

<<FM Radio OFF>>
<<FM Radio Mode>

<<GPS Logger Only> |}

NOTE: If you turn ON the Band Scope function while
using the Dualwatch function, the FM Radio audio
output may be interrupted due to the AF Output
(DUAL/AIR Band) function.
In that case, set “Auto Mute” to OFF, or set “AF
Output (DUAL/AIR Band)” to OFF.
® When “AF Output (DUAL/AIR Band)” is set to ON, the
received audio is momentarily heard during a sweep,
and you will know that a signal is received without
looking at the display.
(IMENU] > FM RADIO > FM Radio Set > Auto Mute)
(IMENU] > SET > Scope > AF Output (DUAL/AIR Band))
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Basic operation

¢ Selecting the FM Radio mode

1. When the FM RADIO window is displayed,
push [MR] to select between the Tuning and the
Memory modes.

2. Rotate [DIAL] to select a frequency or a memory
channel.

* Tuning mode

The FM Radio Tuning mode is used to set the desired
FM Radio frequency.

When the Tuning mode is selected, ‘{MFOY is
displayed.

To save the selected frequency, hold down [MR] for 1

second.
« Enters it into the lowest memory channel of the selected

group.

= % B 12:00

Tuning mode

* Memory mode

The FM Radio Memory mode is very useful to quickly
select often-used frequency settings.

When the Memory mode is selected, ‘B[ and the
selected memory channel group (A ~ Z) and number

are displayed.

[ & % 3 12:00

88. Tus:

FM-A Station

VFO

Memory mode

TIP: Push [QUICK], and select “VFO” to select the
Tuning mode, or select “MR” to select the Memory
mode.

< Selecting the group in the Memory

mode

Up to 50 FM Radio Memory channels can be assigned
to each group for easy memory management.

If you change the group, other area channels can be
selected.

1. Push [MR] to select the Memory mode.
fiaun] = % 8 12:00

FM-A Station

ITBA00

« “lV[:W’ and the selected memory channel number is
displayed.

Push [QUICK].

Select “Group Select.”

12
<<FM Radio OFF>>

W

VFO

Group Select »
SKIP i
ATT |

<<FM Radio Mode>>

=

4. Select the desired group.

A:Areal
B :Area2

!

D:Aread
E :Area5
F :Area6 P

VFO

[ & % 3 12:00

88.2u:

FM-E Station

IEC00

* Returns to the standby screen, and the memory
channel in the selected group is displayed.
5. Rotate [DIAL] to select a memory channel.
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Basic operation

< Searching for an FM Radio signal

While in the Tuning mode, hold down D-pad(5) to
start searching the broadcast signal.

P-While searching, the frequencies are
sequentially displayed.

When a signal is received

* When you hold down D-pad(«), a down scan starts, and
when you hold down D-pad(—), an up scan starts.

* When a signal is received, the scan stops on the
frequency.

» To cancel the scan, push D-pad($5) or [CLR].
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¢ Using the Attenuator function

The Attenuator prevents a desired signal from
becoming distorted when a very strong FM Radio
signal is near the frequency, or when a very strong
electric field, such as from a broadcasting station, is
near your location.

1. Push [QUICK].
Select “ATT.”

12
<<FM Radio OFF>>

MR
ATT »
<<FM Radio Mode>> [’

VFO

3. Select “ON.”

OFF

Displayed when
. the Attenuator is ON.

» “ATT" is displayed.
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Basic operation

< Setting a squelch level

The squelch enables the audio to be heard only while
receiving a signal that is stronger than the set level. A
higher level blocks weak signals, which enables you
to receive only stronger signals. A lower level enables
you to hear weak signals.

The squelch level that is set on the FM RADIO
window is only for the FM Radio.

While holding down [SQL], rotate [DIAL] to select the

squelch level.

] = » 5 12:00 [aen] = » 5 12:00
88.0w:: | > 88.0w:: |

SQUELCH: AUTO SQUELCH: LEVEL3

Automatic squelch Maximum squelch level

® Information
» Options: “OPEN,” “AUTO” (default), and “LEVEL 1” ~
“LEVEL 3"

* “LEVEL 1” is loose squelch (for weak signals), and
“LEVEL 3” is tight squelch (for strong signals).

* “AUTO” is an automatic level adjustment using a noise
pulse counting system.

* “OPEN” is the continuously open setting.
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¢ Using the Monitor function

The Monitor function is used to listen to weak FM
Radio signals without changing the squelch setting.

While holding down [SQL], the transceiver monitors
weak signals on the frequency.
» The squelch opens.

& % 3 12:00

VFO

The first segment blinks.

TIP: You can set the Monitor Hold function on the
MENU screen. The transceiver opens or closes the
squelch each time you push [SQL].

(IMENU] > SET > Function > Monitor)




4 FM RADIO OPERATION

FM Radio memory

¢ Using the FM Radio Memory <¢Add an FM Radio memory

ﬁte?:}aolr(;f 26 groups are selectable for FM Radio Step 1. Adding an FM Radio memory and entering
You can assign up to 50 FM Radio memory channels the edit mode

to each group, for easy memory management. (A [MENU] > FM RADIO > FM Radio Memory

maximum of 500 memories can be assigned to the FM
Radio memory.)

Some area stations are preloaded into the FM Radio
memory for easy memory management.

1. Push [MENUI.
Select “FM Radio Memory” in the “FM RADIO” menu.

FM Radio Set »
TIP: The FM Radio memory contents, described <<FM Radio OFF>>

in this manual, may differ from your transceiver’s <<FM Radio Mode>>

programmed memory.

3. Select a desired group.

»
»
»
»
»
"

U e

@ If there is no memory, “-- Blank --" is displayed.
Push [QUICK].
Select “Add.”

Add

S

* The FM RADIO MEM EDIT screen is displayed.

TIP: To change the group name, push [QUICK], and
then select “Edit Name” in step 4.
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4 FM RADIO OPERATION

FM Radio memory

< Add an FM Radio memory
Step 2. Entering an FM Radio Memory name

Step 4. Selecting the skip setting

1. Select “NAME.”

FREQUENCY:

2. Enter a name.

INAME |

FM-G Station_

EMWCHAR TYPE  abc

® See page iii on how to enter characters.
3. After entering, push [ENT].

TIP: To change the FM Radio memory group, select
“GROUP,” then select the desired group.

Step 3. Entering a frequency

1. Select “FREQUENCY.”

0

NAME: ,
FM-G Station

GROUP: ,

G

2. Rotate [DIAL] to enter the frequency.

88 JMHz

® Push D-pad($5) to move the cursor.
® The usable frequency range differs, depending on the
transceiver’s version.
3. After entering, push [ENT].
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1. Select “SKIP.”

SKIP: \
OFF

<<Add Write>>

2. Select “OFF” or “SKIP.”

SKIP

* OFF: You can select the memory in the Memory mode.
» SKIP:The memory is not displayed in the Memory
mode.

Step 5. Saving the FM Radio Memory

1. Select “<<Add Write>>.”

SKIP:

»
OFF

<<Add Write>>

2. Select “YES.”

CKID-:
& Add write?

NO

v

FM-G Station »

* The entered contents are saved in the FM Radio
memory, and the display returns to the selected
group screen.

TIP: How to cancel the entered data:
1. Push [CLR].
2. Select “YES.”

Cancel edit?

NO

» Cancels the entry, and returns to the selected group
screen.




4 FM RADIO OPERATION

FM Radio memory

¢ Editing an FM radio memory

This function edits FM Radio memory contents. This
is useful when already-entered data is incorrect, has
changed, or new data should be added to the list.

[MENU] > FM RADIO > FM Radio Memory

1. Push [MENU]. 8. After editing, select “<<Overwrite>>.”
2. Select “FM Radio Memory” in the “FM RADIO” menu.
SKIP: ,
OFF
FM Radio Set » <<Add Write>>
<<FM Radio OFF>>
<<FM Radio Mode>>
9. Select “YES.”
3. Select a group that includes the memory you want
to edit. o
&Overwrite?
B : Area 2 » NO
C:Area3 »
D:Aread » g
E:Areas » * The memory contents are overwritten, and returns to
F :Area6 i the selected group screen.

4. Select the memory to be edited.

FM-A Station »

FM-B Station »
FM-C Station »

® DO NOT push [ENT].
Push [QUICK].
Select “Edit.”

oo

7. Select an item, then edit it.
® See page 4-7 for details.
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4 FM RADIO OPERATION

FM Radio memory

< Deleting an FM Radio memory

All the contents of an FM Radio memory can be
deleted.

NOTE: Deleted memories cannot be restored.

[MENU] > FM RADIO > FM Radio Memory

Push [MENU]. 7. Select “YES.”
Select “FM Radio Memory” in the “FM RADIO” menu.

N =

FM Radio Memory »

FM Radio Set 4
<<FM Radio OFF>>
<<FM Radio Mode>>

3. Select a group that includes the memory you want

to delete.
H: »
| : »
J: »
K: > » The selected FM Radio memory is deleted.
L: »

4. Select the memory to be deleted.

FM-G Station »

® DO NOT push [ENT].
Push [QUICK].
Select “Delete.”

o v

AADANIA ~DALID

SKIP
Add
Edit

Move
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4 FM RADIO OPERATION

FM Radio memory

¢ Rearranging the display order of the

FM Radio memories

You can move the entered FM Radio memories to
rearrange their display order in the selected FM Radio
memory group.

[MENU] > FM RADIO > FM Radio Memory

1. Push [MENU]. 7.
2. Select “FM Radio Memory” in the “FM RADIO” menu.

Select a memory to insert the repeater you want to
move above it.

FM-A Station 3

FM Radio Memory  »

FM Radio Set » FM-B Station »
<<FM Radio OFF>> FM-C Station »
<<FM Radio Mode>>
Select a group that includes the memory you want \ 4

to move.

FM-B Station »
FM-C Station >
B:Area2
C:Area3 »
D:Aread »
E :Area5 4
F :Areab d

» The selected memory is inserted above the
destination memory.

@ If you select “<<Move End>>,” the memory is moved
to the bottom of the group.

4. Select the memory to be moved.

FM-A Station »

FM-B Station »
FM-C Station »

® DO NOT push [ENT].
5. Push [QUICK].
6. Select “Move.”
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4 FM RADIO OPERATION

FM Radio memory

< Skip setting for the FM Radio

memory

You can set memories as skip memories. The
selected memories are not displayed in the Memory
mode.

[MENU] > FM RADIO > FM Radio Memory

1. Push [MENU]. 7. Select “SKIP.”
2. Select “FM RADIO.”
3. Select “FM Radio Memory.” Add
Edit
Move
FM Radio Set » Delete

<<FM Radio OFF>>
<<FM Radio Mode>>

4. Select a group that includes the memory you want
to set the skip setting on. FM-B Station 4
FM-C Station »
B : Area 2 »
C:Area3 »
D:Area4 » » “SKIP” is displayed on the selected memory.
E:Areas » ® Push [QUICK], and then select “SKIP” again to
F : Area 6 > cancel the skip setting.

5. Select the memory to be skipped.

TIP: When displaying the FM RADIO window in the

Memory mode, push [QUICK], and selecting “SKIP”
FM-B Station ’ also sets the skip setting.
FM-C Station » 15
<<FM Radio OFF>>
VFO
Group Select »
sk
® DO NOT push [ENT]. e o
6. Push [QUICK]. <<FM Radio Mode>>
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4 FM RADIO OPERATION

Using the FM Radio mode

The transceiver has an exclusive FM Radio mode
where only the FM Radio functions.

1. Push [QUICK].
2. Select “<<FM Radio Mode>>."

Band Scope 'l
<<REC Start>>

<<FM Radio ON>>

P
<<GPS Logger Only>

P

v

& % g 12

frun]

88.0w:-

2021/11/01 (Mon)

» The FM Radio mode screen is displayed.

TIP: To cancel the FM Radio mode
1. Push [QUICK].
2. Select “<<Normal Mode>>."
@ In the exclusive FM Radio mode, the other modes
are in a sleep state. To operate the transceiver in a
normal way, cancel the FM Radio mode.
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4 FM RADIO OPERATION

FM RADIO items

FM Radio Memory Earphone Antenna (Default: Not Used)

[MENU] > FM RADIO > FM Radio Memory

A total of 26 groups are selectable for FM radio
Memories.

You can assign up to 50 memories to each group,

for easy memory management. (A maximum of 500
memories can be assigned to the FM Radio Memory.)

FM Radio memory contents

The name of an FM Radio memory
channel

NAIE ® Enter a name of up to 16 alphanumeric
characters for each memory.
GROUP The group letter and the name of the group
Entered frequency
FREQUENCY ® The usable frequency range differs,
depending on the transceiver’s version.
Shows the skip status.
SKIP ® The Skip channels are not displayed in
the Memory mode.
Auto Mute (Default: 2sec)

[MENU] > FM RADIO > FM Radio Set > Auto Mute

Selects whether or not to mute the FM Radio audio in

the background* while receiving a signal on the A or B

band.

® The FM Radio audio is muted while transmitting,
regardless of this setting.

* See “To listen to the FM Radio while monitoring the A/B
bands” on page 4-2 for details.

* OFF: The Auto Mute function is OFF. The FM Radio

audio is not muted even if the transceiver

receives a signal on the A or B band. The FM

Radio audio is muted when the transceiver

transmits.

The FM Radio audio is automatically muted

when the transceiver transmits or receives

on the A or B band. After transmitting or

receiving, the Auto Mute timer starts. After the

timer period ends, you can listen to FM Radio

again.

®The FM Radio audio is muted when a
signal is received during a sweep by the
Band Scope function.

* 0to 10sec:
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[MENU] > FM RADIO > FM Radio Set >
Earphone Antenna

Selects whether or not to use the earphone antenna
for FM radio.

* Not Used: An earphone antenna is not used.

» Use: An earphone antenna is used.

Power Save (FM Radio)

[MENU] > FM RADIO > FM Radio Set >
Power Save (FM Radio)

Sets the power save function to reduce the current

drain and conserve battery power when the FM Radio

is ON.

» OFF: The power save function is OFF.

* ON: When the FM Radio is ON, and no signal is
received for 5 seconds, this function is activated in
a 1:3 ratio (300 : 900 milliseconds).

(Default: ON)

NOTE: This function is disabled when an external
power source is used.

<<FM Radio ON>>

[MENU] > FM RADIO > <<FM Radio ON>>

Turns ON the FM Radio.

When the transceiver receives on the MAIN band and

SUB band, you can still listen to the FM Radio.

When the FM Radio is ON, <<FM Radio OFF>> is

displayed on the FM RADIO screen. To turn OFF the

FM Radio, select <<FM Radio OFF>>,

® In the Quick Menu window, selecting <<FM Radio OFF>>
also turns OFF the FM Radio.

<<FM Radio Mode>>

[MENU] > FM RADIO > <<FM Radio Mode>>

The transceiver enters an exclusive FM Radio mode

where only the FM Radio functions.

While in the FM Radio Mode, <<Normal Mode>> is

displayed on the FM RADIO screen. To exit from the

FM Radio mode, select <<Normal Mode>>.

@ In the Quick Menu window, selecting <<Normal Mode>>
also exits from the FM Radio mode.




Section 9 D-STAR OPERATION (ADVANCED)

NOTE: See D-STAR GUIDE on the “‘FROM?” (access repeater) setting.........coooviiiiiiiiiiceee e 5-3
Basic manual for details on how to < Using your transceiver’s repeater list ..., 5-4
register your call Sign to a gateway <o Using (gL B S Tor=] o TP 5-5
repeater and the basic operations. < Using the Near Repeater Search function............ccccooviiiiiiiiinciiec e, 5-6
Q USING TX HISTOMY ...t 5-7

“TO” (Destination) Setting .........c.eviiiiiiiiie e 5-8

< Making the “Local CQ” (Local Area call)...........coovuviiiiieiiiiiiiiiiec e 5-9

< Making a “Gateway CQ” (Gateway Call).........ccceevieiiriieiiiiieeiiee e 5-9

<& USIiNg “Your Call SigN” .......ooiiiiieiieie et 5-10

O USING RX HISTONY ... 5-10

Q USING TX HISIOMY ... 5-11

< Directly entering (UR) .......eooeiiecie e 5-11

< Directly entering (RPT) ..o.eeeeiee e 5-12

REPEATER DETAIL SCrEEN ......uuiiiiiiiiiieiee ettt 5-13

Connecting to a reflector ... 5-14

O What is @ refleCtor? ......cooiiiiee e 5-14

O Unlinking @ refleCtor..........vuiiiiieeee e 5-14

< Linking t0 @ reflector ........eoe e 5-15

O USING @ FeflECION ... e 5-16

<O Reflector ECho teStiNG ......eoeiiiiieciee e 5-16

< Requesting repeater information .............cccooiiiii 5-16

MesSage OPEration ..........oooii it 5-17

O Entering @ TX MeSSA0E ....eeiieiiiiiiiiee et 5-17

O Transmitting @ MESSAGE -...ceeeiiiiiiiiee e 5-17

O Deleting @ TX MESSAQE -...eeiieeiiiiiiee e et e e e e e eeeeee s 5-18

Viewing received Call SIgNS........ccoiiiii i 5-19

< Viewing the call signs on the RX History screen ..........ccccoociiiiiiien. 5-19

BK mode communication...............eeeiiiiiiiiiiiic e 5-21

EMR cOmMMUNICALION .....ooiiiiiiiiiic e 5-22

< Adjusting the EMR AF [€VEl.........uuuiiiiiiiieiiiiieee e 5-22

Automatic DV detection............ooiiiiiiiiii e 5-23

Automatic Reply fUNCLION..........cooiii e 5-24

< Recording an Auto Reply MeSSage .........cccvvvviiiiiiieeiiiii e 5-25

< Auto Position Reply fUNCHON .........cooiiiiiiiiie e 5-26
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Section 5 D-STAR OPERATION (ADVANCED)

IMPORTANT!

Data communiCation............ooouiiiiiiiiiee e 5-27
QO CONNECHION ...t 5-27
< Data communication application setting...........cccooveiiiiiiiniiie e 5-27
O SeNAiNG Aata ... e 5-27
< DV Fast Data fuNCHION .......oooiiiiiiiiie e 5-28

About the disSplay tYPe .....cooo i 5-28

Digital squelch fUNCLIONS........cuviiiii e 5-29
< The Digital Call Sign squelch setting........ccccovvieeiiiiiiii 5-29
< The Digital Code Squelch setting .........ccooviiiiiiiiiiiei e 5-29

Repeater list ....... ..o 5-30
< Repeater list CoNtentS........cooviiiiiiii e 5-30

Entering new information into the repeater list............cccccceeevciieeennnnee. 5-31
< Required items for the communication cases ............cccccccvvviriiieieeeeeeen.n. 5-31
< Entering new information into the repeater list............ccccooeiiiiiiiicenne 5-32

Repeater list operation ... 5-36
< Editing repeater data ... 5-36
< Deleting repeater data...........covovieiiiiii e 5-36
< Rearranging the display order of the repeaters............cccccoociiiiiiiiien. 5-37
< Adding new repeater information from RX History ...........cccccoviveiiirnnne. 5-38
< Skip setting for the DR SCAN ........c.eeiiiiiiiiiiiiec e 5-39
< Entering or editing a repeater group Name............ccccceeeeeeiciiieee e 5-40

YOUT Call SIGN ... e 5-41
<& Entering Your Call Sign .....coooviiiiiiei et 5-41
< Deleting Your Call Sign......ccooceiiiiiiiie e 5-42
< Rearranging the display order of Your Call Signs..........cccoceeviiieriiieennne. 5-43

Are your settings COrmrect?..... ... 5-44

» The repeater list, described in this manual, may differ from your transceiver’s preloaded contents.

» Although Japanese repeaters are used in the setting examples, the Japanese repeater node (port) letters
are different from other country’s. BE SURE to add the repeater node letter in the 8th digit of the call sign,
according to the frequency band shown below.

1200 MHz: A (B in Japan)
430 MHz: B (Ain Japan)
144 MHz: C (no repeaters in Japan)

To begin the Digital mode communication using other than the D-STAR Repeater (DR) function

To begin Digital mode communication using other For a Local area call or Gateway call:

than the DR function, you can use the VFO mode, 1. Set the access repeater’s frequency. (p. 11-2)
Memory mode, or Call Channel mode. 2. Set the Duplex direction and frequency offset.
This manual description focuses on the DR function (p. 11-4)

operation, which can be easily set up. If you want to 3. Set the call signs (UR/R1/R2). (p. 12-8)

use other than the DR function, see the procedures

as described to the right, or select the repeater in a For a Simplex call:

Memory channel.

1. Set the operating frequency.
2. Set the call signs (UR/R1/R2). (p. 12-8)
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5  D-sTAR OPERATION (ADVANCED)

“FROM?” (access repeater) setting

Your access repeater must be set in “FROM” when you make a call on the DR screen.
You have 5 ways to select the access repeater.

By rotating [DIAL] ] % & 1200
Select the preset repeater on the DR screen by rotating [DIAL]. QEmoY b ) .
JCQC( 592,707 |«—Displayed while
rmowm Kirkland (1A) rotating [DIAL]
| DR |
FM
440-000 PSKIP

* When you know your access repeater

From the repeater list (p. 5-4)

When your access repeater is in your transceiver’s repeater list, you can

select it by selecting the repeater area and name, if entered, or call sign. Near Repeater ’
TX History 4

* When you do not know which repeaters you can access

Search for a repeater using the DR scan (p. 5-5)

The Normal DR scan searches for output repeater frequencies of nearby : 51700

repeaters. The scan stops when a signal is detected. The scan also stops
on Simplex signals.

The Near Repeater scan searches for output repeater frequencies of
nearby repeaters by using your location and the repeater’s location, if it
is entered in the Repeater List. The DR scan starts scanning and stops
when a signal is detected.

You can also find only FM repeaters using the Near Repeater (FM) scan.

Search for near repeaters (p. 5-6)

The transceiver scan searches for near repeaters by using your location
and the repeater’s location, if it is entered in the Repeater List.

The nearest repeaters in your transceiver’s repeater list are displayed as
selectable options.

You can select the nearby DV or FM repeater type.

Near Repeater (ALL)
Near Repeater (DV)
Near Repeater (FM)

VFO

Scan items

Repeater List ’

Near Repeater 4

TX History ’

* When “FROM?” data is saved in the TX History.

Select from the TX History (p. 5-7)

Select a repeater that you have accessed before from the TX History Repeater List »
record. Near Repeater 3
TX History »
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5  D-sTAR OPERATION (ADVANCED)

‘FROM?” (access repeater) setting

<& Using your transceiver’s repeater list
When your access repeater is in your transceiver’s
repeater list, you can select it from the list. By just
selecting the repeater from the list, the repeater call

sign, its frequency, duplex setting, and frequency
offset are automatically set, for easy operation.

Example: Selecting the “Kirkland (IA)” repeater in

1.

Washington state in the USA from the
repeater list.

Hold down [DR] for 1 second to display the DR
screen.

Push D-pad(!) to select “FROM,” and then push
[ENT].

[unn] ES 12:00|
MDY D-
| I8 cqcaca

Farm Ozondjisse
139.500 V53DV B

FM

440.000

VFO

PSKIP|

Select “Repeater List.”

Repeater List »

Near Repeater »
TX History »

Select the repeater group where your access
repeater is listed.

19: United Kingdo »
20: USA Midwest »

21: USA Northeast?
22: USA Southeast?

m 23: USA West 4

24: Simplex il
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5. Select your access repeater.

Kirkland (1A)

Lake Stevens
Maple Valley
Newcastle

North Bend n
Washinat N7IH B

» Returns to the DR screen, and the selected repeater

name is displayed in “FROM.”

® The repeater list, described in this manual, may differ

from your transceiver’s preloaded contents.

TIP:

When you select an FM repeater:

When an FM repeater is in your transceiver’s
repeater list, you can select it from the list.

When selecting an FM repeater, the “TO” setting is
not necessary, and a “—" is displayed in “TO.”

When selecting an FM repeater.

% & 12:00
D+ TONE

fui]
(MANEY]

T0
an
Dayton
442.100 wsBl

FM

440.000

PSKIP

How to change the repeater group:
To change the repeater group on the DR screen,
push [QUICK], then select “Group Select.”

Group Select .0
Repeater Detail

ATT »
DTMF TX N3
Voice TX »
GPS Information iz




5  D-sTAR OPERATION (ADVANCED)

‘FROM?” (access repeater) setting

¢ Using the DR scan

The DR scan scans frequencies to find a signal on a
repeater, or on a simplex frequency.

You can use 2 kinds of DR scans, Normal scan and
Near Repeater scan.

Normal scan
To quickly find a repeater, the Normal scan skips
repeaters that are not set as an access repeater.
® The “USE (FROM)” setting (p. 5-33) is set to “NO” on the
repeater list.
(IMENU] > MEMORY > Repeater List)

Near Repeater scan

The Near Repeater scan searches for up to 20 nearby
repeaters within 160 kilometers (100 miles) by using
your location and the repeater’s entered position data,
and then lists the repeaters.

® The Near Repeater scan continues, even if you turn OFF

the transceiver, and then turn it ON again during the scan.

@ If your own position data is not being received from GPS
satellites, the last received position data is used.

NOTE: Even if your transceiver receives a repeater
signal, the repeater may not receive your signal,
because the repeater’s output power is higher than
your transceiver’s, and your signal does not reach
the repeater.

TIP: The DR scan scans the simplex frequencies in
the repeater list, in addition to D-STAR repeaters.
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Example: Selecting an active repeater using the DR

scan.
1. Hold down [DR] for 1 second to display the DR
screen.
2. Hold down [SCAN] for 1 second.
:00
Normal

Near Repeater (ALL)
Near Repeater (DV)

Near Repeater (FM)

* The DR scan setting window is displayed.
3. Select the scan type.
* Normal:
Searches for repeaters whose “USE (FROM)” setting
is set to “YES.”
* Near Repeater (ALL):
Searches for up to 20 each of nearby DV or FM
repeaters. (Total 40 repeaters)
* Near Repeater (DV):
Searches for up to 20 nearby DV repeaters.
Near Repeater (FM):
Searches for up to 20 nearby FM repeaters.

The selected scan starts.

« In the DR scan, the repeaters are sequentially
displayed by distance, in descending order.

® The scan resumes the same as other scans. (p. 12-5)

®» 5 12:00

fiann]
MDYV D+

R cococo
Lake Stevens

440.000

<—The repeaters are

KF7UUY B
(o ] sequentially displayed.

FM

440.000

PSKIP|

4. When the transceiver receives a signal from a
repeater, the scan stops. Push [SCAN].

’g * § 12:00
MDYV D+

& CQcQcqQ

Kirkland (1A)
443.575

N7H B
[ DR |

FM

440.000

PSKIP|

* The DR scan is canceled, and the repeater is set to
“FROM.”

’g ® 5 12:00
@MDYV D+

R cacaca

Kirkland (1A)
443.575

N7IH B
[ DR ]

FM

440-000 PSKIP




5  D-sTAR OPERATION (ADVANCED)

‘FROM?” (access repeater) setting

<& Using the Near Repeater Search function

The transceiver searches for the nearest repeaters by
using your location and the repeater’s entered position

4. Select the type of nearby repeater to display.

data.
The nearest repeaters in your transceiver’s repeater
list are displayed as selectable options.

NOTE:

* When using the Near Repeater Search function, BE
SURE first to receive your own GPS position data, or
manually enter your position data.

« If no repeater is found within a 160 kilometers
(100 miles) range, “No Repeater Found” is displayed.

« If the last received position data can be used, “GPS is
invalid. Search by last valid position” is displayed.

Example: Selecting a nearby repeater from the Near
Repeater list.

Step 1: Receiving your own location from the GPS
satellite

Confirm the GPS receiver is receiving the satellite
signals.
» The GPS icon blinks when searching for satellites.

S L R

» The GPS icon stops blinking when the minimum needed
number of satellites is found.

*

@ It may take only a few seconds to receive, or it may take

a few minutes, depending on your operating environment.

If you have difficulties receiving, we recommend that you
try a different location.

@ If your own location is not being received, the last
received position is used for your location.

Step 2: Selecting the access repeater from the
Near Repeater list

1. Hold down [DR] for 1 second to display the DR
screen.

2. Push D-pad(!) to select “FROM,” and then push
[ENT].

o EN 12:00
(A DV D+

2 lcacaca

Kirkland (1A)
+43.575

N7IH B
[ DR |

FM

440-000 PSKIP

3. Select “Near Repeater.”

Repeater List »
Near Repeater »
TX History »
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Near Repeater (ALL) »

Near Repeater (DV) »
Near Repeater (FM) »

* Near Repeater (ALL):
Displays up to 20 nearby DV and FM repeaters.
(A total 40 repeaters)
* Near Repeater (DV):
Displays up to 20 nearby DV repeaters.
* Near Repeater (FM):
Displays up to 20 nearby FM repeaters.
Select the repeater to use as your access
repeater, considering the distance from your
location to the repeater.

Columbus

“FM” is displayed for the FM

repeaters.
Dayton

Hamilton
@® 0.4mi

WS8RTL B<—Repeater call sign

Distance and direction from
your location to the repeater®

*When the “POSITION” setting (p. 5-34) is set to
“Approximate” on the repeater list, the direction data
is not displayed if the distance to the repeater is less
than 5 kilometers.

* Returns to the DR screen and the selected repeater

is set in “FROM.”

® B 1200

’g
@MDYV D+
& CQCQcQ

Dayton
444.08750

WSRTL B
| DR |

FM

440 -000 PSKIP




5  D-sTAR OPERATION (ADVANCED)

‘FROM?” (access repeater) setting

<& Using TX History

The TX History saves up to 10 of the latest access
(From) repeaters you transmitted on. You can select a
repeater from TX History as your access repeater.

Example: Selecting the “Hirano” repeater from TX
History.

1. Hold down [DR] for 1 second to display the DR
screen.

2. Push D-pad(!) to select “FROM,” and then push
[ENT].

a * 12:00]
(MAIN]Y D-
| B lcacaca

Farm Ozondjisse
139.500 V53DV B

FM

440.000

3. Select “TX History.”

PSKIP

-

Repeater List
Near Repeater »
TX History

-

4. Select the TX History (DV) or TX History (FM).

—

X History (DV) »
TX History (FM)

4

» TX History (DV): Displays the TX History of the DV
repeaters.
» TX History (FM): Displays the TX History of the FM
repeaters.
5. Select the repeater to use it as your access repeater.

Kirkland (1A)

Hirano/lcom

Osaka JP3YHH A

» Returns to the DR screen and the selected repeater
is set in “FROM.”
E 12:00

]
[MAIN IS
prgldeldelde]

Hirano/lcom
439.390

JP3YHH A
[ DR |

FM

440.000

PSKIP

5-7

TIP: When you push [QUICK] in step 5, you can
display the REPEATER DETAIL screen or delete the
TX HISTORY screen’s repeater information.

Delete

|Delete All




5  D-sTAR OPERATION (ADVANCED)

“TO” (Destination) setting

“(_:QCQCQ’” the Qestination repeater, or station call TIP: After you receive the individual station or
sign must be set in “TO” when you make a DV mode repeater’s signal, the call sign can be captured by

call. You have 9 ways to set the destination. holding down the Call Sign Capture key ([RX—CS]),
and you can quickly and easily reply to a call.

By rotating [DIAL]
Rotate [DIAL] to select the repeater or Your Call
Sign displayed on the DR screen. (This operation is
disabled when “CQCQCQ” is set.)

To make a Local Area CQ call
Set “CQCQCQ”" in “TO” (Destination). (p. 5-9)

To make a Gateway CQ call

Select a repeater from the Repeater List, if you Local CQ

want to make a Gateway call. (p. 5-9)

Gateway CQ »

Your Call Sign 4

Reflector »
To make a call to a specific station RX History N
Select the station call sign in the Your Call Sign list. T Hi N
(p. 5-10) iIstory i

TIP: How to change the repeater group:
When “Local CQ” or “Gateway CQ” is
selected, you can change the repeater
group.

To change the repeater group on the DR
screen, push [QUICK], then select “Group

To make a call through a Reflector
Select a reflector you want to call through. (p. 5-14)

f - Select.”
To select from RX History 5 12:00
When you receive a call, repeater or caller station rOup Selct : >
data is saved in RX History. A’j_‘?eate' etal .
Select the destination from the record. (p. 5-10) DTME TX N
’ Voice TX »
GPS Information P

To select from TX History

When you make a call, the destination repeater or
called station data is saved in TX History.

Select the destination from the record. (p. 5-11)

To directly enter the destination station call sign
Directly enter the destination station’s call sign.

(p. 5-11) | Direct Input (UR) >

Direct Input (RPT) »

To directly enter the destination repeater call sign
Directly enter the destination repeater’s call sign.
(p. 5-12)

5-8



5  D-sTAR OPERATION (ADVANCED)

“TO” (Destination) setting

<& Making the “Local CQ” (Local Area

call)

When “Local CQ” is selected on the TO SELECT
screen, “CQCQLCQ”" is set in “TO.”

Example: Making a Local area call by accessing the
“Kirkland (IA)” repeater.

1. Hold down [DR] for 1 second to display the DR
screen.
2. Push D-pad(T) to select “TO,” and then push [ENT].

(@
MDYV D+
Hirano/Icom
il [P3YHH A
rrom Kirkland (1A)
[ DR |

12:00|

FM

440.000

VFO

PSKIP

3. Select “Local CQ.”

Gateway CQ
Your Call Sign
Reflector

RX History
TX History

v v v | w | w
[

* Returns to the DR screen, and “CQCQCQ”" is
displayed in “TO.”

5-9

< Making a “Gateway CQ” (Gateway call)

When “Gateway CQ” is selected on the TO SELECT
screen, you can select the repeater to make a
gateway call to.

Example: Making a Gateway CQ call to the “Hirano”
repeater from the “Kirkland (IA)” repeater.

1. Hold down [DR] for 1 second to display the DR

screen.
2. Push D-pad(T) to select “TO,” and then push [ENT].
fun] & § 12
[MAINIY D+

:QCQCQ
3
rrom Kirkland (1A)
[ DR |

FM

440.000

3. Select “Gateway CQ.”

PSKIP|

Local CQ

Gateway CQ

Your Call Sign
Reflector

-

RX History
TX History

v v v | w

4. Select the repeater group where your destination
repeater is listed.

M 13: Japan 4

14: Latin America !

15: Oceania »
16: Poland »
17: Spain »
18: Sweden 4

5. Select the destination repeater.

Hamacho/lcom

Inage

Nagoya UNV

Narayama/lcom

Osaka JP3YHH A

® Each repeater has a correct node (A, B, or C band)
that you want to transmit on. See page 5-2,
“IMPORTANT” for band letter details.

* Returns to the DR screen, and the selected repeater
name is displayed in “TO.”

TIP: After selecting a destination repeater, you can
select another repeater preset in your repeater List
by rotating [DIAL].

& & 12:00

[ns]
(VAN IS

rrom Kirkld_174/709




5  D-sTAR OPERATION (ADVANCED)

“TO” (Destination) setting

< Using “Your Call Sign”

The “Your Call Sign” memory saves individual or
repeater station call signs. When you select the call
sign for the “TO” (Destination) setting, you can make
a Gateway call. When you call an individual station
through a gateway, the signal is automatically sent to
the last repeater that the individual station accessed.
Therefore, even if you do not know where the
individual station is located, you can make a call.

NOTE: If the repeater, set in “FROM” (access
repeater), has no Gateway call sign, you cannot
make a gateway call.

Example: Selecting “Rick” from “Your Call Sign.”

1. Hold down [DR] for 1 second to display the DR

screen.

2. Push D-pad(T) to select “TO,” and then push [ENT].
faen] * 12:00
[MAINRVRS
cQcQcQ
rrom Hirano/lcom

["OR |
FM
440-000 PSKIP|

3. Select “Your Call Sign.”
TOSELECT 4
Local CQ i
Gateway CQ »
Reflector 4
RX History 4
TX History »

4. Select a destination name or call sign.

I —

JM1ZLK

* Returns to the DR screen, and the selected name is
displayed in “TO.”

TIP: After selecting a destination, you can select
another station preset in your transceiver by rotating
[DIAL].

[iamn] % & 12:00
[VIAIN [N
o R
FROM Hirar( 34/36
[ DR |

5-10

¢ Using RX History

When a call is received in the DV mode, the call data
is saved in the RX History.

Up to 50 callers, and only the last called call signs, a
total of 51 histories can be saved.

Example: Selecting “Rick” in the RX History.

1. Hold down [DR] for 1 second to display the DR

screen.

2. Push D-pad(T) to select “TO,” and then push [ENT].
fiaun] EY 12:00
[MAIN [PIVAY

CQCQCQ

rrom Hirano/lcom
[ DR ]

FM

440-000 PSKIP|

3. Select “RX History.”

Local CQ

Gateway CQ
Your Call Sign
Reflector

RX History

TX History

~ RARAR4

-

4. Select a destination name or call sign.

Rick
JG3LUK

JL3YRP

* Returns to the DR screen, and the selected name is
displayed in “TO.”

® The “*” (asterisk) is displayed at the beginning of the
called station’s call sign. (p. 5-19)

TIP: To add an RX HISTORY data to the “Your Call
Sign” memory, push [QUICK], then select “Add To
Your Memory.”

Add To Your Memon

JTVTTZLCT




5  D-sTAR OPERATION (ADVANCED)

“TO” (Destination) setting

< Using TX History

TX History saves the repeater and station name and
call sign of up to 20 “TO” (Destination) settings used
when you made the calls.

NOTE: Until you make a call in the DV mode, you
cannot select “TO” (destination) from the TX History.

Example: Selecting the “Kirkland (IA)” repeater in the
TX History.

1. Hold down [DR] for 1 second to display the DR
screen.

2. Push D-pad(T) to select “TO,” and then push [ENT].

fan] > 12:00|
[MAINRVRS

cQCQCQ

rrom Hirano/lcom
[ DR |

FM

440-000 PSKIP|

3. Select “TX History.”

Local CQ
Gateway CQ

Your Call Sign
Reflector
RX History

X History 4

4. Select a destination repeater.

e —

Melbourne
Vienna

—

Washinat| /N7IH B

The Sub name is
displayed when a
repeater is selected.

» Returns to the DR screen, and the selected repeater
name is displayed in “TO.”

TIP: You can add the TX HISTORY data to memory,
or delete it from the TX HISTORY screen.
Push [QUICK], then select the option.

Add To RPT List

Delete
Delete All

< Directly entering (UR)

The destination station call sign can be directly entered.
Example: Directly entering the call sign “JM1ZLK.”

1. Hold down [DR] for 1 second to display the DR
screen.
2. Push D-pad(T) to select “TO,” and then push [ENT].

%Dv D-
:QCQCQ

from Hirano/Icom
[ DR |

®» 5 12:00

FM

440.000

3. Select “Direct Input (UR).”

PSKIP|

Direct Input (UR) »

Direct Input (RPT) »

4. Enter a call sign of up to 8 characters, including
spaces.

IDIRECT INPUT(UR) |

IM1ZLK

® See page iii on how to enter characters.

5. After entering, push [ENT].
® 5 12:00]

fiaon]
[MAINIVAREE
MIM1ZLK

frROM Hirano/lcom
| DR |

FM

440.000

* Returns to the DR screen and the entered call sign is
displayed in “TO.”

@ After entry, you can edit the call sign in the DIRECT
INPUT (UR) screen.

® The entered call sign remains on the DIRECT INPUT
(UR) screen until you enter a new call sign.

PSKIP|

TIP: If the entered call sign is duplicated in the “Your
Call Sign” memory, the name is displayed.

(Only when the name has been entered.)
& 5 12:00

[iann]
[MAIN [PJVY

frRom Hirano/lcom

5-11




5  D-sTAR OPERATION (ADVANCED)

“TO” (Destination) setting

< Directly entering (RPT)

The destination repeater call sign can be directly
entered.

NOTE: BE SURE to include a node letter as the 8th
digit. See page 5-2 “IMPORTANT” about the node
letters.

Example: Directly entering the call sign “JP3YDH A.”

1. Hold down [DR] for 1 second to display the DR
screen.
2. Push D-pad(T) to select “TO,” and then push [ENT].

fan] *x 5 12
[MAIN VRN

weldelde]

rrom Hirano/lcom
[ DR |

FM

440-000 PSKIP|

3. Select “Direct Input (RPT).”

Direct Input (UR) »

Direct Input (RPT) »

4. Enter a call sign of up to 8 characters, including
spaces.

IDIRECT INPUT(RPT) |

JP3YDH A

® See page iii on how to enter characters.
5. After entering, push [ENT].

* Returns to the DR screen and “JP3YDH A’ is
displayed in “TO.”

@ After entry, you can edit the call sign in the DIRECT
INPUT (RPT) screen.

® The entered call sign remains on the DIRECT INPUT
(RPT) screen until you enter a new call sign.

TIP:

« If the entered call sign is duplicated in the repeater list,
the name is displayed in “TO” (Only when the name has
been entered).

* When directly entering the repeater call sign, including a
“/” at the beginning is also correct.

5-12



5  D-sTAR OPERATION (ADVANCED)

REPEATER DETAIL screen

Depending on the content, such as position data or
UTC offset, the distance between your location and
the repeater, or the repeater time can be displayed on
the REPEATER DETAIL screen.

The detail screen can also be entered from the FROM
SELECT screen.

Example: Displaying the “Hirano/lcom” repeater detail
screen
1. Hold down [DR] for 1 second to display the DR
screen.
2. Push D-pad(T) to select “TO” then push [ENT].

@ & § 12
MDYV D-

cQcacq

From Hirano/lcom
[ DR ]

M

440.000

VFO

PSKIP|

3. Select “Gateway CQ.”

Local CQ
Your Call Sign
Reflector

RX History
TX History

-

v v v |w
[

4. Select “13: Japan.’

M 13: Japan »

14: Latin America »

15: Oceania 14
16: Poland 4
17: Spain »
18: Sweden »

5. Select “Hirano/lcom.”
® DO NOT push [ENT].

Hamacho/lcom
Inage

Nagoya UNV
Narayama/lcom

Hirano/lcom

Osaka JP3YHH A

Push [QUICK].
Select “Detail.”

No

8. Push [ENT].
» Returns to the previous screen.

5-13

The REPEATER DETAIL screen

Repeater frequency

REPEATER DITAIL

Repeater name —Hirano/lcom Repeater
Sub name -»0saka type
Call sign—-JP3YHH A | (DV) PN
Group number —»GRP13  439.390  pur.le— Duplex
Direction from —» wf‘N:ﬂE DST: 0.3mi«—— setting
your position* NsA TIME: 14:35  |pjstance from

T your position
Repeater time

* When the “POSITION” setting (p. 5-34) is set to
“Approximate” on the repeater list, the direction data
is not displayed if the distance to the repeater is less
than 5 kilometers.

@ If there is no position data, the distance and direction
from your position are not displayed. See page 6-3 to
confirm your position.

® When selecting an FM repeater, either of “FM” or “FM-N”"
and the tone setting are displayed.

TIP: You can display the REPEATER DETAIL screen
when the DR screen is displayed.

When you set the repeater as shown below, push
[QUICK], then select “Repeater Detail.”

[iann] * 12:00
(IAMDV  D-

R lcacaca

Hirano/Icom
439.390

JP3YHH A
[ DR |

FM

440.000

VFO

PSKIP

Group Select T7
|
ATT »

DTMF TX N i
Voice TX yill

GPS Information

* The REPEATER DETAIL screen is displayed.




5  D-sTAR OPERATION (ADVANCED)

Connecting to a reflector

OWhat is a reflector?

A reflector is a special server connected to the Internet and running a version of the D-Plus software. If the D-Plus
software is installed on your access repeater, it provides various functions including gateway and reflector linking
capabilities (It is known as the D-STAR reflector system). The D-STAR reflector system enables a number of
D-STAR repeaters anywhere to link to a reflector. This means that when you transmit through a D-STAR repeater
linked to a reflector, your voice can be heard on other repeaters linked to the reflector, and you can hear other
stations that are connected to the reflector.

D-STAR reflector system

Reflector

Access
repeater

AN

AUS

< Unlinking a reflector

Before trying to link to another reflector, BE SURE to
unlink the currently connected to the repeater.

NOTE: If a reflector is already connected, ask on the

air whether or not you can change reflectors and wait

for responses. BE SURE to reconnect back to the

same reflector when you finish your conversation.

1. Hold down [DR] for 1 second to display the DR 4. Select “Unlink Reflector.
screen.

2. Push D-pad(t) to select “TO,” and then push [ENT]. Use Reflector
+ Displays the TO SELECT screen. L'” o R'ectm ’
3. Select “Reflector. oninK etiector
Echo Test
Repeater Information
Local CQ
Gateway CQ »
Your Call Sign 4  Returns to the DR screen, and “Unlink Reflector” and
“U” are displayed in “TO.”
RX History 4 @ EN 12:00]
TX History 4 (VAN
M Unlink Reflector
« Displays the REFLECTOR screen. == Y
from Kirkland (1A)
[ DR |
FM
440-000 PSKIP

5. Hold down [PTT] to unlink the reflector.
» The TX/RX indicator lights red.

5-14



5  D-sTAR OPERATION (ADVANCED)

Connecting to a reflector

< Linking to a reflector

If your repeater is not currently linked to a reflector, or
if you want to change it to another reflector, follow the
steps below. Before linking to another reflector, BE
SURE to unlink the current reflector. (p. 5-14)

Direct inputting a reflector

Example: Directly enter “REFO30CL.”

1. Push D-pad(t) to select “TO,” and then push [ENT].

)
MDYV D+
CQCQCQ

rrom Kirkland (IA)
[ DR |

® 5 12:00

FM

440 -000 PSKIP

2. Select “Reflector.”

Local CQ

Gateway CQ
Your Call Sign

Reflector

RX History
TX History

3. Select “Link to Reflector.”

- RAR4

v | v
<

Use Reflector

Link to Reflector 4

Unlink Reflector
Echo Test
Repeater Information

4. Select “Direct Input.”

Direct Input »

5. Push D-pad to move the cursor, and select the
reflector type, reflector number, or module letter.

REFO30[EL

5-15

6. Push [ENT].

& 5 12:

fiane]
QMDY D+

MLink to Reflector
pmtall REFO30CL
rrom Kirkland (1A)
[ DR |

FM

440.000

PSKIP|

« Returns to the DR screen, and “Link to Reflector” and
“REFO30CL” are displayed in “TO.”
7. Hold down [PTT] to link to the Reflector.

Using TX History

TX History saves up to 5 reflectors that your access
repeater linked to before.

Example: Select “REF030CL” in TX History.

1. Push D-pad(t) to select “TO” then push [ENT].

o

MAMDV D+

cQcQcq
st

rrom|Kirkland (1A)
[ DR |

®x 5 12

FM

440-000 PSKIP|

* The TO SELECT screen is displayed.
2. Select “Reflector.”
The REFLECTOR screen is displayed.
3. Select “Link to Reflector.”
The Link to Reflector screen is displayed.
4. Select the Reflector that you want to link to.

Direct Input 4
REF030CL

« Returns to the DR screen, and “Link to Reflector” and
“REFO30CL” are displayed in “TO.”

E 12:00

[fani]
@MDYV D+
MLink to Reflector
il REF030CL
from Kirkland (1A)
[ DR |

FM

440.000

5. Hold down [PTT] to link to the Reflector.

PSKIP




5  D-sTAR OPERATION (ADVANCED)

Connecting to a reflector

< Using a reflector

1. Push D-pad(t) to select “TO,” and then push [ENT].

» The TO SELECT screen is displayed.
2. Select “Reflector.”

The REFLETOR screen is displayed.
3. Select “Use Reflector.”

Use Reflector

Link to Reflector »

Unlink Reflector
Echo Test
Repeater Information

* Returns to the DR screen, and “Use Reflector” and
“CQCQCQ”" are displayed in “TO.”

fann] £ 12:00
@AmMDV D+

:MUse Reflector
il CQCQCQ
rrom Kirkland (1A)
[ DR |

FM

440.000

PSKIP

4. Hold down [PTT] to transmit.

< Reflector Echo testing

To confirm that your signal is correctly getting into the
repeater, you can transmit a short message as a trial.

After releasing [PTT], your message will be played back.
1. Push D-pad(t) to select “TO,” and then push [ENT].

» The TO SELECT screen is displayed.
2. Select “Reflector.”

The REFLECTOR screen is displayed.
3. Select “Echo Test.”

Use Reflector

Link to Reflector »
Unlink Reflector
Echo Test

Repeater Information

» Returns to the DR screen, and “Echo Test” and “E”
are displayed in “TO.”

[fan] B3 12:00]
[MAIN BVAE

‘MEcho Test
— E

rrom Kirkland (1A)
[ DR |

FM

440-000 PSKIP

4. Hold down [PTT] and speak into the microphone.
5. Release [PTT] to hear your message.

5-16

¢ Requesting repeater information

When you send the repeater information command,
an ID message is sent back.

1. Push D-pad(t) to select “TO,” and then push [ENT].
» The TO SELECT screen is displayed.

2. Select “Reflector.”
» The REFLECTOR screen is displayed.

3. Select “Repeater Information.”

Use Reflector

Link to Reflector »
Unlink Reflector

Echo Test

Repeater Information

* Returns to the DR screen, and “Repeater
Information” and “I” are displayed in “TO.”
* 12:00]

fer]

(VAN IR
‘M Repeater Informati
d I

rrom Kirkland (1A)
[ DR |

FM

440-000 PSKIP

4. Hold down [PTT] to transmit the repeater
Information command.
5. Release [PTT] to hear the repeater ID message.




5  D-sTAR OPERATION (ADVANCED)

Message operation

You can save up to 5 short messages in the
transceiver’s memory to transmit in the DV mode.
Each message can be up to 20 characters.

<O Entering a TX message

[MENU] > SET > My Station > TX Message

Example: Entering “JAPAN TOM” into TX message
memory number 1.
1. Push [MENUI.
Select “My Station” in the “SET” menu.

“; DUP/TONE...

1 3
& Scan 4
i Scope »
@@= Call Sign »

»

& My Station

o DV Set 4.
3. Select “TX Message.”

My Call Sign »

TX Message 4

4. Select a TX Message memory number.

OFF I
2:

@® DO NOT push [ENT].
Push [QUICK].
Select “Edit.”

Clear

oo

7. Enter a message of up to 20 characters.

TX MESSAGE |

JAPAN TOM

EICHAR TYPE ABC

® See page iii on how to enter characters.
8. After entering, push [ENT].
* Returns to the TX MESSAGE screen.

5-17

< Transmitting a message
You can transmit a preset TX message by pushing

[PTT]in the DV mode. First, select a TX message which

also turns ON the Message Transmission function.
[MENU] > SET > My Station > TX Message

1. Push [MENU].
Select “My Station” in the “SET” menu.

“; DUP/TONE...

& Scan
i Scope
@@= Call Sign

& My Station

o« DV Set

il v v v W

-

3. Select “TX Message.”

-

My Call Sign
TX Message

-

4. Select a TX Message memory number.

OFF

1: JAPAN TOM

2:

@ To not transmit any message, select “OFF.”
@ To exit the MENU screen, push [MENU].

® Information

» The message is transmitted with your voice signal.

» The message is transmitted each time you push [PTT].

* When continuously transmitting, the selected TX
message is transmitted every 30 seconds.

TIP: RX call sign and message display

As the default, the received call sign and message
are automatically displayed and scrolled.

To not display and scroll them, set RX Call Sign to
“OFF.”

(IMENU] > SET > Display > RX Call Sign)




5  D-sTAR OPERATION (ADVANCED)

Message operation

¢ Deleting a TX message

[MENU] > SET > My Station > TX Message
Example: Deleting the entered TX message “JAPAN
TOM” from TX message memory number 1.

1. Push [MENU].
Select “My Station” in the “SET” menu.

2, DUP/TONE... b
# Scan >|
i Scope

@ Call Sign

& My Station

- DV Set i
3. Select “TX Message.”

v R

-

-

My Call Sign
TX Message

-

4. Select a TX Message memory number.

OFF

1: JAPAN TOM

2:

® DO NOT push [ENT].
5. Push [QUICK].
6. Select “Clear.”

Edit

Clear

» The confirmation dialog is displayed.
7. Select “YES.”

QEL

Clear?

NO

* The entered message is cleared.
® To exit the MENU screen, push [MENU].
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5  D-sTAR OPERATION (ADVANCED)

Viewing received call signs

When you receive a DV call, the calling station and the repeater call signs are saved. Up to 50 calls can be saved.
When you receive the 51st call, the oldest call history is deleted.
@ Even if the transceiver is turned OFF, the RX records are not deleted.

< Viewing the call signs on the RX History screen

1. Hold down [CD] for 1 second. 3. Push [ENT].
2. Select an RX history memory to view the details. * Displays the RX history detail screen.
® Push D-pad(it) to view the content.

® Information
* The first page of the “RX HISTORY” screen displays the

latest RX record of the MAIN band. The second page or later <1st page>

displays the record according to the received date and time, « CALLER: Displays the caller station’s call

regardless of the band it was received on. Sign*z* and any note entered after
» The RX history number, the caller’'s name (or call the call sign.

sign), destination, RX message, RX date and time, « CALLED: Displays the called station’s call

“GW,” and “GPS” are displayed.
* “GW’ is displayed when the Gateway call is received.
“GPS” is displayed when the received call includes
position data.
“UP” is displayed when the repeater uplink signal is
received.
* In the Quick Menu window, you can select the
following options.

sign*2.
® “CQCQCQ’ is displayed when receiving
a Local Area call or Gateway call.

CALLER:
JIM1ZLK /1D52

RX>CS: Temporarily enters the received CJ/:L;EBA
call sign into “TO.”
Call Sign Display: The received data is displayed in
the Call Sign Display mode. <2nd page>
Name Display: The received data is displayed in « RX RPT1: Displays the repeater’s call sign*2
the Name Display mode. that was accessed by the caller
Delete: Deletes the selected RX history. station
Delete All: Deletes all RX history. )

If the received call was a Gateway

call, this item displays the gateway

call sign of the repeater you

RX HISTORY screen (RX01) received the call from.

« RX RPT2: Displays the repeater’s call sign*?

you received the call from.

® The operating frequency is displayed instead of the
above items when the call was not through a repeater
(Simplex call).

D-PRS TX

Displayed when format icon*!

a Gateway call is Called station

received. W*—* i (“CQcQcqQ’is

History ———»RX01: I displayed if you
number “\jl;gl\_(E:DSz Lelcelved aCQecall) RXRPT1:
JP3YHH G

HELLO CQ D-STAR €+7;—RX message
RPT: JP3YHH A

RXRPT2: 439.390
(2021/11/01 15:05)

JP3YHH A

Caller station*? Received date
® A note may be and time
displayed after “/.”

*1 The displayed icon differs, depending on the D-PRS

TX format.
GPS: Position OBJ: Object
ITEM: ltem WX: Weather

*2 \When a name is entered in the MEMORY, the name
is also displayed.
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Viewing the received call signs

< View the call signs on the RX History screen TIP: To delete RX HISTORY data
<3rd page> On the RX HISTORY or the detail screen, push
* RXMESSAGE: Displays any message [QUICK], then select “Delete” or “Delete All.”
included in the received call if
entered. RX>CS ’
« RX TIME: Displays the date and time Add To Your Memo»
the call was received.

MESSAGE:
HELLO CQ D-STAR

RX TIME: TIP: “RX RPT1” setting may differ, depending on the
2021/11/01 (Mon) way the call was made
15:05:26 y :
<4 ~ 6th page> Example 1: When a Local area call is received.
Displays position data of the caller station. If a
received signal has no data, then no position data a,
. . 'L
is displayed. \”"” ose,
[RX HISTORY 01 139 b
7NN 35 45.00'N
NS4 135 36.00F
GL: PM75TS
7o) ALT: 33ft
DST: 107mi
IM1ZLK-A . .
Example 2: When a Gateway call is received.
COURSE: 95 j’e,/l{l\;II[JKp%arl‘li/n;%from
SPEED: 2.3mph
(7:53)

\
INTERNET-
A4 ﬁ

GPS MESSAGE:
HELLO CQ D-STAR

@ To exit the MENU screen, push [MENU].
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BK mode communication

The Break-in (BK) function enables you to break into a

conversation, where the 2 stations are communicating

with Digital Call Sign squelch (DSQL) enabled.

® The BK function is automatically turned OFF when you
turn OFF the transceiver.

[MENU] > SET > DV Set > BK

1. While 2 stations are communicating in the DV
mode, hold down [RX—CS] for 1 second.

« After releasing [RX—CS], the calling station’s
call sign or the repeater’s call sign is set to “TO”
(Destination).

» Beeps sound, and the calling station’s call sign is
announced.

® When a call sign is not received correctly, error beeps
sound, and no call sign is set.

2. Push [MENU].
3. Select “DV Set” in the SET menu.

“; DUP/TONE... 4
& Scan J
i Scope 4
b
L4

@@= Call Sign
& My Station

-] DV Set Wl

How to use Break-in?

4. Select “BK.”

DV Auto Detect

RX Record (RPT)
[RX>CS] Key

M v v -

W
~

EMR
EMR AF Level

5. Select “ON.”

v | v
<

OFF

6. Push [MENU].

fian] 5 __12:00
| 1R Rick

M Hirano/Icom
439.390 JP3YHH A

2

FM

440-000 PSKIP|

» Returns to the Standby screen and “BK” is displayed.
7. When both stations are in standby, push [PTT] to
transmit.
@ “BK” blinks when receiving a Break-in call.
® To cancel the BK mode, select “OFF” in step 5, or
turn OFF the transceiver.

While using the Digital Call Sign squelch (DSQL), the squelch never opens (no audio is heard) even if a call is

received, unless the call is addressed to your call sign.

However, when a call including the “BK ON” signal (break-in call) is received, the squelch opens, and audio is

heard even if the call is addressed to another station.

Station C calling to Station A with “BK OFF”
Station A and B are communicating using the Digital
Call Sign squelch.

/ Station B

Station C

Station A

Station B does not hear that
Station C is calling Station A.
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Station C calling to Station A with “BK ON”
Station A and B are communicating using the Digital
Call Sign squelch.

Station A \ / Station B

Station C

Station B also hears that
Station C is calling Station A.
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EMR communication

The Enhanced Monitor Request (EMR) communication

function can be used in only the DV mode. Using the
EMR function, no call sign setting is necessary.

® Information
« All transceivers that can receive an EMR signal

automatically receive the signal. DO NOT use this function

except in the case of an emergency.
* When an EMR signal is received, the audio (voice) is

heard at the set level, even if the volume setting level is

set to the minimum level.

* The EMR communication function is automatically turned

OFF when you turn OFF the transceiver.

[MENU] > SET > DV Set > EMR

Example: Transmitting from the “Hirano” repeater
using the EMR function.
1. Push [MENUI.
Select “DV Set” in the “SET” menu.

“; DUP/TONE...
& Scan
i Scope

@ Call Sign
& My Station
~] DV Set

3. Select “‘EMR.”

DV Auto Detect

»
RX Record (RPT) »
[RX>CS] Key 4
BK »

>

EMR AF Level » ]

4. Select “ON.”

OFF

5. Push [MENU].

@ =219
(VAN
MRick
IM1ZLK
FrROM Hirano/Icom
| DR |

FM

440-000 PSKIP|

» Returns to the Standby screen and “EMR” is displayed.

Push [PTT].
» The TX/RX indicator lights red while transmitting.
® “EMR” blinks on a station that receives the EMR

signal. The audio (voice) is heard at the set level, or

the [VOL] level, whichever is higher.

® To cancel the EMR mode, select “OFF” in step 4, or

turn OFF the transceiver.

< Adjusting the EMR AF level

The audio output level when an EMR signal is
received is adjustable between 0 and 39.

When an EMR signal is received, the audio is heard at
the preset level, or the [VOL] control level, whichever
is higher.

To turn OFF the setting, set to “0.”

[MENU] > SET > DV Set > EMR AF Level

1. Push [MENU].
2. Select “DV Set” in the “SET” menu.

“; DUP/TONE...
& Scan

i Scope

@ Call Sign

& My Station

DV Auto Detect
RX Record (RPT)
[RX>CS] Key

BK

EMR

EMR AF Level »

4. Rotate [DIAL] to adjust the EMR audio output level
between 0 (OFF) and 39 (maximum). (Default: 19)

® To exit the MENU screen, push [MENU].
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Automatic DV detection

If you receive an FM signal while in the DV mode, the
“‘DV” and “FM” icons alternately blink to indicate the
received signal is FM.
When the DV Auto Detect function is ON, the
transceiver automatically selects the FM mode to

monitor it temporarily. (Default: OFF)

® Regardless of this setting, the “DV” and “FM” icons
alternately blink if you receive an FM signal while in the

DV mode.

NOTE: When Digital Call Sign squelch (DSQL),

or Digital Code squelch (CSQL) is selected, the
transceiver does not receive FM signals, even if this
function is ON. You can silently wait for calls from

others.

When an FM signal is received while in the DV mode

[MENU] > SET > DV Set > DV Auto Detect

1. Push [MENU].
2. Select “DV Set” in the “SET” menu.

“; DUP/TONE...
& Scan

i Scope
@@= Call Sign
& My Station

YDVSet
Select “DV Auto Detect.”

-

DV Auto Detect »

RX Record (RPT)
[RX>CS] Key

EMR AF Level

»
»
4
4
»

Select “ON.”

OFF

@ To exit the MENU screen, push [MENU].

® When an FM signal is received while in the DV mode,
the “DV” and “FM” icons sequentially blink, and the
transceiver receives the signal in the FM mode.

DV Auto Detect function: OFF
The “DV” and “FM” icons alternately blink, but the

audio cannot be

The icons
alternately blink.

heard.

440.000

PSKIP

AV

a0
’IETIL D+

12:00]

1 cacaca

Kirkland (1A)

443.575

N7IH B

FM

440.000

PSKIP

You cannot hear
the audio.
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DV Auto Detect

function: ON

The “DV” and “FM” icons alternately blink, and the
audio can be heard.

The icons
alternately blink.

[fana] 12:00]
D+

& CQcacqQ

FM

440.000

PSKIP
VFO

AV

D+
1 cacacq

Kirkland (1A)
443.575

12:00|

N7IH B
[ DR ]

FM

440-000 PSKIP

VFO

/

Thanks for
the nice QSO!

\

t

You can hear the
audio!
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Automatic Reply function

When a call addressed to your call sign is received,
the Automatic Reply function sounds beeps and
automatically replies with your call sign.

(Default: OFF)

Depending on the setting, a recorded message may
be transmitted with the call sign.

NOTE: The Automatic Reply function temporarily
sets the received call sign to “TO” (destination).

TIP: To record the Auto Reply message

You can record the Auto Reply message. See page
5-25 for details.

(IMENU] > RECORD > DV Auto Replay)

[MENU] > SET > DV Set > Auto Reply

1. Push [MENU].
Select “DV Set” in the “SET” menu.

“; DUP/TONE...
M Scan

i Scope
@@= Call Sign
& My Station

1DVSet
3. Select “Auto Reply.”

-

Tone Control
DV Data TX »
DV Fast Data »
Digital Monitor 4
Digital Repeater Set »

- Rd

4. Select an option.

Position

* ON: Automatically replies with your own
call sign. (No audio reply is sent)

» Voice: Automatically replies with your own
call sign and an Auto Reply message
recorded on the microSD card (up to
10 seconds).
® If no SD card is inserted, or no message

is recorded, replies with only your own
call sign (No audio reply is sent).

* Position: Automatically replies with your call
sign and your position data using the
internal GPS receiver.
® When “GPS Select” is set to “OFF” or

“Manual,” the internal GPS receiver is
temporarily turned ON.

Push [MENU].

* Returns to the Standby screen, and displays “Ay.”

® When “ON” or “Voice” is selected, the Automatic
Reply function is automatically turned OFF when you
push [PTT].
When “Position” is selected, the Automatic Reply
function remains ON, when you push [PTT].

Example: After receiving a call from “JM1ZLK,” beeps

sound, and the transceiver automatically
sends a reply call.

® =012:00]
Av

[iamn]
(MAIN]YR]
#CQCQCQ
FrRom 441,000
SLO [ DR ]
UR: JIM1ZLK
FM

440-000 PSKIP

VFO

The “TO” setting does not change, but “UR:
JM1ZLK (Caller’s call sign)” is displayed.
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Automatic Reply function

¢ Recording an Auto Reply message

You can record the Auto Reply message that is saved
on a microSD card to reply to the call with your voice.

NOTE: Confirm a microSD card is in the card slot.

[MENU] > RECORD > DV Auto Reply

1. Push [MENUI.
2. Select “DV Auto Reply” in the RECORD menu.

QSO Recorder »
Voice Recorder »

DV Auto Reply »

3. Hold down [PTT] to start a recording, release it to
stop recording.

REC Level:
GEDREC @DPLAY

® Information

» The maximum recording time is 10 seconds.

* Hold the microphone 5 ~ 10 cm (2 ~ 4 inches) from your
mouth, then speak at your normal voice level.

» Only 1 message can be recorded. The current contents are
overwritten if you record again.

4. To exit the MENU screen, push [MENU] twice.

5-25

The DV AUTO REPLY screen

DV AUTOREPLY |
°
0:02/0:10
REC Level:
IIIIIJIIIIIIIIIII !
@DRER 1
I I
Audio level is  Adjust the Mic gain so that the REC
displayed Level does not reach to this range

(IMENU] > SET > Function > MIC Gain
(Internal), MIC Gain (External))

TIP: To delete the recorded message, push [QUICK]
on the DV AUTO REPLY screen, then select “Clear.”
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Automatic Reply function

< Auto Position Reply function
1. Acall addressed to your

When you receive a call addressed to your call sign, call sign.
but are in a situation that makes it difficult to operate
the transceiver, this function sounds beeps and

. |
automatically replies with your call sign and transmits /k
your position data. D

estination
2. Your position data  (ID-52A/E)
After receiving the Auto Position Reply call, the . is automatically
. - ) . Your station i
caller’s position data is displayed in a window. transmitted. |
® Icom transceivers* display the position after receiving a
call. L. .
® You can turn OFF the caller’s position display. (p. 12-26) 3. Aftgr receiving, the position data
(IMENU] > SET > Display > Reply Position Display) is displayed on the - - A
* Except for the ID-31A/E, 1C-9100, ID-880H/E880, IC- destination’s transceiver. i~ JAIYUA |
80AD/E80D, IC-92AD/E92D, IC-2820H/E2820, ID-800H, W\Aj 3534.28N |
IC-91AD/E91, IC-V82, IC-U82 " 1354818

DST: 66.6mi ]
GPS a

RX: JASYUA L

f

Scrolls your call sign or the TX message.
® Your status message may be displayed.

VFO

When no valid position data is received

After receiving a call addressed to your call sign, L RWE/I2:00
the internal GPS receiver is temporarily turned ON §!COM ARC
for approximately 5 minutes to receive your position rrovi441.000 -
data, even if “GPS Select” is set to “OFF” or “Manual.” MSG: No Posi & GPS St
Then, the transceiver automatically replies with a A
message, as described below. 440.000 FSKIF
(IMENU] > GPS > GPS Set > GPS Select)
® When the internal GPS receiver is temporarily ON, and

valid position data is received, the transceiver transmits

your position data if a call addressed to your call sign is TIP:

received again. » The position data is transmitted according to the

“GPS TX Mode.” (p. 6-12)
Reply message list when no valid position data is * When the “GPS TX Mode” settings are incorrect
received for the Automatic Reply function, the transceiver
Message Status automatically corrects them to reply to a call.
” ) * When “GPS TX Mode” is set to “OFF,” “D-PRS” is
No Position Whe.n no position data is automatically selected.
received.

Old Position 2 minutes or more has passed

since receiving position data.

The internal GPS receiver is
temporarily turned ON but has
not received your position data
yet.

No Posi & GPS Start

The internal GPS receiver is

temporarily turned ON, and 2
minutes or more have passed
since receiving position data.

Old Posi & GPS Start
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Data communication

In addition to digital voice communication, you can

send and receive data. Also, you can use the DV Fast

Data function for data communication (p. 5-28)

To send and receive data, a USB cable (purchase
separately or user supplied), and a data
communication software (user supplied) are required.

NOTE: “DV Data TX” is set to “Auto” as the

default setting. When you enter text data into your
communication software, the transceiver may
automatically transmit it, depending on the software
and the software settings.

¢ Connection

Connect the transceiver to your PC using a USB
cable, as shown below.

Tranceiver

NOTE: Before you start sending data, BE SURE to
set the following items.
+ Set “GPS Out (USB Port)” to “OFF ”
(IMENU] > GPS > GPS Set > GPS Out (USB Port))
» Set “USB Connect” to “Serialport,”
(IMENU] > SET > Function > USB Connect)
» Set “USB Serialport Function” to “DV Data.”
(IMENU] > SET > Function > USB Serialport Function)
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<& Data communication application

setting
Set the communication software, as shown below.

* Port: The COM port number that is used by the
ID-52A/E *

» Baud rate: Your desired speed

 Data: 8 bit

* Parity: none

 Stop: 1 bit

 Flow control: Xon/Xoff

* Depending on the PC environment, the COM port number
used by the ID-52A/E may be higher than 5. In that case,
use an application that can set it to higher than 5.

¢ Sending data

1. Set your call sign, the destination call sign, and
the repeater call sign.
2. Follow the instructions of your data communication
application software.
3. When you enter text data into your communication
software, the transceiver may automatically
transmit it, depending on the software and its
settings.
® When “DV Data TX" is set to “PTT,” pushing [PTT]
transmits the text data and a voice signal. (p. 12-10)
(IMENU] > SET > DV Set > DV Data TX)

® Before transmitting the data, the transceiver sends a
carrier sense signal approximately 500 milliseconds.

NOTE:

» Only ASCII code can be used for data
communication.

» The transceiver also has the Message
Transmission function that transmits up to 20
characters. (p. 5-17)

» Depending on the combination of your PC and
your communication software, some data may be
lost.

» While receiving voice or data through the Internet,
some packets may be lost due to network error
(poor data throughput performance) In such a
case, an “L” is displayed on the screen to indicate
that packet loss has occurred.
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Data communication

¢ DV Fast Data function

To send data using the DV Fast Data function, follow
the instructions below.
® DV Fast Data communication can be made by only the
following lcom transceivers:
(As of November 2021)
* IC-705
* 1C-9700
» ID-31A/E PLUS
» ID-4100A/E
+ ID-5100A/E*
» ID-51A/E (PLUS, PLUS2, 50th Anniversary model)
» ID-52A/E
* Usable only when firmware versions CPU M 1.10,
S 1.00, C 1.10, and DSP 1.10 or later are installed.

NOTE: If you want to send GPS data to other
transceivers that can receive only slow-speed data,
set “GPS Data Speed” to “Slow.” (p. 6-4)

(IMENU] > SET > DV Set > DV Fast Data > GPS Data Speed)

[MENU] > SET > DV Set > DV Fast Data > Fast Data

1. Push [MENU]
2. Select “DV Set” in the “SET” menu.

“y DUP/TONE...
M Scan
i Scope

@ Call Sign
& My Station
] DV Set

Tone Control

»
Auto Reply »
DV Data TX »

)

Digital Monitor
Digital Repeater Set

v | v
[«

4. Select “Fast Data.”

-

Fast Data
GPS Data Speed 4
TX Delay (PTT)

A

5. Select “ON.”

OFF

* To exit the MENU screen, push [MENU].
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About the display type

You can enlarge the characters, such as the repeater
name displayed by the DR function.
® This setting can be used only when the Single band
display is selected.
1. Display the Main screen that you want to change
in the Single band display.

& 5 12:

[aann]
@DV D-
R cQcQcQ

Hirano/lcom

439.390 JP3YHH A

[OR ]
2021/11/01 (Mon)

SLO

2. Push [QUICK].
3. Select “Display Type.”
Weather Alert ]
Display Type »
D.sQL »
rVol‘cage
S\Band Scope 4
<<REC Start>>
4. Select “Large.”
Normal .

F|

2021/11/01 (Mon)

* The characters, such as the repeater name, are
displayed larger.
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Digital squelch functions

The digital squelch opens only when you receive a ¢ The Digital Code Squelch setting
signal addressed to your own call sign or a signal that 1. Push [QUICK]

includes a matchlng digital code. 2. Select “D.SQL.”
You can silently wait for calls from others.

You can independently set the Digital squelch function GPS Position |
in the VFO mode, Memory mode, Call channel mode, Weather Alert il
or DR function. X
SKIP i
< The Digital Call Sign squelch setting HolmeCH Set  »
Volt
1. Push [QUICK]. — i
2. Select “D.SQL.” 3. Select“CSQL.”
12:
GPS Position 1 )
Weather Alert P | OFF 1
eate |
Sor a T
Home CH Set | i
Voltage P
o
3.
v
[un] = 5 12:00] . .
oy of csa. [<«———“DSQL” is displayed.
2 CQCQcQ
Kirkland (1A)
443.575 N7H B
["OR |
FM
bl 440.000 PSKIP
v 4. Push [MENU].
Fin} ~ 5 700 o 5. Select “DUP/TONE...” in the “SET” menu.
oV of osaL | «———“DSQL” is displayed. 6. Select “Digital Code.”
» lcqcacq
Kirkland (1A)
443.575 N7IH B Offset Freq 4
i o
440-000 PSKIP|
* When the received signal includes a matching call
sign, the squelch opens, and you can hear the audio.
® When the received signal does not include a 7. Rotate [DIAL] to select a digital code.
matching call sign, the digital call sign squelch does
not open. However, the S/RF meter displays the
received signal level.
NOTE:
» DO NOT use the Digital Call Sign Squelch (00
function when communicating with 2 or more
stations, because it opens only when receiving a
signal addressed to your call sign. Therefore the + When the received signal includes a matching code,
function can be used when communicating with the squelch opens, and you can hear the audio.
only 1 station. ® When the received signal does not include a matching
 Even if the squelch is closed by the Digital Call code, the digital code squelch does not open.
Sign Squelch function, you can receive data in the However, the S/RF meter displays the signal level.
DV mode. ® To exit the MENU screen, push [MENU].

NOTE: Even if the squelch is closed by the Digital
Code Squelch function, you can receive data in the
DV mode.
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Repeater list

You can save repeater information for quick and
simple communication in up to 2500 repeaters
(repeater list) in up to 50 Groups.

Data must be in the repeater list to use the DR
function.

You can add and edit repeater content and groups in
the repeater list.

You can enter 4 types of frequencies into the repeater
list, as shown below:

* DV Repeater

* DV Simplex

* FM Repeater

* FM Simplex

TIP:

» For easy operation, the repeater list is preloaded
into your transceiver. However, if you do an
All Reset, the CPU deletes all setting data, the
Memory channels, and the repeater list. We
recommend that you back up the memory data to
a microSD card or save it to a PC using the CS-52
PROGRAMMING SOFTWARE.

» The repeater list can be downloaded from the Icom
website. See “Updating the repeater list” that can
be downloaded from the Icom website about how
to update the repeater list using a microSD card.

https://www.icomjapan.com/support/

<O Repeater list contents
The following contents are included in the repeater list:

* TYPE: Communication type (p. 5-32)

* NAME: Repeater name (p. 5-32)

+ SUB NAME: Repeater sub name (p. 5-32)

* CALL SIGN: Repeater call sign and port letter
(p. 5-32)

« GW CALL SIGN: Gateway repeater’s call sign and port “G”
(p. 5-32)

* GROUP: Repeater group (p. 5-33)

« USE (FROM):
« FREQUENCY:

access repeater use (p. 5-33)
access repeater’s frequency (p. 5-33)

* DUP: Duplex direction (p. 5-33)
»« OFFSET FREQ: Frequency offset (p. 5-33)
* MODE: Operating mode (p. 5-34)
* TONE: Tone setting (p. 5-34)

+ REPEATER TONE: Repeater tone (p. 5-34)

* POSITION: Position data accuracy level (p. 5-34)
* LATITUDE: Latitude of the repeater (p. 5-34)
* LONGITUDE: Longitude of the repeater (p. 5-35)

- UTC OFFSET:  UTC Offset (p. 5-35)
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Example: “Hirano” repeater information

TYPE: i
DV Repeater
NAME:
Hirano/lcom
SUB NAME:

Osaka

CALL SIGN: |
JP3YHH A

GW CALL SIGN:
JP3YHH G
GROUP:

13 Japan

USE (FROM):
YES
FREQUENCY:
439.390.00
DUP:
DUP-|

OFFSET FREQ:

POSITION:

LATITUDE:
34 37.55'N §

LONGITUDE:
135 34.09'E

UTC OFFSET:
+ 9:00
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Entering new information into the repeater list

This section describes how to manually enter new
repeater information into the repeater list.

The required setting items differ, depending on your
communication usage. Confirm the required items, as
shown below.

NOTE: To enter repeater information into the
repeater list, the repeater’s call sign must be entered
first.

¢ Required items for the communication cases

Repeater list Used as an access .Us.ed asa Used as an FM Simplex (FROM)
contents repeater destination repeater repeater

TYPE DV Repeater DV Repeater FM Repeater DV Simplex FM Simplex
NAME (@) (@) (@) (@) @)
SUB NAME @) @) ©) (©) ©)
CALL SIGN [ ] (] (@) N/A N/A
GW CALL SIGN (Fora Ga:away call [ ] N/A N/A N/A
GROUP (@) (@) (@)
USE(FROM) [ ] (@) [ ]
FREQUENCY ([ ] (@) [ )
DUP ® (@) [ N/A N/A
OFFSET FREQ ® (@) (] N/A N/A
MODE N/A N/A @) N/A ©)
TONE N/A N/A (@) N/A @)
NPl N/A N/A o N/A o
POSITION (@) (@) (@) (@) (@)
LATITUDE @) @) (@) ©) ©)
LONGITUDE (@) (@) (@) (@) (@)
UTC OFFSET ©) @) ©) (©) (©)

®: Must be entered
O: Possible to enter
N/A: Not Applicable
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Entering new information into the repeater list

< Entering new information into the repeater list

Step 1. Selecting the repeater group

Step 4. Entering the repeater sub name

[MENU] > MEMORY > Repeater List

1. Push [MENUI.
Select “MEMORY” on the second page of the
MENU screen.

3. Select “Repeater List.”

Memory CH
Call CH

Your Call Sign
Repeater List

v | w w

I

4. Select a repeater group to add a repeater to.

M 13: Japan »

14: Latin America »
15: Oceania [scie |3

16: Poland 4
17: Spain »
18: Sweden 4

« Displays the repeater list of the selected repeater group.

Hamacho/lcom »

Nagoya UNV 4
Narayama/lcom 4
Hirano/lcom 4
Chiba JPTYJQ A
Push [QUICK].
Select “Add.”

oo

AT IIcT AnALIn 40

SKIP

Edit

SKIP All ON
SKIP All OFF

Move

loxvo TTTTTO A

» The REPEATER LIST EDIT screen is displayed.

Step 2. Selecting the communication type

1. Select “TYPE.”

2. Select the communication type.
* DV Repeater: Repeater operation in the DV mode.
« DV Simplex: Simplex operation in the DV mode.
* FM Repeater: Repeater operation in the FM mode.
* FM Simplex: Simplex operation in the FM mode.

Step 3. Entering the repeater name

1. Select “NAME.”

2. Enter a name of up to 16 characters.
® See page iii on how to enter characters.

3. After entering, push [ENT].

1. Select “SUB NAME.”

2. Enter a sub name of up to 8 characters.
® See page iii on how to enter characters.

3. After entering, push [ENT].

Step 5. Entering the repeater call sign

® When Step 2. Selecting the communication type
is set to “DV Simplex” or “FM Simplex,” go to Step
7. Changing the repeater group.
1. Select “CALL SIGN.”
2. Enter the repeater call sign of up to 8 characters,
including spaces and the node letter.

ICALLSIGN |

JPTYYY A

NOTE: BE SURE to add the repeater node letter
in the 8th digit of the call sign, according to the
frequency band shown below. Note that there
are almost always different node letters between
Japanese D-STAR repeaters and repeaters in
other countries.

Cross band operation between different nodes at
the same repeater site can be made.

* 1200 MHz: A (B in Japan)

* 430 MHz: B (Ain Japan)

* 144 MHz: C (no repeaters in Japan)

3. After entering, push [ENT].

Step 6. Entering the gateway repeater call sign

® This item is displayed when Step 2. Selecting the
communication type is set to “DV Repeater.”

® The 8th digit in the call sign entered in Step 5.
Entering the repeater call sign is automatically
set to “G” as the gateway port, so you can skip this
setting and go to the next item.

Select “GW CALL SIGN.”

Enter a gateway repeater call sign of up to 8
characters, including spaces.

® Only a space or “G” can be entered in the 8th digit.

|GW CALLSIGN |

JPIYYY G

N —

3. After entering, push [ENT].



5  D-sTAR OPERATION (ADVANCED)

Entering new information into the repeater list

< Entering new information into the repeater list

Step 7. Changing the repeater group

Step 10. Selecting the Duplex direction

® The repeater group that is selected in Step 1.
Selecting the repeater group is displayed. You can
skip this setting and go to the next item. To change
the group, follow the steps described below.

1. Select “GROUP.”

2. Select the repeater group. (01 ~ 50)

M 13: Japan

14: Latin America

15: Oceania
16: Poland
17: Spain

18: Sweden

Step 8. Setting “USE(FROM)” to be used as an
access repeater

® You can use the entered repeater as an access
repeater when using the DR function. When not
using as an access repeater, select “NO,” and go
to Step 15. Selecting the position data accuracy
level. In that case, the entered repeater is not
displayed in “FROM” on the DR screen.

Select “USE(FROM).”
Select “YES” to use the repeater as an access
repeater.

N —

NO

Step 9. Entering the access repeater frequency

1. Select “FREQUENCY.”
2. Rotate [DIAL] to enter the repeater frequency.

439.340.00

® Push D-pad($5) to move the cursor.
3. After entering, push [ENT].

5-33

® When Step 2. Selecting the communication type
is set to “DV Simplex” or “FM Simplex,” this item is
not displayed.

® “DUP-" is automatically set when the access
repeater frequency is entered in Step 9. Entering
the access repeater frequency. If necessary, you
can change the Duplex direction.

1. Select “DUP.”
2. Select a Duplex direction.
OFF
DUP+
* OFF: Turn the duplex function OFF.
* DUP-: The transmit frequency shifts down from the
receive frequency by the offset amount.
* DUP+: The transmit frequency shifts up from the

receive frequency by the offset amount.

Step 11. Entering the frequency offset

N —

® When Step 2. Selecting the communication type
is set to “DV Simplex” or “FM Simplex,” this item is
not displayed.

® The offset value* is automatically set when the
access repeater frequency is entered in Step
9. Entering the access repeater frequency. If
necessary, you can change the frequency offset.
* The default value differs, depending on the transceiver

version.

Select “OFFSET FREQ.”

Rotate [DIAL] to enter the frequency offset
(0.000.00 ~ 59.995.00 MHz).

5.000.00

® Push D-pad(5) to move the cursor.
After entering, push [ENT].
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Entering new information into the repeater list

< Entering new information into the repeater list

Step 12. Setting the FM mode

® When Step 2. Selecting the communication type
is set to “DV Repeater” or “DV Simplex,” this item is
not displayed.

Select “MODE.”

Select “FM” or “FM-N.”

Step 15. Selecting the position data accuracy level
® When the Near Repeater Search function is not
used, or the distance between your location and
a repeater is not needed, select “OFF,” and go to
Step 18. Setting the UTC offset.

N —~

1. Select “POSITION.”
2. Select the position data accuracy level.
FV-N
Approximate
Exact
Step 13. Setting the tone
® When Step 2. Selecting the communication type * None: Select when the repeater has no

N —

is set to “DV Repeater” or “DV Simplex,” this item is
not displayed.

Select “TONE.”
Select an option.

position data.
« Approximate: Select when the entered position data
is approximate.

« Exact: Select when the entered position data

is exactly correct.

Step 16. Entering the latitude

® This item is displayed only when Step 15.
TONE . i .
TsaL Selecting the position data accuracy level is set
to “Approximate” or “Exact.”
1. Select “LATITUDE.”
2. Rotate [DIAL] to enter the latitude.
* OFF: Turn OFF the Tone function.

* TONE: Select when the repeater requires an access
tone.

Select when you want to use the tone
squelch in simplex operation.

* TSQL:

I 0o.0o'N

Step 14. Selecting the repeater tone frequency

® When Step 2. Selecting the communication type
is set to “DV Repeater” or “DV Simplex,” this item is
not displayed.

® This setting is required when Step 13. Setting the
tone is set to “TONE” or “TSQL.”

1. Select “REPEATER TONE.”

2. Rotate [DIAL] to select the repeater tone

frequency, and then push [ENT].

® Push D-pad($5) to move the cursor.
® To enter a north latitude, select “N,” and to enter a
south latitude, select “S.”
3. After entering, push [ENT].
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Entering new information into the repeater list

< Entering new information into the repeater list

Step 17. Entering the longitude

Step 19. Saving the repeater list

® This item is displayed only when Step 15.
Selecting the position data accuracy level is set
to “Approximate” or “Exact.”

1. Select “LONGITUDE.”

2. Rotate [DIAL] to enter the longitude.

It 00.00E

® Push D-pad($5) to move the cursor.
® To enter an east longitude, select “E,” and to enter a
west longitude, select “W.”
3. After entering, push [ENT].

Step 18. Setting the UTC offset

® Universal Time Coordinated (UTC) offset is the time
difference between UTC and repeater local time.
This is a useful function to know the repeater’s local
time before you make a call. (p. 5-13)

1. Select “UTC OFFSET.”
2. Rotate [DIAL] to set the time difference between
UTC and the local time, then push [ENT].
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1. Select “<<Add Write>>."
» The confirmation dialog is displayed.
2. Select “YES.”

LI QACECET:

& Add write?

NO

» The entered contents are saved to the repeater list,
and the display returns to the selected repeater group
screen.

TIP: To cancel the entered data
1. Push [CLR] to display the “Cancel edit?” window.
2. Select “YES.”

SUD INAIVIE.

» Cancels the entry and returns to the selected
repeater group screen.
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Repeater list operation

< Editing repeater data
You can edit repeater data. This is useful when

already-entered data is incorrect, has changed, or
some data needs to be added to the list.

[MENU] > MEMORY > Repeater List

1. Push [MENUI.
Select “MEMORY” on the second page of the
MENU screen.

3. Select “Repeater List.”

Memory CH
Call CH

Your Call Sign

Repeater List

4. Select a repeater group where the repeater you
want to edit is listed.

M 13: Japan »

14: Latin America »

15: Oceania »
16: Poland »
17: Spain »
18: Sweden »

5. Select a repeater you want to edit, and then push

[QUICK].
6. Select “Edit.”

SKIP

Add

SKIP All ON

SKIP All OFF
MOE

7. Select an item, and then edit it.
® See pages 5-32 ~ 5-35 for details.
8. After editing, select “<<Overwrite>>."

LONGITUDE: N
135 34.09'E
UTC OFFSET: ,
+ 9:00
<<Add Write>>

<<Qverwrite>>

» The confirmation dialog is displayed.
9. Select “YES.”

ANCITIINE:
/I Overwrite?

NO

ATUT VVTTLE

<<Overwrite>>

» The edited contents are saved to the repeater list and

return to the selected repeater group screen.
® To exit the MENU screen, push [MENU].

< Deleting repeater data

[MENU] > MEMORY > Repeater List
1.

Push [MENU].

Select “MEMORY” on the second page of the
MENU screen.

Select “Repeater List.”

Memory CH
Call CH

Your Call Sign

Repeater List

Select a repeater group where the repeater you
want to delete is listed.

M 13: Japan »

14: Latin America »

15: Oceania »
16: Poland 14
17: Spain »
18: Sweden »

Select the repeater to be deleted, and then push
[QUICK].
Select “Delete.”

» The confirmation dialog is displayed.
Select “YES.”

» The selected repeater contents are deleted from the
repeater list and return to the selected repeater group
screen.

® To exit the MENU screen, push [MENU].

NOTE: The currently selected repeater on the DR
screen cannot be edited or deleted. To edit or delete
the repeater, select another repeater on the DR screen.
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Repeater list operation

¢ Rearranging the display order of the repeaters
You can move the entered repeaters to rearrange their
display order in the selected repeater group.

[MENU] > MEMORY > Repeater List

1. Push [MENU]. 8. Select the position to insert the repeater you want
2. Select “MEMORY” on the second page of the to move the repeater above.

MENU screen.
3. Select “Repeater List.”

Kirkland (1A)

Lake Stevens
Memory CH » Maple Valley
Call CH » Newcastle
o
Your Call Sign » North Bend i
Repeater List » Washinat WA7VC B

® While moving, “DESTINATION” blinks at the top left
of the screen.

4. Select a repeater group where the repeater you

want to move is listed. v
19: United Kingdo » Kirkland (1A) »
20: USA Midwest » Maple Valley ’
21: USA Northeast! Newcastle »
22: USA Southeast? !
North Bend y
24: Simplex » Washinat KF7UUY B

Select the repeater to be moved.

* The selected repeater is inserted above the
destination repeater name.

@ If “<<Move End>>" is selected, the repeater is moved

i"ad (1A) to the bottom of the group.

-

Maple Valley N ® To exit the MENU screen, push [MENU].
Newcastle »

North Bend 4

Washinat KF7UUY B

® DO NOT push [ENT].
6. Push [QUICK].
7. Select “Move.”

SKIP All ON

SKIP All OFF
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Repeater list operation

< Adding new repeater information from RX History

1. Hold down [CD] for 1 second. 8. Select “YES.”
* The RX HISTORY screen is displayed.

2. Push D-pad(!1) to display the repeater you want to
add to the repeater list, then push [ENT].

& Add write?

NO

RXO01:

JM1ZLK /1D52
JA3YUA

HELLO CQ D-STAR
RPT: JP3YHH A
(2021/11/01 15:05)

» The repeater contents are added to the repeater list,
and the display returns to the RX HISTORY screen.
® To exit the RX HISTORY screen, push [MENU].

« Displays the RX history detail screen.
3. Push D-pad(i1) to display “RXRPT1” and “RXRPT2.”

RXRPT1:
JP3YHH G

RXRPT2: 439.390
JP3YHH A

&

Push [QUICK].
5. Select “Add To RPT List.”

Add To RPT List 4

Delete

6. Select the repeater call sign that you want to add
to the repeater list.

JP3YHH A

* Displays the REPEATER LIST EDIT screen. The
selected repeater call sign is automatically entered.
@ If the selected repeater is already in the repeater list,
“Duplicate Call Sign” is displayed.
® See pages 5-32 ~ 5-35 to edit the contents.
7. Select “<<Add Write>>."

<<Add Write>>

» The confirmation dialog is displayed.
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Repeater list operation

< Skip setting for the DR scan

You can set repeaters as scan skip repeaters. The

selected repeaters are skipped for faster scanning.

You can set the skip setting to all repeaters in the

selected repeater group or individual repeaters.

® When a repeater is set as a skip repeater, its “USE
(FROM)” setting is automatically set to “NO.” In that
case, the repeater cannot be selected in “FROM” (access
repeater) on the DR screen.

<Individual skip setting> <Group skip setting>
[MENU] > MEMORY > Repeater List 1. On the REPEATER GROUP screen, select a
repeater group, as described to the left.

1. Push [IYIENU]. . 2. Push [QUICK], then select “SKIP All ON” to skip
2. Select “MEMORY” on the second page of the the group’s repeaters during the DR scan.
MENU screen. ® To cancel the skip settings in the group, select “SKIP
3. Select “Repeater List.” All OFF.”
Memory CH » TIP:
CallCH ' « When you select “Repeater List” on the FROM SELECT
Your Call 59” ¢ screen, you can set the skip setting as described to the
left.
* When “FROM” is selected on the DR screen, push
[QUICK] to set the skip setting, as shown below.
4. Select a repeater group where the repeater you i
set the skip setting is listed. GPS Position I
Weather Alert ’
D. SQL
14: Latin America » Home CH Set »
15: Oceania 4 Voltage
16: Poland 4
17: Spain »
18: Sweden d
) [ T2:00
5. Select the repeater to be skipped, and then push fY
[QUICK]. A ES;S:dQ(IA) EaQ
6. Select “SKIP.” 443.575 N7IH B
(DR ]
FM
440-000 PSKIP

SKIP All ON @ Displays “SKIP” in the “FROM” field.
SKIP All OFF

Move
oo

@ Displays “SKIP” by the selected repeater.

Hamacho/lcom »
Inage B,
Nagoya UNV »
Narayama/lcom 4
Hirano/lcom »
Chiba JP1YJQ A

@ Select “SKIP” again to cancel the skip setting.
@ Select “SKIP All ON” to set the skip setting to all
repeaters in the group.
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Repeater list operation

< Entering or editing a repeater group name

[MENU] > MEMORY > Repeater List
1. Push [MENU]. 8. After entering [ENT].
2.

Select “MEMORY” on the second page of the
MENU screen.

« — 25: FM-USA »
3. Select “Repeater List. B 26: My Town 5
27: »
Memory CH » 28: »
Call CH » 29: »
Your Call Sign » 30: '
Repeater st ) * Sets the entered name.

® To exit the MENU screen, push [MENU].

4. Select a Repeater group that you edit the name.

25: FM-USA »
»

27:

»
28: »
29: »
30: »

® DO NOT push [ENT].
@ If you select an already named group, the name is
overwritten.

Push [QUICK].
Select “Edit Name.”

oo

Edit Name

oo

7. Enter a group name of up to 16 characters.

IGROUPNAME |

My Town_

EMEWCHAR TYPE  ABC

Selectable characters and symbols

AtoZ,atoz,0t09,!"#$% & ' ()*+,-./:;<=>7?
@I\I"_"{I}" (space)

® See page iii on how to enter characters.
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Your Call Sign

< Entering Your Call Sign 9. Select “CALL SIGN.”

You can manually enter a Your (destination) Call Sign.
When a Your Call Sign is entered into “TO,” you can NAME:
make a call to the station, even if you do not know
where the station is currently located.

Up to 300 “Your Call Signs” can be entered.

»
Rick

<<Add Write>>

[MENU] > MEMORY > Your Call Sign 10. Enter a call sign of up to 8 characters, including
Example: Entering “Rick/JM1ZLK” to the Your Call spaces.
Sign memory. caLsiGn |
JM1ZLK
1. Push [MENU]. '
2. Select “MEMORY” on the second page of the

MENU screen.
3. Select “Your Call Sign.”

11. After entering, push [ENT].

M CH
CaTIrrécl)-lry 12. Select “<<Add Write>>.”
Repeater List NAME:
Rick.
CALL SIGN: ,
4. Push [QUICK] on the YOUR CALL SIGN screen. JM1ZLK
5. Select *Add.”
» The confirmation dialog is displayed.
t 13. Select “YES.”
Move
Delete
&Add write?
6. Select “NAME.”

NO

NAME: 3
CALL SIGN: ,
<<Add Write>>

7. Enter a station name of up to 16 characters.

IM1ZLK

Rick

* “Rick JM1ZLK” is entered into the Your Call Sign
memory.
® To exit the MENU screen, push [MENU].

EIBCHAR TYPE  abc

® See page iii on how to enter characters.
8. After entering, push [ENT].
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Your Call Sign

< Entering Your Call Sign

TIP:

To cancel the entered call sign

1. Push [CLR] to display the “Cancel edit?” window.

2. Select “YES” to cancel the entry and return to
the YOUR CALL SIGN screen.

lcALLSIGN |

NA171

Cancel edit?

NO

To edit the entered call sign

To edit the entered call sign, select “Edit” in step 5.
This is useful when already-entered data is incorrect,
has changed, or some data needs to be added to the
list.

JIVTTZLT
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< Deleting Your Call Sign

[MENU] > MEMORY > Your Call Sign

1. Push [MENUI.

2. Select “MEMORY” on the second page of the
MENU screen.

3. Select “Your Call Sign.”

Memory CH
Call CH

Your Call Sign

Repeater List

~ RARd

hd

4. Select a call sign you want to delete.

Kate »
Eddy »
JM1ZLK

® DO NOT push [ENT].
Push [QUICK].
Select “Delete.”

oo

TTVTTZLCT

» A confirmation dialog is displayed.
7. Select “YES.”

& Delete?

NO

IM1ZLK
Eddy »
JL3YRP

* The selected call sign is deleted from the Your Call Sign
list and the returns to the YOUR CALL SIGN screen.
® To exit the MENU screen, push [MENU].

NOTE: The currently selected Your Call Sign on the
DR screen cannot be edited or deleted. To edit or
delete the Your Call Sign, select another Your Call
Sign on the DR screen
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Your Call Sign

¢ Rearranging the display order of

Your Call Signs

You can move Your Call Signs to rearrange their
display order.

If the stations you often communicate with are moved
to the top of the list, it is easy to find them.

[MENU] > MEMORY > Your Call Sign

Example: Moving “Rick” above “Eddy.”

1.
2.

3.

Push [MENU].

Select “MEMORY” on the second page of the
MENU screen.

Select “Your Call Sign.”

Memory CH

Call CH

Your Call Sign

Repeater List

Select a Your Call Sign to be moved.

Eddy »
Kate »
JM1ZLK

® DO NOT push [ENT].
Push [QUICK].
Select “Move.”

JTVTTZLT
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7. Select the position to insert the Your Call Sign you

want to move the call sign above.

Rick
Eddy

<<Move End>>

JL3YRP

® While moving, “DESTINATION?” blinks at the top left
of the screen.

Eddy »
Kate »
JM1ZLK

» The selected call sign is inserted above the
destination call sign.

@ If “<<Move End>>" is selected, the Your Call Sign is
moved to the bottom of the group.

® To exit the MENU screen, push [MENU]I.
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Are your settings correct?

If you make a Local Area call with a gateway repeater
still selected in “TO,” the destination repeater will be
busy while you transmit.

The stations that want to use the repeater as their
access repeater cannot access it, as shown below.

BE SURE to set CQCQCAQ in “TO” on the DR screen
when you intend to make a Local Area call or finish a
Gateway call.

Example: JA3YUA wants to make a Local Area call.

through JP3YHH port A for a local call...

CQ D-STAR Hirano, this is JASYUA
His setting is wrong!

~ X | can’t access the repeater!
Caller INTERNET,
(JA3YUA)
ey
»(Ps?‘\x\‘::\\ 5??;(\’\
SV oY
033 3::\;\‘0,()\\,. Called
N)‘
Hirano area Hamacho area
JA3YUA's setting NOTE: With this setting, you can make a Local Area
R call, but the destination Repeater, selected in “TO,”
Hamacho/Icom is also busy while you transmit.
rrom Hirano/lcom The stations that want to use the repeater as their
iﬁ{: JIP1YIUA o Access Repeater cannot access it.
FM
440-000 PSKIP

The destination (“TO”) setting is incorrect.

Correct setting

] ® 5 12:00
[AMDV Y D-
h CQCQCQ

frRoM Hirano/lcom
SLO [ DR ]
UR: CQCQCQ

FM

440 -000 PSKIP

VFO

To make a Local Area call, set the destination (“TO”)
to “CQCQCAQ." See page 5-9 for details.
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GPS operation features

D-PRS Extension function (p. 6-4)

The D-PRS Extension function enables you to transmit or receive Object, ltem, and Weather information in addition
to Position data. With this extension, you can simultaneously transmit or receive earthquake information, traffic
accident information, emergency information, or weather information, and so on, along with voice audio in the DV
mode.

GPS Memory (p. 6-22)

You can enter up to 300 GPS Memories in the transceiver. By adding destination position information in a GPS
Memory, you can effectively use the GPS Alarm function. The position information that you acquired can also be
entered in a GPS Memory.

Editing GPS Memories using
a PC is easier than using

o o | can enter the location information A
o the transceiver!

of the mountain I'm going to hike!

o

GPS Alarm function (p. 6-27)

When a target station comes into the set alarm area, or when you approach an entered GPS Memory position, the
function can sound an alarm. With this function, you can know that you are approaching the destination.

GOAL! i \

” N I'm almost there!

GPS Logger function

The GPS Logger function enables you to save the position data from a GPS receiver into a microSD card as a log.
If you use this GPS Logger while driving, you can check your driving history on a mapping software program.

| can track my GPS log in a
mapping software program.
This is how | traveled...interesting!

See “Using the GPS Logger function” that can be downloaded from the Icom website about using the function.
https://www.icomjapan.com/support/
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Before starting GPS operation

NOTE: Before using the GPS function, read “IMPORTANT NOTES” about the GPS receiver in the Basic manual.

The transceiver has a built-in internal GPS receiver.
The GPS receiver’s position data can be received in
any mode.

NOTE: Transmit or receive position data that can be
transmitted in only the DV mode.

< Confirming the GPS signal receiving

Confirm the GPS receiver is receiving satellite signals.

The GPS icon blinks when searching for satellites.
LY Y

The GPS icon stops blinking when the minimum
number of satellites needed is found.

*

® Information
« It may take only a few seconds to receive, or it may take

a few minutes, depending on your operating environment.

If you have difficulties receiving, we recommend that you
try a different position.

* When “GPS Select” is set to “Manual,” the icon is not
displayed.
(IMENU] > GPS > GPS Set > GPS Select)
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NOTE: Continuously using the Internal GPS mode
causes the transceiver’s battery to be exhausted
quickly. Turn ON the Power Save mode if needed.
See page 6-30 for details.

(IMENU] > GPS > GPS Set > GPS Option

> Power Save)

TIP: To prolong the battery life in the GPS mode
Manually update your location with the received GPS
data.

1. Set “GPS Select” to “ON,” and receive your
position from the internal GPS receiver.
(IMENU] > GPS > GPS Set > GPS Select)

2. Open the MANUAL POSITION screen, and then
push [QUICK].

(IMENU] > GPS > GPS Set> Manual Position)

3. Select “Capture From GPS.”

Edit
Set From GPS Memo
Default

* Your current position is now memorized and
displayed on the MANUAL POSITION screen.
4. Set “GPS Select” to “Manual.”
(IMENU] > GPS > GPS Set > GPS Select)
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GPS TX mode and TX format types

GPS position data has 2 TX modes, D-PRS, and Example: When the caller’s TX format is D-PRS
NMEA. Moreover, with the D-PRS mode data, 5 Position (Mobile)
position formats, Position (Mobile station/Base (IMENU] > GPS > GPS Position)

station), Object, ltem, and Weather, are selectable.

FNN 34 37.38N COURSE: 95
"4 1353438 SPEED: 5.6mph
GL: PM7450 (12:00)
a6 ALT: 33ft
DST: 107mi
Rx  IMIZLK-A I RX

D-PRS is a function that simultaneously sends position data received from the
internal GPS receiver, using the slow speed data packet space, along with voice.

A station operating from a vehicle, or other position, away from its normal base

D-PRS

Position (Mobile)

position.
Position (Base) A station operating at home or in a building.

Transmitting Object data such as earthquake information, satellite tracking
Object information, and so on.

An Object contains a time stamp.

Transmitting Item data such as a traffic accident, lighthouse, antenna, or DV
Item access point position, and so on.
An Item does not contain a time stamp.

Weather A station transmitting weather information received from a weather device.
NMEA A station transmitting position data (NMEAOQ183) received from the internal GPS
receiver.

Difference between older models

(As of November 2021)
* The GPS TX mode, “GPS (DV-G)” and “GPS-A (DV-A),” are now called as “NMEA (DV-G)” and “D-PRS (DVA).”
GPS (DV-G) — NMEA (DV-G)
GPS-A (DV-A) — D-PRS (DV-A)
For users who have one of the following models:
ID-800H, IC-91AD/E91, IC-U82, IC-V82, IC-7100, ID-51A/E, ID-31A/E, IC-9100, IC-80AD/E80D, ID-880H/E880,
IC-92AD/E92D, IC-2820H/E2820
When you receive a D-PRS position (Base), Object, Iltem, or Weather information, their data is not displayed.
Only the ID-51A/E PLUS, ID-51A/E PLUS2, ID-31A/E PLUS, ID-5100A/E, ID-4100A/E, IC-R30, 1C-9700, IC-705,
and ID-52A/E can receive Power, Height, Gain, and Directivity data.
For users who have one of the following models:
IC-9100, IC-80AD/E8OD, ID-880H/E880, IC-92AD/E92D, IC-U82, IC-V82
If you transmit with the Altitude setting ON, the character string is included in a comment on the products that
cannot display the altitude.
Set the GSV sentence to OFF when sending the GPS message to conventional digital transceivers (1C-2820H/
E2820, ID-800H, IC-91AD/E91, IC-V82, IC-U82, IC-2200H). The GSV sentence is incompatible with them.
They will not display GPS messages properly if sent as a GSV sentence from the ID-52A/E.
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When a received signal

contains position data

When a received signal contains position data, the
caller’s position data is displayed on the RX position
screen.

See to the right for details.

Example: When the signal from JM1ZLK contains
position data.

] % § 12:0
7N~ IM1ZLK-A i
W\fj 34'37.38N ||

135" 34.38'E
DST: 107mi
RX: JIM1ZLK /ID52(R|,

S

When you receive the signal, the RX
position data is displayed in the RX position
window.

v

After a few seconds, the window
disappears.

[n] £ 12:00
[MAINDIYES
9ICOM ARC
FrRoM 441.000
SLO

MSG:
FM

440.000

<—RX position icon

PSKIP|
VFO

When the received signal contains position
data, the RX position icon is displayed, as
shown above.

@ You can turn OFF the caller’s position data display.
(IMENU] > SET > Display > RX Position Display)

® You can turn OFF the RX position icon indication.
(IMENU] > SET > Display > RX Position Indicator)
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Checking your location

You can check your current location.
This section is described using received position data.
® The screens are just examples.

< Displaying Position Data
1. Push [QUICK].
2. Select “GPS Position.”
» Opens the GPS POSITION screen.
3. Rotate [DIAL].
» Changes between the MY (My position), RX
(Received position), MEM (GPS Memory position), or
ALM (GPS Alarm position) screen.

'~ 34 37.39'N

w A E ., ,

Vo/ 135 34.29°F
0 GL:

PM74S0O
ALT: 75ft

SPEED: 2.3mph

[wy] TIME: 2:39:24

The displayed icon depends on the type of
screen (MY, RX, MEM, or ALM).

4. To close the GPS POSITION screen, push
[MENU].

NOTE: Latitude, longitude, and altitude data may
differ, depending on your received GPS signal.

TIP:

+ If you transmit with the GPS POSITION screen open,
the screen closes. To check the location, push [QUICK],
and then select “GPS Position” while transmitting.

» On the MY screen or RX screen, you can enter the
displayed position information in a GPS Memory by
pushing [QUICK] and select “GPS Memory.”

» See page 6-22 about the GPS Memory function and
see page 6-27 about the GPS Alarm function.
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Checking your location

<O GPS POSITION screens and their meanings

® Information Example for the GPS POSITION screens:

» Pushing to [QUICK], change the compass direction.
(p. 6-10)

» About the Course (p. 6-8)

» About the Grid Locator (p. 6-9)

4 GPS Memory: l

Tokyo Skytree

GPS Alarm:
Tokyo Big Sight

251 mi

248 mi

107 mi 2%

t R

Your station Call station

MY screen (Your position information)

Course: 0 degrees
Speed: 2.3 mph

(D-PRS: mobile)
Course: 95 degrees
Speed: 5.6 mph

When “GPS Select” is set to “Manual,” the compass
heading and course direction are not displayed.
(p. 6-30) ((MENU] > GPS > GPS Set > GPS Select)

[GPS POSITION 44

Your course W/K\E 34' 37.39'N «——Latitude
heading 34 135 34.29'E «——Longitude

MEM screen (GPS Memory’s information)

[GPS POSITION 44

Course direction—»0  GL: PM7450<-—Grid Locator Direction from your{ wf‘“’\E 35: 42 59'N
ALT: 75ft «——F—Altitude location N4 139°48.65'E
SPEED: 2.3mph <«——Speed GL: PM95VR
My TIME: 2:39:24 «=—Received DST: 25Tmi

time

*

MEM Tokyo Skytree<—

RX screen (Caller’s position information)

Depending on the caller's GPS TX Mode and TX

format, the displayed item’s meanings may differ, and

some data may not be displayed. (p. 6-7)

Example: The caller station’s GPS TX Mode is “D-PRS,”
and its TX format is “Position (Mobile).”

ALM screen (GPS Alarm’s information)

(GPS POSITION 5|

. r"~ 35 37.78'N
GPS POSITION Dlst'a.nce from your~|: N 13947 66E
N . \ - position s
Direction from{w”)\‘g 34ﬂ 37'38|N I GL: PIVI95.VP
your location N4 135 34.38E DST: 248mi
GL: PM74S0
D-PRS symbol—»-d® ALT: 33ft ALM Tokyo Bigsite «—x*
DST: 107mi<—Distance from
RX  JM1ZLK-A your location

Caller’s call sign with SSID

(GPSPOSITION 54

Caller’'s Course —» COURSE: 95
direction SPEED: 5.6mph <—-Caller’s speed
Time the caller —»(12:00)
acquired the
position data

* When a name is not entered in the GPS Memory
channel, date and time are displayed instead of the
name. You can change the GPS Memory or GPS
Alarm in the GPS POSITION screen in the Quick

RX Menu window. (p. 6-9)
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Checking your location

<¢ About the RX screen

TX format:
D-PRS

Position (Mobile)

WXN\E 34° 37.38'N
N, A4 135 34.38'E

COURSE: 95
SPEED: 5.6mph

GL: PM74S50 (12:00)
& ALT: 33ft

DST: 107mi
RXT IM1ZLK-A RX

I
Moving symbol

Object

|
For a mobile station,
Course and Speed
are displayed.

Weather

"~ 34 37.55'N IM1ZLK-A

T4 13534.15€ POWER: 81W
GL: PM74SP HEIGHT: 40ft I
ALT: 23ft GAIN: 7dB
DST: 376mi DIRECT: Omni

RX HAM FESTA RX (12:00)<—i

Time that the caller

sent the Object’s data.

5% 35 34.28N

E VW R .

\y4 135°48.18'E
GL: PM75VN

DST: 66.8mi
RX JM1ZLK

77°F 80%
RAIN: 0.04in/h
WINDDIR: 25°

WINDSPD: 4mph
BARO: 29.2inHg
RX (12:03)

Time that the caller

acquired the weather data.

@ Call sign is displayed with an SSID.
® When the Object or ltem is disabled, “KILLED” is displayed.

Position (Base)

"~ 35 37.40'N POWER:
"4 139 47.30€ HEIGHT:
GL: PMI5VO GAIN
4 ALT: 47ft DIRECT
DST: 376mi (12:00)
RXT IM1ZLK-A 1 [rx T

[ ] I

Base station symbol For a base station, Output
power, Antenna height,
Antenna gain, and Antenna

direction are displayed.

Item
N~ 3541.11'N IM1ZLK-A
N4 139 47.28W POWER: 81W
GL: CMO05CQ HEIGHT: 160ft
(‘;é'\’) ALT: Oft GAIN: 5dB
DST: 742mi DIRECT: Omni
RX Repeater 1 RX

@ For an Item station, Time is not displayed.

TX format:
NMEA

"~ 35 37.40'N

W E . |

W4 139°47.30'E
GL: PM95VO
ALT: 24ft
DST: 248mi

RX  JMI1ZLK

COURSE: 275
SPEED: 21.2mph
(12:00:00)

® A symbol or SSID is not displayed when the TX format is NMEA.
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Checking your location

<O Setting the display type (MAIN/SUB)

You can select the display type of the RX screen.

1. Push [QUICK] when the RX screen is displayed.
2. Select “Display Select (MAIN/SUB).”

Display Select (MAIM

Add To GPS Memory
GPS Memory
Compass Direction »

3. Select the item you want to switch.

Latest (MAIN/SUB)

MAIN
SUB

« Latest (MAIN/SUB): Displays the target station’s
latest location information
regardless of the MAIN band or
the SUB band.

* MAIN: Displays only the latest location
information of the target station
received in the MAIN band.

* SUB: Displays only the latest location

information of the target station
received in the SUB band.
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<© About the Course

The course displayed on the GPS POSITION screens
is indicated in degrees.

00
|
315° N 45°
270° —W E—90°
225° s 135°
|
180°
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Checking your location

< About the Grid Locator ¢ Changing the GPS Memory or Alarm

Grid Locator (GL) is a position compressed into a 6 You can change the GPS Memory or GPS Alarm in

character code, calculated by the longitude and the the GPS POSITION screen.

latitude.

The locator is simply calculated by dividing the earth’s 1. While selecting the MEM screen or ALM screen,

surface into squares. push [QUICK].

It is used to find the location of a transceiver station. 2. Select “GPS Memory Select,” or select “Alarm
Select.”

7V~ 34'37.39'N Field
SAZ 1353429 —L— MEM screen

i ammso | PM74SO
i

GPS Memory Select

ALT: 75ft

'~ 3542.59'N o
SPEED: 23mph i . : Compass Direction »
My TIME: 2:39:24 Square Subsquare N4 139°48.65'E
GL: PM95VR
DST: 251mi

MEM Tokyo Skytree

The grid locator map of Japan

ALM screen
n Alarm Seect ¢
N~ 3537.78'N canction 4
w E o
\JI4 139'47.66' P
GL: PM95VP
DST: 248mi

ALM Tokyo Bigsite

3. Select the GPS Memory or GPS Alarm to display
on the GPS POSITION screen.
® Adding or editing a GPS Memory: p. 6-22
@ Setting the GPS Alarm: p. 6-27
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Checking your location

¢ Changing the Compass Direction < Saving your own or a received

You can set the compass direction to Heading station’s position

Up. North Up, or South Up. You can save the position of your station or the

position of the caller station.

The transceiver has 300 GPS memories, and the
memories can be assigned to one of 27 banks, A~ Z,
and (No Group).

1. While displaying the GPS POSITION screen, push
[QUICK].
2. Select “Compass Direction.”

1. Select the screen that_you want to save.
® To save your own position: MY screen
® To save a received position: RX screen
2. Push [QUICK].
3. Select “Add To GPS Memory.”
3. Select the compass direction.

GPS Memory
Compass Direction »

Heading Up
North Up

South Up

® See pages 6-22 ~ 6-24 for entering details.
4. Select “<<Add Write>>.”

Heading Up North Up South Up GROUP:
(No Group)’
A \ N 5N
A " - E W
Ave® 3 A S A
e S N
The top is always The top is The top is ® To select the destination group to be saved, select
your course direction.  always north. always south. “GR?UP'” ,
5. Select “YES.
GRALID-
&Add write?
NO

» Saves the data in the GPS Memory, then returns to
the GPS POSITION screen.

6. To close the GPS POSITION screen, push
[MENUI.

TIP: The position is saved in the selected group in
the GPS MEMORY EDIT screen. (Step 4)
(IMENU] > GPS > GPS Memory)
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Checking GPS information (Sky view screen)

This screen is used to view GPS satellite information
when the GPS icon does not stop blinking for a long
time.

The GPS Information displays the quantity, signal
power, and position of the satellites.

The sky view screen displays the position of the
satellites. The screen also displays each satellite’s
direction, elevation angle, satellite numbers, and their
receiving signal strength status.

1. Push [QUICK].
2. Select “GPS Information.”

QGroup Select
Repeater Detail

34°37.23'N
135 34.18'E

About the display
- il Untracking satellite.

. @8: Tracking satellite with a weak signal, shown
by the satellite number.

. @: Tracking satellite with a strong signal, shown
by the satellite number.

* SAT: The quantity of tracking satellites.

* Altitude: The altitude of your station. The altitude is

only displayed when 4 or more satellites
are tracked. When 3 or less satellites are
tracked, “------ ft” is displayed.

* Longitude/Latitude:
Longitude and Latitude of your station.

TIP: The following satellite number is assigned to
the each satellite system.

+ GPS: 01~32
+ SBAS: 33~71
+ GLONASS: 65 ~ 96
+ QZSS: 193 ~ 202

3. To close the GPS INFORMATION screen, push
[MENU].
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N SAT: 5<+—Tracking
. K.\ satellite
Sky view screen »@\JQD E quantity
@®
\QS/ 83f‘t|<—AItitude
34'37.23'N |<—Latitude
135 34.18'E | <+—Longitude

Satellite N '\
number 19's <e—rUntracking satellite
signal is weak.—ﬁ’ \

;@—Q ® E

|- 24

Satelite pd \. |-? e——Elevation angle
number 06’s . // 0 degree line
signal is strong. L

Elevation angle
30 degree line

Elevation angle
60 degree line

Elevation angle
90 degree line
(Zenith)

The image of satellite number 06

Elevation angle
90 degree line (Zenith) Elevation angle

60 degree line
Elevation angle
30 degree line

E

Elevation angle
0 degree line
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Transmitting D-PRS data

When D-PRS is selected as the GPS TX mode, you

can transmit D-PRS data.

When operating in the D-PRS mode, the following

codes are transmitted to the PC.
D-PRS code is based on APRS® code.

NOTE:

+ If “GPS select’ is set to “Manual,” the manually entered
position data in “Manual Position” is changed to the
D-PRS data format to transmit.

(IMENU] > GPS > GPS Set > GPS Select)

» Note that if “GPS Auto TX” is set to any other setting than
“OFF,” it is transmitted according to the set time.
(IMENU] > GPS > GPS Auto TX)

(APRS®: Automatic Packet Reporting System)

<¢D-PRS

D-STAR Packet Reporting System (D-PRS) is a mode
that simultaneously sends position data received from
the internal GPS receiver, using the slow speed data
packet space, along with voice audio in the DV mode.
In the Analog mode, you can transmit or receive only
voice audio or data at one time. However, a D-PRS
capable radio can transmit or receive message data
or GPS position data simultaneously when voice is
being transmitted or received. An |-GATE is required

to send position data to the APRS server.

The image of D-PRS

<Using a Repeater>

Voice, Messages, and
D-PRS positions/

D-STAR Repeater

D-PRS positions q

=== \

Voice, Messages, and
D-PRS positions

<Simplex>

==
()

Voice, Messages, and
D-PRS positions

T~

Voice, Messages, and
D-PRS positions

/

< Operating in the D-PRS mode

To transmit D-PRS data, follow the steps below.
For more details, see the pages listed along with the

steps.
1. Enter “MY” (Your own call sign).
(Basic manual D-STAR GUIDE)

2. Confirm the GPS signal is receiving.
3. Set GPS TX mode to “D-PRS.” (p. 6-14)
4. Set TX information.

® You must set “SSID” and “Symbol.”

(IMENU] > GPS > GPS TX Mode > D-PRS)

l

APRS server

Information from
an APRS network

D-PRS
positions

——INTERNET:

You can check the
position on a map site!

b D-PRS positions é
]

I-GATE

TIP: In the D-PRS mode, you can transmit
earthquake or weather information, in addition to
position data.

([IMENU] > GPS > GPS TX Mode > D-PRS > TX Format)

TX format of D-PRS
+ Position (Mobile/Base):
Used to transmit position data.

* Object: Used to transmit specific position data.
(Contains a time stamp.)

o ltem: Used to transmit specific position data.
(Does not contain a time stamp.)

» Weather: Used to transmit weather information.

Complete! You can transmit in the D-PRS mode.
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Transmitting D-PRS data

¢ Displayed items

Depending on the TX format, the setting items and displayed order of the items differ.

D-PRS
Position Object ltem
= =
= =
© ©
o o
a a
C C
£ £
s | 9 - | 9
3| & 3| 5
Q_ - — Q_ - —
o | 2 o | f
[} = [} =
o ) o [}
L S = L =] =
L (I
| 3 & o 8§ &
c c c c c c
iel iel iel iel iel iel
(7)) » » (2] (2] ()
C C C C C C
2 2 2 2 2 2 .
x X X X x x (0]
K} () () () () () () =
2 $| & 8| &8 &8 8| 8| T
o © © © © © © © o
S  m| o a|lo alal al =2
Unproto Address v v v v v v v v v
Comment v v v v v v v v v
Altitude v Ve
Object Name/
v
ltem Name
Data Type v v v v
Position information
(Latitude/Longitude/ v v v v v v
Altitude)
Data Extension v Ve v v v v v v
Course v v
Speed v v
Power v v v
Height v v v
Gain v v v
Directivity v v v
Symbol v v v v v v v v v
SSID v v v v v v v v v
Time stamp v v v v v v
v: Displayed
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Transmitting D-PRS data

¢ Setting D-PRS Position (Mobile/Base)

Set to transmit as a D-PRS Position (Mobile/Base).
® See page 6-31 for details.

1. Setting the GPS TX Mode to D-PRS

9. Setting the Data Extension

[MENU] > GPS > GPS TX Mode > D-PRS

2. Checking the Unproto Address

You should use the default address, and editing is not
recommended.

3. Setting the TX format to “Position”

Set “TX Format” to “Position.”

4. Selecting the Symbol

Select the Symbol that indicates your operating
situation.
® See page 6-31 to directly enter the Symbol.

5. Selecting the SSID

To help identify your station’s type, select the APRS®
(Automatic Packet Reporting System) based SSID
after the D-PRS data call sign. (p. 6-32)

6. Entering a comment

Enter a comment, and transmit it with the D-PRS
position data.
® The number of characters you can enter differs,
depending on the data extension and altitude settings.
(p. 6-32)

Select “Comment.”

Push [QUICK].

Select “Edit.”

Enter a comment.

After entering, push [ENT].

Push [ENT] again.

ok wN-~

7. Setting the Time Stamp

Set the Time Stamp function to transmit the received
time data in UTC (Universal Time Coordinated) time.
(p. 6-32)

8. Setting the Altitude

Set whether or not to transmit the altitude data
acquired from the GPS receiver. (p. 6-33)

NOTE: If you transmit with the altitude setting ON,
the character string is included in a comment on the
products that cannot display the altitude. (p. 6-4)
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Set the data extension of your station’s information.

® Set “Data Extension” to “Course/Speed” to transmit as a
mobile station.

® Set “Data Extension” to “Power/Height/Gain/Directivity” to
transmit as a base station.

When you set “Data Extension” to
“Power/Height/Gain/Directivity”:

9-1. Setting the TX power

Select the TX power level of the base station to
transmit along with the position data.

9-2. Setting the antenna height

Select the height of the base station’s antenna to
transmit along with the position data.

9-3. Setting the antenna gain

Select the gain of the base station’s antenna to
transmit along with the position data.

9-4. Setting the antenna directivity

Select the direction the base station’s antenna was
pointing to transmit along with the position data.

10. Exiting the POSITION screen

To close the POSITION screen, push [MENU].
* Returns to the standby screen, and then DV - is
displayed.
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Transmitting D-PRS data

< Setting D-PRS Object/ltem

Set to transmit as a D-PRS Object or Iltem.
® See page 6-31 for details.

1. Setting the GPS TX Mode to D-PRS

9. Setting the Data Extension

[MENU] > GPS > GPS TX Mode > D-PRS

2. Checking the Unproto Address

You should use the default address, and editing is not
recommended.

3. Setting the TX format to “Object” or “ltem”

Set “TX Format” to “Object” or “ltem.”

4. Entering Object name or Item name

Enter an Object or Iltem name, such as event information or
location.

5. Selecting Data type

Set the Object or ltem’s status.

® For example, if you want to transmit finished event
information as an Object, set the Date type to “Killed
Object.”

6. Setting the Symbol

Select the Symbol that indicates an Object or Item.
® See page 6-31 to directly enter the Symbol.

7. Entering a comment

Enter a comment to transmit as an Object or Item.
® The number of characters you can enter differs,
depending on the data extension and altitude settings.
(pp. 6-34, 6-36)

Select “Comment.”

Push [QUICK].

Select “Edit.”

Enter a comment.

After entering, push [ENT].

Push [ENT] again.

ok whN =

o

. Entering the Position data

Enter the position data of an Object or ltem.

® For example, if you want to transmit traffic accident
information as an ltem, enter the position data where the
accident happened.
If the position data is in the GPS memory, you can easily
set the position data from the memory.
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Set the data extension of an Object or Iltem’s

information.

® Set “Data Extension” to “Course/Speed” to transmit as a
mobile station.

® Set “Data Extension” to “Power/Height/Gain/Directivity” to
transmit as a base station.

When you set “Data Extension” to
“Course/Speed”:

9-1. Entering the Course

Enter the Object or Item’s course when the station
moves.

9-2. Entering the Speed
Enter the Object or Item’s speed.

When you set “Data Extension” to
“Power/Height/Gain/Directivity”:

9-3. Setting the TX power

Select the Object or Item’s TX power level if the
station is a repeater, node, access point, and so on,
and an antenna is installed.

9-4. Setting the antenna height
Select the height of the Object or Item’s antenna.

9-5. Setting the antenna gain
Select the gain of the Object or Item antenna.

9-6. Setting the antenna directivity

Select the direction the base Object or ltem’s
antenna is pointing.

10. Selecting the SSID

To help identify your station’s type, select the APRS®
(Automatic Packet Reporting System) based SSID
after the D-PRS data call sign. (p. 6-32)

11. Setting the Time Stamp

® This item is displayed when the TX format is
“Object.”

Set the Time Stamp function to transmit the received

time data in UTC (Universal Time Coordinated) time.

(p. 6-35)

12. Exiting the OBJECT or ITEM screen

To close the OBJECT or ITEM screen, push [MENU].
* Returns to the standby screen, and then DV - is
displayed.
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Transmitting D-PRS data

¢ Setting D-PRS Weather

Set to transmit as a D-PRS Weather station.
® See page 6-31 for details.

1. Setting the GPS TX Mode to D-PRS
[MENU] > GPS > GPS TX Mode > D-PRS

2. Checking the Unproto Address

You should use the default address, and editing is not
recommended.

3. Setting the TX format to “Weather”
Set “TX Format” to “Weather.”

4. Selecting the Symbol

Select the Symbol that indicates the weather station.
® See page 6-31 to directly enter the Symbol.

5. Selecting the SSID

To help identify your station’s type, select the APRS®
(Automatic Packet Reporting System) based SSID
after the D-PRS data call sign. (p. 6-32)

6. Entering a comment

Enter a comment to transmit as a D-PRS Weather
station.

Select “Comment.”

Push [QUICK].

Select “Edit.”

Enter a comment.

After entering, push [ENT].

Push [ENT] again.

ook wh=

7. Setting the Time Stamp

Set the Time Stamp function to transmit the received
time data in UTC (Universal Time Coordinated) time.
(p. 6-38)

8. Exiting the WEATHER screen

To close the WEATHER screen, push [MENU].
» Returns to the standby screen, and then DV 7 is
displayed.
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Transmitting D-PRS data

O Weather station transmission

When you transmit as a weather station, you should
set the weather station’s settings and input the
weather data into the [USB] port.

You can input the weather data from a third party’s
weather device by converting it to the APRS weather
format in your PC or microcomputer.

After completing the weather station’s settings and
inputting the weather data, you can transmit as a
weather station.

NOTE: To input the Weather data into the [USB]
port, set “USB Connect” to “Serialport,” and set “USB
Serialport function” to “DV Data.”

(IMENU] > SET > Function > USB Connect)

(IMENU] > SET > Function > USB Serialport function)

If the weather data is not input into the [USB] port,
you cannot transmit as a weather station.

USB cable
(User supplied)

Weather

ort
P device

Microcomputer

< Application setting

Configure the communication software as follows.

* Port: The COM port number that is used by the
transceiver.*

* Baud rate: Your desired speed

« Data: 8 bit

* Parity: none

» Start: 1 bit

» Stop: 1 bit

» Flow control: none

* Depending on the PC environment, the COM port number
used by the ID-52A/E may be higher than 5.
In that case, use an application that can set it to higher
than 5.
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< Confirming the weather data input

You can confirm whether or not the weather data is

input into the [USB] port.

1. Set “GPS TX Mode” to “D-PRS,” and “TX format”

to “Weather.” (p. 6-16)

2. On the Standby screen, push [QUICK].

3. Select “Weather Information.”

@ Displays the WEATHER INFORMATION screen if the
weather data is entered correctly.

® When the weather information is displayed, you can
transmit as a weather station. If “-” is displayed on the
screen, the weather data is not entered. In that case,
check the entered data settings.

fan] % & 12:00
TEMP: 77 F
RAIN: 0.04in/h
WINDDIR: 25’
WINDSPD: 4mph
BARO: 29.2inHg
HUMI: 80% b

VFO

<¢ About the weather data content

The weather data should be input according to the
format (based on the APRS® Weather Data), shown
below.

Example:
220/004 g005 t077 r000 p000 PO00 h50 b09900 End code
1 2 3 4 5 6 7 8 9
No. Item Value Unit
Wind direction 000 to 360 °
2 | Wind speed 000 to 999 mph
Gust speed g000 to g999 mph
4 Temperature t-99 to t-01, °F
t000 to t999
5 |Rainfall r000 to r999*! inch
Rainfall (24 Hours) | p000 to p999*! inch
Rainfall (Midnight) P000 to P999*" inch
8 Humidity h00, h01 to h99 %
(h0O0 indicates 100%.)
9 Barometric pressure | b00000 to b99999*2 | hPa,
mb

*! The last two digits indicate the one decimal place and the
two decimal places.

*2 The last digit indicates the one decimal place.

@ If you have no data, enter a space or “.” (period) instead
of a number.
(Example: “.../...g...t077r000p...P...h50b.....")

® Enter <CR>, <LF>, or <CR><LF> for an end code.
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Transmitting D-PRS data

< Displaying your location using mapping software

If you transmit to an I-GATE station, and then enter
the call sign information on the Internet map website,
the selected symbol is displayed.

Example: Check your location on the APRS fi site.

1. Display a free APRS® related map site on the
Internet. (Example: http://aprs.fi/ )

Enter your call sign in the “Track callsign” field.
Click <Search>.

w N

* The icon (D-PRS symbol) is displayed on the map site.

You can check it on the Internet!

PC

=

‘aishaWard Office
AERET D

a TAISHOWARD
AER
a

INTEX Osaka ke é

= o
\ SUMINGE wARD [

Goigle \ SUMNOEM o
(Y5

1 W

o e B

Smartphone

Enter your call sign,
and then click <Search>.

Track callsign: Clear

[Search| 7

o TN\ o], WBreA - Login 4
Shirakita *
g é-.i‘ T w
(=)
\
% e L ®
5 A\ Track callsign: Clear *
Search| 3 ¥
MIYAKOJIMA, |y =
WARD —
o WRE_ /) b
: y A
8 "
=  hours
o A
g F 58 T tail length:
srgele— = fhaur Y]
— X=
Updated: (19h6m)
Position: 34°40.57° N 135°28.91' E

O |2015] [2016] [2017| T 4= =

 Other SSTDs: £ Wi

Wt A5.09C B5% 1004 mbar 0.0 mia W

o0
« Raw packets

+ Status packets - Beacon packets
+ APRS/CWOP weather - Telemetry
2 + Messages - Bulletin board

+ Preflx browsing

+ Google Earth KML 7

TENNDJI WARD g lkuno K
REFE 5]
ak

=]

+ Data export tool
<] « Preferences - My account
Information:
Stations currently moving « FAQ + Blog -
Discussion group - Linking to apes.fl - AT

4 APi- Change log - Planned changes -
Credits and thanks - Terms Of Service
iPhone/iPad APRS

fﬁ@— Your symbol and your call sign

!



© GPS OPERATION (ADVANCED)

Transmitting D-PRS data

TIP:
D-PRS data content

D-PRS data content are shown below.

<O Position (Mobile)
(e.g.) JA3YUA-A>API52 DSTAR*:/002338h3437.38N/13534.29E>090/002/A=000012ID-52 OP.SATOH
® ® ® @ @ é) é) @ ®

<Position (Base)

(e.g.) JASYUA-A>API52, DSTAR*:/002338h3437.38N/13534.29E-PHG51320P.SATOH

© @ ® ® o & G
<& Object
(e.g.) JASYUA-A>API52,DSTAR*:;;HAM FESTA*01234523437.38N\13534.29Eh2021.11.01 am10-pm4
© @ ® @ 6 ® 0 3 $
Oltem
(e.g.) JASYUA-A>API52, DSTAR*:)REPEATER!3454.00N/13536.00ErPHG5132439.39MHz DV RPT JP3YHH A
® @ ® @ 06 © & e @
OWeather
(e.g.) JASYUA-A>API52 DSTAR*:/01234523454.00N/13536.00E_220/004g005t077r000p000P000h50b09900
® © ©) @ O é éD ® ® @ ® @ @ @
. @Data Extension(PHG codes)
%ggllle on PHG codes definitions
(®Unproto Address 0 1 2 3 4 5 6 7 8 9
@D-PRS Data type First: Power 0 1 4 9 16 | 25 | 36 | 49 | ea | 81 | W
{ ﬁos!t!on W'I: t'“:‘ta_ stamtp Second: Height [ 10 20 40 80 160 | 320 | 640 | 1280 | 2560 | 5120 | (feet)
» Fosttion without time stamp Third: Gain 0 1 2 3 4 5 6 7 8 9 (dB)
') ﬁ:ﬁ ot Fourth: Directivity| omni | 45°NE | 90°E | 135°SE | 180°S | 225°sw | 270°w |315°Nw/| 360°N | - -
(®O0bject Name/ltem Name
(®Data Type B3Altitude @9Rainfall (24 Hours)
* Live Object —99999 ~ 999999 feet 0.00 ~9.99 inch
I Live Item (@Comment @)Rainfall (Midnight)
_ Killed Object/Killed Item @3Wind direction/Wind speed 0.00 ~9.99 inch
@Time Stamp (UTC) Wind direction:0 ~ 360° @DHumidity
h Hour Minute Second Wind speed: 0 ~ 999 mph 1 ~99%, 00=100%
z Day Hour Minute (®Gust speed @Barometric pressure
(®Latitude 0 ~ 999 mph 0.0 ~9999.9 hPa
®Symbol @Temperature
{Longitude -99 ~ 999°F
{Data Extension (Course/Speed)  @Rainfall
Course:0 ~ 360° 0.00 ~9.99 inch

Speed:0 ~ 999 knots
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Transmitting NMEA data

Set a GPS sentence to transmit GPS data in the DV
mode.

<© Setting the GPS data sentence
[MENU] > GPS > GPS TX Mode > NMEA > GPS Sentence

1. Push [MENU]. 6. Repeat step 5 to set the GPS sentence.

2. Select “GPS TX Mode” in the “GPS” menu. @ Up to 4 GPS sentences can be set at a time.

3. Select “NMEA.” 7. To close the “GPS Sentence” screen, push [MENU].

4. Select “GPS Sentence.” » Returns to the standby screen, and then DV 7 is
displayed.

v

GPS Sentence
GPS Message > NOTE:

» Set “GSV Sentence” to “OFF” when sending the GPS
message to conventional digital transceivers. (p. 6-4)

* If “GPS Select” is set to “Manual,” the transceiver
automatically sets the NMEA sentence and transmits

5. Select the GPS Sentence. it along with the manually entered position data in

“Manual Position.”

(IMENU] > GPS > GPS Set > GPS Select)

(IMENU] > GPS > GPS Set > Manual Position)

GGA « Note that if “GPS Auto TX" is set to any other option
LlGLL than “OFF,” data is automatically transmitted according
[Ivre to the set time.

L]GsA (IMENU] > GPS > GPS Auto TX)

LlGsv @ If “GPS Select” is set to “OFF” or “Manual,” the GPS

- Displays 7]’ when the sentence is set to ON. Automatic Transmission function is not activated.

® The selectable GPS sentences are RMC, GGA, GLL,
VTG, GSA, and GSV. The GGA sentence is set to
ON as the default GPS sentence.

@ To reset to the default setting, push [QUICK], and
then select “Default.”

Contents of GPS sentence

Lon Date 2D COG SOG
Sentence ILat Alt UTC (UTC) Status /3D (True)  (knot) Others

RMC 4 v v v v 4 Magnetic variation, Mode Indicator
Number of satellites in use, HDOP,

GGA 4 4 v 4 Geoidal separation, Age of Differential
GPS data, Differential reference station ID

GLL v v v Mode Indicator

VTG v v COoG (Ma.gnetlc north), SOG (km/h),
Mode Indicator

GSA v v PRN number of satellites used in

solution, PDOP, HDOP, VDOP

Total number of sentences, Sentence
number, Total number of satellites in
view, Satellite information (ID, Elevation,
Azimuth, S/N)

GSvV
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Transmitting NMEA data

¢ Setting a GPS message

Enter a GPS message to be transmitted with the
position data.

Example: Entering “OSAKA Suzuki”

[MENU] > GPS > GPS TX Mode > NMEA >
GPS Message

Push [MENU].

Select “GPS TX Mode” in the “GPS” menu.
Select “NMEA.”

Select “GPS Message.”

PowN =

GPS Sentence »
GPS Message

-

5. Push [QUICK].
6. Select “Edit.”

Clear

7. Enter a GPS message of up to 20 characters.

GPS Message |

OSAKA Suzuki_

ERCHAR TYPE  ABC

® See page iii on how to enter characters.
8. After entering, push [ENT].

OSAKA Suzuki

* You can confirm the entered message.
9. To close the “GPS Message” screen, push
[MENUI.
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GPS Automatic Transmission

NOTE:

» Use the GPS Automatic Transmission function in only
the Simplex mode.

* Using the function through a Repeater may interfere
with other communications.

You can set the GPS Automatic Transmission function
in the following menu.

[MENU] > GPS > GPS Auto TX

If you set this function, GPS data is automatically

transmitted according to the set time.

® This function is not activated if your call sign (MY) is not
entered in the transceiver.

@ If “GPS Select” is set to “OFF” or “Manual,” this function is
not activated.
(IMENU] > GPS > GPS Set > GPS Select)
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GPS Memory

You can add GPS data to GPS Memory.

You can add your own position, other station’s
position, or any entered positions manually.

You can save up to 300 GPS memories, and
conveniently saved in up to 27 groups, from A~ Z and
“(No Group).” The A to Z groups can also be named.

¢ Adding a GPS Memory
Example: Add “HOME” into (No Group).

1. Adding a GPS Memory and entering the edit mode

| GPS Memory | Group names are just

example.

—| (No Group) |

— A ICOM |——| lcom Osaka HC |

—| lcom America |

—|B: HAM festa I Tokyo Big Sight |

—| C: Railroad | -| Dayton Hamventio |

-| Friedrichshafen |

1z |

2. Entering a GPS Memory name

[MENU] > GPS > GPS Memory

1. Push [MENUI.
Select “GPS Memory” in the “GPS” menu.

GPS Set
GPS TX Mode

GPS Information
GPS Position

PS Memory
GPS Alarm I
» The previously added GPS Memories are displayed
on the GPS MEMORY screen.
3. Select “(No Group).”

M (No Group)

A ICOM

: HAM festa
: Railroad

: Mt.Fuji

mgonNnw

Push [QUICK].
5. Select “Add.”

B

Delete All In Group

» The GPS MEMORY EDIT screen is displayed.

TIP: To edit the previously saved GPS Memory,
select “Edit” in step 5. You can enter the content in
the same way as described above.
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1.
2.

3.

Select “NAME.”

Enter a GPS Memory name of up to 16
characters. (Example: HOME)

7YY T ——

HOME_

EIRCHAR TYPE ABC

® See page iii on how to enter characters.
After entering, push [ENT].

»
2021/11/01 (Mon)
TIME:

13:00:16" |
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GPS Memory

< Adding a GPS Memory (Continued)
3. Entering the GPS Memory date

5.

Entering the GPS Memory latitude

Select “DATE.”

Push D-pad($5) to move the cursor.
Rotate [DIAL] to enter the date.

® Set between 2000/01/02 and 2099/12/30.
Repeat steps 2 and 3 to enter the date.

EXP%]/11/01 (Mon)

After entering, push [ENT].

HOIVIE’

DATE ,
2021/11/01 (Mon)

TIME: ,

0:15:46 |

4. Entering the GPS Memory time
1. Select “TIME.”
2. Push D-pad($s) to move the cursor.
3. Rotate [DIAL] to enter the date.
® Set between 00:00:00 and 23:59:59.
4. Repeat steps 2 and 3 to enter the time.
Eo0:16
5.

After entering, push [ENT].

»
2021/11/01 (Mon)

TIME: )
13:00:16
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1.

Select “LATITUDE.”

2. Push D-pad($5) to move the cursor.
3. Rotate [DIAL] to enter the latitude.
@ Information
» Set between 0°00.00" and 90°00.00".
* You can change the unit.
(IMENU] > SET > Display > Display Unit >
Latitude/Longitude)
» To enter a north latitude, select “N,” and to enter a
south latitude, select “S.”
4. Repeat steps 2 and 3 to enter the latitude.
B 37.23'N
5. After entering, push [ENT].
LATITUDE: \
34'37.23'N
LONGITUDE: ,
0’ 00.00'W
6. Entering the GPS Memory longitude
1. Select “LONGITUDE.”
2. Push D-pad($5) to move the cursor.
3. Rotate [DIAL] to enter the longitude.

® Information

» Set between 0°00.00' and 180°00.00".

* You can change the unit.
(IMENU] > SET > Display > Display Unit >
Latitude/Longitude)

» To enter an east longitude, select “E,” and to enter a
west longitude, select “W.”

Repeat steps 2 and 3 to enter the longitude.

[EE 34.17E

After entering, push [ENT].

LATITUDE: ,
34'37.23'N

LONGITUDE: ,
135 34.17'W
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GPS Memory

< Adding a GPS Memory (Continued)

7. Entering the GPS Memory altitude 9. Writing the GPS Memory
1. Select “ALTITUDE.” 1. Select “<<Add Write>>."
2. Rotate [DIAL] to select plus or minus.
3. Push D-pad($) to move the cursor. GROUP: ,
4. Rotate [DIAL] to enter the altitude. (No Group)
® Set between —32808 and +32808 feet.
5. Repeat steps 3 and 4 to enter the altitude.
ALTITUDE | i
» The confirmation dialog is displayed.
@ If you edit a previously added GPS Memory, select
+0006[Fft “<<Qverwrite>>.”
2. Select “YES.”
GRAILID-
6. After entering, push [ENT]. A\ Add write?
(GPS MEMORY EDIT
LATITUDE: , NO
34'37.23'N
LONGITUDE: ,
135 34.17'E A 4
ALTITUDE: \
66ft n
8. Selecting a GPS Memory group
1. Select “GROUP.”
GROUP: . « The data is added to the GPS memory, and then the
RCIETEHS) selected GPS Memory group screen is displayed.
<<Add Write>> ® To exit the MENU screen, push [MENU].
TIP:
To view the entered content:
2. Select the group between (No Group) and A ~ Z. Select the GPS Memory channel. Rotate [DIAL] to
check the whole content.
NAME:
A |c0|v|f HOME
B : HAM festa DATE:
¢ : Railroad 2021/11/01 (Mon)
D Mt.Fuji TIME:
E: 13:00:16J

® You can save up to 300 Memories in each group.
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To cancel the entered data:

While entering or editing the GPS Memory, push [CLR]
to display the confirmation dialog, as shown below.
Select “YES” to cancel entering, and the display
returns to the GPS Memory group screen.

Cancel edit?

NO

LILLLAL =

12:00:00"
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GPS Memory

< Entering the GPS Memory group name

You can enter a name for each GPS Memory group.
[MENU] > GPS > GPS Memory

1. Push [MENU].
2. Select “GPS Memory” in the “GPS” menu.

GPS Set

GPS TX Mode
GPS Information
GPS Position

GPS Alarm

v RARAR AR S

hd

3. Select the group that the name to be entered.

(No Group)
A:ICOM

B : HAM festa
C : Railroad

D : Mt.Fuji

® DO NOT push [ENT].
4. Push [QUICK].
5. Select “Edit Name.”

Edit Narﬁe

Delete All In Group

6. Enter a group name of up to 16 characters.

GROUPNAME |

HOME AREA

@IRCHAR TYPE ABC

® See page iii on how to enter characters.
7. After entering, push [ENT].

(No Group)
A:ICOM
B : HAM festa

C : Railroad

D : Mt.Fuji
M E : HOME AREA

® To exit the MENU screen, push [MENU].
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< Deleting the GPS Memory

You can delete the GPS Memories.
There are 2 ways to delete the Memories:
* Deletes all GPS Memory in a group.

* Deletes a specific GPS Memory.

NOTE: Deleted GPS Memories cannot be restored.

[MENU] > GPS > GPS Memory

Example: Deleting all in Group E.

1. Push [MENUI.

2. Select “GPS Memory” in the “GPS” menu.

3. Select the group where the GPS Memory to delete
is saved.

(No Group)
A:ICOM
B : HAM festa
C : Railroad
D : Mt.Fuji
[m e : HOME AREA ]
® DO NOT push [ENT].
4. Push [QUICK].
5. Select “Delete All In Group.”
Eit a

Delete All In Group

A
— group?

NO

. vit.rujr L4

[m E : HOME AREA |

» All GPS Memory in the selected group are deleted,
then returns to the GPS MEMORY screen.

@ To exit the MENU screen, push [MENU].

TIP: Deleting a specific GPS Memory

1. Select the GPS Memory to delete, then push
[QUICK].

2. Select “Delete.”

NP A

Add
Edit
Move

Delete All In Group

» The confirmation dialog is displayed.

3. Select “YES.”
» The selected GPS Memory is deleted.
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GPS Memory

< Rearranging the display order of the GPS data

You can move the entered GPS Memories to
rearrange their display order in the selected GPS

Memory group.

® To move the GPS Memory out of their assigned Memory
group, select the Memory group in the GPS MEMORY
EDIT screen, and then save.

[MENU] > GPS > GPS Memory

1. Push [MENU]. 6. Select the position to insert the Memory you want
2. Select “GPS Memory” in the “GPS” menu. to move.

GPS Set Tokyo Station

»
GPS TX Mode 4 Shinagawa Statio
GPS Information » Shin Osaka Stati
GPS Position » Hakata Station
GPS Alarm d
3. Select the group where the GPS Memory you v

want to move is saved.

Shinagawa Statio 4
Shin Osaka Stati »
»

(No Group) »

A ICOM » Hakata Station

B : HAM festa » Tokyo Station »
M C : Railroad »

D : Mt.Fuji

E : HOME AREA

v | v

* The selected Memory is inserted above the
destination Memory name.

@ If you select “<<Move End>>,” the Memory is moved
to the bottom of the group.

@ To exit the MENU screen, push [MENU].

4. Select the GPS Memory to move, and then push
[QUICK].

-

Shinagawa Statio
Shin Osaka Stati
Hakata Station

v v | v

5. Select “Move.”

Delete All In Group

Shinagawa Statio
Shin Osaka Stati

Hakata Station
<<Move End>>

« “DESTINATION?” blinks at the top left of the screen.
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GPS Alarm

The transceiver can sound a GPS Alarm when a target station or position comes into the alarm area.
This function can be set to a caller station, all GPS Memories, a selected GPS Memory group, or a selected GPS
Memory.

Alarm Area (Group) (Setting plural stations)
When “All Memories” or a GPS Memory group is selected:

i : ‘ N
Point A | 025" b 025 |
ﬁ —
| .
\ &
‘ o
Your location ——————#&-——-—- 21—\
8
o
Point Bﬁ Y
Point C
Sounds 3 beeps.
Alarm Area (RX/Memory) (Setting specific station)
When a specific GPS Memory is selected:
Extended range N

approximately:1.km, 1094.Y
Limited range

approximately 500'm, 547'Y'

Your location / E)
S

-
Target m

station T

Sounds a beep.  Sounds 3 beeps.

6-27



© GPS OPERATION (ADVANCED)

GPS Alarm

< Setting the GPS Alarm function to All Memories (all GPS Memories)

[MENU] > GPS > GPS Alarm

1. Push [MENU].
2. Select “GPS Alarm” in the “GPS” menu.

® Information
* When either one of the group’s stations enters the set

P range, the alarm sounds 3 times.
GPS Set * When the transceiver sounds a GPS Alarm, “GPS
GPS TX Mode ALARM" is displayed on the screen, and “{})|” blinks.
GPS Information See the illustration below.
GPS Position « To cancel the GPS Alarm function, select “OFF” in step
GPS Memory 4 to the left.
Blinks
3. Select “Alarm Select.” }Wmm

1 cacaca

OFF sLo

Alarm Area (Group) » M e
Alarm Area (RX/Mem» 440.000 PSKIP
“GPS ALARM’ is displayed on the screen
4. Select “Group.” and the alarm sounds 3 times.

”

TIP: When selecting “All Memories,” “No Group,” or
a GPS Memory group (A~ Z) in step 5 to the left,
o you also have to set “Alarm Area (Group)” to use the
Memry GPS Alarm function. (p. 6-43)

(IMENU] > GPS > GPS Alarm > Alarm Area (Group))

OFF
RX

-

5. Select “All Memories.”

All Memories

(No Group)
A:ICOM

B : HAM festa
C : Railroad

D : Mt.Fuji

v

Alarm Select .
All Memories

Alarm Area (Group)
Alarm Area (RX/Mem»

* Returns to the GPS ALARM screen.

@ If you want to set the alarm to a specific GPS
Memory group, select “(No Group)” or “A” to “Z.”

® To exit the MENU screen, push [MENU].
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GPS Alarm

< Setting the GPS Alarm function to RX (a caller station)

[MENU] > GPS > GPS Alarm

1. Push [MENU].
2. Select “GPS Alarm” in the “GPS” menu.

GPS Set
GPS TX Mode
GPS Information

GPS Position
GPS Memory

3. Select “Alarm Select.”

Alarm Select .
OFF

Alarm Area (Group) *

Alarm Area (RX/Mem»

4. Select “RX.”

Alarm Select

4
RX

Alarm Area (Group)
Alarm Area (RX/Mem»

* Returns to the GPS ALARM screen.

@ If you want to set the alarm to a specific GPS
Memory group, select “Memory” and then select a
GPS Memory in a GPS Memory group.

® To exit the MENU screen, push [MENU].
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® Information

* When a station with its GPS Alarm set enters within an
approximate 1 kilometer (1094 yards) range, it sounds
once. When it enters within an approximate 500
meters (547 yards) range, the alarm sounds 3 times.

* When the transceiver sounds a GPS Alarm, “GPS
ALARM?” is displayed on the screen, and “P)" blinks.
See the illustration below.

 To cancel the GPS Alarm function, select “OFF” in step
4 to the left.

Blinks
|21]712:00

o
(@RDV ¥
R cqcacq

GPS ALARM]|

SLO

FM

440.000

PSKIP

“GPS ALARM” is displayed on the screen
and the alarm sounds 3 times.

NOTE: Even if “RX” is selected in step 4, when the
received signal has no position data, the GPS Alarm
does not sound.

TIP: When selecting “RX” or a specific GPS Memory
in step 4 to the left, you also have to set the “Alarm
Area (RX/Memory)” to use the GPS Alarm function.
(p. 6-44)

(IMENU] > GPS > GPS Alarm > Alarm Area (RX/Memory))
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NOTE: The default settings shown below are for the USA transceiver version. The default settings may differ,
depending on your transceiver version. To return to your transceiver version’s default settings, push [QUICK] and
select “Default.”

GPS Select (Default: ON) Power Save (Default: Auto)
[MENU] > GPS > GPS Set > GPS Select [MENU] > GPS > GPS Set > GPS Option >
Selects how to capture position data. Power Save
® When “GPS Time Correct” is set to “Auto,” set this item to Selects whether or not to use the Power Save function
“ON” to automatically correct the time by a received GPS for the internal GPS receiver.
sentence. (p. 12-30) When this function is ON, and if the GPS receiver
* OFF: A GPS receiver is not used. does not receive signals from a satellite for 5 minutes,
* ON: Position data of the internal GPS receiver the function turns OFF the GPS receiver for this set
is used for the GPS functions. period of time.
* Manual: Manually enter the current Latitude, « OFF: The GPS receiver is always turned ON.
Longitude, and Altitude in “Manual « 1,2, 4, 8min:
Position.” When the receiver cannot receive signals
SBAS (Default: OFF) from a satellite for 5 minutes, the GPS
receiver is turned OFF for the selected
[MENU] > GPS > GPS Set > GPS Option > SBAS period of time. (1, 2, 4, or 8 minutes).
Turns the SBAS (Satellite Based Augmentation After this period, the receiver resumes
System) function ON or OFF. receiving.
® When turning ON this function, the GPS position accuracy * Auto: When the receiver cannot receive signals
can be improved, but the transceiver’s battery is quickly from a satellite for 5 minutes, the GPS
exhausted. receiver is turned OFF for 1 minute.
* OFF: Turns OFF the function. After this period, the receiver resumes
+ ON: Turns ON the function. receiving. The Power Save interval time
GLONASS (Default: OFF) extends to.2., 4, and.then 8 minutes
when receiving no signals for another 5
[MENU] > GPS > GPS Set > GPS Option > GLONASS minutes, respectively.
Selects whether or not to use the data from Satellite Information Out
the GLONASS (GLObal'naya NAvigatsionnaya (Default: GPS/QZSS/GLONASS)
Sputnikovaya Sistema) satellites.
@® When turning ON this function, the GPS position accuracy [MENU] > GPS > GPS Set > GPS Option >
can be improved, but the transceiver’s battery is quickly Satellite Information Out
exhausted. Selects whether or not to output the data from the
* OFF: Does not use the data from the QZSS (Quasi-Zenith Satellite System) satellites and
GLONASS satellites. the GLONASS satellites.
* ON: Uses the data from the GLONASS « GPS/QZSS/GLONASS:
satellites. Outputs the data from the GPS satellites,
the QZSS satellites, and the GLONASS
satellites.
* GPS Only: Outputs the data from only the GPS
satellites.

Manual Position
(Default: LATITUDE: 0°00.00'N,
LONGITUDE:0°00.00'W, ALTITUDE: ------ ft)

[MENU] > GPS > GPS Set > Manual Position

Manually enter the latitude, longitude, and altitude of

your current position.

® You can capture position data from the GPS receiver if
“Capture From GPS” is selected.
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GPS Out (USB Port) (Default: OFF)

Symbol (Default: Person)

[MENU] > GPS > GPS Set > GPS Out (USB Port)

Selects whether or not to output the position
information to the USB port.

* OFF: Does not send the position information to
the USB port.

* ON: Send the position information to the USB
port.

GPS TX Mode (Default: OFF)

[MENU] > GPS > GPS TX Mode

Selects a GPS transmission mode to send GPS
position data while in the DV mode.

* OFF: Does not transmit GPS data.

* D-PRS: Transmits GPS data in the D-PRS format.
« NMEA: Transmits GPS data in the NMEA format.

Unproto Address (Default: AP152,DSTAR*)

[MENU] > GPS > GPS TX Mode > D-PRS >
Unproto Address

Displays an unproto address of up to 56 alphanumeric
characters.

NOTE: You should use the default address, and
editing is not recommended.
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[MENU] > GPS > GPS TX Mode > D-PRS >
TX Format > Position > Symbol

Selects the symbol that indicates your operating
situation. The selected symbol channel’s symbols (1 ~
4) are transmitted with position data.

<Editing a symbol with a 2 character symbol code>
1. Select a symbol channel.

® DO NOT push [ENT].

Push [QUICK].

Select “Edit Symbol.”

Push [QUICK].

Select “Direct Input.”

Rotate [DIAL] to edit the first digit.

Push D-pad(—) to select the second digit.

Rotate [DIAL] to edit the second digit.

N>R ®N

Selectable characters and symbols
<For the first digit>/,\,0t0 9,Ato Z
<For the second digit>Ato Z,atoz, 0t0 9, ! “ #
$%& () +,-./;<=>2@[\]1"_"{l}~

9. After editing, push [ENT].
» Sets the symbol into the symbol channel selected in
step 1.

<Selecting a preset symbol>
1. Select a symbol channel.
® DO NOT push [ENT].
2. Push [QUICK].
3. Select “Edit Symbol.”
4. Select a symbol.
» Sets the symbol into the symbol channel selected in
step 1.
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SSID (Default: ---)

Comment

[MENU] > GPS > GPS TX Mode > D-PRS >
TX Format > Position > SSID

Selects an SSID based on APRS® to add to your call
sign, to show your operating style to other stations.
® The SSID’s additional methods differ, depending on
whether the call sign includes a space or not.
The space in call sign is converted to “-.”
@ If no text is entered after space, space will
be deleted, and space is not converted to
Example: JA3YUA — JA3YUA
JA3YUA A — JA3YUA-A
No SSID is added.
@ If a call sign includes a space, any text or
digit after space will be deleted.
Example: JA3YUA — JA3YUA
JA3YUA A — JA3YUA

(-0):

* -1~-15:  Adds an SSID of -1 to -15 to your call sign.
® Example: SSID is “-9.”
JA3YUA — JA3YUA-9
JA3YUA A — JA3YUA-9
* -A~-Z:  Adds an SSID of -A to -Z to your call sign.

® Example: SSID is “-Z.”
JA3YUA — JA3YUA-Z
JA3YUA A — JA3YUA-Z

TIP: About the SSID

According to a common guideline, to help identify a
station’s type, designated call sign SSIDs are used
in D-PRS (or APRS®).

The guideline may be changed when the
infrastructure environment, such as a product or
network, is changed. Check the latest guideline

in the web site related to D-PRS and APRS® and
correctly set.

http://aprs.org/aprs11/SSIDs. txt
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[MENU] > GPS > GPS TX Mode > D-PRS >
TX Format > Position > Comment

Enter a comment to transmit it with the D-PRS
position data.

You can enter up to four comments.

The number of characters you can enter differs,
depending on the Data Extension and Altitude settings.

Characters
Data Extension Altitude entered

(maximum)

OFF OFF | 43 (Default)
OFF ON 35
Course/Speed OFF 36
Course/Speed ON 28
Power/Height/Gain/Directivity OFF 36
Power/Height/Gain/Directivity ON 28

The symbol “]” displays the transmittable comment
range. Note that the characters that exceed the range
will not be transmitted.

ID-52. J

|EECHAR TYPE  ABC|

Transmittable comment range display
(Example: up to 28 characters)

Time Stamp (Default: OFF)

[MENU] > GPS > GPS TX Mode > D-PRS >
TX Format > Position > Time Stamp

Selects the transmitting time stamp type.

The time stamp is transmitted with the position

data in the D-PRS mode, and UTC (Universal Time

Coordinated) time is used.

® When your position is manually set, time stamp data is
not transmitted.

* OFF: Does not transmit the time information.

* DHM: Transmits the time stamp in the Day,
Hour, and Minute format.

« HMS: Transmits the time stamp in the Hour,

Minute, and Second format.
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Altitude (Default: OFF)

[MENU] > GPS > GPS TX Mode > D-PRS >
TX Format > Position > Altitude

Selects whether or not to transmit altitude data with

the position data in the D-PRS mode.

® The number of characters you can enter in “Comment”
differs, depending on the “Altitude” and “Data Extension”

settings.
» OFF: No altitude data is transmitted.
* ON: Transmits altitude data with position data.

Data Extension (Default: OFF)

[MENU] > GPS > GPS TX Mode > D-PRS >
TX Format > Position > Data Extension

Selects whether or not to transmit the Course/Speed
data or the Power/Hight/Gain/Directivity data with the
position data in the D-PRS mode.
® The number of characters you can enter in “Comment”
differs, depending on the “Altitude” and “Data Extension”
settings.
» OFF: Does not transmit any information.
» Course/Speed:
Transmits the course and speed data
with the position data.
® The course and speed data are not transmitted
when your location is manually set.
® When transmitting with this setting, your
station is regarded as a mobile station.
» Power/Height/Gain/Directivity:
Transmits the TX power level, height,
antenna gain, antenna direction, and
position data.
® The Power, Height, Gain, and Directivity
data are transmitted even if your location is
manually set.
® When transmitting with this setting, your
station is regarded as a base station.

(Default: OW)

[MENU] > GPS > GPS TX Mode > D-PRS >
TX Format > Position > Power

Power

Selects the TX power level of the base station to

transmit along with the position data.

@ This item is displayed when “Data Extension” is set to
“Power/Height/Gain/Directivity.”

» Select 0, 1, 4, 9, 16, 25, 36, 49, 64, or 81 W.
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Height (Default: 10ft)

[MENU] > GPS > GPS TX Mode > D-PRS >
TX Format > Position > Height

Selects the height of the base station’s antenna to

transmit along with the position data.

® This item is displayed when “Data Extension” is set to
“Power/Height/Gain/Directivity.”

 Select 10, 20, 40, 80, 160, 320, 640, 1280, 2560, or
5120 feet.”
* If the Altitude/Distance unit is set to “m,” select 3, 6, 12,

24, 49, 98, 195, 390, 780, or 1561 meters.

(Default: 0dB)

[MENU] > GPS > GPS TX Mode > D-PRS >
TX Format > Position > Gain

Gain

Selects the gain of the base station’s antenna to

transmit along with the position data.

@ This item is displayed when “Data Extension” is set to
“Power/Height/Gain/Directivity.”

+ Select between 0 and 9 dB.
Directivity (Default: Omni)

[MENU] > GPS > GPS TX Mode > D-PRS >
TX Format > Position > Directivity

Selects the direction the base station’s antenna was

pointing to transmit along with the position data.

@ This item is displayed when “Data Extension” is set to
“Power/Height/Gain/Directivity.”

+ Select Omni, 45° NE, 90° E, 135° SE, 180°S, 225°
SW, 270° W, 315° NW, or 360° N.

Object Name

[MENU] > GPS > GPS TX Mode > D-PRS >
TX Format > Object > Object Name

Sets an Object’s name of up to 9 characters.

Data Type (Default: Live Item)

[MENU] > GPS > GPS TX Mode > D-PRS >
TX Format > Object > Data Type

Selects the Object’s status.
* Live ltem: The Item station is valid.
 Killed Item: The ltem station is invalid.

Symbol (Default: Transceiver)

[MENU] > GPS > GPS TX Mode > D-PRS >
TX Format > Object > Symbol

The symbol is an icon that indicates the Object’s
means of transportation or location. The saved symbol
is transmitted along with the position data while in the
D-PRS mode.

® See page 6-31 for details of editing a symbol.
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Comment

[MENU] > GPS > GPS TX Mode > D-PRS >
TX Format > Object > Comment

Enters a comment to transmit it with the D-PRS
position data.

You can enter up to four comments.

The number of characters you can enter differs,
depending on the Data Extension and Altitude settings.

Characters
Data Extension Altitude entered

(maximum)

OFF — 43 (Default)
OFF Entered 35
Course/Speed — 36
Course/Speed Entered 28
Power/Height/Gain/Directivity — 36
Power/Height/Gain/Directivity Entered 28

The symbol “]” displays the transmittable comment
range. Please note that the characters that exceed the
range will not be transmitted.

\Comment |

ID-52. J

E@IRCHAR TYPE ABC

Transmittable comment range display
(Example: up to 28 characters)
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Position
(Default: LATITUDE: 0°00.00'N,
LONGITUDE:0°00.00'W, ALTITUDE:

[MENU] > GPS > GPS TX Mode > D-PRS >
TX Format > Object > Position

Displays the position information of the Object.
Push [QUICK] to open the Quick Menu window shown
below.

Capture From GPS

TIP: When you select “Capture From GPS” or “Set
From GPS Memory,” you can capture the position
from the GPS or set the ltem’s position from the
GPS memory.

Entering the position information manually
1. Select “Edit” on the Quick Menu window.
* The POSITION EDIT screen is displayed.
Select “LATITUDE.”
Enter a latitude.
® Select “N/S” to switch the north latitude and the
southern latitude.
4. Select [ENT].
5. Select “LONGITUDE.”
6. Enter a longitude.
® Select “E/W” to switch the east longitude and the
west longitude.
7. Select [ENT].
8. Select “ALTITUDE.”
9. Enter an altitude.
@ After entering, select [+/-] to switch “+” and “-.”
10. Select [ENT].
11. Select “<<Write>>.”
12. Select “YES.”
» The position information is entered.

2.
3.



© GPS OPERATION (ADVANCED)

GPS items

Data Extension (Default: OFF)

Gain (Default: 0dB)

[MENU] > GPS > GPS TX Mode > D-PRS >
TX Format > Object > Data Extension

Selects whether or not to transmit the Course/Speed
data or the Power/Hight/Gain/Directivity data with the
position data in the D-PRS mode.
® The number of characters you can enter in “Comment”
differs, depending on the “Altitude” and “Data Extension”
settings.
» OFF: Does not transmit any information.
» Course/Speed:
Transmits the course and speed data
with the position data.
» Power/Height/Gain/Directivity:
Transmits the TX power level, height,
antenna gain, antenna direction, and

position data.
Course (Default: 0°)

[MENU] > GPS > GPS TX Mode > D-PRS >
TX Format > Object > Course

Sets the Object’s course to between 0° and 360°
@ This item is displayed when “Data Extension” is set to
“Course/Speed.”

Speed (Default: Omph)

[MENU] > GPS > GPS TX Mode > D-PRS >
TX Format > Object > Speed

Sets the Object’s speed to between 0 and 1150 mph.*
* If the Speed unit is set to “km/h,” set to between 0 to
1850 km/h, or set to “knots,” set to between 0 and

999 knots.
@ This item is displayed when “Data Extension” is set to
“Course/Speed.”

Power (Default: OW)

[MENU] > GPS > GPS TX Mode > D-PRS >
TX Format > Object > Power

Selects the TX power level of Object to transmit along
with the position data.
® This item is displayed when “Data Extension” is set to
“Power/Height/Gain/Directivity.”
» Select 0, 1, 4, 9, 16, 25, 36, 49, 64, or 81 W.

Height (Default: 10ft)

[MENU] > GPS > GPS TX Mode > D-PRS >
TX Format > Object > Height

Selects the height of the Object’s antenna to transmit

along with the position data.

® This item is displayed when “Data Extension” is set to
“Power/Height/Gain/Directivity.”

 Select 10, 20, 40, 80, 160, 320, 640, 1280, 2560, or
5120 feet.”
* If the Altitude/Distance unit is set to “m,” select 3, 6, 12,

24, 49, 98, 195, 390, 780, or 1561 meters.
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[MENU] > GPS > GPS TX Mode > D-PRS >
TX Format > Object > Gain

Selects the gain of the Object’s antenna to transmit

along with the position data.

® This item is displayed when “Data Extension” is set to
“Power/Height/Gain/Directivity.”

+ Select between 0 and 9 dB.

Directivity (Default: Omni)

[MENU] > GPS > GPS TX Mode > D-PRS >
TX Format > Object > Directivity

Selects the direction the Object’s antenna was

pointing to transmit along with the position data.

@ This item is displayed when “Data Extension” is set to
“Power/Height/Gain/Directivity.”

» Select Omni, 45° NE, 90° E, 135° SE, 180°S, 225°
SW, 270° W, 315° NW, or 360° N.

SSID (Default: ---)

[MENU] > GPS > GPS TX Mode > D-PRS >
TX Format > Object > SSID

Selects an SSID based on APRS® to add to your call

sign, to show your operating style to other stations.

® The SSID’s additional methods differ, depending on
whether the call sign includes a space or not.

® See page 6-32 for details of the SSID.

The space in call sign is converted to “-.”

* (-0): No SSID is added.

e -1~-15; Adds an SSID of -1 to -15 to your call
sign.

s -A~-Z: Adds an SSID of -A to -Z to your call
sign.

Time Stamp (Default: OFF)

[MENU] > GPS > GPS TX Mode > D-PRS >
TX Format > Object > Time Stamp

Selects the transmitting time stamp type.

The time stamp is transmitted with the position

data in the D-PRS mode, and UTC (Universal Time

Coordinated) time is used.

® When your position is manually set, time stamp data is
not transmitted.

* DHM: Transmits the time stamp in the Day,
Hour, and Minute format.
* HMS: Transmits the time stamp in the Hour,

Minute, and Second format.
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Item Name Position

(Default: LATITUDE: 0°00.00'N,
%&ngjn; tG>P|tSe ;EFI’E; ;XN'Z';‘LG >D-PRS > LONGITUDE:0°00.00'W, ALTITUDE: —--—ft)

[MENU] > GPS > GPS TX Mode > D-PRS >
TX Format > Item > Position

Sets the Item station’s name of up to 9 characters.

Data Type (Default: Live ltem) Displays the position information of the Item.
[MENU] > GPS > GPS TX Mode > D-PRS > Push [QUICK] to open the Quick Menu window shown
TX Format > Item > Data Type below.

Selects the Item station’s status.

Capture From GPS
Set From GPS Memo
Default

* Live ltem: The Item station is valid.
 Killed Item: The Item station is invalid.

Symbol (Default: Transceiver)

[MENU] > GPS > GPS TX Mode > D-PRS >

IR = (LS = ST o TIP: When you select “Capture From GPS” or “Set From
Selects the symbol that indicates the Item’s means GPS Memory,” you can capture the position from the
of transportation or location. The selected symbol GPS or set the Item’s position from the GPS memory.
channel’'s symbols are transmitted with position data
while in the D-PRS mode. ® See page 6-34 when you want to enter the position
@ See page 6-31 for details of editing a symbol. information manually.
Comment Data Extension (Default: OFF)
[MENU] > GPS > GPS TX Mode > D-PRS > [MENU] > GPS > GPS TX Mode > D-PRS >
TX Format > Item > Comment TX Format > Item > Data Extension
Enters a comment to transmit it with the D-PRS Selects whether or not to transmit the Course/Speed
position data. data or the Power/Hight/Gain/Directivity data with the
The number of characters you can enter differs, position data in the D-PRS mode. _
depending on the Data Extension and Altitude settings. ® The number of characters you can enter in “Comment
differs, depending on the settings.
Characters » OFF: Does not transmit any information.
Data Extension Altitude | entered + Course/Speed:
(maximum) Transmits the course and speed data
OFF — 43 (Default) with the position data.
OFF Entered 35 » Power/Height/Gain/Directivity:
Course/Speed — 36 Transmits the TX power !eve!, height,
antenna gain, antenna direction, and
Course/Speed Entered 28 position data.
Power/Height/Gain/Directivity — 36 Course (Default: 0°)
Power/Height/Gain/Directivity | Entered 28
Ty . [MENU] > GPS > GPS TX Mode > D-PRS >
The symbol “]” displays the transmittable comment TX Format > ltem > Course

range. Please note that the characters that exceed the
Sets the Item’s course to between 0° and 360°

range will not be transmitted. o S L
@ This item is displayed when “Data Extension” is set to

\Comment | “Course/Speed.”
ID-52. J
Speed (Default; 0°)

[MENU] > GPS > GPS TX Mode > D-PRS >
TX Format > ltem > Speed

GIDCHAR TYPE  ABC Sets the Item’s speed to between 0 and 1150 mph.*
Transmittable comment range display * If the Speed unit is set to “km/h,” set to between 0 to
(Example: up to 28 characters) 1850 km/h, or set to “knots,” set to between 0 and

999 knots.
® This item is displayed when “Data Extension” is set to
“Course/Speed.”
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Power (Default: OW)

SSID (Default: ---)

[MENU] > GPS > GPS TX Mode > D-PRS >
TX Format > Item > Power

Selects the TX power level of Item, to transmit along

with the position data.

® This item is displayed when “Data Extension” is set to
“Power/Height/Gain/Directivity.”

» Select 0, 1, 4, 9, 16, 25, 36, 49, 64, or 81 W.

Height (Default: 10ft)

[MENU] > GPS > GPS TX Mode > D-PRS >
TX Format > Item > Height

Selects the height of the ltem’s antenna to transmit

along with the position data.

@ This item is displayed when “Data Extension” is set to
“Power/Height/Gain/Directivity.”

» Select 10, 20, 40, 80, 160, 320, 640, 1280, 2560, or
5120 feet.”
* If the Altitude/Distance unit is set to “m,” select 3, 6, 12,

24,49, 98, 195, 390, 780, or 1561 meters.

Gain (Default: 0dB)

[MENU] > GPS > GPS TX Mode > D-PRS >
TX Format > Item > Gain

Selects the gain of the Item’s antenna to transmit

along with the position data.

@ This item is displayed when “Data Extension” is set to
“Power/Height/Gain/Directivity.”

+ Select between 0 and 9 dB.

Directivity (Default: Omni)

[MENU] > GPS > GPS TX Mode > D-PRS >
TX Format > Item > Directivity

Selects the direction the ltem’s antenna was pointing

to transmit along with the position data.

@ This item is displayed when “Data Extension” is set to
“Power/Height/Gain/Directivity.”

» Select Omni, 45° NE, 90° E, 135° SE, 180°S, 225°
SW, 270° W, 315° NW, or 360° N.
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[MENU] > GPS > GPS TX Mode > D-PRS >
TX Format > Item > SSID

Selects an SSID based on APRS® to add to your call

sign, to show your operating style to other stations.

® The SSID’s additional methods differ, depending on
whether the call sign includes a space or not.

® See page 6-32 for details of the SSID.

The space in call sign is converted to “-.”

* (-0): No SSID is added.

«-1~-15; Adds an SSID of -1 to -15 to your call
sign.

c -A~-Z: Adds an SSID of -A to -Z to your call
sign.
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Symbol (Default: WX Station)

[MENU] > GPS > GPS TX Mode > D-PRS >
TX Format > Weather > Symbol

The symbol is an icon that indicates the weather
station’s means of transportation or location.
The saved symbol is transmitted along with the
position data while in the D-PRS mode.

® See page 6-31 for details of editing a symbol.

SSID (Default: ---)

[MENU] > GPS > GPS TX Mode > D-PRS >
TX Format > Weather > SSID

Selects an SSID based on APRS® to add to your call

sign, to show your operating style to other stations.

® The SSID’s additional methods differ, depending on
whether the call sign includes a space or not.

® See page 6-32 for details of the SSID.

o The space in call sign is converted to “-.”

* (-0): No SSID is added.

e -1~-15; Adds an SSID of -1 to -15 to your call
sign.

s -A~-Z: Adds an SSID of -A to -Z to your call
sign.

Comment

[MENU] > GPS > GPS TX Mode > D-PRS >
TX Format > Weather > Comment

Enter a comment to transmit it with the D-PRS
position data, up to 43 characters.

Time Stamp (Default: OFF)

[MENU] > GPS > GPS TX Mode > D-PRS >
TX Format > Weather > Time Stamp

Selects the transmitting time stamp type.

The time stamp is transmitted with the position

data in the D-PRS mode, and UTC (Universal Time

Coordinated) time is used.

* OFF: Does not transmit the time information.

* DHM: Transmits the time stamp in the Day,
Hour, and Minute format.

*« HMS: Transmits the time stamp in the Hour,
Minute, and Second format.
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GPS Sentence (Default: GGA) GPS Message
[MENU] > GPS > GPS TX Mode > NMEA > [MENU] > GPS > GPS TX Mode > NMEA >
GPS Sentence GPS Message
Selects sentences to be transmitted in the GPS mode Enter a GPS message of up to 20 alphanumeric
to transmit position data. Set to between RMC, GGA, characters. (p. 6-21)

GLL, VTG, GSA, and GSV. NOTE: When you do not want to send a message,
NOTE: Set the GSV sentence to OFF when delete the entered message.

sending the GPS message to conventional digital
transceivers. (p. 6-4) GPS Information
The GSV sentence is incompatible with them.

[MENU] > GPS > GPS Information

® Information Displays the GPS satellite direction, elevation angle,

* Up to 4 GPS sentences can be set at a time. satellite number, and receiving status. (p. 6-11)
» Displays ‘{v]" when the sentence is set to ON.
* “VTG,” “GSA,” and “GSV” sentences are not transmitted

when your position has been manually set.

TIP: Contents of GPS sentence
The Time Stamp is displayed based on the UTC (Universal Time Coordinated) time.
GPS Time
Sentence Lon/Lat Alt Stamp LD Status 2D/3D G ok
(UTC) (True) (knot)
(UTC)
RMC v v v v v v
GGA 4 v v v
GLL v v v
VTG v v
GSA v v
GSV
Sentence Others
RMC Magnetic variation, Mode Indicator
Number of satellites in use, HDOP, Geoidal separation, Age of Differential GPS data,
GGA . . )
Differential reference station ID
GLL Mode Indicator
VTG COG (Magnetic north), SOG (km/h), Mode Indicator
GSA PRN number of satellites used in solution, PDOP, HDOP, VDOP
Gsv Total number of sentences, Sentence number, Total number of satellites in view,
Satellite information (ID, Elevation, Azimuth, S/N)
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GPS Position

[MENU] > GPS > GPS Position

Your current position, received position, GPS Memory,
or GPS Alarm position information is displayed.

(p. 6-6)

Rotating [DIAL] to select the MY, RX, MEM, and ALM
screens.

MY screen (MY Position)

Compass* Displays your direction.
Course Displays your direction heading.
Latitude Displays your latitude.
Longitude Displays your longitude.
Displays the grid locator based on
GL the latitude and longitude of your
location.
ALT Displays your own altitude.
SPEED Displays your speed over the ground.
TIME Displays current time received from

the GPS.

® When “GPS Select” is set to “Manual,” the screen
displays only latitude, longitude, altitude, GL (Grid
locator), and time (internal clock).

RX screen (Received position data of the other station)
Depending on the caller’'s TX mode or TX format, the
displayed items and these meanings are different. The
following lists describe the items for each category.

No data is displayed when no position data is received
on your transceiver.

<1. When the caller’s TX mode is NMEA>
Displays the caller’s direction from

Compass* .

your location.
Latitude Displays the caller’s latitude.
Longitude Displays the caller’s longitude.

Displays the grid locator based on
GL the latitude and longitude of the
caller’s location.

ALT Displays the caller’s altitude.

Displays the caller’s distance from

DST .
your location.

Call sign Displays the caller’s call sign.
COURSE Displays the caller’s direction over
the ground.

SPEED Displays the caller’s speed.

Displays the time that the caller

CIPE TS S acquired the position data.

<2. When the caller’s TX format is D-PRS Position
(Mobile station)>

Displays the caller’s direction from

CCIEED your location.

Symbol Displays the caller’'s D-PRS
symbol.

Latitude Displays the caller’s latitude.

Longitude Displays the caller’s longitude.

Displays the grid locator based on
GL the latitude and longitude of the
caller’s location.

ALT Displays the caller’s altitude.

Displays the caller’s distance from

DST .
your location.

Displays the caller’s call sign

CEllEE (with SSID).

COURSE Displays the caller’s direction over
the ground.

SPEED Displays the caller’s speed.

Displays the time that the caller

SRS acquired the position data.

* You can change the display type in the Quick Menu
window.
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GPS items

GPS Position (continued)

<3. When the caller’s TX format is D-PRS Position

<4. When the caller’s TX format is D-PRS Object/

(Base station)> Item>
,, Displays the caller’s direction from * Displays the Object/Item’s direction
Compass . Compass -
your location. from your location.
Symbol Displays the caller’'s D-PRS Symbol Displays the Object/ltem’s D-PRS
symbol. symbol.
Latitude Displays the caller’s latitude. Latitude Displays the Object/Item’s latitude.
Longitude Displays the caller’s longitude. Longitude Displays the Object/ltem’s longitude.
Displays the grid locator based on Displays the grid locator based on
GL the latitude and longitude of the GL the latitude and longitude of the
caller’s location. Object/Item’s location.
ALT Displays the caller’s altitude. ALT Displays the Object/Item’s altitude.
Displays the caller’s distance from Displays the Object/Item’s distance
DST . DST -
your location. from your location.
. Displays the caller’s call sign Object/ltem name Displays the Object/ltem’s name.
Call sign ith SSID
(wi )- Sl el Displays the caller’s call sign
POWER Displays the caller’s TX power level. 9 (with SSID).
HEIGHT Displays the caller’s antenna height. Displays the Object/ltem’s direction
COURSE th d
GAIN Displays the caller’s antenna gain. over the ground.
Displays the direction of the caller’s SPEED Displays the Object/ltem’s speed.
DIRECT " : - ,
antenna was pointing. POWER Displays the Object/ltem’s TX power
; ; level.
' Displays the time that the caller
IR S S acquired the position data. HEIGHT Displays the Object/ltem’s antenna
height.
GAIN Displays the Object/ltem’s antenna
gain.
DIRECT Displays the direction that the

Object/ltem’s antenna was pointing.

GPS Time Stamp

Displays the time that the caller
sent the Object’s data.

® When the Object or Item is disabled, “KILLED” is

displayed.

* You can change the display type in the Quick Menu

window.
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GPS items

GPS Position (continued)

<5. When the caller’s TX format is D-PRS Weather>

MEM screen (GPS memory position)

Displays the caller’s direction from

Displays GPS Memory channel’s

CCLIEED your location. Celmpees direction from your location.
Symbol Displays the caller’'s D-PRS Latitude D|§plays GPS Memory channel’s
symbol. latitude.
Latitude Displays the caller’s latitude. . Displays GPS Memory channel’s
Longitude lonaitud
Longitude Displays the caller’s longitude. ongitude.
Displays the grid locator based on Displays the grid locator based on
GL the latitude and longitude of the GL the latitude and longitude of the
caller’s location. GPS Memory channel.
DST Displays the caller’s distance from DST Displays GPS Memory channel’s
your location. distance from your location.
Cal sian Displays the caller's call sign GPS memory name Displays the caller’s call sign (with
9 (with SSID). SSID).
Displays the temperature of the @® You can change the GPS Memory in the Quick Menu
Temperature L .
caller station’s area. window.
Humidit Displays the humidity of the caller -
umidity station’s area. ALM screen (GPS alarm position)
RAIN Displays the rainfall of the caller Compass* Displays GPS Alarm area’s
station’s area. direction from your location.
Displays the wind direction of the Latitude Displays GPS Alarm area’s latitude.
WIND DIR - - ,
caller station’s area. Longitude Displays GPS Alarm area’s
WIND SPD Displays the wind speed of the longitude.
caller station’s area. Displays the grid locator based on
BARO Displays the barometric pressure of GL the latitude and longitude of the
the caller station’s area. GPS Alarm area.
GPS Time Stam Displays the time that the caller DST Displays the GPS Alarm area’s
p acquired the position data. distance from your location.
Displays “RX,” GPS memory
GPS Alarm group name, or GPS memory

name specified for the GPS Alarm
function.

@ You can change the GPS Alarm in the Quick Menu

window.

* You can change the display type in the Quick Menu

window.
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GPS items

GPS Memory

Alarm Select

(Default: OFF)

[MENU] > GPS > GPS Memory

The transceiver has 300 GPS memories to save the
received position data, or often-used position data,
with an alphanumeric memory name.

The channels can be divided into the “(No Group)”
group and each Memory group (A to Z) for easy
Memory management.

The display of the GPS MEMORY screen

(No Group)

GPS Memories not assigned to any
group

A~ Z: Group Name

GPS Memories assigned to the
selected group.

GPS Memory Groups (A~ Z)

GROUP NAME

GPS Memory Group name
(Up to 16 alphanumeric characters)

® You can edit the GPS Memory Group name. (p. 6-25)

GPS Memories

NAME

GPS memory name
(Up to 16 alphanumeric characters)

DATE Saved date

TIME Saved time

LATITUDE Saved position (latitude)
LONGITUDE Saved position (longitude)
ALTITUDE Saved altitude

GROUP The group letter and the name of

the group

® When you save the received position data on the GPS
POSITION screen, the received station’s call sign is used
as the GPS Memory name.

@ In the Quick Menu window, you can edit the GPS Memory

contents, such as the GPS Memory name.
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[MENU] > GPS > GPS Alarm > Alarm Select
Selects the target positions for the GPS Alarm

function.

+ OFF: Turns OFF the function.

*« RX: The GPS Alarm sounds when a target
(the last received position) enters
your active alarm range.

» Group: The GPS Alarm sounds when a target
(positions in the GPS Memory, or the
selected GPS Memory Group) enters
your active alarm range.

* Memory: The GPS Alarm sounds when a target

(the entered position in the GPS
Memory) enters your active alarm
range.

Alarm Area (Group) (Default: 0.25")

[MENU] > GPS > GPS Alarm > Alarm Area (Group)

Sets the GPS active alarm range.

When a target enters this set active alarm range, the

GPS Alarm sounds, and the GPS Alarm icon blinks.

® When “Alarm Select” is set to “Group,” this setting is
enabled.

Ranges differ, depending on the Latitude/
Longitude unit setting.

« Latitude/Longitude = ddd°mm.mm’
Ranges: 00.08' to 59.99' (0.01' steps)
+ Latitude/Longitude = ddd°mm'mm"”
Ranges: 00'05" to 59'59" (0'01" steps)
+ Latitude/Longitude = ddd.dddd”®
Ranges: 0.0014° to 0.9999° (0.0001° steps)
® Pushing D-pad($5) moves the cursor to the tenths and
hundredths place digits, or the thousandths and ten
thousandths place digits.

Example:
When a target enters the active alarm range, the GPS
Alarm sounds, and the GPS alarm icon blinks.

Point A i

i3

Your location

Point Bﬁ

Point C
Sounds 3 beeps.



© GPS OPERATION (ADVANCED)

GPS items

Alarm Area (RX/Memory) (Default: Both) GPS Logger (Default: ON)

[MENU] > GPS > GPS Alarm >
Alarm Area (RX/Memory)

Selects the GPS active alarm range.
When a target enters the active alarm range, the GPS
Alarm sounds, and the GPS alarm icon blinks.
® When “Alarm Select” is set to “RX” or “Memory,” this
setting is enabled. (p. 6-43)
 Limited: The transceiver sounds 3 beeps, and
the GPS Alarm icon blinks when the
target enters the 500 meters range.
The transceiver sounds 3 beeps, and
the GPS Alarm icon blinks when the
target enters the 1-kilometer range.
The transceiver sounds a beep, and
the GPS Alarm icon blinks when the
target enters the 1-kilometer range
and sounds 3 beeps, and the icon
blinks when it enters the 500 meters
range. When the target exits the
500 meters range but is still in the
1-kilometer range, the icon continues
to blink, but no beeps sound.

» Extended:

* Both:

Example:

When a target station enters the active alarm range
(500 meters or 1 kilometer range, depending on the
setting), the GPS Alarm sounds, and the GPS Alarm

Extended range
approximately:1,km, 1094.Y

Limited range
approximately 500'm, 547 Y:

Your location ﬂ)
S

Target

icon blinks.
i fLNk

station T

Sounds a beep.  Sounds 3 beeps.
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[MENU] > GPS > GPS Logger

Turns the GPS Logger function ON or OFF.
This function logs the position, altitude, course, speed,
and number of satellites being used.

* OFF: Turns OFF the function.

* ON: The transceiver automatically logs GPS data.
Once this function is turned ON, the GPS
data will be continuously logged until turning
it OFF, even if the transceiver power is turned
OFF, then ON again.

® This function requires a microSD card (User supplied).

® When “GPS select” is set to “OFF” or “Manual,” this

function does not save the log.

TIP: The log data is saved on the microSD card. The
file name is automatically created, as shown below:
* Log start date and time: 1st November 2021 15:30:00

* Filename: 20211101_153000.csv

Record Interval (Default: 10sec)

[MENU] > GPS > GPS Logger > Record Interval

Sets the GPS Logger function record interval to 1, 5,
10, 30 seconds, or 1, 5, or 10 minutes.

Record Sentence
(Default: [v] RMC/ [v] GGA/ [v]VTG/ [v] GSA)

[MENU] > GPS > GPS Logger > Record Sentence

Sets the GPS Logger function record sentence to
RMC, GGA, VTG, or GSA.
- Displays ‘[v]" when the sentence is set.

NOTE: Select at least one sentence, otherwise an
error beep will sound.

<<GPS Logger Only>>

[MENU] > GPS > GPS Logger >
<<GPS Logger Only>>

You can turn ON the GPS Logger Only mode.
Only the GPS Logger is functioning in this mode, and
the transceiver does not transmit or receive it.

® Information

* BE SURE to insert a microSD card.

» Set “GPS Select” to “ON.” (p. 6-30)

» To cancel the mode, restart the transceiver.
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GPS items

GPS Auto TX (Default: OFF)

[MENU] > GPS > GPS Auto TX

Selects an option for the GPS automatic transmission
function.

This function automatically transmits the current
position data received from a GPS receiver and any
entered GPS message at the set interval.

* OFF: Does not automatically transmit the position
data. (When you push [PTT], the transceiver
transmits the position data.)

+ 30 sec to 30 min:

Transmits the current position data at the
selected interval (30 seconds, or 1, 3, 5, 10,
or 30 minutes).
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7 VOICE TX FUNCTION

Voice TX function

The Voice TX function transmits the recorded audio
that is on the microSD card, one time or repeatedly,
for up to 10 minutes at the set interval.

This function is convenient to repeatedly call CQ, or
for other events.

You can assign the [Voice TX] key function to an
optional microphone key or optional Bluetooth
headset. (pp. 12-18, 12-34)

NOTE: BE SURE to insert a microSD card into the
transceiver.
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¢ Recording the voice audio

[MENU] > VOICE > Record

1. Push [MENU].
2. Select “VOICE.”
3. Select “Record.”

<<Single TX>>
<<Repeat TX>>

v
[VOICE TX RECORD _ |

REC Level:

GDREC EDPLAY

4. Hold down [PTT] to record.

VOICE TX RECORD _ |
Displayed —»®
while 0:09/ 1:00
recording REC Level — Recording time
NI — Audio level
GDREC

@® Information

* Hold the microphone 5 ~ 10 cm (2 ~ 4 inches) from
your mouth, then speak at your normal voice level.

* The maximum record time is 1 minute.

* Only 1 voice memory can be recorded.

TIP: On the VOICE TX RECORD screen,
push [QUICK], then select “Clear” to clear the
recorded audio.

5. Push [ENT] to confirm the recorded voice.

* The voice is played back.

Displayed — p _
while playing 0:04/0:10 <—— Total time
REC Level: — Play back time
EnsToP

@ If you hold down [PTT], the recording starts again.
In this case, the previous recorded audio will be
overwritten.

® To exit the MENU screen, push [MENU].
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Voice TX function

< Transmitting the recorded voice audio
NOTE: BE SURE to insert a microSD card into the

transceiver.

[MENU] > VOICE > <<Single TX>>

[MENU] > VOICE > <<Repeat TX>>

1. Push [MENU].
2. Select “VOICE.”

3. Select “<<Single TX>>" or “<<Repeat TX>>."
» <<Single TX>>:
The recorded voice audio is transmitted only once.

»
14

<<Single TX>>

<<Repeat TX>>

* <<Repeat TX>>:
The recorded voice audio is repeatedly transmitted.

<<Single TX>>

<<Repeat TX>>

»
4

v

[MAINIZY]

146.010

VFO

PSKIP

FM

440000 PSKIP
v
‘%BFM — 12:03

146.010

FM

440.000

PSKIP

Blinks

Transmission is
paused
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@ Information

» While transmitting, the SD card icon blinks.

* When you select “<<Repeat TX>>,” the transceiver
repeatedly transmits the recorded voice audio for up to 10
minutes at the interval set in “Repeat Time.”

([IMENU] > VOICE > TX Set > Repeat Time)

1sec
2sec
3sec

4sec

5sec

6sec

» Any of the following action cancels the transmission.
- Pushing [PTT]
- Turning OFF the transceiver, then turning it ON again.
- Pushing any key (except for [VOL] and [()])

+ After the second transmission, the transmission continues
pausing, if receiving a signal, even if “Busy Lockout” is set
to “ON.”

(IMENU] > SET > Function > Busy Lockout)
However, if the squelch is manually opened in the
FM mode, the voice audio is repeatedly transmitted,
according to the “Repeat Time” setting.

* You can select whether or not to output the TX voice
audio from the speaker.

(IMENU] > VOICE > TX Set > TX Monitor)

OFF

TIP: To transmit the recorded voice audio in the
Quick Menu window, push [QUICK], then select
“Voice TX.”

Voicex |

GPS Information

GPS Position

Weather Alert W[

Home CH Set 4

Voltage P
VFQO
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VOICE items

Record

<<Single TX>>

[MENU] > VOICE > Record

Up to 1 minute of audio can be recorded onto a
microSD card for voice transmission. (p. 7-2)

The transceiver can save only 1 voice audio.

® BE SURE to insert a microSD card.

® While recording a QSO, you cannot use this function.

Repeat Time (Default: 5sec)

[MENU] > VOICE > TX Set > Repeat Time

Sets the Repeat Time to between 1 and 15 seconds
(in 1 second steps).

The transceiver repeatedly transmits the recorded
voice audio for this set interval.

NOTE: The recorded voice audio is repeatedly
transmitted for up to 10 minutes. If 10 minutes
passes while transmitting, the transceiver
continues to transmit until the complete voice audio
transmission is finished.

TX Monitor (Default: ON)

[MENU] > VOICE > TX Set > TX Monitor

Turns the TX Monitor function ON or OFF.

* OFF: The TX voice audio is not heard from the
speaker.

* ON: The TX voice audio is heard from the speaker.
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[MENU] > VOICE > <<Single TX>>

The transceiver transmits the recorded voice audio
only once.
® You can also select “Single TX” in the Quick Menu
window.
([QUICK] > Voice TX > Single TX)

<<Repeat TX>>

[MENU] > VOICE > <<Repeat TX>>

The transceiver repeatedly transmits the recorded
voice audio for up to 10 minutes, according to the
“Repeat Time” setting.

® Information

* You can also select “Repeat TX” in the Quick Menu
window.

([QUICK] > Voice TX > Repeat TX)

« If 10 minutes passes while transmitting, the transceiver
continues to transmit until the complete voice audio
transmission is finished.

» Any of the following action cancels the transmission.

- Pushing [PTT]
- Turning OFF the transceiver, then turning it ON again.
- Pushing any key (except for [VOL] and [()])
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Recording a QSO audio

NOTE:

* You must insert a microSD card into the transceiver
before recording audio.

 The recording function is continuously ON, even if the
transceiver is turned OFF then ON again.

To start recording

To stop recording

1. Push [QUICK].
2. Select “<<REC Start>>.”
00

Band Scope 4
<<FM Radio ON>>

<<FM Radio Mode>
<<GPS Logger Only>

v

fan] ®» 5 12:00
EAMFM 0]

Recording started.

p|

440-000 PSKIP|

» “Recording started.” is displayed, then returns to the
standby screen.

) % @ 12:00 .
(MANEY] m<— Recording standby

146.010

PSKIP
VFO
FM n

440.000 PSKIP
v
I%DFM » g 12:02

<+—The recording starts when you
1 46_ 01 0 transmit or the squelch opens.
While recording, the SD card icon
wo | blinks.

FM n

440 -000 PSKIP

® Information

» The recording pauses while no signal is received, and
resumes when a signal is received again.

* The recording continues until you manually stop

recording, or the card becomes full.

If the recording file’s content reaches 2GB, the

transceiver automatically creates a new file, and

continues recording.
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1. Push [QUICK].
2. Select “<<REC Stop>>."
:00

Band Scope

<<FM Radio ON>>

<<FM Radio Mode>
<<GPS Logger Only>|[t

v

®» 5 12:00

fian]
[MANEY]

Recording stopped.

Pl

440-000 PSKIP|

TIP:

* You can select to record the received audio from
only the MAIN band or both the MAIN and SUB
bands. (p. 8-15)

(IMENU] > RECORD > QSO Recorder
> Recorder Set > REC Operation)

* When “RX REC Condition” is set to “Always,” the
recording automatically starts when
“<<REC Start>>" is selected. In that case,
recording continues, even when no signal is
received.” (p. 8-15)

(IMENU] > RECORD > QSO Recorder
> Recorder Set > RX REC Condition)

* The recorded file contains no sound.
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Playing back a recorded audio

NOTE: Insert the microSD card that contains the
recorded audio file into the transceiver’s slot.

[MENU] > RECORD > QSO Recorder > Play Files

1. Push [MENUI.
2. Select “RECORD.”
3. Select “QSO Recorder.”

QSO Recorder »
Voice Recorder »
DV Auto Reply »

4. Select “Play Files.”

<<REC Start>>

Play Files »
Recorder Set 4
Player Set »

5. Select the folder that contains the audio file to play.

| 20211101 »

20211102 »

® The folder is named in the following format:
yyyymmdd (yyyy: year, mm: month, dd: day)
6. Select the audio file to play.

Recorded time
-
|.120211101
2021/11/01 16:57:23 A =—Band (A/B)

2021/11/01 17:19:11 A

439390 DV TX 0:07<—Total playback time

T P _xRrx

Operating mode
Operating frequency

» The VOICE PLAYER screen is displayed, and the file
starts to play.
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TIP: Selecting the record file type to display.
In step 6, push [QUICK], then select “Display File”
and select the record file type to display.

* ALL: Displays all recorded files.

» Aonly: Displays only the audio file that was recorded on
the A band.

+ B only: Displays only the audio file that was recorded on
the B band.

The VOICE PLAYER screen description

The number of the file being played back/
The total number of recorded files.

Recording start

date and time —2021/11/01 17:19:11  A<—Band (A/B)

. | 439.390 DV  TXe—TX/RX
Qperatmg RPT: JP3YHH A (Hiran
information -+ >
0:00/ 0:07 «4—— Play back time/
@DPAUSE Total time
——[RX—CS]

) Plays the previous file
Rx>cs|

[R(:alav]im—sog@o—[LO] Fast forwards

[ENT] Pauses or plays
[DR] Plays the next file

Fast forward [LO]/Rewind [CD]

» Hold down to continuously fast forward, or rewind the file.

» The default skip time is 10 seconds. If you want to
change it, see page 8-16 for details.

* You can fast forward or rewind the file by rotating

[DIAL]. The fast forward/rewind time is 1/20 of the total

file time, regardless of the skip time setting.

If you push [CD] within the first 1 second of the file, the

end of the previous file is played back.

Playing the previous file [RX—CS]

» While the oldest file in the folder is playing back,
pushing [RX—CS] plays back the same file.

» While the file is paused, pushing [RX—CS] moves to
the beginning of the previous file.

Playing the next file [DR]
While the latest file in the folder is playing back,
pushing [DR] plays back the same file.

Operating information
The operating frequency, mode, and audio category
(RX/TX audio) are displayed.
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Changing the QSO recorder settings

You can change the recording settings.
See pages 8-15 and 8-16 for details.

Continue to record, even while the squelch is
closed

[MENU] > RECORD > QSO Recorder >
Recorder Set > RX REC Condition

® The default setting is “Squelch Auto” (Records only while
the squelch is open).

Record the QSO audio as one file

[MENU] > RECORD > QSO Recorder >
Recorder Set > File Split

ON

® The default setting is “ON” (transmit and receive audio
are separately recorded in different files).

® When “RX REC Condition” is set to “Squelch Auto,” an
audio file is created every time the squelch opens. The
received audio is recorded in a separated file.

Separately start or stop recording on the selected
band (MAIN band)

[MENU] > RECORD > QSO Recorder >
Recorder Set > REC Operation

A/B Separate

A/B Link

® The default setting is “A/B Link” (recording simultaneously
starts on the MAIN and SUB bands).
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Synchronize the recording to PTT

[MENU] > RECORD > QSO Recorder >
Recorder Set > PTT Auto REC

ON

® The default setting is “ON” (Recording is synchronized to
PTT).

TIP: When “PTT Auto REC” is set to “ON”

« Starts recording not only when [PTT] is pushed, but also
when switched to transmit by a speaker microphone
or a Bluetooth headset, by a CI-V command, or by the
VOX function.

» Asignal that is received within 10 seconds after the
squelch is closed is recorded in the same file.

Change the Skip Time

[MENU] > RECORD > QSO Recorder >
Player Set > Skip Time

3sec
S5sec

30sec

® The default setting is “10sec.”
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Deleting the audio folder/file

NOTE: A deleted audio file can NOT be recovered.

< Deleting an audio folder
NOTE: All audio files in the folder are deleted.

[MENU] > RECORD > QSO Recorder > Play Files

1. Push [MENUI. TIP: To delete all folders

. Select 'RECORD.” Select “Delete All Folders” in step 7.
3. Select “QSO Recorder.”

Folder Information

Delet
QSO Recorder » eee o
i r
Voice Recorder » _ ete olders
DV Auto Reply »

4. Select “Play Files.”

<<REC Start>>

Play Files »
Recorder Set 4
Player Set 4

5. Select the folder to delete.

| 20211101 4

20211102 »

® DO NOT push [ENT].
Push [QUICK].
Select “Delete.”

No

Folder Information

Delete All Folders

» The confirmation dialog is displayed.
8. Select “YES.”

Delete folder?

NO

* The folder is deleted.
® To exit the MENU screen, push [MENU].
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Deleting the audio folder/file

< Deleting an audio file
[MENU] > RECORD > QSO Recorder > Play Files

1. Push [MENUI. :
2. Select “RECORD.” TIP: To delete all files
3. Select “QSO Recorder.” Select “Delete All” in step 8.

@ If “Display File” is set to “A only” or “B only,” only

QSO Recorder displayed files are deleted.

Voice Recorder

DV Auto Reply ’ » “Display File” is “ALL
S Filelnforation
Delete
jDelete Al
4. Select “Play Files.” |Display File y

<<REC Start>>

,
Recorder Set »
Player Set ’ S Filelnforation
Delete
fDelete All (A only) |
5. Select the folder that contains the audio file to delete. |Display File 4

| 20211101 »

20211102 » .
Filelnforation
Delete
Delete All (B only)
6. Select the audio file to delete. Display File »

2021/11/01 15:21:35 A

2021/11/01 15:21:44 A
2021/11/01 16:24:36 A
2021/11/01 16:57:18 B
2021/11/01 16:57:20 B
146.010 FM  TX 0:05

® DO NOT push [ENT].
7. Push [QUICK].
8. Select “Delete.”

File Information

Delete All
|Display File 4

» The confirmation dialog is displayed.
9. Select “YES.”

Delete file?

NO

146.010 FM__ TX 0:05|

* The file is deleted.
@ To exit the MENU screen, push [MENU].
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Viewing the file information

The recorded audio file contains the recording data.
See page 8-8 for the recorded contents.

[MENU] > RECORD > QSO Recorder > Play Files

1. Push [MENU].
2. Select “RECORD.”
3. Select “QSO Recorder.”

QSO Recorder »
Voice Recorder »
DV Auto Reply »

4. Select “Play Files.”

<<REC Start>>

Play Files »
Recorder Set 4
Player Set 4

5. Select the folder that contains the audio file to
view the information.

| 20211101 »

20211102 »

6. Select the audio file to view the information.

2021/11/01 15:21:35 A

2021/11/01 15:21:44 A
2021/11/01 16:24:36 A
2021/11/01 16:57:18 B
2021/11/01 16:57:20 B
146.010FM TX 0:05

® DO NOT push [ENT].
7. Push [QUICK].
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8. Select “File Information.’

File Information

Delete
Delete All
Display File »

R T TN
FREQ: 146.010
MODE: FM >
POWER: High
START: 2021/11/01
15:21:35

146.0TU FM TX U

9. Rotate [DIAL] to change the screen.

® To exit the MENU screen, push [MENU].

TIP: To view the folder information
Push [QUICK] in step 5, and then select “Folder
Information” to view the folder information.

Folder Information

Delete
Delete All Folders

NAME: 20211101 <=

FILE: 7 (334KB) <

DATE: 2021/11/01
15:21:34

Folder name
Total files (total size)

—Created date and time
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Viewing the file information

File information examples
® Depending on the recording status, some data may not be displayed.
® The file is named in the following format: yyyymmdd_hhmmss
(yyyy: year, mm: month, dd: day, hh: hour, mm: minute, ss: second)

+ TX audio file information * RX audio file information
120211101 Operating information (TX) 120211101 Operating information (RX)
FREQ: 439.390 Recording date and time FREQ: 439.390 Recording date and time
MODE: DV TX MODE: DV RX
POWVER: High S-MET: $1
START: 2021/11/01 START: 2021/11/01

17:19:11 16:23:59

439.390 DV TX U 439.390 DV RX 0

120211101 MY station position 120211101
MY POSITION: MY POSITION:

MY station position

LAT: 34 37.38'N LAT: 34'37.37'N
LON: 135 34.27'E LON: 135 34.28'E

GL: PM74S0O GL: PM74S0O
ALT: 8ft ALT: 71ft

439.390 DV RX U

TO: CALLER:
CcQCQCQ IM1ZLK

Rick

FROM: RXRPT:
JP3YHH A JP3YHH A
Hirano/lcom Hirano/lcom

. 439.390 DV RX U

120211101 DR setting 120211101 ] Caller and received repeater

1201211101 File data 120211101 RX station position
NAME: 20211101_17 RX POSITION:
SIZE: 125KB LAT: 35 34.28'N
DATE: 2021/11/01 LON: 135 48.18'E
17:19:18 GL: PM75VN
ALT: 33ft
DST: 66.8mi
4393900V IX U 46.010 DV RX U
120211101 File data
NAME: 20211101_1¢
SIZE: 115KB
DATE: 2021/11/01
16:24:06
439.390 DV RX U
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Using the Voice Recorder function

The microphone audio, including audio from an
external microphone, can be recorded for your
convenience.

NOTE: You must insert a microSD card into the
transceiver before recording audio.

< To start recording

NOTE: You cannot record a voice while recording

a QSO. In that case, push [QUICK] in the standby
screen, and then select “Stop Recording” to stop the
QSO recording.

[MENU] > RECORD > Voice Recorder > Record

1. Push [MENU].
2. Select “RECORD.”
3. Select “Voice Recorder.”

QSO Recorder »
DV Auto Reply »

4. Select “Record.”

Play Files
Recorder Set
Player Set

hd

v v v

v

REC Time:

0:00:00

Remain 265h34m<T Remaining time

REC Level:
Microphone gain level
EBREC |

» The VOICE RECORDER screen is displayed.
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® Depending on the microSD card capacity, you may
continuously record up to a maximum of about 37 hours.
If the file size exceeds 2 GB, a new file is automatically
created in the same folder, and the recorded voice audio
is saved there.

5. Push [PTT] to start recording.

» The microphone audio recording starts.

\VOICE RECORDER |

REC Time:

® 0:00:15 «—— Recording time
Remain 265h34m

REC Level:
LT TR |

EmSTOP

<— Microphone input level

6. Push [PTT] again to stop.

@ To exit the MENU screen, push [MENU].

TIP: Even if the external microphone or Bluetooth
headset is connected, the internal microphone’s
voice audio is recorded when the transceiver’s [PTT]
is pushed.

To record the external microphone’s voice audio,
hold down the external microphone’s [PTT].

To record the Bluetooth headset’s voice audio, hold
down the Bluetooth headset’s [PTT].

To change the microphone gain level
Push [QUICK] in the VOICE RECORDER screen,
and then select “MIC Gain.”
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Using the Voice Recorder function

< Playing back a recorded audio

NOTE: You cannot play back a recorded audio while
recording a QSO. In that case, push [QUICK] in the
standby screen, and then select “Stop Recording” to
stop the QSO recording.

[MENU] > RECORD > Voice Recorder > Play Files

1. Push [MENU].
2. Select “RECORD.”
3. Select “Voice Recorder.”

QSO Recorder »
DV Auto Reply »

4. Select “Play Files.”

Record
Recorder Set
Player Set

-~ R4

v | v

5. Select the folder that contains the audio file to play.

| 20211101 »

20211105 »

® The folder is named in the following format:
yyyymmdd (yyyy: year, mm: month, dd: day)
6. Select the audio file to play.

Recorded time
120211101y
2021/11/01 15:46:00

1:1

)

<+—Total playback time

» The VOICE PLAYER screen is displayed, and the file
starts to play.

8-10

The VOICE PLAYER screen description

The number of the file being played back/
The total number of recorded files.

Recording start

date and time —2021/11/01 15:46:27

> 0:12/ 1:13 «4—— Play back time/
@DPAUSE Total time
—[RX—CS]

) Plays the previous file
Rx>cs|

[R(;E:v]im—sog@o—ﬂm Fast forwards

[ENT] Pauses or plays
[DR] Plays the next file

Fast forward [LO]/Rewind [CD]

» Hold down to continuously fast forward or rewind the file.

» The default skip time is 10 seconds. If you want to
change it, see page 8-16 for details.

* You can fast forward or rewind the file by rotating

[DIAL]. The fast forward/rewind time is 1/20 of the total

file time, regardless of the skip time setting.

If you push [CD] within the first 1 second of the file, at

the end of the previous file is played back.

Playing the previous file [RX—CS]

» While the oldest file in the folder is playing back,
pushing [RX—CS] plays back the same file.

» While the file is paused, pushing [RX—CS] moves to
the beginning of the previous file.

Playing the next file [DR]
While the latest file in the folder is playing back,
pushing [DR] plays back the same file.
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Using the Voice Recorder function

< Deleting an audio folder

NOTE: TIP: To delete all folders

+ All audio files in the folder are deleted. Select “Delete All Folders” in step 7.
» Adeleted audio file can NOT be recovered.

Folder Information

Delete

[MENU] > RECORD > Voice Recorder > Play Files

1. Push [MENU].
2. Select “RECORD.”
3. Select “Voice Recorder.”

QSO Recorder »
DV Auto Reply »

4. Select “Play Files.”

Record

Play Files
Recorder Set
Player Set

»
4

v v

5. Select the folder to delete.

| 20211101 »

20211105 »

® DO NOT push [ENT].
6. Push [QUICK].
7. Select “Delete.”

Folder Information

Delete All Folders

» The confirmation dialog is displayed.
8. Select “YES.”

Delete folder?

NO

* The folder is deleted.
@ To exit the MENU screen, push [MENU].
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Using the Voice Recorder function

< Deleting an audio file
NOTE: A deleted audio file can NOT be recovered.

[MENU] > RECORD > Voice Recorder > Play Files

1. Push [MENU]. 9. Select “YES.”
2. Select “RECORD.” L
3. Select “Voice Recorder.” aaaLns1.A0.00
Delete file?
QSO Recorder 4
NO
DV Auto Reply » 113

» The file is deleted.
® To exit the MENU screen, push [MENU].

4. Select “Play Files.” -
_ TIP: To delete all files
Cocond | Selfzct Delete All" in step 8.
File Information
Recorder Set 14 Delete
Player Set »
5. Select the folder that contains the audio file to delete. —5
20211105 >

6. Select the audio file to delete.

2021/11/01 15:46:00

2021/11/01  15:46:27

1:13
® DO NOT push [ENT].
7. Push [QUICK].

8. Select “Delete.”

File Information

Delete All

» The confirmation dialog is displayed.
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Using the Voice Recorder function

< Viewing the file information
[MENU] > RECORD > Voice Recorder > Play Files

1. Push [MENU]. TIP: To view the folder information
2. Select “RECORD.” Push [QUICK] in step 5, and then select “Folder
3. Select “Voice Recorder.” Information” to view the folder information.

Folder Information

R »
QSO Recorder Delete

i »
Delete Al Folders

DV Auto Reply »

4. Select “Play Files.”

Record
Play Files NAME: 20211101 <
Recorder S FILE: 2 (1.3MB) =
ecorder et DATE: 2021/11/01
Player Set 15:46:00

Folder name
Total files (total size)

—Created date and time

5. Select the folder that contains the audio file to
view the information.

| 20211101 »

20211105 »

6. Select the audio file to view the information.

2021/11/01  15:46:00

2021/11/01  15:46:27

1:13]
® DO NOT push [ENT].
7. Push [QUICK].
8. Select “File Information.”

File Information

Delete
Delete All

1990211101
NAME: 20211101_154
SIZE: 1.2MB
DATE: 2021/11/01
15:47:40

1:T3]

@ To exit the MENU screen, push [MENU].
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Playing back the recorded audio on the PC

You can play back the recorded audio on your PC.
® Operation data is not displayed.
® Windows 10 is used for these instructions.

Example: Playing back the audio file on the microSD
card on your PC.

1. Insert the microSD card into the memory card slot 5. Double-click the folder that contains the audio file
or memory card reader on your PC. to play it back. (Example: “20211101”)
|4 | = Voice
Home Share View
« v 4 » USB Drive (H:) » ID-52 » Voice
Name -
l 3t Quick access .
N ‘ [ 2w ]<¢——Double-Click
== < @ OneDrive 20211102
= [ R=Cm ~
microSD To the . . .
card  |D-52A/E card reader PC 6. Double-click the file to play it back.
(Example: “20211101_152135A.wav”)
2. Click the “Open folder to view files” option to | [ = |z
access the card. fome st Ve
« v 4 » USB Drive (H:) » ID-52 » Voice » 20211101
Removable Disk (H:) Neme -
3 Quick access .
Choose what to do with remavable drives, 4__ DOU ble'CIle
@ OneDrive | ZUZ1 11U D2 148RWav,
Cun‘fig\}'m Ehis drive for backup B This pe a] 20211101_162220Awav
ol . 8] 20211101_162352B.wav
m .Cunﬁgure storage settings B 3D Objects |8] 20211101_16235%A.wav
| E Open folder to view fles Click ® See the instruction manual of your player for
e operation details.
B e ® The audio file may not play back, depending on the
player.
3. Double-click the ‘ID-52’ folder.
EEE — T TIP: When “USB Connect” is set to “SD Card Mode,”
Home  share  view | DrweTools and the transceiver is connected to the PC through a
& 1 > USBDrive (H) USB data cable, you can directly access the microSD
Mo - card that is set in the transceiver from the PC.
o Quickccess [ ==  ]«——Double-Click (IMENU] > SET > Function > USB Connect)
@ OneDrive

4. Double-click the ‘Voice’ folder.

I M < | D52
Home Share View
€« v » USB Drive (H) » ID-32 »
Name
3t Quick access
Capture
@ OneDrive Cav
8 This PC G
OpeningPicture
J 3D Objects
Picture
[ Desktop Qsolog
[£| Documents Reply
4 Downloads RxLog
D Music Soioo .
', o J«—Double:Ciik
B Videos VOICEREC
VoiceT
i aral Dick (01
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RECORD items

<<REC Start>>

RX REC Condition

(Default: Squelch Auto)

[MENU] > RECORD > QSO Recorder >
<<REC Start>>

After selecting “<<REC Start>>,” starts QSO
recording.
» “Recording started.” is displayed.

® Information

* BE SURE to insert a microSD card.

» While recording, “<<REC Stop>>" is displayed on the
QSO RECORDER screen. To stop recording, select
“<<REC Stop>>."

» Once a recording has started, the recording will continue,
even if the transceiver is turned OFF and then ON again.

Play Files

[MENU] > RECORD > QSO Recorder > Play Files

Displays saved voice data folders.
® BE SURE to insert a microSD card.

Playing back:

1. Select a folder that contains the file you want to
playback.

2. Select a file to playback.
» The VOICE PLAYER screen is displayed and starts

playing back the audio.

® See page 8-3 for details.

3. Push [MENU] to exit the VOICE PLAYER screen.

NOTE:

» The folder is automatically named, as shown below:
(Example)
Recording date: 1st November 2021
Folder name: 20211101

* The file is automatically named, as shown below:
(Example)
Recording date and time: 1st November 2021 15:30:00
File name: 20211101_153000

» The voice audio is recorded onto a microSD card, and
saved in the “wav” format. (“.wav” is not displayed on
the transceiver’s screen.)

» The recorded voice audio can also be played back on a
PC.
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File Split

[MENU] > RECORD > QSO Recorder >
Recorder Set > RX REC Condition

Selects whether or not the squelch status affects the
received voice audio recording.

+ Always: The transceiver always records the
receive voice audio regardless of the
squelch status.

» Squelch Auto: The transceiver records the receive
voice audio only when a signal is
received (the squelch is opened).
When the squelch closes while
recording, the recording will continue
for 2 seconds, and then pause.

(Default: ON)

REC Operation

[MENU] > RECORD > QSO Recorder >
Recorder Set > File Split

Turns the File Split function ON or OFF.

* OFF: Once a recording starts, the transceiver

continues to record on the same file.

@ If the file size exceeds 2 GB, a new file is
automatically created in the same folder, and the
voice audio is recorded there.

During recording, if transmission and

reception, or squelch status® (open and close)

is changed, a new file is automatically created
in the same folder, and the voice audio is
saved into a new file.

* Only when “RX REC Condition” is set to

“Squelch Auto.”

* ON:

(Default: A/B Link)

[MENU] > RECORD > QSO Recorder >
Recorder Set > REC Operation

Selects the recording operation on the dual band
display.

» A/B Separate: The recording function is separately
active/inactive on the selected band
(MAIN band) when the function is
started or stopped.
The recording function is
simultaneously active/inactive on
both MAIN and SUB bands when the
function is started or stopped.
® On the single band display,
only displayed band (A or B) is
recorded.

+ A/B Link:
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RECORD items

PTT Auto REC (Default: ON)

Play Files

[MENU] > RECORD > QSO Recorder >
Recorder Set > PTT Auto REC

Turns the PTT Automatic Recording function ON or OFF.

® Transmitting from a speaker microphone or a Bluetooth
headset, using the VOX function, or sending a CI-V
command also starts recording.

* OFF: Turns OFF the function.
* ON: The recording automatically starts when you
push [PTT].
The recording stops when:
* No signal is transmitted for 10 seconds after releasing [PTT].
* No signal is received for 10 seconds after releasing [PTT].
® When the transceiver receives a signal within
10 seconds after releasing [PTT], the recording
automatically starts.
» The operating frequency, Frequency Selecting mode,
or operating mode is changed after releasing [PTT].

Skip Time (Default: 10sec)

[MENU] > RECORD > QSO Recorder >
Player Set > Skip Time

Sets the Skip Timer to 3, 5, 10, or 30 seconds to

rewind or skip forward for this set period of time when

you push the fast-rewind or fast-forward key while

playing the recorded QSO audio.

® See “The VOICE PLAYER screen description” for
forwarding or rewinding. (p. 8-3)

Record

[MENU] > RECORD > Voice Recorder > Record

Push [ENT] to display the VOICE RECORDER
screen, and then push [PTT] to start a voice
recording. While recording, push [PTT] again to stop
the recording. (p. 8-9)

® Information

* BE SURE to insert a microSD card.

* This function cannot record a QSO.

* While recording a QSO, you cannot use this function.
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[MENU] > RECORD > Voice Recorder > Play Files

Plays back the voice audio that is recorded on the
VOICE RECORDER screen.

Push [ENT] to display the folders that contain the
recorded voice audio files.

® BE SURE to insert a microSD card.

MIC Gain

[MENU] > RECORD > Voice Recorder >
Recorder Set > MIC Gain

Sets the internal microphone sensitivity to between 1
(minimum sensitivity) and 4 (maximum sensitivity) for
the Voice Recorder function. Higher values make the
microphone more sensitive to your voice.

(Default: 3)

Skip Time (Default: 10sec)

[MENU] > RECORD > Voice Recorder >
Player Set > Skip Time

Sets the Skip Timer to 3, 5, 10, or 30 seconds to

rewind or skip forward for this set period of time when

you push the fast-rewind or fast-forward key while

playing the recorded voice audio.

® See “The VOICE PLAYER screen description” for
forwarding or rewinding. (p. 8-10)

DV Auto Reply

[MENU] > RECORD > DV Auto Reply

Up to 10 seconds of audio can be recorded for the
Automatic Reply function.

® BE SURE to insert a microSD card.

® See page 5-25 for details.
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9 MEMORY OPERATION

General description

The Memory mode enables you to quickly select
often-used frequencies, modes, and other parameters.
While operating in the Memory mode, you can
temporarily change the operating frequency, mode,
and so on, without overwriting the memory channel

NOTE: Memory content may be accidentally
cleared by static electricity, electric transients,

and other causes. In addition, it may be cleared

by a malfunction, or during repairs. Therefore, we
recommend that you backup the Memory content or

contents. save it onto a microSD card* or a PC.
*User supplied
Memory _r ® The CS-52 PROGRAMMING SOFTWARE can also be used
Group Descriptions . -
channel to backup your memory content. See its instruction

Regular memory channels. manual for details.

Up to 1000 channels can be
separately stored in the 100
memory channel groups.

144 CO/C1 | Call channels each of the 144 and
430 C0/C1 | 430 bands.

00to 99 | 00 to 99

CALL CH

<& Memory channel content

The following information can be entered into the
Memory channels:

» Operating frequency

* Duplex ON/OFF

» Duplex direction (DUP+ or DUP-)

» Duplex frequency offset

* Memory name

» Scan skip setting

Tuning step

Operating mode

Subaudible tone encoder, tone squelch, or DTCS squelch
ON/OFF

Subaudible tone frequency, tone squelch frequency, or
DTCS code with polarity

Digital code

Digital Call sign squelch or Digital code squelch ON/OFF
» UR station call sign

R1/R2 call signs

9-2
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S

electing a Memory channel

In the Memory mode, you can select the Memory
channels by rotating [DIAL].

1.

Push [MR] to enter the Memory mode.

@ b3 12:00|
[MAINIZY]

146.010

SKIP
ITW00-00

FM

440.000

VFO

PSKIP|

® For only the ID-52A, pushing [MR] each time selects
the Memory and Weather Channel modes.

Rotate [DIAL].

» Selects a Memory channel.

@ Blank channels are not selected.

® To select a Memory Group, push [QUICK], and then
select “Group Select.”

® The Memory channels are commonly used for the A
and B bands. On the B band, if you select a memory
channel that is out of the selectable frequency range

“4 X" is displayed, and the signal cannot be received.

TIP: To sequentially select a channel in a
different group

1.

Push [QUICK].

2. Select “Channel Select Group Range.”

12:0
Group Select »
Channel Select Grot
DUP »
TONE »F
TS »
ATT '
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Selecting a Call channel

Call channels are used for quick recall of most often
used operating frequencies.

Factory default frequencies and operating modes are
entered into the Call channels. Change these to suit
your operating needs.

1.

Hold down [CALL] for 1 second to enter the Call
Channel mode.

I%mw' * 5§ 12:00
FM Call CH
146.520
= [@XM8144C0
440.000 PSKIP|

Rotate [DIAL].
« Selects a Call channel.
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Entering Memory channel contents

After selecting a frequency in the VFO mode, you can

enter it into a selected channel or an automatically
selected blank channel.

< Entering into a selected channel

Example: Entering 146.030 MHz/FM mode into
Channel 11 in Group 01.

1. Push [VFO/MHZ] to enter the VFO mode.

2. Push [MODE] to enter the FM mode.

3. Rotate [DIAL] to set a frequency to 146.030 MHz.

[ - N 5 12

146.030

PSKIP

FM

440.000

4. Hold down [MW] for 1 second.
» Ashort and a long beep sound.
5. Select “Write to New CH.”

Write to New CH

Write to Selected CH
Manage Memory

PSKIP|

Pl

Push [QUICK].
Select “Group Select.”

N o

Group Select

<<Write>>
<<Insert Write>>

ToTaTTR <rT)

8. Select Group “01.”

W DESTINATION

01:

(Blank CH)
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10. Push [ENT].
» The confirmation dialog is displayed.
11. Select “YES.”

FM

Write to a blank
channel?

NO

(Blank CH)

» Beeps sound and the Memory contents are briefly
displayed, then returns to the VFO mode.

TIP: In step 7, you can select the following options.
* NAME:
Displays the Memory name edit screen. (p. 9-11)
+ SKIP:
Displays the SKIP setting items.
* Group Select:
Displays the GROUP SELECT screen.
o <<Write>>:
Enters into the selected Memory channel.
» <<Insert Write>>:
Inserts a Memory channel above the selected
channel.
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Entering Memory channel contents

< Overwriting to the selected channel

You can write a frequency into a pre-entered channel.

Example: Entering 146.330 MHz/FM mode into

1.

B w

Channel 11 in Group 01.
Push [MR] to enter the Memory mode.
@ For only the ID-52A, pushing [MR] each time selects
the Memory and Weather Channel modes.

Rotate [DIAL] to select Channel 11 in Group 01.
[ - ® 5 12:00]

146.030

ETWO01-11

FM

440-000 PSKIP|

® To select a Memory Group, push [QUICK], and then
select “Group Select.”

Push [VFO/MHZz] to enter the VFO mode.

Rotate [DIAL] to set a frequency to 146.330 MHz.

faom] EY 12:00|
lTﬂ]}]FM =

146.330

PSKIP|
VFO

FM

440-000 PSKIP|

Hold down [MW] for 1 second.

» Ashort and a long beep sound.

Select “Write to Selected CH.”
:00

Write to New CH

Write to Selected CH

Manage Memory

146.330

W DESTINATION

01:
=i 6.030

Push [MR].
Select “YES.”

F

A \ Overwrite?

NO
140.U3U

» Beeps sound and the Memory contents are briefly
displayed, then returns to the VFO mode.
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< Entering to a blank channel

Example: Entering 441.100 MHz/FM mode into a

1.

3.

blank channel.
Push [VFO/MHZz] to enter the VFO mode.
Push [MODE] to enter the FM mode.
Rotate [DIAL] to set a frequency to 441.100 MHz.

fiam] % & 12:00
l_[mmwl =

441.100

PSKIP|

FM

440.000

Hold down [MW] for 3 seconds.

[ane] * 12:00
‘;[EH]DFM g

PSKIP|

Completed.
CH: 00-02
FREQ: 441.100

440.000

» The Memory contents are briefly displayed for 2
seconds, then returns to the VFO mode.

PSKIP|
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Copying Memory content to the VFO

It is convenient when you want to operate on a
channel frequency near a Memory or Call channel.

Example: Copying Memory Channel 11 in Group 01
to the VFO.
1. Push [MR] to enter the Memory mode.
@ For only the ID-52A, pushing [MR] each time selects
the Memory and Weather Channel modes.

2. Rotate [DIAL] to select Channel 11 in Group 01.
IQF * 5 1

146.330

ETW01-11

FM

440-000 PSKIP|

® To select a Memory Group, push [QUICK], and then
select “Group Select.”
3. Hold down [MW] for 1 second.
» Ashort and a long beep sound.
4. Select “Copy to VFO.”

Edit

Copy to VFO

Manage Memory

5. Select “YES.”

®x 5 12

@
[MAINIZY]

Copy to VFO?

NO 1
440.000 PSKIP)

v

& g 12

frun]
[MANEY]

146.330

PSKIP

FM

440-000 PSKIP|

» Beeps sound and copies the selected Memory
contents to the VFO, then returns to the VFO mode.

9-6
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MEMORY screen

On the MEMORY screen, you can easily manage the
Memory or Call channel content.

O Tree view of the MEMORY screen

— Memory CH  |—— Group 00
|

Group 99

S: SKIP CH’

s

— Call CH —

1

144 CO

144 C1
430 CO

430 C1

Your Call Sign

Repeater List

* Skips the set frequency during a scan.
(While a VFO scan is paused and if you want to skip
the frequency, holding down [MW] for 1 second sets
the frequency as the Skip channel.)

9-7

< Viewing the Memory channel contents

You can view the Memory channel contents on the
MEMORY screen.

Example: Viewing the contents of Channel 01 in
Group 00.

[MENU] > MEMORY > Memory CH

1. Push [MENU].
2. Select “MEMORY” on the second page of the
MENU screen.
@ In the VFO, Memory, or Call Channel mode, you can
open the MEMORY screen by holding down [MW] for
1 second, then selecting “Manage Memory.”

3. Select “Memory CH.”
4. Select Group “00.”
mo0
01: »
02: (Blank)»
03: (Blank)»
04: (Blank)»
05: (Blank)»

5. Select Channel “01.”

00: 146.010 FM »
01: 440.000 FM »

02: 441.100 FM »
03: »
»
»

04:
05:

NAME:

FREQUENCY:
440.000.00
TS:

25.0kHz

» Channel contents are displayed.
® Rotate [DIAL] to scroll the screen.
@ To exit the MENU screen, push [MENU].

TIP: To edit, copy, or clear the memory content.
1. Push [QUICK] in step 5.
2. Select “Edit,” “Copy,” or “Clear.”

Clear
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Copying Memory contents to another Memory channel

You can copy the memory content to another Memory
channel.

Example: Copying Channel 01 in Group 00 to
Channel 06 in Group 00.

[MENU] > MEMORY > Memory CH

1. Push [MENU]. 8. Select the destination channel.
2. Select “MEMORY.”
3. Select “Memory CH.”
4. Select Group “00.”
5. Select Channel “01.”
00: 146.010 FM »
02:441.100 FM
05; »ll
® DO NOT push [ENT]. Fu
6. Push [QUICK]. 440.000
7. Select “COpy.” IR 00-06

[T 4.

Edit

* Beeps sound, and the contents are copied to the
Move destination channel.

Clear @ If the selected channel is not blank, a confirmation
Insert dialog is displayed. When you select “YES,” the
Delete (next CH mov Memory contents are overwritten.

TIP: To copy the channel to a different group
In step 6, while “DESTINATION” is displayed, push
[QUICK] and select “Group Select.”

00: 146.010 FM

01: 440.000 FM

FM

Group Select

* The GROUP SELECT screen is displayed.

9-8
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Moving the Memory contents to another channel in a different group

You can move the memory content to another Memory
channel in a different group.

Example: Moving Channel 01 in Group 00 to Channel
00 in Group 02.

[MENU] > MEMORY > Memory CH

1. Push [MENUI. 11. Select the destination channel.
2. Select “MEMORY.”
3. Select “Memory CH.”
4. Select Group “00.”
5. Select Channel “01.”
00: 146.010 FM  »
02: 441.100 FM
05: il
01: »
® DO NOT push [ENT]. 02- ,
6. Push [QUICK]. 03: N
7. Select “Move.” 04: »
05: 'l
» Beeps sound, and the contents are moved to the
destination channel.
® Channels other than the one that you moved will
move up.
Delete (next CH mov
v TIP: To rearrange the display order in the
selected group
In step 7, while “DESTINATION” is displayed, go to
step 11.
00: 146.010 FM
: . FM
8. Push [QUICK].
9. Select “Group Select.”

Group Select

10. Select the destination group.

9-9
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Inserting a blank channel

You can insert a blank channel between 2 Memory
channels. This function is convenient to organize your
memory channels.

Example: Inserting a blank channel between Channel
00 and 01 in Group 00.

[MENU] > MEMORY > Memory CH

1. Push [IYIENU]. ) TIP: To insert a blank group
2. Select “MEMORY' ” On the Memory Group screen, select a group and
3. Select "Memory CH. push [QUICK], then select “Insert Group.”
4. Select Group “00.”
5. Select Channel “01.” Edit Name
-
00: 146.010 FM » Move Group
01:441.100 FM ’ Clear This Group Me
02: » Delete Group
03: » o —
0 ' « Ablank group is inserted above the selected group.
05:440.000 FM |l
® DO NOT push [ENT].
6. Push [QUICK].
7. Select “Insert.”

Delete (next CH mov

TSRO OO

* Beeps sound, a blank channel is inserted above the
selected channel.

@ If you select channel 99 in step 5, a confirmation
dialog is displayed. When you select “YES,” channel
99 is deleted.

9-10
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Entering a group/memory name

You can assign a name of up to 16 characters to each
channel group (00 ~ 99) and memory channel.

Example: Entering “Calling” as a Memory name to
Channel 01 in Group 00.

[MENU] > MEMORY > Memory CH

Push [MENU].
Select “MEMORY.”
Select “Memory CH.”
Select Group “00.”
Select Channel “01.”

SARE ol

00: 146.010 FM

»

. >

»
»
»

® DO NOT push [ENT].
Push [QUICK].
Select “Edit.”

No

Delete (next CH mov

8. Select “NAME.”

NAME: 3

FREQUENCY: ,
440.000.00
TS: ,
25.0kHz |
@IRBCHAR TYPE  ABC
9. Enter a name.
Calling
EIDCHAR TYPE  abc

® See page iii on how to enter characters.

10. After entering, push [ENT].

NAME: 3
Calling

FREQUENCY: ,
440.000.00

TS: ,
25.0kHz |

11. Select “<<Overwrite>>."

TONE:

»
OFF

<<Overwrite>>

12. Select “YES.”

TAONIE-
/I Overwrite?

NO

v

Completed.

440.000

Calling
EIER00-01

057 4.

» Beeps sound, then returns to the Memory channel
screen.

TIP: To enter a group name
On the Memory Group list screen, select a group
and push [QUICK], then select “Edit Name.”

Edit Name

Insert Group
Move Group
Clear This Group Me
Delete Group

U ToToTTy T |

» The Group Name edit screen is displayed.

9-11
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Selecting a memory name display

While in the memory mode, the entered memory
name can be displayed in different styles. You can
select a display type.

Example: Selecting “Name (Large)” in the Single
band display.
1. Push [MR] to select the Memory mode.
@ For only the ID-52A, pushing [MR] each time selects
the Memory and Weather Channel modes.
2. Push [QUICK].
3. Select “Display Type.”
0

14

Home CH Set

Display Type »
Voltage
Band Scope 4

<<REC Start>>
<<FM Radio ON>>

4. Select a display type.

12

Freq (Name OFF)
Freq (Normal Name)
Freq (Large Name)
Name (Normal)

v

* 12:00|

%FM
Calling
440.000

IW00-01
2021/11/01 (Mon)

® “Freq (Name OFF)” is set as the default.

9-12

TIP: There are 5 types of Memory name displays.

* Freq (Name OFF):
Displays onIy the frequency

440.000

I3 00-01
2021/11/01 (Mon)

* Freq (Normal Name):
Displays the large font sized frequency and small font
sized Memory name.
® In the Dual band display, select “Freq.”

12:00

gFM
440.000
Calling
EE800-01
2021/11/01 (Mon)

* Freq (Large Name):
Displays the large font sized frequency and large font
sized Memory name.
® You cannot select in the Dual band display.

2021/11/01 (Mon)

* Name (Normal):
Displays the small font sized Memory name and small
font sized frequency.

2021/11/01 (Mon)

* Name (Large):
Displays the large font sized Memory name and small
font sized frequency

2021/11/01 (Mon)
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Clearing a Memory contents

Contents of entered memories can be cleared
(erased), if desired.

® The cleared channel becomes a blank channel.
@ You can also clear the Skip channels (Group “S”).

NOTE: Cleared memory channel contents cannot be
restored.

Example: Clearing channel 01 in group 00.
[MENU] > MEMORY > Memory CH

Push [MENU].
Select “MEMORY.”
Select “Memory CH.”
Select Group “00.”
Select Channel “01.”

TIP: To Delete a memory channel
In step 7, select “Delete (next CH moves up).”

AN Sl

00: 146.010 FM »
’

01: 440.000 FM

>
03: »
»

» The selected channel is deleted.

05: d ® You can also delete Memory groups.

@® DO NOT push [ENT]. Select a group, then select “Delete Group.”
Push [QUICK].
Select “Clear.”

No

LAeBALLID AN

Edit
Copy
Move

Clear

Insert
Delete (next CH mov

8. Select “YES.”

Q0146 010 CAA

Clear?

NO

05: 4

» Beeps sound, and the contents are cleared.
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1 () SCAN OPERATION

Scan Type

Scanning is a versatile function that can automatically search for signals. A scan makes it easier to locate stations
to contact or listen to, or to skip unwanted channels or frequencies.

OVFO scan

The VFO scan searches for signals within the
specified frequency range.

Full scan (ALL)
Repeatedly scans the entire band.

ID-52A/E ID-52A/E
RX frequency RX frequency
lower end upper end
| |

I
P SKIP  Scan P SKIP
‘ U L)

Band scan (BAND)
Repeatedly scans the selected band.

Band edge frequency
lower end
|

! PSKIP  Scan PSKIP !

Band edge frequency
upper end
|

Program scan (P00 ~ P24)
Repeatedly scans the selected Program Scan range
(P-Scan Edge 00 ~ 24).

Lower edge Upper edge

| Scan range |

! PSl(IP Scan PS.KIP !

® At least one Program Scan range (P-Scan Edges) must
be entered to start a Program scan.
(IMENU] > SET > Scan > P-Scan Edge)

See page 10-7 for more details.

Program Link scan (P-LINK 0 ~ 9)

Sequentially scans the Program Scan ranges. The
links are set on the MENU screen.

(IMENU] > SET > Scan > Program Link)

® See page 10-8 for more details.

Program scan edges (Example: POO ~ P10)

Scan
o)
"""""""" Jamp T

10-2

<& Memory scan

The Memory scan searches signals on the
preregistered memory channels.

ALL scan (ALL)
Repeatedly scans all memory channels.

Memory Groups (00 ~ 99 and S: Skip CH)

Empty groups are skipped

Selected band scan (BAND)
Scans all memory channels on the same frequency
band as the selected channel.

Mode scan (MODE)
Scans memory channels that are entered with the
same operating mode as the currently selected mode.

® The Mode scan scans all memory groups.
(Group 00 ~ 99, S: SKIP CH)

Example: Scanning AM mode
Memory group 02

Modes other than AM are skipped

Group link scan (GROUP LINK)
Sequentially scans the memory groups that are set to
link on the MENU screen.

Memory Groups (00 ~ 99 and S: Skip CH)

. Jum
Unchecked groups are skipped

@ At least 2 groups must be checked to start a Group Link
scan. ((MENU] > SET > Scan > Group Link)
See page 10-10 for more details.

Group scan (GROUP 00 ~ 99)
Scans the Memory channels in the selected group.



1 () SCAN OPERATION

Scan Type

Duplex (DUP) scan

The Duplex scan searches for signals on both TX

and RX frequencies used in duplex operation

(p- 11-4).

® “D-"or “D+” is displayed in the Duplex mode.

® A Duplex scan does not start when the frequency offset
is set to “0.000.00 MHz.”

Tone scan

The Tone scan searches for signals with tone

frequencies or DTCS codes from stations using the

Tone Squelch function.

® A Tone scan is usable in any VFO, Memory, or Call
channel mode.

® During a scan, rotate [DIAL] to change the scan
direction.

® See pages 15-8 and 15-9 about the Tone Squelch
function and DTCS Code Squelch function.

10-3
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About Scans

< [DIAL] operation during a scan

* Rotate [DIAL] to change the scan direction during a scan.
* When the scan is paused, rotate [DIAL] to resume the
scan.

<& Squelch setting for a scan

You can change the squelch level to suit your

operating needs. Set the squelch level to open the

squelch, according to the received signal strength.

® During a scan, rotate [DIAL] while holding down [SQL]
to adjust the squelch level. The scan resumes after
adjusting.

[

[MANEY]

130
14541 i <—Blinks
AUTO

& § 12:00]

SQUELCH:
FM

440.000

VFO

PSKIP

< Tuning step for a VFO scan

The selected tuning step is applied to the scan.

For a Program scan or Program Link scan, set the
tuning step in the Program Scan Edge ranges (P-Scan
Edge).

< Scan Skip function

The skip function speeds up scanning by not scanning
those frequencies set as skip channels.
® These settings can be separately set to A band and B band.

In the VFO mode
The frequencies that are set as “PSKIP” are skipped
during a scan. (p. 10-6)

In the Memory mode

The frequencies that are set as skip channels “PSKIP”

and “SKIP” are not scanned. (p. 10-11)

® You must enter 2 or more Memory channels to start a
memory scan.

TIP: When “Program Skip” is set to OFF, you cannot
use the Program Skip scan function. (p. 12-5)

(IMENU] > SET > Scan > Program Skip)

10-4

< Operating mode during a scan

» The VFO scan uses the selected operating mode.
* During a Memory mode scan, the operating mode
entered into the channel is used.

<¢When a signal is received

When a signal is received, the scan pauses for this
set period of time. (p. 12-5)

When a received signal disappears, the scan resumes
for this set period of time. (p. 12-5)

® These settings can be separately set to A band and B band.

[MENU] > SET > Scan > Pause Timer
[MENU] > SET > Scan > Resume Timer

@ > 12:00]
[MAINIIY]

146,075
..... ..f....mz}Bans

440.000

VFO

PSKIP

< Scan Stop Beep function

The Scan Stop Beep function sounds a beep when a
signal is received.
This function can be turned ON or OFF on the MENU
screen. (p. 12-29)

[MENU] > SET > Sounds > Scan Stop Beep
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VFO Scan

1. Push [VFO/MHZz] to enter the VFO mode. < Scan Type
. Push [MODE] to select the operating mode. . ALL: Full scan
3. Hold down [SCAN] for 1 second. « BAND: Band scan
* Opens the Scan Type Select window. « DUP: Duplex scan
4. Select a scan type. (Displayed only when Duplex is set)
-00 e P-LINKO ~9: Program Link scan
— « P00 ~ 24: Program scan
BAND « TONE: Tone scan
P-LINKO (For the Tone Squelch scanning)
PQO: 144.000 - 440.000
TONE ® Information
b » The frequencies that are set as a Skip channel
(PSKIP) are skipped during a scan. (p. 10-6)
A 4 » When “Program Skip” is set to “OFF,” the Skip channel
fan] w5 1500 frequencies are not skipped. (p. 12-5)
WM (IMENU] > SET > Scan > Program Skip)
1 46@“7 5 » To set a Program Link scan, see page 10-8.
- Blinks » To set a Program scan, see page 10-7.
(VEG|ALL |
FM
440.000 PSKIP| TIP:
+ During a scan, rotate [DIAL] to change the scanning
direction.
* The scan starts. . « During a scan, push [MODE] to select the operating
» The decimal point and the selected Scan Type icon mode.
blink. o . . + During a scan, hold down [p=Q)] to turn the Lock
® When receiving a signal, the S-meter displays the function ON or OFE.
received signal strength. « The scan continuously runs, even if you push [MENU]
5. Hold down [SCAN] for 1 second. or [QUICK] during a scan.
y Canc_els the scan. * You can select a scan type by rotating [DIAL] while
® Pushing [CLR] also cancels the scan. holding down [SCAN]. Release [SCAN] to start the
scan.

10-5
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VFO Scan

< About a Program scan name

When a Scan name is entered to a Program scan, the
name is displayed in the Scan Type Select window.
(p. 10-5)

® The name is not displayed during a scan.

® To enter the name, see page 10-7.

When the Scan name is entered

12:

ALL

BAND
P-LINKO

P0O: SCANO i

TONE

VFO

When the Scan name is not entered
12

ALL

BAND
P-LINKO

POO: 144.000 - 440.000 ||

TONE

VFO

<& About a Program Link scan name

When a Program Link scan name is entered, it is
displayed in the Scan Type Select window.

(p. 10-5)

® The name is not displayed during a scan.

@ To enter the name, see page 10-8.

When a Program Link name is entered
x H 12

ALL

BAND

P00: SCANO
TONE

el

VFO

When a Program Link name is not entered
12:

ALL
BAND
P-LINKO
P0O: SCANO

TONE

VFO
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< Storing the skip frequencies

You can skip unnecessary frequencies during a scan.
While a scan is paused and if you want to skip the
frequency, you can store it into the Skip channels
group S (00 ~ 99) as a Skip channel (PSKIP).

The Scan Skip function speeds up a scan.

1. While a VFO scan is paused, hold down [MW] for
1 second.

5 12-00
Adds to SKIP MR Gr

Temp Skip Set

» The window, as shown above, is displayed.
2. Select “Adds to SKIP MR Group.”
» Two short beeps sound.
» The frequency is stored in the Skip channels group.
« After storing, the scan resumes.
@ If there is no blank channel, an error beep sounds,
and the frequency is not stored.

TIP: Once a frequency is set as a Skip channel, the

frequency is skipped until you clear the skip setting.

To clear the skip setting, see page 10-11.

® The skip setting is also cleared when the Memory
channel set as a Skip channel is cleared.
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VFO Scan

<O Entering Program Scan Edges

You can enter the upper and lower frequency edges
for a Program scan.

Each Program Scan range has its tuning step and
operating mode setting.

You can enter up to 25 Program Scan ranges (P-Scan
Edge) on the MENU screen.

[MENU] > SET > Scan > P-Scan Edge

1. Push [MENU].
2. Select “Scan” in the “SET” menu.
3. Select “P-Scan Edge.”

Pause Timer

Resume Timer
Temporary Skip Time»
Program Skip »
Group Link »

® DO NOT push [ENT].
5. Push [QUICK].
6. Select “Edit.”

* The edit screen is displayed.
7. Select “FREQ LOW” or “FREQ HIGH” to enter the
lower edge and higher edge, and then push [ENT].

@ Information

» Rotate [DIAL] to select the item, and push [ENT] to

enter the edit screen.

Set the lower edge and higher edge by rotating

[DIAL].

Push [VFO/MHZz] to select the 1 MHz tuning step.

When the “NAME” is entered, it displays on the Scan

Type Select window.

See page iii on how to enter characters.

* When the “TS” (Tuning Step) and/or “MODE” is
blanked, they have used the current setting on the
VFO mode.

The “TS” and “MODE” must be set to match with your
desired signals.

10-7

8. After editing contents, select “<<Write>>.”

» The confirmation dialog is displayed.

9. Select “Yes.”

03: 144.000 - 440.000

® To exit the MENU screen, push [MENU].

TIP:

+ To clear the Program scan range, select “Clear” in step 6.
* When scanning a range where the set “TS” or “MODE”
cannot be used, the preset “TS” or “MODE” setting on

each band is applied.
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VFO Scan

< About the Program Link Scan

This item sets the Link function for 2 or more
Program Scan ranges to sequentially scan during a
Program Link scan. The Program Link scan scans all
frequencies in the scan ranges.

Example settings of the Program Link

Program Scan Program Scan
lower edge upper edge

0:  J———{ 01:144.000-440.000 )
L(Edit Namej L( Delete ]

[Program Link

Program Scan range (p. 10-7)
Program Link number (0 to 9)

® Information

» The Program Link Number screen displays the frequency
range.

* You can add a Link setting by pushing [QUICK] when 2 or
more Program Scan ranges (P-Scan Edge) are entered.

* When there is no Program Scan range (P00 ~ P24)
entered, “Add” is not displayed after pushing [QUICK].

10-8

¢ Setting the Program Link function

[MENU] > SET > Scan > Program Link

1. Push [MENU].
2. Select “Scan” in the “SET” menu.
3. Select “Program Link.”

Program Link »

DUP Check During M »

4. Select a Program Link number “0” ~ “9.”

1: »
2: »
3: »
4: »
5: »

* The Program Link Number screen displays the
preregistered Program Scan ranges.
® When no Program Scan range is selected, “— Blank —”

is displayed.

5. Push [QUICK].

6. Select “Add.”
Add . »
Delete

7. Select the Program Scan range that you want to add.

01: 144.000-148.000

02: 420.000-450.000

8. Repeat steps 6 and 7 until all Program scan ranges that
you want are added.

9. Push [ENT] to save the Program Link.
@ To exit the MENU screen, push [MENU].

TIP:

+ To edit the name of the Program Link, push [QUICK]
and select “Edit Name” at above step 4.

+ To delete the registered Program Scan range from the
Program Link, select “Delete” at above step 6.
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Memory Scan

NOTE: You must enter 2 or more Memory channels
that are not set as Skip channels to start a Memory
scan.

1. Push [MR] to enter the Memory mode.
® For only the ID-52A, pushing [MR] each time selects
the Memory and Weather Channel modes.
2. Hold down [SCAN] for 1 second.
» Opens the Scan Type Select window.
3. Select a scan type.
> 00|

ALL

BAND
MODE
GROUP LINK
GROUP 00

TONE i

v

EN 12:00|

146,010

[ MR 11K, o=

—Blinks

FM

440-000 PSKIP|

* The scan starts.

» The decimal point and ‘BN IW’ blink.

® When receiving a signal, the S-meter displays the
received signal strength.

4. Hold down [SCAN] for 1 second.

» Cancels the scan.

® Pushing [CLR] also cancels the scan.

10-9

<& Scan Type

» ALL:

* BAND:
* MODE:
* DUP:

* GROUP LINK:
+ GROUP 00 ~ 99:
» TONE:

Full scan

Band scan

MODE scan

Duplex scan

(Displayed only when Duplex is set)
Group Link scan

Group scan

Tone scan

(For the Tone Squelch scanning)

® When 2 or more Memory channels that are not set as
Skip channels are entered, the Memory scan is usable.

® The channel set as a Skip channel (PSKIP or SKIP) is
skipped during a scan. (p. 10-11)

TIP:

direction.

scan.

+ During a scan, rotate [DIAL] to change the scanning

* During a scan, hold down [m=Q)] to turn the Lock
function ON or OFF.

« The scan continuously runs, even if you push [MENU]
or [QUICK] during a scan.

* You can select a scan type by rotating [DIAL] while
holding down [SCAN]. Release [SCAN] to start the
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<& About a Group scan name < Setting the Group Link

When a group name is entered to a Memory channel You can sequentially scan the memory groups which
group, the name is displayed in the Scan Type Select are set to link on the MENU screen.

window. (p. 10-9) @ In the default setting, all groups are set to link.

® The name is not displayed during a scan.

® To enter the name, see page 9-11. [MENU] > SET > Scan > Group Link

1. Push [MENU].

When the Group name is entered
Select “Scan” in the “SET” menu.

{PE '

ALL 3. Select “Group Link.”

BAND

MODE Pause Timer 4

GROU INI( Resume Timer »

00: Aviation(RJTT) r Temporary Skip Time »

TONE - P Program Skip »
Group Link 4
P-Scan Edge »

When the Group name is not entered )
4. Select a group, “00” ~ “99,” “S: SKIP CH.”

12:

ALL
BAND [/] 00:
MODE [Z]01:
GROUP LINK [Z]02:
GROUP 00 [Z]03:
TONE 3 7] 04

VFO 05:

5. Push [ENT] to turn the Link function ON or OFF.
» ‘[0 is displayed when the function is set to “ON.”
® Push [QUICK] to quickly turn all the groups ON or

OFF.

® To exit the MENU screen, push [MENU].

10-10
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<O Setting the skip channel

You can set or clear a Skip Channel setting.
The channels that are set as a Skip channel are
skipped during a scan.

1. Push [MR] to enter the Memory mode.

@ For only the ID-52A, pushing [MR] each time selects
the Memory and Weather Channel modes.

Select the memory channel to be skipped.

Push [QUICK].

Select “SKIP.”

Select an option.

aRrwn

faun] EY 12:00
lTﬂ]}]rm -

146.010

[s<#]«—When a Skip channel is set,

i TIROODOT «gKIP” or “PSKIP” is displayed.
440-000 PSKIP|
* OFF: Cancels the Skip Channel setting.

» SKIP: Skipped during a Memory scan.
* PSKIP:  Skipped during both VFO and Memory
scans.

10-11

Temporary skip function

This function temporarily skips unwanted frequencies
(or memory channels) during a scan for the set
period of time or condition, without changing the Skip
Channel setting.

1. While a scan is paused, hold down [MW] for 1
second.
2. Select “Temp Skip Set.”

Adds to SKIP MR Gr

Temp Skip Set

» Sets the frequency or Memory channel as a Skip
Frequency or Channel.
» The scan automatically resumes.

TIP:

* Up to 20 Temporary Skip frequencies or Memory
channels can be set. When the 21st frequency
or Memory channel is set, the oldest setting is
automatically deleted.

* You can also set the Temporary Skip function in the
Quick Menu window.

» The Temporary Skip function is canceled when the
Temporary Skip Timer (Default: 5 min) has passed, or
when selecting “Temp Skip Cancel” in the Quick Menu
window.

(IMENU] > SET > Scan > Temporary Skip Timer)
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1 1 REPEATER AND DUPLEX OPERATIONS

FM Repeater operation

A Repeater receives signals and on one frequency,
and then retransmits them on a different frequency.
When using a Repeater, the transmit frequency is
shifted from the receive frequency by a frequency
offset.

A Repeater can be accessed using the Duplex
function by setting the transceiver’s offset to the same
value as the Repeater’s offset.

See Section 5 for details on accessing a D-STAR
Repeater.

O Setting the Repeater frequency

1. Push [VFO/MHZ] to enter the VFO mode.
2. Push [MODE] to select the FM mode.
*® 5§ 12:00

(]
146.010

PSKIP|
VFO

FM

440-000 PSKIP|

3. Rotate [DIAL] to set the frequency received from a

repeater.

fan] E 12:00|
‘;[EH]DFM 2

145.500

PSKIP|
VFO

FM

440-000 PSKIP|

TIP: For only the USA version
The Auto Repeater function (p. 11-5)
automatically sets the repeater settings (duplex
ON/OFF, duplex direction, tone encoder ON/
OFF). When the function is ON, steps 4 ~ 8 are
not necessary.
@ You can turn OFF the function and manually set the
repeater settings.
(IMENU] > SET > Function > Auto Repeater)

4. Set the offset frequency and the Duplex direction.
(p. 11-4)

faon] £ 12:00
[MAINEY]

145.500

PSKIP|
VFO

FM

440-000 PSKIP|

» The Duplex icon is displayed.

5. Set the Repeater tone. (Default: 88.5 Hz)
(IMENU] > SET > DUP/TONE... > Repeater Tone)
(p. 12-4)

6. Push [MENU] to exit the MENU screen.

Repeater
RX: 144.900 MHz
TX: 145.500 MHz

Station B
RX: 145.500 MHz
TX: 144.900 MHz

Station A
RX: 145.500 MHz
TX: 144.900 MHz

7. Push [QUICK].

8. Select “TONE” and turn ON the Repeater Tone.
[a = 5§ 12:00

AMFM  D-|TONE

145.500

PSKIP|
VFO

FM

440-000 PSKIP|

» The TONE icon is displayed.

9. Hold down [PTT] for 2 seconds.

« If your transmit signal reached the repeater, after
releasing [PTT], you can hear the repeater’s call sign
in morse codes or its announcement.

Accessing Receiving from
a Repeater a Repeater
Push [PTT] for Receives the

2 seconds. Repeater’s call sign
10. Operate in the same way as a simplex call,
alternately transmit and receive.

Receive frequency Transmit frequency

b3 12:00] . * 5 12:00
‘%}]FM D- TONE - Shifts by the FM D- TONE

145.500  cfsetamount 1144 900

FM FM

440.000 s 440.000 e

VFO

TIP:

* When the repeater tone frequency or the frequency
offset is changed, the tone or offset for Auto Repeater
function is also changed.

« If the offset value causes the transmit frequency to be
out of the band, “OFF BAND” is displayed on the display
when you push [PTT], and transmit is inhibited. (p. 11-5)
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FM Repeater operation

< Checking the Repeater input signal

You can check whether or not that another station’s
transmit signal can be received directly (not through a
repeater), by listening to the repeater input frequency.

Hold down [SQL] to listen on the repeater input
frequency.

Display while monitoring

fani]
MEMFM  D- TONE

144.900

=

M

440.000

VFO

PSKIP
VFO

PSKIP

® Information

While monitoring, the status indicator lights green, and an

S/RF meter dot blinks.

» While monitoring, the displayed frequency automatically
changes to the transceiver transmit frequency (repeater
input frequency).

* When the other station’s signal can be directly received,
move to a non-repeater frequency, and use simplex.
(Duplex OFF)

<©1750 Hz tone burst

A 1750 Hz tone is required to access many European
repeaters.

For the ID-52E only
Push [PTT] briefly and release, and then hold down
[PTT] to transmit a 1750 Hz tone burst signal.

1. Push [MENU].
Select “DTMF/T-CALL” in the “SET” menu.

B SPEECH

i DTMF/T-CALL
& QSO/RX Log
#: Function

-
o

* Display
J Sounds

v v v w

3. Select “DTMF Memory.”

DTMF Memory »

DTMF Speed 4

4. Select “T-CALL.”

5. Push [MENU] to exit the MENU screen.

6. Rotate [DIAL] to set the frequency received from a
repeater.

7. Set the offset frequency and the duplex direction.
(p. 11-4)
* The duplex icon is displayed.

8. While holding down [PTT] to transmit, push [SQL]
to transmit a 1750 Hz tone signal.
* Accesses the repeater with a short tone burst.

9. Operate in a normal way.
® In the same way as a simplex call, alternately

transmit and receive.
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Duplex operation

The duplex operation shifts the transmit frequency
up or down from the receive frequency by an offset
amount.

< Setting the frequency offset

NOTE: The frequency offset cannot be changed
when using the DR function.

[MENU] > SET > DUP/TONE... > Offset Freq

1. Push [MENU].
2. Select “DUP/TONE...” in the “SET” menu.

DUP/TONE...
& Scan
i Scope
f- Call Sign
& My Station
o« DV Set

v v v v v RS

3. Select “Offset Freq.”

Offset Freq
Repeater Tone
TSQL Freq
Tone Burst
DTCS Code
DTCS Polarity

4. Rotate [DIAL] to set the offset.

v v wv v | w

® Information

» Set to between 0.000.00 and 59.99500 MHz.

* The selected tuning step in the VFO mode is used to
set the offset.

* To exit the MENU screen, push [MENU].

TIP: If the offset value causes the transmit frequency
to be out of the band, “OFF BAND” is displayed
when you push [PTT], and transmit will be inhibited.

(p. 11-5)

¢ Setting the duplex direction

1. Push [QUICK].
2. Select “DUP.”

% H 12

Band Select
DUP

TONE

TS

ATT

DTMF TX

~ R4

v v v | w

3. Select the duplex direction.
* OFF: For simplex operation (the receive and
transmit frequencies are the same).
* DUP-: The transmit frequency shifts down from the
receive frequency by the offset amount.
* DUP+: The transmit frequency shifts up from the
receive frequency by the offset amount.

ILM

[MAINIZY]

145.500

PSKIP|
VFO

FM

440.000

« Displays “D-" or “D+.”

PSKIP|

< Duplex operation

1. Hold down [SQL] to listen to the transmit
frequency to check whether another station is
transmitting on it, or not.
 The shifted transmit frequency is displayed.

2. Operate in a normal way.
® In the same way as a simplex call, alternately

transmit and receive.

NOTE: When the Auto Repeater function is ON, and
the operating frequency is set out of the repeater
output frequency range, the Duplex mode is
automatically canceled.

(IMENU] > SET > Function > Auto Repeater)
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Auto Repeater function

When the operating frequency falls within the
Repeater output frequency range, the Auto Repeater
function automatically sets the Repeater settings
(Duplex ON/OFF, Duplex direction, Tone encoder ON/
OFF). The Auto Repeater function uses the preset
repeater tone frequency and frequency offset.

NOTE for the USA version transceiver:

When turned ON, the Auto Repeater function

has priority over the manual duplex setting. If the
transmit frequency changes after setting, the Auto
Repeater function may have changed the duplex
setting.

[MENU] > SET > Function > Auto Repeater

1. Push [MENU].
Select “Function” in the “SET” menu.

B SPEECH
! DTMF/T-CALL

% QSO/RX Log

2 Function /|

“ Display
J Sounds

fll v v v
= 5

v -

3. Select “Auto Repeater.”

Power Save

Monitor

Dial Speed-UP
Remote MIC Key
Key Lock

hdl ¥ v ¥

v v
[«

4. Select the option to turn ON the Auto Repeater
function.

OFF

ON (DUP, TONE)

Turns OFF the function.

Turns ON only the duplex

operation. (Default)

* ON (DUP, TONE): Turns ON the duplex operation
and Tone encoder.

® To exit the MENU screen, push [MENU].

* OFF:
+ ON (DUP):

Frequency range and offset direction

Frequency range Shift direction
145.200 ~ 145.495 MHz “DUP-"is set
146.610 ~ 146.995 MHz “DUP-"is set
147.000 ~ 147.395 MHz “‘DUP+” is set
442.000 ~ 444.995 MHz “‘DUP+" is set
447.000 ~ 449.995 MHz “DUP-"is set

Off band indication

If the transmit frequency is out of the amateur band,
the off band indication, “OFF BAND,” is displayed
when you push [PTT]. Check the frequency offset or
duplex direction in this case. (p. 11-4)

[an] * 12:00]

EDFM - D-

AU A [
1

PSKIP
VFO

FM

440 -000 PSKIP
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12 SET MODE

Selecting an item

You can open the MENU screen by pushing [MENU].
You can use the MENU screen to set infrequently
changed values or function settings.

In addition to this page, see pages 12-4 through 12-36
for details of each item’s options and default values.

O MENU screen operation

Selects an item or option.

Switches between the Goes to the
previous tree

MENU screen and l H ‘ N
L
‘ Cj'“"” ﬂﬁ@m{ ./, level.

the standby screen.
Goes to the
|\\\ @\/ e //

Goes to the previous
tree level.

Returns to the

[ENT]
Sets an option.

00000 o
© 080000100008

©00000C|I00000 0
©00000(|0000G

Selects an item or option.

Simplified description—‘Select’ operation

In this manual, the user’s ‘Select’ operation is
simplified, as described below.

Simplified description:
1. Push [MENUI.
2. Select “30min.”

Operation:

1. Push [MENU] to open the MENU screen.

2. Push D-pad(i1) to select “30min,” and then push
[ENT].

next tree level.

60|00 00 gg default setting.
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TIP: The MENU screen is constructed in a tree
structure. You may go to the next tree level, or go
back a level, depending on the selected item.

RECORD FM RADIO

O

cD DV GW

GPS

DUP/TONE...
& Scan
i Scope
= Call Sign
& My Station
o« DV Set

v v v v - REE
a — i

v

it DTMF/T-CALL
& QSO/RX Log
2 Function

& Display

J Sounds

v v v w w
=

v

& Time Set

& sD Card

© Bluetooth Set
E3 Others

>+ v - EBt
5Ll
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Selecting an item

O Selecting an item

Example: Set “Auto Power OFF” to “30 min.” TIP: To return to the default setting
[MENU] > SET > Time Set > Auto Power OFF 1. Push [QUICK] in step 5.
2. Select “Default.”

1. Push [MENUJ.
2. Select “SET”

3. Select “Time Set.”

€ Time Set vi

SD Card »
© Bluetooth Set »
E3 Others »

» The setting returns to the default.

4. Select “Auto Power OFF.”

Date/Time »
GPS Time Correct »
UTC Offset »

Auto Power OFF »

5. Select “30min.”

 Sets the option, then goes back to a tree level.
(The TIME SET screen is displayed.)
® To exit the MENU screen, push [MENU].

12-3
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NOTE: The default settings shown below are for the USA transceiver version. The default settings may differ,

depending on your transceiver version.

DUP/TONE...

Offset Freq (Default: 0.600.00%)

DTCS Code (Default: 023)

[MENU] > SET > DUP/TONE... > Offset Freq

Sets the frequency offset for Duplex (repeater)

operation to between 0.000.00 and 59.995.00 MHz.

® Push [VFO/MHZz] to select the 1 MHz tuning step.

® The Duplex shift direction (DUP—/DUP+) (p. 11-4) or the
tuning step is set in the Quick Menu window.

® When the DR function is ON, editing is disabled.

* The default value may differ, depending on the frequency
band (selected as the MAIN band before entering the
MENU screen) and the transceiver version.

Repeater Tone (Default: 88.5)

[MENU] > SET > DUP/TONE... > Repeater Tone

Selects a repeater tone frequency for repeater access
and other functions.
You can select 50 tone frequencies (67.0 ~ 254.1 Hz).

TSQL Freq (Default: 88.5)

[MENU] > SET > DUP/TONE... > TSQL Freq

Selects a CTCSS tone frequency for the Tone Squelch
function.
You can select 50 tone frequencies (67.0 ~ 254.1 Hz).

+ Selectable Repeater Tone/TSQL frequencies
(Unit: Hz)

67.0 88.5 | 1148 | 151.4 | 177.3 | 203.5 | 250.3
69.3 91.5 | 118.8 | 156.7 | 179.9 | 206.5 | 254.1
71.9 94.8 | 123.0 | 159.8 | 183.5 | 210.7
74.4 974 | 127.3 | 162.2 | 186.2 | 218.1
77.0 | 100.0 | 131.8 | 165.5 | 189.9 | 225.7
79.7 | 103.5 | 136.5 | 167.9 | 192.8 | 229.1
825 | 107.2 | 141.3 | 171.3 | 196.6 | 233.6
854 | 1109 | 146.2 | 173.8 | 199.5 | 241.8
Tone Burst (Default: OFF)

[MENU] > SET > DUP/TONE... > Tone Burst

Turns the Tone Burst function ON or OFF in the FM
mode when using the Tone Squelch function.

» OFF: When you transmit a signal that superimposes
the CTCSS tone, the other station may hear

a short burst of noise from their receiver, just
after you stop transmitting.

When you transmit a signal that superimposes
the CTCSS tone, the function mutes the noise
from being heard in the other station’s receiver.

* ON:
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[MENU] > SET > DUP/TONE... > DTCS Code

Selects a DTCS (both encoder/decoder) code for the
DTCS Squelch.
You can select a total of 104 codes (023 ~ 754).

« Selectable DTCS codes

023 | 072 | 152 | 244 | 311 | 412 | 466 | 631
025 | 073 | 155 | 245 | 315 | 413 | 503 | 632
026 | 074 | 156 | 246 | 325 | 423 | 506 | 654
031 114 | 162 | 251 | 331 | 431 | 516 | 662
032 | 115 | 165 | 252 | 332 | 432 | 523 | 664
036 | 116 | 172 | 255 | 343 | 445 | 526 | 703
043 | 122 | 174 | 261 | 346 | 446 | 532 | 712
047 | 125 | 205 | 263 | 351 | 452 | 546 | 723
051 | 131 | 212 | 265 | 356 | 454 | 565 | 731
053 | 132 | 223 | 266 | 364 | 455 | 606 | 732
054 | 134 | 225 | 271 | 365 | 462 | 612 | 734
065 | 143 | 226 | 274 | 371 | 464 | 624 | 743
071 | 145 | 243 | 306 | 411 | 465 | 627 | 754

DTCS Polarity (Default: Both N)

[MENU] > SET > DUP/TONE... > DTCS Polarity

Selects the DTCS polarity to use for transmitting (TX)
and receiving (RX).

» Both N: Normal polarity is used for both TX and RX.
* TN-RR: Normal polarity is used for TX, Reverse
polarity for RX.

Reverse polarity is used for TX, Normal
polarity for RX.

Reverse polarity is used for both TX and
RX.

* TR-RN:

* Both R:

Digital Code (Default: 00)

[MENU] > SET > DUP/TONE... > Digital Code

Selects the digital code for Digital Code Squelch.
You can select a total of 100 codes (00 ~ 99).
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Pause Timer (Default: 10sec)

[MENU] > SET > Scan > Pause Timer

Selects the Scan Pause Timer. When receiving a
signal, the scan pauses for this set period of time.

@ Individually selectable for A band and B band.

+ 2sec ~ 20sec: When a signal is received, the scan
pauses for 2 ~ 20 seconds (in 2
second steps).

The scan pauses on a received
signal until the signal disappears.

* HOLD:

Resume Timer (Default: 2sec)

Program Skip

[MENU] > SET > Scan > Program Skip

Turns the Program Skip Scan function ON or OFF for

a VFO scan. This function enables the transceiver to

skip the unwanted frequencies that are entered as a

Memory channel and are set to “PSKIP.”

@ Individually selectable for A band and B band.

* OFF: The transceiver scans all frequencies.

* ON: The transceiver does not scan frequencies set
as “PSKIP” frequencies.

(Default: ON)

Group Link  (Default: [v] 00 ~ [v] 99/v] S: SKIP CH)

[MENU] > SET > Scan > Resume Timer

Selects the scan Resume Timer. When a received
signal disappears, the scan resumes for this set
period of time.

@ Individually selectable for A band and B band.

» Osec: The scan resumes immediately after
the signal disappears.

The scan resumes 1 ~ 5 seconds after
the signal disappears.

The scan remains paused for the
“Pause Timer” setting, even if the
signal disappears.

NOTE: Rotate [DIAL] to resume the scan.

* 1sec ~ 5sec:

* HOLD:

Temporary Skip Timer (Default: 5min)

[MENU] > SET > Scan > Temporary Skip Timer

Selects the effective time of the Temporary Skip
function.

@ Individually selectable for A band and B band.

@ This timer is activated for the VFO scan, Memory scan,

and DR scan.

* 5min/10min/15min: The Temporary Skip channels
are skipped for the set period
of time.

The Temporary Skip channels
are skipped until the Scan is
stopped.

The Temporary Skip channels
are skipped until the
transceiver is turned OFF.

» While Scanning:

* While Powered ON:
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[MENU] > SET > Scan > Group Link

Selects groups to be scanned during a Group Link
Scan. The Group Link function scans all channels in
the selected groups.

Select a group, A ~ Z, and then push [ENT] to turn the
Link function ON or OFF.

@ Displays “v” when the function is set to ON.

@ Individually selectable for A band and B band.

P-Scan Edge

[MENU] > SET > Scan > P-Scan Edge

You can delete, copy, or edit the upper and lower

frequencies for programmed scans.

The transceiver has a total of up to 25 frequency

ranges (00 ~ 24), and you can set the scan name,

tuning step, and operating mode for each scan edge.

® The default setting may differ, depending on the
transceiver version.
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Scan

Program Link

[MENU] > SET > Scan > Program Link

Sets the link function for two or more Program Scan
Edge ranges to be sequentially scanned during

a Program Link Scan. The link function scans all
frequencies in the scan range.

Default settings of the Program Link:

01: 144.000-148.000 j

02: 430.000-450.000 ]

Program Link number (0 to 9)  Program Scan Edge range

[Program Link

® The default setting may differ, depending on the
transceiver version.

® When only one Program Scan Edge range is entered, or
there is no Programmed Scan Edge is left, “Add” is not
displayed after pushing [QUICK].

DUP Check During MR Scan (Default: OFF)

[MENU] > SET > Scan > DUP Check During MR Scan

During a Memory scan, selects whether or not to scan
the offset frequency if Duplex is set on the channel.

* OFF: The offset frequency is not scanned.

* ON: The offset frequency is also scanned.

12-6
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Scope Mode (Default: Center)

FIX Mode Center Frequency

[MENU] > SET > Scope > Scope Mode

Selects the Band Scope display mode.

» Center: Displays signals around the
operating frequency within the
selected span.

The operating frequency is always
displayed in the center of the screen.

Displays signals within a specified
frequency range.

Displays signals within a specified
frequency range. When the operating
frequency moves outside of the
screen, the displayed frequency
range is automatically shifted.

» FIX:

- Scroll (FIX):

Displayed Steps (Default: £15 Steps)

[MENU] > SET > Scope > Displayed Steps

Selects the number of displayed steps around the
center frequency in the Band scope.

® The tuning step depends on the TS setting.

» +15 Steps:

I e [T —— T —
T r T ——+tTr 7T 1T — 7T

» +20 Steps:
T R SN WY

Waterfall Function (Default: ON)

[MENU] > SET > Scope > Waterfall Function

Selects whether or not to use the waterfall display in
the single display when the Band Scope function is
ON.

* OFF: Turns OFF the Waterfall display.

* ON: Turns ON the Waterfall display.

Waterfall Speed (Default: Fast)

[MENU] > SET > Scope > Waterfall Speed

Selects the waterfall speed.
 Slow: Sets the Waterfall speed to Slow.
» Fast: Sets the Waterfall speed to Fast.
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[MENU] > SET > Scope > FIX Mode Center Frequency

Sets the center frequency of the FIX mode Band

Scope for each band.

® The selected tuning step in the VFO mode is used to set
the center frequency. To select the tuning step, open the
Quick Menu window on the Standby screen.

® To return to the default setting, push [QUICK], and
then select “Default” on the “Center Freq. (FIX)” or
“FREQUENCY” screen.

® The default setting may differ, depending on the
transceiver version.

AF Output (DUAL/AIR Band) (Default: OFF)

[MENU] > SET > Scope > AF Output (DUAL/AIR Band)

Selects whether or not to momentarily output the

received audio during a sweep by the Band Scope

function, when using the Dualwatch function or

selecting the AIR band.

* OFF: No audio is output during the sweep.

* ON: The received audio is momentarily output
during the sweep.
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Call Sign

Call Sign

[MENU] > SET > Call Sign

Set or view the “UR,” “R1,” “R2,” and “MY” call signs
to use in the DV mode.

When not using the DR function, sets the call signs on
this screen.

For Simplex operation (DV mode)
You can set the “UR” and “MY” call signs.

For Duplex (repeater) operation

(DV mode/DR function)

You can set only the “MY” call sign when the DR
function is ON.

<To manually set the Duplex (repeater) operation>

Example: Making a gateway CQ call to Kirkland
repeater (N71H B) from the Hirano repeater
(JP3YHH A), in the DV mode.
® Before starting to set the call sign, set the frequency of
your Access repeater and duplex direction on the standby
screen.

TIP: When the Digital Repeater Set function is ON,
the repeater call sign is automatically set.
(IMENU] > SET > DV Set > Digital Repeater Set)

Step 1. Setting the call sign “R1”

1. Select “R1.”
® DO NOT push [ENT].
2. Push [QUICK].
3. Select “Edit.”
4. Rotate [DIAL] to enter the first character.
® Selectable characters are alphanumeric characters
and symbol (“/").
Push D-pad (5) to move the cursor.
Repeat steps 4 and 5 to enter the repeater call
sign of up to 8 characters, including a space.
(Example: JP3YHH A)
7. After entering, push [ENT].
» Saves the entered repeater call sign.

oo
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Step 2. Gateway “R2” setting

1. Select “R2.”
® To manually enter a call sign, push [QUICK], then
select “Edit.”
2. Select “GW.”

About the RPT2 SELECT screen

NOT USED* For local area calls

To select the gateway call sign from the

€3 repeater list.

To select the repeater that has the

Repeater name same gateway as the “R1” repeater.

Step 3. Destination “UR” setting

1. Select “UR”
® To manually enter a call sign, push [QUICK], then
select “Edit.”
2. Select “Gateway CQ.”
3. Select a repeater group where your destination
repeater is listed.
4. Select a destination repeater.

About the YOUR SELECT screen

To select “CQCQCQ" to make a non-

cQcQcQ : o
call sign specific call.
Gateway CQ* To.select Gateway.CQ to make a call
using the repeater list.
. To select the destination “UR” call sign
Ve E S using the Your Call Sign memory.
. To select the destination “UR” call sign
RO R using RX History.
TX History To select the destination “UR” call sign

using TX History.

* Not displayed in the Simplex mode.
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My Station

My Call Sign

TX Message

[MENU] > SET > My Station > My Call Sign

The transceiver has a total of 6 memories to save

your own call signs for use in the DV mode. You can

enter a call sign of up to 8 digits.

Also, you can enter a note of up to 4 characters, for

operating transceiver type, area, and so on.

® See D-STAR GUIDE in the Basic manual for MY Call Sign
entry.

@ To select another My Call Sign, push D-pad(i1) to select
a call sign, and then push [ENT] on the MY CALL SIGN
screen.
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[MENU] > SET > My Station > TX Message

The transceiver has a total of 5 memories to save
short messages for transmission with your voice
signal in the DV mode.

Enter a message of up to 20 alphanumeric characters
for each memory.

® See page 5-17 for TX message entry.

@ To select other TX message, push D-pad(i1) to select

a memory, and then push [ENT] on the TX MESSAGE
screen.

TIP: To transmit no message, select “OFF.”
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DV Set

RX Bass (Default: Normal)

Auto Reply (Default: OFF)

[MENU] > SET > DV Set > Tone Control > RX Bass

Selects the receive audio bass filter level.
* Cut: Reduces low frequencies.

* Normal: Normal tone balance.

* Boost: Increases low frequencies.

RX Treble (Default: Normal)

[MENU] > SET > DV Set > Tone Control > RX Treble

Selects the receive audio treble filter level.
» Cut: Reduces high frequencies.

* Normal: Normal tone balance.

» Boost: Increases high frequencies.

RX Bass Boost (Default: OFF)

[MENU] > SET > DV Set > Tone Control >
RX Bass Boost

Turns the Receive Audio Bass Boost function ON or

OFF.

@ This function is different from the “Boost” setting of “RX
Bass.”

* OFF: Turns OFF the function.

* ON: This function boosts the receive audio bass.

TX Bass (Default: Normal)

[MENU] > SET > DV Set > Tone Control > TX Bass

Selects the transmit audio bass filter level.
* Cut: Reduces low frequencies.

* Normal: Normal tone balance.

» Boost: Increases low frequencies.

TX Treble (Default: Normal)

[MENU] > SET > DV Set > Tone Control > TX Treble

Selects the transmit audio treble filter level.
» Cut: Reduces high frequencies.

* Normal: Normal tone balance.

» Boost: Increases high frequencies.
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[MENU] > SET > DV Set > Auto Reply

Selects an option for the Automatic Reply function in

the DV mode. This function automatically replies to a

call addressed to your own call sign (MY), even if you

are away from the transceiver.

* OFF: Turns OFF the function.

* ON: Replies with your own call sign (MY).

(No audio reply is sent)

Replies with your call sign (MY) and any

Auto Reply message recorded on the

microSD (up to 10 seconds).

® The transmitted audio can be monitored.

@ If no microSD card is inserted, or no
message is recorded, only your call sign is
transmitted.

Replies with your own call sign and

transmits your position data using the

internal GPS receiver.

® When “GPS Select” is set to “OFF” or
“Manual,” the internal GPS receiver is
temporarily turned ON.

® When “ON” or “Voice” is selected, the Automatic Reply
function is automatically turned OFF when you push
[PTT]. When “Position” is selected, the Automatic Reply
function is not turned OFF, even if you push [PTT].

* Voice:

* Position:

DV Data TX (Default: Auto)

[MENU] > SET > DV Set > DV Data TX

Selects whether to manually or automatically transmit

data in the DV mode.

* PTT: Push [PTT] to manually transmit data.

+ Auto: When data is input from a PC through the
[USB] port, the transceiver automatically
transmits it.

Fast Data (Default: OFF)

[MENU] > SET > DV Set > DV Fast Data > Fast Data

Selects whether or not to use the DV Fast Data

function for data communication in the DV mode.

The DV Fast Data function uses the data and the

audio frames to send data approximately 3.5 times

faster than the normal speed. So, no audio can be

sent.

* OFF: Sends data at a slow speed
(approximately 950 bps).

* ON: Sends data at a fast speed
(approximately 3480 bps).

@ Even if “ON” is selected, when you push [PTT], the data
is sent at the slow speed, because the audio frame is
used for the audio transmission.

® The GPS data speed is set in “GPS Data Speed.”
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DV Set

GPS Data Speed (Default: Slow)

DV Auto Detect (Default: OFF)

[MENU] > SET > DV Set > DV Fast Data >
GPS Data Speed

Sets the GPS data speed when the data is sent using

the DV Fast Data function.

» Slow: Sends GPS data at slow speed
(approximately 950 bps).

» Fast: Sends GPS data at fast speed
(approximately 3480 bps).

TX Delay (PTT) (Default: 2sec)

[MENU] > SET > DV Set > DV Fast Data >
TX Delay (PTT)

Sets the time for when the transceiver returns to
receive after sending DV data in the DV Fast Data
mode using [PTT].

* OFF: After releasing [PTT], the transceiver
returns to receive.
* 1 ~ 10sec: After releasing [PTT], the transceiver

sends data using the DV Fast Data
mode for this set period.

When the TX data is completely sent
within this set period, the transceiver
automatically returns to receive.

NOTE: This function is usable only when “DV Data
TX" is set to “PTT.”

Digital Monitor (Default: Auto)

[MENU] > SET > DV Set > Digital Monitor

Selects a receive mode when pushing [SQL] in the DV
mode.

» Auto: Receives in the DV mode or the FM mode,
depending on the received signal.

+ Digital: Receives in the DV mode.

+ Analog: Receives in the FM mode.

Digital Repeater Set (Default: ON)

[MENU] > SET > DV Set > Digital Repeater Set

Turns the Digital Repeater Set function ON or OFF.
When accessing a repeater that has a call sign that
is different from the transceiver’s setting, this function
reads the repeater’s transmit signal and automatically
sets the repeater call sign.

* OFF: Turns OFF the function.

* ON: Automatically sets the repeater call sign.
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[MENU] > SET > DV Set > DV Auto Detect

Turns the DV mode Automatic Detect function ON

or OFF. When in the DV mode, if you receive a non-

digital signal, this function automatically sets the

operating mode to the FM mode.

* OFF: Turns the function OFF. The operating mode
is fixed to the DV mode.

* ON: Automatically selects the FM mode for
temporary operation.

RX Record (RPT) (Default: ALL)

[MENU] > SET > DV Set > RX Record (RPT)

The transceiver can record the data of up to 50
individual calls. When the received signal includes a
status message (“UR?” or “RPT?”) that is sent back
from the access repeater, you can record up to 50
messages, or only the last call, in the Received Call
Record.

« ALL: Records up to 50 calls.

+ Latest Only: Records only the last call.

[RX>CS] Key (Default: Call Sign Capture)

[MENU] > SET > DV Set > [RX>CS] Key

Selects the [RX—CS] Call Sign Capture key operation
when you hold down.

+ Call Sign Capture: While holding down, the RX
History is displayed. After
releasing, the last received call
station’s call sign is set to “TO”
(destination).

When you hold down for 1
second, the RX History is
displayed. Rotate [DIAL] to
select a call sign to set to “TO”
(destination), and then push
[ENT].

+« RX>CS List:

BK

[MENU] > SET > DV Set > BK

The Break-in (BK) function enables you to break

into a conversation, where the two other stations are

communicating with call sign squelch enabled.

* OFF: Turns OFF the function.

* ON: Turns ON the function.

® The BK function is automatically turned OFF when the
transceiver is turned OFF.

(Default: OFF)
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DV Set

EMR (Default: OFF)

[MENU] > SET > DV Set > EMR

The Enhanced Monitor Request (EMR) function

enables all transceivers that receive an EMR signal

in the DV mode automatically to open their squelch to

receive the signal.

* OFF: Turns OFF the function.

* ON: Turns ON the function.

® The EMR function is automatically turned OFF when the
transceiver is turned OFF.

EMR AF Level (Default: 19)

[MENU] > SET > DV Set > EMR AF Level

Sets the audio output level when an EMR
communication mode signal is received. When an
EMR signal is received, the audio will be heard at the
programmed level, or the transceiver’s audio level,
whichever is higher.

To disable the setting, set to “0.”

NOTE: After an EMR signal disappears, the audio
level will remain at the EMR level. In this case, rotate
[VOL] to adjust the audio level.
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SPEECH

RX Call Sign SPEECH (Default: ON (Kerchunk))

DIAL SPEECH (Default: OFF)

[MENU] > SET > SPEECH > RX Call Sign SPEECH

Turns the RX Call Sign Speech function ON or OFF
for calls received in the DV mode.

® Information

» When the Digital Squelch function is used, the calling

station’s call sign is not announced if the received signal

is not addressed to your call sign, or does not include a

matching digital code.

When you receive a signal from a repeater (“UR?” or

“RPT?"), the caller station’s call sign is not announced.

* While scanning, the transceiver resumes the scan during
an announcement.

» Even if a note is entered after the call sign, it is not
announced.

* When you receive a signal during an announcement, the
transceiver cancels the announcement, and you can hear
the received audio.

» OFF: The caller station’s call sign is not
announced, even when a call is
received.

* ON (Kerchunk): The caller station’s call sign is
announced only when they make a
quick transmission.

The caller station’s call sign is

always announced.

- ON (All):

RX>CS SPEECH (Default: ON)

[MENU] > SET > SPEECH > RX>CS SPEECH

Turns the RX>CS Speech function ON or OFF.

The RX>CS Speech function announces the station

call sign that is selected from a Received Call Record

by pushing [RX—CS].

@ If a call is received during an announcement, the received
audio is muted, and the audio is not recorded onto the
microSD card.

* OFF: The station call sign is not announced.
» ON: The station call sign is announced.
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[MENU] > SET > SPEECH > DIAL SPEECH

Turns the Dial Speech function ON or OFF.

The Dial Speech function announces the frequency or

repeater call sign that is selected by rotating [DIAL].

® When using the DR function, the frequency is announced
if the Simplex mode is selected or the FM repeater does
not have a call sign.

® When you receive a signal during an announcement, the
transceiver cancels the announcement, and you can hear
the received audio.

* OFF: The frequency or repeater call sign is not
announced.

* ON: The frequency or repeater call sign is
announced, 1 second after rotating [DIAL].
In the VFO, Memory, or Call Channel mode,
the frequency is announced.
When using the DR function, the repeater call
sign is announced.

MODE SPEECH (Default: OFF)

[MENU] > SET > SPEECH > MODE SPEECH

Turns the operating mode announcement ON or OFF.
® During a VFO scan, the operating mode is announced
when you change the mode.
» OFF: The selected operating mode is not
announced.
* ON: The selected operating mode is announced.

SPEECH Language (Default: English)

[MENU] > SET > SPEECH > SPEECH Language
Sets the speech language to English or Japanese.

Alphabet

[MENU] > SET > SPEECH > Alphabet

Selects the type of phonetic announcement.

* Normal: Normal code is used.
(Example: A as eh, B as bee)

* Phonetic Code: The Phonetic code is used.
(Example: A as Alfa, B as Bravo)

(Default: Normal)
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SPEECH

SPEECH Speed (Default: Fast)

[MENU] > SET > SPEECH > SPEECH Speed
Sets the speech speed to Fast or Slow.

SPEECH Level (Default: 7)

[MENU] > SET > SPEECH > SPEECH Level

Sets the Voice Synthesizer audio output level to

between 0 (OFF), 1 (minimum) and 9 (maximum).

® The voice synthesizer audio output level is linked with the
[VOL] setting from the minimum audio volume up to this
set level.
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DTMF/T-CALL

You can set the DTMF tone code and DTMF Memory
channel for DTMF tone operation.
See page 15-5 for details.

DTMF Memory (Default: d0)

[MENU] > SET > DTMF/T-CALL > DTMF Memory

Displays a list of the DTMF Memory channels.
» T-CALL: 1750 Hz tone burst signal
* d0 ~ d#: DTMF memory channel list

DTMF Speed (Default: 100ms)

[MENU] > SET > DTMF/T-CALL > DTMF Speed

Selects the DTMF transmit speed.

* 100ms: Transmits the DTMF codes at about 100
milliseconds per code
(5 characters per second).

* 200ms: Transmits the DTMF codes at about 200
milliseconds per code
(2.5 characters per second).

» 300ms: Transmits the DTMF codes at about 300
milliseconds per code
(1.6 characters per second).

* 500ms: Transmits the DTMF codes at about 500
milliseconds per code
(1 character per second).
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QSO/RX Log

QSO Log (Default: ON)

Separator/Decimal (Default: Sep[,] Decl.])

[MENU] > SET > QSO/RX Log > QSO Log

Selects whether or not to make a communication log
on a microSD card. The communication log is made
on the card, and saved in the “csv” format.

® This function requires a microSD card (User supplied).

» OFF: The QSO Log function is OFF.

* ON: The transceiver makes a log on the microSD
card. The transceiver starts making a log
when you begin talking.

TIP:

» The folder name is automatically created, as
[ID-52\QsoLog].

» The file name is automatically created, as shown in the
example below:
Log start date and time: 1st November 2021 15:30:00
File name: 20211101_153000.csv

» The log contents are not displayed on the transceiver.

* You can display the log contents on a PC.

RX History Log (Default: OFF)

[MENU] > SET > QSO/RX Log > RX History Log

Selects whether or not to make a DV mode’s receive
history log on a microSD card. The receive history log
is made on a microSD card, and saved in the “csv”
format.

@® This function requires a microSD card (User supplied).

» OFF: The RX History Log function is OFF

* ON: The transceiver makes a DV mode’s receive
history log on the microSD card. The
transceiver starts making a receive history log
when you finish talking.

TIP:

» The folder name is automatically created, as
[ID-52\RxLog].

* The file name is automatically created, as shown in the
example below:
Log start date and time: 1st November 2021 15:30:00
File name: 20211101_153000.csv

» The log contents are not displayed on the transceiver.

* You can display the log contents on a PC.
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[MENU] > SET > QSO/RX Log > CSV Format >
Separator/Decimal

Selects the separator and the decimal character for

the CSV format.

® The default value may differ, depending on the
transceiver version.

» Sep [,] Dec [.]: Separator is “,”

» Sep [;] Dec [.]: Separator is “;”

“.”

» Sep [;] Dec [,]: Separator is

“

and Decimal is “.

“

and Decimal is “.

“

and Decimal is ¢,

Date (Default: mm/dd/yyyy)

[MENU] > SET > QSO/RX Log > CSV Format >
Date

Selects the date format between “yyyy/mm/dd,”

“mm/dd/yyyy,” and “dd/mm/yyyy.”

(y: year, m: month, d: day)

® The default value may differ, depending on the
transceiver version.
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QSO/RX Log

The call log contents are shown below:

Contents Example Descriptions

TX/RX TX RX Transmission and reception

Date 11/01/2021 13:51:48 | 11/01/2021 13:51:48 | Date and time the call was started.

Frequency 438.010000 438.010000 Operating frequency

Mode DV DV Operating mode (FM/FM-N/DV)

. Your latitude (unit: degrees)
My Latitude 134764667 34.764667 (+: North latitude, —: South latitude)
. Your longitude (unit: degrees)

My Longitude 135.375333 135.375333 (+: East longitude, — West longitude)

My Altitude 505 505 Your altitude (unit: n_1eters)
Records to one decimal place.

RF Power LOW (Blank) TX output power level

S meter (Blank) S0 The relative signal strength of the receive signal
(in 14 levels)

RPT Call Sign | JP3YHJ JP3YHJ A Repeater call sign (DV mode only)

TX Call Sign cQcacaQ (Blank) TX Call sign (DV mode only)

RX Call Sign (Blank) JA3YUAA/52 RX Call sign/Note (DV mode only)
Caller’s latitude, if sent. (unit: degrees)

RX Latitude (Blank) 34.764667 (+: North latitude, —: South latitude)
Records only when you receive in the DV mode.
Caller’s longitude, if sent. (unit: degrees)

RX Longitude (Blank) 135.375333 (+: East longitude, —: West longitude)
Records only when you receive in the DV mode.

. Caller’s altitude, if sent. (unit: meters)
RX Altitude (Blank) 30.5 Records only when you receive in the DV mode.
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QSO/RX Log

The RX log contents are shown below:

Contents Example Descriptions
Frequency 438.010000 RX Frequency
Mode DV Operating mode (DV mode is fixed)
Caller JASYUAA Call sign of the caller station (up to 8 characters)
/ ID52 Note after the call sign (up to 4 characters)
Called cQcaca Call sign of the called station
Rx RPT1 JP3YHH G ?:I?zis;nri?(;sterrlgiglsaiggao: gggactzll.er station, or the gateway repeater
Rx RPT2 JP3YHH A Access repeater call sign of the called station
Message Hello CQ D-STAR! | Message included in the received call (up to 20 characters)
Status (Blank) Normal: blank, Uplink: “RPT UP”, Access repeater reply: “UR?” or “RPT?”

Received date

11/01/2021 13:51:48

Date and time the call was received
The format may differ, depending on the setting.

BK * BK call: “*”, Normal call: Blank

EMR * EMR call: “*”, Normal call: Blank

Latitude 34.764667 Caller’s latitude, if sent. (unit: degrees) (+: North latitude, —: South latitude)
Longitude 135.375333 Caller’s longitude, if sent. (unit: degrees) (+: East longitude, —: West longitude)
Altitude 30.5 Caller’s altitude, if sent. (unit: meters) Records to one decimal place.
SSID -A Caller’s SSID, if sent. (0, -1 to -15, -Ato -Z)

D-PRS Symbol Car Icon: Converts to text, None: Code

Course 123 Caller’s course (unit: degrees)

Speed 23.5 Caller’s speed (unit: km/h) Records to one decimal place.

Power 49 TX power (unit: watts)

Height 24 Antenna height (unit: meters)

Gain 6 Antenna gain (unit: dB)

Directivity Omni Antenna directivity (Omni, 45, 90, 135, 180, 225, 270, 315, or 360)
Object/ltem Name |HAM FES Object name or Item name (up to 9 characters)

Data Type Live Object Data type of Object or Item (Live or Kill)

Temperature 20.5 Temperature (unit: °C) Records to two decimal places.

Rainfall 253.75 Rainfall (unit: mm) Records to two decimal places.

Rainfall (24 Hours) |253.75 Rainfall (24 Hours) (unit: mm) Records to two decimal places.
Rainfall (Midnight) |253.75 Rainfall (Midnight) (unit: mm) Records to two decimal places.

Wind Direction 315 Wind Direction (unit: degrees)

Wind Speed 10.0 Wind Speed (unit: m/s) Records to one decimal place.

Gust Speed 10.0 Gust Speed (unit: m/s) Records to one decimal place.

Barometric 1013.0 Barometric (unit: hPa) Records to one decimal place.

Humidity 85 Humidity (unit: %)

GPS Time Stamp | 12:00:00 Time data that the caller station acquires along with the position data

GPS Message

Osaka City/ID-52

Caller is “NMEA”: Records the GPS message
Caller is “D-PRS: Records the D-PRS comment
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Power Save (Default: Auto (Short))

Dial Speed-UP (Default: ON)

[MENU] > SET > Function > Power Save

Sets the Power Save function to reduce the current
drain and conserve battery power. When the Power
Save function is activated, the call sign or the
beginning of the signal may not be received correctly.

* OFF: Turns OFF the function.
« Auto (Short): Sets the Power saving time to
“Short.”
15 ms
Standby -
Reception— === =
Disabled
75 ms

No signal is received
for 5 seconds.

+ Auto (Middle): Sets the Power saving time to

“Middle.”
15 ms 15 ms
Standby - -
Reception-»jl—l_|l—|l_|—,'¢J_|
Disabled | 75 ms | 150 ms

T 60's
No signal is received
for 5 seconds.

» Auto (Long): Sets the Power saving time to

“Long »
15 ms 15 ms
Standby - ’||—|k
Reception— - -- I | I
Disabled | 75 ms | 300 ms
T 60's

No signal is received
for 5 seconds.

NOTE: The Power Save function is disabled when:
Using an external DC power source.

Scanning.

Using the DV Gateway function.

Using the VOX function.

Monitor

[MENU] > SET > Function > Monitor

Selects an option for the [SQL] Monitor function.

(Basic manual Section 3)

 Push: Hold down [SQL] to monitor the frequency.
Release to stop monitoring.

* Hold: Push [SQL] momentarily to monitor the
frequency and push momentarily again to
cancel it.

(Default: Push)
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[MENU] > SET > Function > Dial Speed-UP

Turns the Dial Speed Acceleration ON or OFF.

The acceleration automatically increases the tuning
speed when you rapidly rotate [DIAL].

* OFF: Turns OFF the function.

* ON: Turns ON the function.

Auto Repeater (Default: ON (DUP))

[MENU] > SET > Function > Auto Repeater

The Auto repeater function automatically turns the

duplex operation and tone encoder ON or OFF.

@ This item is displayed in only the USA version.

» OFF: Turns OFF the function.

+ ON (DUP): Turns ON the duplex settings
only.

* ON (DUP, TONE): Turns ON the duplex settings
and the tone encoder function.

Remote MIC Key

[MENU] > SET > Function > Remote MIC Key

The function assignments for the [A], [B], [A], and
[V] keys on the optional HM-75LS REMOTE CONTROL
SPEAKER MICROPHONE can be changed.

See pages 12-19 and 12-20 for the assignable key
functions.

» During RX/Standby: The assigned key function is
enabled while receiving or in
the standby mode.

(Default: [A]l: BAND

[B]: VFO/MR

[A]: UP

[V]: DOWN)
The assigned key function is
enabled while transmitting.
(Default: [A]:  T-CALL

[B]: -

[AL -

[V]: )

TIP: Volume level adjustment while monitoring

* When “VYOL UP”/“VOL DOWN?” are assigned, push
these keys to adjust the volume level.

* When “VOL UP"/*VOL DOWN?” are not assigned, but
“UP”/“DOWN?” are assigned, push these keys to adjust
the volume level.

* When “VOL UP’/*VOL DOWN"/“UP”/*“DOWN?” are not
assigned, push [A)/[V] to adjust the volume level, if
“Monitor (Push)” or “Monitor (Hold)” is not assigned to
[AVIV].

* During TX:
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The assignable key functions
* During RX/Standby

Function Descriptions
- No function
UP Push to increase the frequency, Memory channel, repeater, or station call sign.
DOWN Push to decrease the frequency, Memory channel, repeater, or station call sign.
VOL UP Push to increase the volume level.
VOL DOWN Push to decrease the volume level.
SQL UP Push to increase the squelch level.
SQL DOWN Push to decrease the squelch level.
Monitor (Push) Hold down to open the squelch. Release to close the squelch.
Monitor (Hold) Push to open or close the squelch.
CALL Push to select a Call Channel mode.

MR (00-00 CH)

In the Memory mode, push to select Memory channel 00-00.

MR (00-01 CH)

In the Memory mode, push to select Memory channel 00-01.

VFO/MR Push to select the VFO mode and the Memory mode.
DR Push to turn the DR function ON or OFF.
FROM (DR) In the DR screen, push to select “FROM.”
TO (DR) In the DR screen, push to select “TO.”
Home CH Push to directly select the Home Channel that is set to the selected mode (VFO/Memory) or DR screen.
® While in the Call Channel mode, or when no Home CH is set, an error beep sounds.
BAND Push to select an operating band.
SCAN Push to start the previously selected scan. While scanning, push to stop the scan.
. Push to set the frequency to be skipped while scanning.
Temporary Skip The selected frequencies are temporarily skipped for faster scanning.
Hold down for 1 second to set the last calling station’s call sign to “TO” (destination).
@ If “[RX—CS] Key” is set to “RX > CS List,” the received call sign is not captured. The RX History list
RX>CS is displayed instead.
@ To select the call sign in the RX History using the optional remote control speaker microphone,
assign “UP”/"“DOWN.”
* In the VFO, Memory, or Call Channel mode, push to announce the frequency and operating mode.
* In the DR screen, push to announce the call sign.
SPEECH @ If the Simplex mode is selected, the frequency is announced.
If the FM repeater is selected, the frequency and operating mode, or the call sign and operating
mode are announced.
* Push to set the A or B band as the MAIN band.
MAIN/DUAL » Hold down for 1 second to turn the Dualwatch function ON or OFF.
MODE Push to select the operating mode.
LOW Push to select the transmit output power.
DUP Push to turn the Duplex mode ON or OFF, and the shift direction to DUP+ or DUP-.
* In the FM/FM-N mode, push to select the tone type.
TONE/D.SQL + In the DV mode, push to select the digital squelch type.
MW In the VFO mode or on the DR screen, hold down for 1 second to enter the Memory channel contents
to a blank channel.
REC * Push to start recording.
» While recording, hold down for 1 second to stop recording.
. * Push to transmit the voice audio recorded on the microSD card once.
Voice TX

* Hold down for 1 second to repeatedly transmit the voice audio.

12-19




12 SET MODE

The assignable key functions

* During TX
Function Descriptions
- No function
VOL UP Push to increase the volume level.
VOL DOWN Push to decrease the volume level.
 Push to transmit the voice audio recorded on the microSD card once.
Voice TX * Hold down for 1 second to repeatedly transmit the voice audio.
® To make a repeat transmission, [PTT] must be released after the transmission is started.
T-CALL Push to transmit a 1750 Hz tone.
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Key Lock (Default: Normal) Active Band (Default: All)
[MENU] > SET > Function > Key Lock [MENU] > SET > Function > Active Band
Selects the key lock type when the Key Lock function Selects whether or not to enable continuous frequency
is ON. selection of the operating frequency across all bands
using [DIAL].

NOTE: Regardless of the setting, you can still use

[&], [PTT], and [rmO] even if the Key Lock function is + Single: When you rotate [DIAL] on the band edge,

the displayed band’s higher or lower

ON. .
frequency is selected.
« Normal: All keys and dials, except [SQL] and [VOL] * Al When you rotate [DIAL] on the band edge,
are locked. the next band is selected.
« No SQL: All keys and dials, except [SQL] are locked. The selectable frequencies are set to all
« No VOL: All keys and dials, except [VOL] are locked. bands, for continuous selection.
o ALL: All keyS and dials are locked. « HAM: When you rotate [DlAL] on the band

edge, the amateur band’s higher or lower
frequency is selected. You cannot select a
PTT Lock (Default: OFF) frequency out of the amateur band.

. ® To select another band when “Single” is selected, push
[MENU] > SET > Function > PTT Lock [QUICK], then select “Band Select.”

Turns the PTT Lock function ON or OFF. @® This setting is for the [DIAL] operation, so all frequencies
To prevent accidental transmissions, this function are scanned.
inhibits all transmissions.
» OFF: Turns OFF the function. .
Mi I | Default: 2
* ON: Inhibits all transmissions. C Gain (Internal) (Default: 2)
[MENU] > SET > Function > MIC Gain (Internal)
Busy Lockout (Default: OFF) Sets the internal microphone gain to between 1
- (minimum) and 4 (maximum), to suit your operation
[MENU] > SET > Function > Busy Lockout needs.
Turns the Busy Lockout function ON or OFF. Higher values make the microphone more sensitive to
This function inhibits a transmission while receiving a your voice.
signal, or when the squelch is open.
* OFF: Turns OFF the function. .
Ext I Default: 2
* ON: Turns ON the function. MIC Gain (External) (Default: 2)
[MENU] > SET > Function > MIC Gain (External)
Time-Out Timer (Default: 5min) Sets the external microphone gain to between 1
- - - (minimum) and 4 (maximum), to suit your operation
[MENU] > SET > Function > Time-Out Timer needs.
To prevent an accidental prolonged transmission, Higher values make the microphone more sensitive to
the transceiver has the Time-Out Timer function. The your voice.

function inhibits continuous transmissions longer than
this set period of time.
* OFF: Turns OFF the function.
* 1 to 30 min: The transmission is cut OFF after the
set period of time ends
(1, 3, 5, 10, 15, or 30 minutes).
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VOX (Default: OFF)

CI-V Address (Default: AB)

[MENU] > SET > Function > VOX > VOX

Turns the Voice Operated Transmission (VOX)
function ON or OFF.

The VOX function starts transmission without pushing
[PTT] when you speak into the microphone, and
then, automatically returns to receive when you stop
speaking.

* OFF: Turns OFF the function.

* ON: Starts transmission without pushing [PTT]
when you speak into the microphone. Then
automatically returns to receive when you
stop speaking.

VOX Level (Default: 5)

[MENU] > SET > Function > VOX > VOX Level

Sets the VOX gain level to between 1 and 10, or OFF.
Higher values make the VOX function more sensitive
to your voice.
* OFF: Turns OFF the VOX function.
* 1~10: 1 (The minimum sensitivity)

10 (The maximum sensitivity)

VOX Delay (Default: 0.5sec)

[MENU] > SET > Function > VOX > VOX Delay

Sets the VOX Delay to 0.5, 1.0, 1.5, 2.0, 2.5, or 3.0
seconds. The VOX Delay is the amount of time the
transmitter stays ON after you stop speaking, before
the VOX switches to receive.

VOX Time-Out Timer (Default: 3min)

[MENU] > SET > Function > VOX >
VOX Time-Out Timer

Sets the VOX Time-Out Timer to prevent an accidental
prolonged transmission. To disable the function, set to
“OFF.”
* OFF: Turns OFF the function.
« 1,2, 3,4,5, 10, or 15min:
If a continuous transmission exceeds the set
period of time, the transmission is stopped.

Headset Select (Default: Other)

[MENU] > SET > Function > VOX > Headset Select

Selects the headset type to be connected.
» HS-95: Select when using the HS-95.
» Other: Select when using the HS-94 or HS-97.
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[MENU] > SET > Function > CI-V > CI-V Address

Sets the CI-V address in hexadecimal code.

® To distinguish devices, each CI-V transceiver has its own
Icom standard address. “A6” is the default address of
the ID-52A/ID-52E. When 2 or more ID-52A/ID-52Es are
simultaneously controlled by a PC, set a different address
for each transceiver between 02 and DF (hexadecimal).

CI-V Baud Rate (SP Jack)

[MENU] > SET > Function > CI-V >
CI-V Baud Rate (SP Jack)

Sets the CI-V data transfer speed when remotely
controlling the transceiver through the [SP] jack,

to 4800, 9600, 19200 bps, or Auto. When “Auto” is
selected, the baud rate is automatically set according
to the controller’s data rate.

(Default: Auto)

CI-V Transceive (Default: OFF)

[MENU] > SET > Function > CI-V > CI-V Transceive

Turns the Transceive function ON or OFF.

@® To use the RS-MS1A or RS-MS11, set to “ON.”

» OFF: The status is not output.

* ON: The status is output. When you change
a transceiver setting, the same change
is automatically set on other connected
transceivers or receivers, and vice versa.

Cl-V USB/Bluetooth—REMOTE Transceive
Address (Default: 00)

[MENU] > SET > Function > CI-V >
Cl-V USB/Bluetooth—REMOTE Transceive Address

If you remotely operate your transceiver through a
USB cable or using Bluetooth when “CI-V Transceive”
is set to ON, the devices in the same system are also
externally controlled through the [SP] jack.

To prohibit the external control of an Icom transceiver,
set this value to other than “00.”

The control signal is output from the [SP] jack.

Select an address between 00 and DF (hexadecimal).
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USB Connect (Default: Serialport)

[MENU] > SET > Function > USB Connect

Selects the mode when connecting the transceiver to

a PC with a USB cable.

» Charge Only:
You can only charge the transceiver using a USB
cable.

+ Serialport:
You can program the transceiver, input/output
D-STAR data, output GPS information, input
weather data, and remotely control the transceiver
using the CI-V commands.

® Information
* You need to install the USB driver.
« When a PC is connected, the USB connection indicator g5t
is displayed on the transceiver.
« Select the input/output data type in “USB Serialport
Function.”
+ Confirm that “GPS Select” is set to “ON,” when you output
the received position data.
(IMENU] > GPS > GPS Set > GPS Select)
+ SD Card Mode:
You can transfer the files between the inserted
microSD card and a PC, using a USB cable.
@ A confirmation dialog is displayed. (p. 2-9)

NOTE:

» To charge from a PC, set “USB Power Input (Phone,
Tablet, PC)” to “ON.”

+ Use a data communication compatible USB cable when
“Serialport” or “SD Card Mode” is selected.

* While in the SD Card Mode, the transceiver works
not as a transceiver but as a data storage device. It
temporarily stops recording and logging.

TIP: Download the USB driver and the installation
guide from the Icom website.
https://www.icomjapan.com/support/
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USB Serialport Function
(Default: CI-V (Echo Back OFF))

[MENU] > SET > Function > USB Serialport Function

Selects the Serialport function for the USB connection

to a data device, PC, and so on.

» CI-V (Echo Back OFF):
The CI-V command is input or output
through the USB port. Does not send
back the CI-V command input from the
USB port.

» CI-V (Echo Back ON):
The CI-V command is input or output
through the USB port. Sends back the
CI-V command input from the USB port.

» DV Data: The DV data is input or output to the USB
port.

NOTE: When “ClI-V (Echo Back OFF)” or “CI-V
(Echo Back ON)” is selected, you cannot remotely
control the transceiver through the [SP] jack.

Heterodyne (Default: Normal)

[MENU] > SET > Function > Heterodyne

Selects the 1st Local Oscillator frequency.

Depending on a combination of the two operating
frequencies in the Dualwatch mode, the transceiver
might generate a spurious signal on a specific receive
frequency. This may cause the S-meter to fluctuate,
even when no signal is received, for example.

If this occurs, the Heterodyne function may help. The
Heterodyne function shifts the 1st Local Oscillator
frequency to the opposite side of the signal to change
the frequency combination.
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Battery Pack Select (Default: BP-271/BP-272)

LO/CALL Key Actions (Default: Standard)

[MENU] > SET > Function > Battery Pack Select

Selects the model of the attached battery pack to
display the optimized battery status.

Battery Pack Confirmation (Default: OFF)

[MENU] > SET > Function > Battery Pack Confirmation

Selects whether or not to display the Battery Pack
Select dialog the first time the transceiver is turned
ON after reattaching a battery pack.

Charging (Power ON) (Default: ON)

[MENU] > SET > Function > Charging (Power ON)

Selects whether or not to charge the battery pack
when the optional external DC power cable (CP-12L
or OPC-254L) is connected to [DC IN], even if the
transceiver is ON.

USB Power Input (Phone, Tablet, PC) (Default: ON)

[MENU] > SET > Function >
USB Power Input (Phone, Tablet, PC)

Selects whether or not to use a mobile device or a PC
as an external power source.

Screen Capture [PWR] Key (Default: OFF)

[MENU] > SET > Function > Screen Capture [PWR] Key

Assigns the Screen Capture function to [(].

* OFF: [(h] does not act as the Screen Capture key.

* ON: Pushing [(b] captures the transceiver display
onto a microSD card.

Screen Capture File Type (Default: BMP)

[MENU] > SET > Function > Screen Capture File Type

Sets the file format for the Screen Capture function to
PNG or BMP.

12-24

[MENU] > SET > Function > LO/CALL Key Actions

Selects whether or not to change the [CALL], [LO],
and [MR] keys operation to the same as the ID-51A/E.
« Standard: The key’s operations do not change.
+ ID-51 Compatible (CS/LOW):
The key’s operation change as described
below.
[CALL]: Hold down for 1 second to
change the transmit power
levels.

[LO]:  Inthe DV mode, hold down for
1 second to display the CALL
SIGN screen.

[MR]:  Push to enter the Memory mode,

and then push again to enter the

Call Channel mode.

®For the ID-52A only
In the Call Channel mode,
push to enter the Weather
Channel mode.

() =\(Euss [CALL]
(Y GA o —MR]
O=d)

FED 5D°n:°° % / [LO]
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Display

Backlight (Default: Auto (DC IN:ON))

Dim Screen (Default: ON)

[MENU] > SET > Display > Backlight

Selects an option for the transceiver backlight.

» OFF: The backlight does not light.

* ON: The backlight lights continuously.

+ Auto: The backlight lights when you push a key or
rotate [DIAL], and reduces the brightness*
after the set period of time in “Backlight Timer.”

» Auto (DC IN:ON):

The backlight lights when you push a key or

rotate [DIAL], and reduces the brightness*

after the set period of time in “Backlight Timer.”

®When an external DC power source is
connected, lights continuously.

® When using the GPS Logger Only mode, “Auto” is

automatically selected.
* When “Dim Screen” is set to “OFF,” the backlight goes out
after the set period of time in “Backlight Timer.”

Backlight Timer (Default: 10sec)

[MENU] > SET > Display > Backlight Timer

Sets the Backlight Timer to 5, 10, or 30 seconds.

Depending on the “Backlight” setting, the backlight

lights for this set period of time, and then automatically

reduces the brightness.

® When “Dim Screen” is set to “OFF,” the backlight goes out
after this set period of time.

Brightness (Default: 8)

[MENU] > SET > Display > Brightness

Sets the LCD backlight brightness level to between
1 (dim) and 8 (bright).
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[MENU] > SET > Display > Dim Screen

Selects whether or not to automatically reduce the
backlight brightness.

» OFF: The backlight immediately goes out after the
set period of time in “Backlight Timer.”

The backlight brightness automatically changes
to the “Brightness (Dim)” level after the set
period of time in “Backlight Timer,” and goes
out after the set period of time in “Dim Timer.”

* ON:

The image of the Dim Screen function
Operating No operating

The Dim Screen The Backlight

function is ON. goes out.
©— ©—
Backlight Timer Dim Timer
(Default: 10sec) (Default: 1min)

Lights at the Lights at the
“Brightness” level. “Brightness (Dim)” level.

(Default: 8) (Default: 1)

hd hd

123 456 7 8

Dim Timer (Default: 1min)

[MENU] > SET > Display > Dim Timer

Sets the Dim Timer to 1, 2, 5, or 10 minutes, or Hold.
Depending on the “Dim Screen” setting, the backlight
lights at the “Brightness (Dim)” level for this set period
of time, and then automatically goes out.

+ 1/2/5/10min: The backlight goes out after this set
period of time.

The backlight does not go out.

* Hold:

Brightness (Dim) (Default: 1)

[MENU] > SET > Display > Brightness (Dim)

Sets the LCD backlight brightness level for the set period

of time in “Dim Timer,” to between 1 (dim) and 7 (bright).

® Set a lower level than “Brightness.” If you set a higher level
than “Brightness,” the Dim Screen function does not work.

® You can check the brightness at each level on the
“Brightness” screen.

Background Color (Default: White)

[MENU] > SET > Display > Background Color
Sets the display background color to Black or White.

Contrast (Default: Standard)

[MENU] > SET > Display > Contrast
Sets the display contrast to Light, Standard, or Dark.
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Display

Busy LED (Default: ON)

RX Position Display (Default: ON (Main/Sub))

[MENU] > SET > Display > Busy LED

Selects whether or not to light the TX/RX indicator

while receiving a signal, or the squelch is open. To

conserve battery power, turn OFF this function.

® The indicator lights red while transmitting, regardless of

the setting.

» OFF: The indicator does not light, even if a signal is
received.

* ON: The indicator lights green while receiving a
signal, or the squelch is open.

RX Call Sign (Default: Normal)

[MENU] > SET > Display > RX Call Sign

In the DV mode, selects whether or not to display the

call sign and the message of the caller station when a

call is received.

» OFF: Does not display the caller station’s call

sign and message.

The caller station’s call sign and message

automatically scroll once, and then

disappear.

The caller station’s call sign and message

automatically scroll once, and then the

call sign is displayed on the transceiver’s

display until the signal disappears.

The caller station’s call sign and message

automatically scroll once, and then the

call sign is displayed on the transceiver’s

display until the signal disappears.

When the signal disappears, the call sign

and the message are each repeatedly

displayed for 2 seconds.

® When “Normal,” “RX Hold,” or “Hold” is selected, and if
the call sign and name of the caller station is entered in
your memory, the name is displayed after displaying the
call sign.

* Normal:

* RX Hold:

* Hold:

RX Position Indicator (Default: ON)

[MENU] > SET > Display > RX Position Indicator

Selects whether or not to display the indicator when
position data is included in the signal received in the
DV mode.

» OFF: No indicator is displayed, even though the
position data is included in the received
signal.

* ON: The indicator is displayed when the position
data is included in the received signal.

® When “RX Call Sign” is set to “OFF,” the indicator is not

displayed, even though position data is included in the
received signal.
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[MENU] > SET > Display > RX Position Display

Selects whether or not to display position data in

a dialog when the caller station’s position data is

included in the signal received in the DV mode.

+ OFF: No data is displayed in a dialog.

* ON (Main/Sub):
When the caller station’s position data is
included in the signal, its data is displayed in
a dialog.

* ON (Main Only):
When the caller station’s position data is
included in the signal received in the MAIN
band, its data is displayed in a dialog.

® The time period to display the dialog depends on the “RX

Position Display Timer” setting.

RX Position Display Timer (Default: 10sec)

[MENU] > SET > Display > RX Position Display Timer

Sets the RX position data’s time period to display in a
dialog.

» 5/10/15/30sec: Displays the caller’s position for this
set period of time.

Displays the caller’s position until
you operate the transceiver.

* Hold:

Reply Position Display (Default: ON)

[MENU] > SET > Display > Reply Position Display

Selects whether or not to display the caller’s position

data when the data is included in the Auto Replay

signal.

» OFF: Does not display the caller’s position data.

* ON: Automatically displays the caller’s position
data.

RX Picture Indicator (Default: ON)

[MENU] > SET > Display > RX Picture Indicator

Selects whether or not to display the RX Picture
Indicator when a picture is included in the received
signal.
» OFF: No indicator is displayed, even if a picture is
included in the received signal.
* ON: The indicator is displayed when a picture is
included in the received signal.
® When “RX Call Sign” is set to “OFF,” the indicator is not
displayed, even if a picture is included in the received
signal.
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Display

DV RX Backlight (Default: ON)

[MENU] > SET > Display > DV RX Backlight

Turns the DV RX Backlight function ON or OFF.

In the DV mode, this function turns ON the backlight
while displaying the calling station’s call sign or a
received message.

* OFF: Turns OFF the function.

* ON: The backlight automatically lights when
displaying the calling station’s call sign or a
received message. The backlight stays ON
while the call sign or message is scrolling.

NOTE: When you set this item to “ON,” set
“Backlight” to “Auto” or “Auto (DC IN:ON).”

TX Call Sign (Default: Your Call Sign)

[MENU] > SET > Display > TX Call Sign

Selects whether or not to display the My or Your call
sign while transmitting.
» OFF: Turns OFF the function.
* Your Call Sign: Displays and scrolls the call sign of
the target station.
* My Call Sign: Displays and scrolls your own call sign.
® When “Your Call Sign” is selected, and if the call sign and
name of the caller station is entered in your memory, the
name is displayed after the call sign, in any DV mode
except when using the DR function.

Scroll Speed (Default: Fast)

[MENU] > SET > Display > Scroll Speed

Sets the scrolling speed of the message, call sign, or
other text, that are displayed on the screen to “Slow”
or “Fast.”

Opening Message (Default: ON)

[MENU] > SET > Display > Opening Message

Selects whether or not to display the opening
message at power ON.

When you set this item to “ON,” Icom logo, MY call
sign, and the model are displayed.

Voltage (Power ON) (Default: ON)

[MENU] > SET > Display > Voltage (Power ON)

Selects whether or not to display the voltage of the
battery or external DC power source at power ON.

NOTE: When the external DC power source voltage
is above 15.6V, “HI Voltage” is displayed. In that
case, immediately disconnect the DC power source.
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Single Band Display (Default: Date)

[MENU] > SET > Display > Single Band Display

Selects to display the date or GPS information at the
bottom of the Single band display.

+ Date: Displays the date.

* GPS Information: Displays the GPS information.

Latitude/Longitude (Default: ddd® mm.mm’)

[MENU] > SET > Display > Display Unit >
Latitude/Longitude

Selects the format to display the position data.

Altitude/Distance (Default: ft/mi)

[MENU] > SET > Display > Display Unit >
Altitude/Distance
Selects the format to display the distance and elevation.

® The default value may differ, depending on the
transceiver version.

Speed (Default: mph)

[MENU] > SET > Display > Display Unit > Speed

Selects the format to display the speed.
® The default value may differ, depending on the
transceiver version.

Temperature (Default: °F)

[MENU] > SET > Display > Display Unit > Temperature

Selects the format to display the temperature.
® The default value may differ, depending on the
transceiver version.

Barometric (Default: inHg)

[MENU] > SET > Display > Display Unit > Barometric

Selects the format to display the barometric pressure.
® The default value may differ, depending on the
transceiver version.
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Display

Rainfall (Default: inch)

[MENU] > SET > Display > Display Unit > Rainfall

Selects the format to display the amount of rainfall.
® The default value may differ, depending on the
transceiver version.

Wind Speed

[MENU] > SET > Display > Display Unit > Wind Speed

Selects the format to display the wind speed.
® The default value may differ, depending on the
transceiver version.

(Default: mph)

Display Language (Default: English)

[MENU] > SET > Display > Display Language

Sets the screen display language to English or

Japanese.

@ This item is displayed only when “System Language” is
set to “Japanese.”

System Language (Default: English)

[MENU] > SET > Display > System Language

Sets the system language of the transceiver.

* English:  The system language of the transceiver
is English. Only alphabetical characters
(AtoZ,atoz 0to9)and symbols (! “ #
$%& ()*+,-./;<=>2@[\]1"_"
{]}~) can be displayed.

If Japanese characters (Kanji, Hiragana,
and Katakana) are included, the

display shows “=" or “_” instead of that
character. In that case, you can only
delete “=”" or “_” in the transceiver’s edit
mode.

» Japanese: The system language of the transceiver
is Japanese. Kaniji, Hiragana, and
Katakana characters, and the 2-bytes
symbols can be displayed. To display
such characters in the DR screen or
Menu mode, set “Display Language” to
“‘Japanese.”

® When this item is set to “English,” “Display Language” is

not displayed.

When you set the system language of the
transceiver to Japanese, the transceiver has the
capability to display both English and Japanese
characters. HOWEVER, if you select Japanese, all
menu items throughout the transceiver system will
be displayed in only Japanese characters. There will
be no English item names. Unless you are fluent in
reading Japanese characters, use this feature with
extreme caution.

If you have change the transceiver’s language to
Japanese and do not understand the menu system
in the new setting, you will have to change the
language back to English by doing a partial reset
of the transceiver CPU. A partial reset will not clear
your call sign databases.

To do a partial reset of the CPU, do the following

steps:
1. Push [MENU].
2. Select “SET.”
M
'
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3. Select the item (with the “etc” icon) shown below.
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b
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@ BluetoothiE »
F

4. Select the bottom item shown below.

KIREHR »
g0-v »

5. Select the upper item shown below.
1 Iy
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® DO NOT select the lower item. The lower item is
for the All reset function, and the All reset clears all
entries and returns all settings to their factory defaults.
6. Select the upper option.
1 iy

A\ N=2vILUty
EOLFETN?

LWZ

* When the partial reset is completed, “PARTIAL
RESET” is displayed, then the display automatically
returns to the default screen.
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Volume Select (Default: All)

Beep Level (Default: 3)

[MENU] > SET > Sounds > Volume Select

Select whether or not to adjust the audio output level
independently, according to the operating status.

« All: The audio output level for the FM Radio,
Aband (VFO A), and B band (VFO B) are
adjusted at the same time.

* FM Radio Separate:

The audio output level for the FM Radio
is independently adjusted. The audio
output level for A band (VFO A) and B
band (VFO B) are adjusted at the same
time.

The audio output level for the FM Radio,
Aband (VFO A), and B band (VFO B) are
independently adjusted.

NOTE: When an EMR signal is received, the audio

output level for A band and/or B band may be set to

the selected level in “EMR AF Level,” depending on

this setting.

® The audio output level for the FM Radio is not changed,
because the EMR function is for the DV mode
operation.

When “All” or “FM Radio Separate” is selected:
The audio output level for A band and B band is set
to the selected level in “EMR AF Level.”

When “Separate” is selected:

Either the audio output level for A band or B band
that the signal is received on, is set to the selected
level in “EMR AF Level.”

» Separate:

FM Radio Level (Default: 0)

[MENU] > SET > Sounds > FM Radio Level

Sets the initial audio output level difference between

the FM Radio and the A and B bands when “Volume

Select” is set to “All.”

» +5 ~ +1: The FM Radio audio output level is higher

than the VFO mode audio.

The FM Radio audio output level is the

same as the VFO mode audio.

* -5 ~—1: The FM Radio audio output level is lower
than the VFO mode audio.

* 0:

Earphone Mode (Default: OFF)

[MENU] > SET > Sounds > Earphone Mode

Turns the earphone mode ON or OFF.

While in the earphone mode, the audio volume level is
automatically adjusted to the comfortable level when
the optional earphone is connected to the [MIC/SP]
jack.
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[MENU] > SET > Sounds > Beep Level

Sets the beep output level to 0 (OFF) or 1 (minimum)
~ 9 (maximum).

Beep/Vol Level Link (Default: OFF)

[MENU] > SET > Sounds > Beep/Vol Level Link

Selects whether or not the beep output level can be

adjusted by rotating [VOL].

* OFF: The output level is fixed to the level set in
“‘Beep Level.”

* ON: The output level can be adjusted by rotating
[VOL].

Key-Touch Beep (Default: ON)

[MENU] > SET > Sounds > Key-Touch Beep

Turns the confirmation beep ON or OFF.
» OFF: No beep sounds.
* ON: A beep sounds when you push a key.

Home CH Beep (Default: ON)

[MENU] > SET > Sounds > Home CH Beep

Turns the Home CH Beep ON or OFF.

» OFF: No beep sounds.

* ON: A beep sounds when you select the Home

Channel.

® In the VFO or Memory mode, when the Home Channel
frequency or the Home Channel Memory is selected, the
Home CH Beep sounds.

@ In the DR screen, when the Home Channel Access
repeater is set in FROM, the Home CH Beep sounds.

Band Edge Beep (Default: OFF)

[MENU] > SET > Sounds > Band Edge Beep

Turns the Band Edge Beep ON or OFF.

» OFF: No beep sounds.

* ON: A beep sounds when you tune out of, or back
into the AIR, VHF, and UHF band’s frequency
range.

Scan Stop Beep (Default: OFF)

[MENU] > SET > Sounds > Scan Stop Beep

Turns the Scan Stop Beep ON or OFF.

» OFF: No beep sounds.

* ON: Abeep sounds when a scan stops by
receiving a signal.
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Standby Beep (Default: ON (to me:Alarm/High Tone))

DATE

[MENU] > SET > Sounds > Standby Beep

Turns the Standby Beep function ON or OFF.

This function sounds a beep after a received signal

disappears, in the DV mode.

» OFF: Does not sound a beep after a received signal
disappears.

* ON: Sounds a beep after a received signal
disappears.

* ON (to me:High Tone):
Sounds a high pitched beep when a received
signal that is addressed to your call sign (MY)
disappears. When any other received signal
disappears, a regular beep sounds.

* ON (to me:Alarm/High Tone):
Sounds alarm (PiRoPiRoPiRo) when a
received signal that is addressed to your
call sign (MY) disappears. When any other
received signal disappears, a regular beep
sounds.

® The standby beep sounds even when “Key-Touch Beep”

is set to “OFF.”
® The standby beep output level depends on the “Beep
Level” setting.

Sub Band Mute (Default: OFF)

[MENU] > SET > Sounds > Sub Band Mute

Selects whether or not to mute the SUB band audio
signal while receiving on the MAIN band, and/or
sound a beep when a signal disappears on the SUB
band.

» OFF: Turns OFF the function.

* Mute: While receiving on the MAIN band,
the SUB band audio signal is muted.

* Beep: When a signal disappears on the

SUB band, a beep sounds.

While receiving on the MAIN band,

the SUB band audio signal is muted.

When a signal disappears on the

SUB band, a beep sounds.

® When you set this item to “Beep” or “Mute & Beep,” a
beep sounds, even if no signal is received on the MAIN
band.

* Mute & Beep:
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[MENU] > SET > Time Set > Date/Time > DATE

Manually set the date to between 2020/01/01 and

2099/12/31.
® The day of the week is automatically set.

TIME

[MENU] > SET > Time Set > Date/Time > TIME

Manually set the time that is displayed at the top of the
screen. The time is displayed in the 24 hour format.
When “GPS Time Correct” is set to “Auto,” the GPS
receiver automatically sets the time by calculating the
received Universal Time of Coordinated (UTC) time
and “UTC Offset.”

GPS Time Correct (Default: Auto)

[MENU] > SET > Time Set > GPS Time Correct

Selects whether or not the time data is automatically

corrected by a received GPS sentence.

» OFF: Does not correct the time.

+ Auto: Automatically corrects the time by calculating
the received UTC time and the “UTC Offset”
setting.

UTC Offset (Default: £0:00)

[MENU] > SET > Time Set > UTC Offset

Sets the UTC offset time to between —14:00 and
+14:00.

Auto Power OFF (Default: OFF)

[MENU] > SET > Time Set > Auto Power OFF

Selects whether or not to automatically turn OFF the
transceiver after inactivity for this set period of time.
® “AUTO POWER OFF” is displayed and beeps sound
5 seconds before turning OFF the transceiver. If you
operate the transceiver during this period of time, the
Auto Power OFF timer is reset.
» OFF: Does not turn OFF the transceiver.
+ 30/60/90/120min:
Turns OFF the transceiver after inactivity for
this set period of time.
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SD Card

Load Setting

Date (Default: mm/dd/yyyy)

[MENU] > SET > SD Card > Load Setting
Selects the saved data file to load.

Save Setting

[MENU] > SET > SD Card > Save Setting
Saves the setting data onto a microSD card.

Save Form (Default: Now Ver)

[MENU] > SET > SD Card > Save Form

Selects the format to save the settings to a microSD
card.
* Now Ver:

Saves the settings in the current

version format.

+ Old Ver (x.xx - X.xx):
Saves the settings in an older version
format indicated in the parenthesis
(x.xx = version).

@ If you select “Old Ver (x.xx - x.xx),” a function that is
added when the transceiver’s firmware format is updated
will not be saved.

® You cannot load a setting file that is saved in the current
version format to an earlier firmware version.

Import

[MENU] > SET > SD Card > Import/Export > Import

Import the Memory channel contents, Radio memory
contents, UR call sign, repeater list, or GPS memory
data in the CSV format file.

Export

[MENU] > SET > SD Card > Import/Export > Export

Export the Memory channel contents, Radio memory
contents, UR call sign, repeater list, or GPS memory
data in the CSV format file.

Separator/Decimal (Default: Sep[,] Decl.])

[MENU] > SET > SD Card > Import/Export >
CSV Format > Separator/Decimal

Selects the separator and the decimal character for
the CSV format.
® The default value may differ, depending on the
transceiver version.
» Sep [,] Dec [.]: Separator is “,” and Decimal is “.”

“

and Decimal is “.

“

and Decimal is “,

* Sep [;] Dec [.]: Separator is “;”

» Sep [;] Dec [,]: Separator is ;
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[MENU] > SET > SD Card > Import/Export >
CSV Format > Date

Selects the date format between “yyyy/mm/dd,”

“mm/dd/yyyy,” and “dd/mm/yyyy.”

(y: year, m: month, d: day)

® The default value may differ, depending on the
transceiver version.

Opening Picture

[MENU] > SET > SD Card > Opening Picture

Selects the picture that is displayed at power ON.
® See page 15-15 for details.

SD Card Info

[MENU] > SET > SD Card > SD Card Info

Displays the microSD card capacity and the time
remaining for voice recording.

Screen Capture View

[MENU] > SET > SD Card > Screen Capture View
Displays the selected screen capture.

TX/RX Picture View

[MENU] > SET > SD Card > TX/RX Picture View

Displays the pictures that are saved on the microSD card.

® The transceiver cannot display the picture while
transmitting picture data.

® The transceiver can display up to 500 pictures.

Firmware Update

[MENU] > SET > SD Card > Firmware Update
Displays the Firmware Update mode.

Format

[MENU] > SET > SD Card > Format

Formats the microSD card.
If you use a brand new microSD card, be sure to
format it in the transceiver.

Unmount

[MENU] > SET > SD Card > Unmount

Unmounts the microSD card.

Before you remove a card when the transceiver is ON,
be sure to electrically unmount it. Otherwise, the data
may be corrupted or deleted.
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Bluetooth Set

Bluetooth (Default: OFF)

Headset Function Select (Default: Normal)

[MENU] > SET > Bluetooth Set > Bluetooth
Turns the Bluetooth function ON or OFF.

Auto Connect (Default: ON)

[MENU] > SET > Bluetooth Set > Auto Connect

Selects whether or not to automatically connect to the

paired Bluetooth device when its power is turned ON.

* OFF: Does not connect to the paired device.

* ON: Automatically connects to the last connected
device.

Pairing/Connect

[MENU] > SET > Bluetooth Set > Pairing/Connect

Searches for the Bluetooth device to connect, or
display the paired Bluetooth devices in the list.
® See page 13-3 for details.

<<Pairing Reception>>

[MENU] > SET > Bluetooth Set > <<Pairing Reception>>

Enters the pairing reception mode.
® See page 17-7 for details.

AF Output (Default: Headset Only)

[MENU] > SET > Bluetooth Set > Headset Set >
AF Output

Selects the AF Output device when a Bluetooth

headset is connected.

* Headset Only: Outputs audio to only the connected
Bluetooth headset.

* Headset & Speaker:
Outputs audio to both the connected
Bluetooth headset and the
transceiver’s speaker.
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[MENU] > SET > Bluetooth Set > Headset Set >
Headset Function Select

Selects the PTT and microphone combination when
both the Bluetooth headset and the transceiver
microphone are used.

* Normal: Transmits the audio from the Bluetooth
headset, or the transceiver microphone,
whichever [PTT] is pushed.

* Microphone:

Transmits the audio from the Bluetooth
headset.

Transmission is enabled by pushing either
the [PTT] on the Bluetooth headset, or the
transceiver microphone. The transceiver
microphone is only used for the PTT
control.

Transmits the audio from the transceiver
microphone.

Transmission is enabled by pushing either
the [PTT] on the Bluetooth headset, or the
transceiver microphone. The Bluetooth
headset is only used for the PTT control.

- PTT:

® The Bluetooth headset operation for each option is listed
below.

Option TX control TX audio
Normal Enabled Enabled
Microphone Enabled Enabled
Disabled
PTT Enabled | (Audio from the microphone is
transmitted.)

Auto Disconnect (Default: OFF)

[MENU] > SET > Bluetooth Set > Headset Set >
Auto Disconnect

Sets the Disconnect Timer between 0 and 10

seconds, or OFF.

If there is no audio output from the Bluetooth headset,

and there is no key operation for this set period of

time, the Synchronous Connection-Oriented (SCO)

link* is automatically disconnected.

® The SCO link is connected when the signal is received, a
beep sounds, or there is a key operation.

* A Bluetooth link for voice communication
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Bluetooth Set

RX Priority Setting (LE Device)
(Default: MAIN Band)

[MENU] > SET > Bluetooth Set > Headset Set >
RX Priority Setting (LE Device)

Selects the communication priority for the DV Fast

Data and receive audio, when connecting an iOS

device (Bluetooth LE (Low Energy)) and a Bluetooth

headset. The Bluetooth LE communication cannot

be simultaneously used for both DV Fast Data and

Headset audio.

® When connecting to an SPP (Serial Port Profile) device
such as a data device or PC, the Bluetooth device
functions according to the “Serialport Function” (p. 12-34)
setting.

* DV Fast Data: Received audio is not output from
the headset, regardless of the band
(MAIN or SUB).

DV Fast Data is not transferred
during the received audio is output
from the headset.

The audio received on the SUB band
is not output from the headset when
a DV Fast Data is received on the

MAIN band.

DV Fast Data that is received on the
SUB band is not transferred while a
signal is received on the MAIN band.

* RX Audio:

* MAIN Band:

VOX (Default: OFF)

[MENU] > SET > Bluetooth Set > Headset Set >
VOX > VOX

Turns the Voice Operated Transmission (VOX)
function ON or OFF.

The VOX function starts transmission without pushing
[PTT] when you speak into the microphone, and
then, automatically returns to receive when you stop
speaking.

@ To use the VOX function, the optional Bluetooth headset

is required.

* OFF: Turns OFF the function.

* ON: Starts transmission without pushing [PTT]
when you speak into the microphone. Then
automatically returns to receive when you
stop speaking.

12-33

VOX Level (Default: 5)

[MENU] > SET > Bluetooth Set > Headset Set >
VOX > VOX Level

Sets the VOX gain level to between 1 and 10, or OFF.
Higher values make the VOX function more sensitive
to your voice.
* OFF: Turns OFF the VOX function.
* 1~10: 1 (The minimum sensitivity)

10 (The maximum sensitivity)

VOX Delay (Default: 0.5sec)

[MENU] > SET > Bluetooth Set > Headset Set >
VOX > VOX Delay

Sets the VOX Delay time to 0.5, 1.0, 1.5, 2.0, 2.5 or
3.0 seconds. The VOX Delay is the amount of time the
transmitter stays ON after you stop speaking, before
the VOX switches to receive.

VOX Time-Out Timer (Default: 3min)

[MENU] > SET > Bluetooth Set > Headset Set >
VOX > VOX Time-Out Timer

Sets the VOX Time-Out Timer to prevent an accidental
prolonged transmission. To disable the function, set to
“OFF.”
* OFF: Turns OFF the function.
« 1,2, 3,4,5, 10, or 15min:
If a continuous transmission exceeds the set
period of time, the transmission is cut off.
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Bluetooth Set

Power Save (Default: OFF)

[MENU] > SET > Bluetooth Set > Headset Set >
Icom Headset > Power Save

Selects whether or not to operate with the Power Save
mode while the optional VS-3 headset is connected.
® When a headset (user supplied) or a data device is
connected, the Power Save mode is automatically turned
OFF, regardless of this setting.
» OFF: Turns OFF the function.
* ON: The Power Save mode is enabled when no
communication or operation is performed for
120 seconds.

One-Touch PTT (Default: OFF)

[MENU] > SET > Bluetooth Set > Headset Set >
Icom Headset > One-Touch PTT

Sets the One-Touch PTT function when the optional

VS-3 headset is connected.

This function enables you to transmit without

continuously holding down [PTT].

® When a headset (user supplied) is connected, this
function is automatically turned ON, regardless of this
setting.

* OFF: Transmits while holding down [PTT].

* ON: Pushing [PTT] toggles between transmit and

receive.

PTT Beep (Default: OFF)

[MENU] > SET > Bluetooth Set > Headset Set >
Icom Headset > PTT Beep

Sets the beep sound when you push [PTT] on the
optional VS-3 headset.

» OFF: No beep sounds.

* ON: Abeep sounds.

Custom Key Beep (Default: OFF)

[MENU] > SET > Bluetooth Set > Headset Set >
Icom Headset > Custom Key Beep

Sets the beep sound when you push the Custom Key
([PLAY]/[FWDJ/[RWD]) on the optional VS-3 headset.
* OFF: No beep sounds.

* ON: Abeep sounds.
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Custom Key (Default: [PLAY]: ---
[FWD]: UP

[RWD]: DOWN)

[MENU] > SET > Bluetooth Set > Headset Set >
Icom Headset > Custom Key

Assigns the functions to the Custom Key ([PLAY]/
[FWDJ/[RWD]) on the optional VS-3 headset.
® See page 12-35 about the functions.

Serialport Function
(Default: CI-V (Echo Back OFF))

[MENU] > SET > Bluetooth Set > Data Device Set >
Serialport Function

Sets the serial port function for the Bluetooth SPP
(Serial Port Profile) connection to a data device, PC,
and so on.
» CI-V (Echo Back OFF):
Transmits or receives a Cl-V command.
Does not send back the serial data
received from the SPP connection.
* CI-V (Echo Back ON):
Transmits or receives a Cl-V command.
Sends back the serial data received from
the SPP connection.
Transmits or receives data in the DV
mode.
Does not input the cloning or weather
data entries, or output the GPS data.

e DV Data:

Bluetooth Device Information

[MENU] > SET > Bluetooth Set >
Bluetooth Device Information

Displays the Bluetooth device information.

Initialize Bluetooth Device

[MENU] > SET > Bluetooth Set >
Initialize Bluetooth Device

Initializes the installed Bluetooth unit.
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Bluetooth Set

The assignable key functions

Function Descriptions
- No function
UP Push to increase the frequency, Memory channel, repeater, or station call sign.
DOWN Push to decrease the frequency, Memory channel, repeater, or station call sign.
VOL UP Push to increase the volume level.
VOL DOWN Push to decrease the volume level.
SQL UP Push to increase the squelch level.
SQL DOWN Push to decrease the squelch level.
Monitor (Push) Hold down to open the squelch. Release to close the squelch.
Monitor (Hold) Push to open or close the squelch.
CALL Push to select a Call Channel mode.

MR (00-00 CH)

In the Memory mode, push to select Memory channel 00-00.

MR (00-01 CH)

In the Memory mode, push to select Memory channel 00-01.

VFO/MR

Push to select the VFO mode and the Memory mode.

DR

Push to turn the DR function ON or OFF.

FROM/TO (DR)

In the DR screen, push to select “FROM” and “TO.”

Push to directly select the Home Channel that is set to the selected mode (VFO/Memory) or DR screen.

Home CH ® While in the Call Channel mode, or when no Home CH is set, an error beep sounds.
BAND Push to select an operating band.
SCAN Push to start the previously selected scan. While scanning, push to stop the scan.
Temoorary Ski Push to set the frequency to be skipped while scanning.
porary Skip The selected frequencies are temporarily skipped for faster scanning.
Hold down for 1 second to set the last calling station’s call sign to “TO” (destination).
@ If “[RX—CS] Key” is set to “RX > CS List,” the received call sign is not captured. The RX History list
RX>CS is displayed instead.
® To select the call sign in the RX History using the optional remote control speaker microphone,
assign “UP”/“DOWN.”
+ In the VFO, Memory, or Call Channel mode, push to announce the frequency and operating mode.
* In the DR screen, push to announce the call sign.
SPEECH @ If the Simplex mode is selected, the frequency is announced.
If the FM repeater is selected, the frequency and operating mode, or the call sign and operating
mode are announced.
+ Push to set the A or B band as the MAIN band.
MAIN/DUAL * Hold down for 1 second to turn the Dualwatch function ON or OFF.
MODE Push to select the operating mode.
LOW Push to select the transmit output power.
DUP Push to turn the Duplex mode ON or OFF, and the shift direction to DUP+ or DUP—.
* In the FM/FM-N mode, push to select the tone type.
TONE/D.SQL * In the DV mode, push to select the digital squelch type.
MW In the VFO mode or on the DR screen, hold down for 1 second to enter the Memory channel contents
to a blank channel.
REC + Push to start recording.
» While recording, hold down for 1 second to stop recording.
Voice TX * Push to transmit the voice audio recorded on the microSD card once.
» Hold down for 1 second to repeatedly transmit the voice audio.
T-CALL Push to transmit a 1750 Hz tone.
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Voltage

[MENU] > SET > Others > Information > Voltage

Displays the voltage of the battery pack and external

power source.

® When you attach the Li-ion battery pack, the charge
status of the battery pack and the battery voltage are
displayed.

® When you attach the optional battery case, the battery
case’s terminal voltage is displayed.

Version

[MENU] > SET > Others > Information > Version
Displays the transceiver firmware’s version number.

Clone Mode

[MENU] > SET > Others > Clone > Clone Mode

Enters the clone mode to read or write the CS-52 data
from or to the PC.
® Restart the transceiver to cancel the clone mode.

Partial Reset

[MENU] > SET > Others > Reset > Partial Reset

Resets operating settings to their default values (VFO
frequency, VFO settings, menu contents).
® See page 15-18 for details.

All Reset

[MENU] > SET > Others > Reset > All Reset

Clears all data and returns all settings to their factory
defaults.

Memory channel contents, Repeater list, and so on
will all be cleared, so you will need to rewrite your
operating settings.

® See page 15-18 for details.
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Bluetooth® operations

You can connect Bluetooth devices to the transceiver

using the Bluetooth function.
® See the Basic manual to pair, disconnect, or delete
devices.

Ilcom Headset

When you connect the VS-3 Bluetooth® headset to the
transceiver, you can wirelessly transmit and receive it.
The VS-3 has a [PTT] switch, so you can transmit in
the same way as using the transceiver’s [PTT] switch.
The VOX function can also be used to select transmit
and receive by using your voice through the headset
to switch between TX and RX.

You can assign a function to the keys on the side
panel of the VS-3 to remotely operate the transceiver.

Android™/iOS device

When you connect a mobile device to the transceiver

through Bluetooth and using the application, you can

use the extended D-STAR functions such as data

transmission and image transmission.

® See page 17-5 for the applications and how to pair the
transceiver with a mobile device.

Headselt device

Optional VS-3
(Bluetooth Headset)

ID-52A/E
Mobile device

l

Data device
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Turning ON the Bluetooth®

function

[MENU] > SET > Bluetooth Set > Bluetooth

1. Push [MENU].
. Select “Bluetooth Set” in the “SET” menu.
3. Select “Bluetooth.”

Bluetooth »
Auto Connect 14
Pairing/Connect 4
<<Pairing Reception>>
Headset Set »
Data Device Set 4
4. Select “ON.”
OFF

@ To exit the MENU screen, push [MENU].

IMPORTANT: The Bluetooth communication range
may vary, depending on the environment in which
the device operates. Microwave ovens or Wireless
LAN may cause interference.

In that case, stop using those devices or increase
the space between the Bluetooth device and the
other devices.

All Bluetooth devices have a range of use. If the
communication is unstable, use the device within the
range.
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Connecting to a Bluetooth® headset

You can connect an optional Bluetooth headset to the
transceiver.

Step 1. Selecting the pairing mode of the headset.

See the instruction manual of the headset to select
the pairing mode.

Step 2. Searching for the headset (Transceiver)

[MENU] > SET > Bluetooth Set > Pairing/Connect

1. Push [MENU]. 7. Select “YES.”
2. Select “Bluetooth Set” in the “SET” menu.
3. Select “Pairing/Connect.”

Connect?
Bluetooth ’
Auto Connect » NO
<<Pairing Reception>>
Headset Set » v
Data Device Set 4
4. Select “Device Search.” Device Search >

2 ICOM BT-002

Device Search »

 After connecting to the headset, _ is displayed in
the pairing list.
8. To exit the MENU screen, push [MENU].

5. Select “Search Headset.”

Search Headset > % ® & 12:00
Search Data Device » 146 01 0
PSKIP|
FM
440.000  er

« Displays the usable headsets in the pairing list.

6. Select a headset to pair. @® While connected to a Bluetooth device, the Bluetooth

icon is displayed on the Standby screen.
® When “AF Output” is set to “Headset Only” and the
Bluetooth connection is accidentally disconnected, a
dialog is displayed to select whether or not to output
the audio from the transceiver’s speaker. (p. 13-4)

» The confirmation dialog is displayed.
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Headset Settings

These are settings when using a Bluetooth headset.

1. Push [MENU].
2. Select “Bluetooth Set” in the “SET” menu.
3. Select “Headset Set.”

Bluetooth »
Auto Connect »
Pairing/Connect »

<<Pairing Reception>>

Headset Set >

Data Device Set 4
AF Output »
Headset Function Sele?
Auto Disconnect »
RX Priority Setting (LE»
VOX »
Icom Headset 4
< AF Output

[MENU] > SET > Bluetooth Set > Headset Set >
AF Output

You can select the AF Output device.

If “AF Output” is set to “Headset & Speaker,” you can
hear audio from both a connected Bluetooth headset
and the transceiver’s speaker.

® See page 12-32 for details.

TIP: When “AF Output” is set to “Headset Only,”
the following dialog is displayed if the Bluetooth
connection is accidentally disconnected.

[iamn] ®» 5 12:00
ICOM BT-002
Disconnected.
Output audio from
the transceiver's SP? [
I
NO

P

VFO
* YES: The audio is output from the transceiver’s
speaker.
The transceiver’s volume level is automatically
set to 0, and the audio is not output from the
transceiver’s speaker.

* NO:
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O Headset Function Select

You can select the PTT and microphone combination
when either a Bluetooth headset or the transceiver
microphone are used.

® See page 12-32 for details.

[MENU] > SET > Bluetooth Set > Headset Set >
Headset Function Select

* Normal:
Transmitting the voice from the Bluetooth headset
while pressing [PTT] or the internal microphone’s
voice.

* Microphone:
Using the Bluetooth headset as a microphone.
® The audio from the internal microphone cannot be
transmitted.
® You can also transmit by pressing the Bluetooth
headset’s [PTT].

* PTT:
Using the Bluetooth headset as a PTT switch.
® The audio from the internal microphone is transmitted.
The audio from the Bluetooth headset cannot be
transmitted.
® You can also transmit by pressing the transceiver’s
[PTT].

The operation of the Bluetooth headset for each
setting is shown in the table below.

Setting Transmit operation Audio input
Normal 4 v
Microphone 4 v
PTT 4 (Use internal microphone)
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Headset Settings

< Auto Disconnect

[MENU] > SET > Bluetooth Set > Headset Set >
Auto Disconnect

You can set the disconnect timer between 0 and 10

seconds or OFF.

If there is no audio signal to the Bluetooth headset, or

no operation is performed for a set period of time, the

receiver automatically disconnects the Synchronous

Connection-Oriented (SCO) link.

® When a signal is received, or an operation is performed
while the SCO link is disconnected, the receiver will
automatically reconnect the SCO link again.

® See page 12-32 for details.

O RX Priority Setting (LE Device)

[MENU] > SET > Bluetooth Set > Headset Set >
RX Priority Setting (LE Device)

You can select the communication priority for the DV

Fast Data and receive audio, when connecting an iOS

device (Bluetooth LE (Low Energy)) and a Bluetooth

headset.

The Bluetooth LE communication cannot be

simultaneously used for both DV Fast Data and

Headset audio.

® When connecting to a SPP (Serial Port Profile) device
such as data device or PC, the Bluetooth devise functions
according to the “Serialport Function” (p. 12-34) setting.

® See page 12-33 for details.

13-5

<O VOX function

The Voice Operated eXchange (VOX) function toggles
the transceiver between transmit and receive by your
voice. This function provides hands-free operation.
You can use the VOX function with the optional VS-3
or a third party’s Bluetooth headset.

Depending on the headset, the VOX function may be
disabled because of the differences in microphones.

NOTE:

« If the transceiver does not connect to a Bluetooth
headset, you cannot use the VOX function through
Bluetooth, even if “VOX” is set to ON.

BE SURE to check the Bluetooth connection between
the transceiver and the headset before using the VOX
function.

* This setting is used for when using the Bluetooth
microphone.

See page 15-10 for using the external microphone.

® See page 12-33 for details on the setting items and their
options.

[MENU] > SET > Bluetooth Set > Headset Set > VOX

VOX screen
You can turn the VOX function ON or OFF.

VOX Level screen
You can set the VOX gain level. Higher values make
the VOX function more sensitive to your voice.

VOX Delay screen

You can set the VOX Delay. The VOX Delay is the
amount of time the transmitter stays ON after you stop
speaking, before the VOX switches to receive.

VOX Time-Out Timer screen

You can set the VOX Time-Out Timer to prevent an
accidental prolonged transmission. To disable the
function, set to “OFF.”
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Headset Settings

< About the Icom headset (VS-3)

You can set the detailed settings of the optional VS-3

Bluetooth® HEADSET.

Also, you can assign a key function to [PLAY], [FWD],

and [RWD] on the “Custom Key” screen.

® See page 12-34 for details on the setting items and their
options.

[MENU] > SET > Bluetooth Set > Headset Set >
Icom Headset

Optional VS-3
Power Save screen Bluetooth® headset
The Power Save function temporarily disconnects the
Bluetooth connection if no communication or operation
is performed for 120 seconds.
The Power Save function is disabled when the VOX
function is ON.

One-Touch PTT screen

The One-Touch PTT function enables you to push
[PTT] to transmit, and then push again to return to
receive.

PTT Beep screen
You can set a beep to sound when you push [PTT] on
the VS-3.

Custom Key Beep screen
You can set a beep to sound when you push [PLAY],
[FWD], or [RWD] on the VS-3.

Custom key screen

You can assign a key function to [PLAY], [FWD], and
[RWD] on the VS-3.
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Editing the installed

Bluetooth® unit name

Initializing the installed
Bluetooth® unit

You can edit the transceiver Bluetooth unit’'s name.
@ After initializing the unit, the edited name remains.

[MENU] > SET > Bluetooth Set >
Bluetooth Device Information
1. Push [MENU].

. Select “Bluetooth Set” in the “SET” menu.
3. Select “Bluetooth Device Information.”

Bluetooth Device Infc»

Initialize Bluetooth De

Push [QUICK].
Select “Edit Name.”

o &

Edit Name

6. Enter a name of up to 9 characters®, and then
push [ENT]. (Example: ICOM BT(ID-52)A)
*After “ICOM BT.”

DEVICENAME |

ICOM BT(ID-52)

@IBCHAR TYPE ABC

v

ICOM BT(ID-52)A

EIDCHAR TYPE  ABC

® To exit the MENU screen, push [MENU].
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You can initialize the transceiver’s Bluetooth unit.

You should initialize the unit if you have trouble during

Bluetooth operation.

@ After initializing the unit, the pairing/connect list is deleted,
but the Bluetooth settings and the unit name remain.
The Bluetooth settings return to their factory defaults only
when you do a Partial Reset or All Reset. (p. 15-18)

[MENU] > SET > Bluetooth Set >
Initialize Bluetooth Device
Push [MENU].

1.
2. Select “Bluetooth Set” in the “SET” menu.
3. Select “Initialize Bluetooth Device.”

Bluetooth Device Inf »

Initialize Bluetooth De!

4. Select “YES.”

Initialize Bluetooth
Device?

NO

» The transceiver will automatically restart.

The maximum number of

paired devices

You can pair 2 types of Bluetooth devices: a Headset
and a Data device.

Number of maximum pairing devices

* Up to 5 Bluetooth headset and data devices such as
Android device can be paired.
(Headset 1~4, Data device 1~4)

» Up to 2i0S devices (Bluetooth LE) can be paired.

£} 1COM BT-002
ICOM

Displays the paired
Bluetooth device.
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14 SHARE PICTURES FUNCTION

About the Share Pictures function

With this function, you can send a picture that is saved
on a microSD card, and view a received picture.

® Information

* You must insert a microSD card into the transceiver.

 To use this function, first format microSD card using the
transceiver.

* You cannot use this function while operating in the Access
Point mode.

NOTE:

» Even if no microSD card is inserted into the transceiver,
a picture can be received, but the picture is not saved in
RX Picture History.

@ A picture received before inserting a microSD card
is deleted when you insert an SD card into the
transceiver.

* DO NOT remove the microSD card from the transceiver
while using the Share Picture function. Otherwise, the
card data may be corrupted or deleted.

« If the card data is not in a supported format, or it is
corrupted, an error dialog is displayed.

In that case, select “YES” to delete the data that is not
in a supported format or corrupted.

About a picture file to use
« File type*':  JPEG (The file extension is “jpg.”)
« Picture size*?: 640 x 480, 320 x 240, or 160 x 120 (px)
* File size: 200 KB or less
* File name: up to 23 characters
(except a filename extension)
*! The transceiver cannot read a file whose extension is
“jpeg,” or a file in the Progressive JPEG format.
*2 The transceiver cannot read a picture that is other than
the specified size, even if its aspect ratio is 4:3.
® The transceiver displays only 500 pictures, even if you
save more than 501 pictures onto the microSD card.
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About the free download software

With the ST-4001W (for Windows), ST-4001A (for

Android), or ST-40011 (for iOS), you can add text

and cut pictures down to size to send from the

transceiver. When using the ST-4001A or

ST-4001I, the edited picture can be transferred to the

transceiver through Bluetooth.

® Before using, read each manual, and use these
software according to the instructions.

@ In this manual, ST-4001W, ST-4001A, and ST-4001! are
described as “Picture Utility software.”

To transfer a picture to the transceiver

To transfer a picture to the transceiver through
Bluetooth, connect your mobile device and your
transceiver using the Bluetooth function. (p. 17-5)

Mobile device Transceiver
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Using the Picture screen

[MENU] > PICTURE The RX PICTURE screen
1. Push [MENU]. ® Push [ENT] to display the RX PICTURE detail
2. Select “PICTURE.” screen. _ _ ,
- The Picture screen is displayed. ® Push D-pad(l1) to display the RX Picture history.
® To close the Picture screen, push [QUICK], and then (p. 14-7)

select “<<Exit Picture Screen>>."

[l % 5 12:00
MAIN| DV

146.010 o

(VFQ)

440. 000 PSKIP m
Received band - <+— TX block marker
j E 15:54:04) IM1ZLK
I

Mr’w v
RX Pictgre zone X Plcture'zone - Current time
Select to display the Select to display the LAST(A): «— History number
RX PICTURE screen. TX PICTURE screen. e 640x480 <«— Picture Size
High Quality «—— Pjcture Quality
* When signals that contain picture data are received on the From: JM1ZLK
MAIN and SUB bands at the same time, both pictures are Receiver: ------
saved on a microSD card, but a picture is displayed on (2021/11/01 15:54:04) <¢—— Received time

only the MAIN band.

The TX PICTURE screen

In the Quick Menu wind lect th
n the Quick Menu window, you can select the ® Push [ENT] to display the TX PICTURE SET

following options.

screen.
Item Action ® Push D-pad(!1) to display the TX Picture history.
Turns OFF the Share (p- 14-7)
OFF ) :
Pictures function.
Tums ON the Share [FT;W TX block marker
Pictures function.
Picture TX . ® The picture is sent while
Single TX transmitting. After the
sending is completed, this
function is turned OFF.
Repeat TX |The picture is repeatedly sent. \ 4
<<TX All>> Sends the.plcture using the DV Fast
Data function.
TX Picture ’
<<Back To 1st>> Moves the TX block marker back to the 021 1 11_1 54
1st block. Picture Size ,
<<Exit Picture Closes the Picture screen i '640><480
Screen>> . Picture Quality

Standard (50%) |

When a received signal contains picture data
When the received signal contains picture data, the
RX Picture icon is displayed.

Lo - ® 5 12:00
146.010 PSKIP)
sussamnnnsl . . .
Mse.cop-sTaR  [l]=—— RX Picture icon
440.000 PSKIP

® You can turn OFF the RX Picture icon.
(IMENU] > SET > Display > RX Picture Indicator)
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14 SHARE PICTURES FUNCTION

Preparing a TX picture

There are 2 ways to prepare a TX picture.
+ Transfer from a mobile device using the Picture Utility software, through Bluetooth.
+ Save on a microSD card using the PC or mobile device.

<O Transfer from the mobile device

through Bluetooth

Insert a microSD card into the transceiver’s slot,

and then turn ON the transceiver.

In the mobile device, open the Picture Utility

software.

® When using an Android device for the first time, pair
the transceiver with your device. (p. 17-7)

Open the Transfer Settings screen.

Select “Using Bluetooth,” and then set “Transfer

Devices” to your transceiver.

® When using an iOS device for the first time, pair the
transceiver with your device. (p. 17-9)

® See the ST-4001A or ST-4001! instruction manual
for details. They can be downloaded from the Icom
website.

Open a picture to transfer using the Picture Utility

software.

Touch the Transfer (E) button.

« Starts transferring, and the transferred picture is
saved on the microSD card.

® The file name is automatically set in the following
format: yyyymmdd_hhmmss (yyyy: Year, mm: month,
dd: day, hh: hour, mm: minute, ss: second).

NOTE: If you cannot transfer the picture, check the
following:

On the transceiver

The transceiver is turned ON.

The Bluetooth function is ON.

The transceiver’s firmware is the latest version.

A microSD card is inserted into the transceiver.

The transceiver is in a normal operating mode.

® The transceiver cannot receive the picture in special
modes, such as the firmware update mode, clone
mode, setting save mode, and import or export mode.

On the device

The Bluetooth function is ON.
“Transfer Devices” is set to your transceiver.
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< Save on the microSD card using the

PC or mobile device

1. Turn OFF the transceiver, then remove the
microSD card from the transceiver.

2. Insert it into the microSD card drive or a memory
card reader* on your PC or mobile device.
* User supplied.

3. Copy a picture file, and paste it in the “Picture”
folder (“ID-52” > “Picture”) on the card.

4. Remove the card from your device, and insert it
into the transceiver’s slot.

NOTE: Before you remove the SD card, be sure to
electrically unmount it. Otherwise, the data may be
corrupted or deleted.

TIP:

* When “USB Connect’ is set to “SD Card Mode,” and the
transceiver is connected to the PC through a USB data
cable, you can directly access the microSD card that is
set in the transceiver from the PC.

(IMENU] > SET > Function > USB Connect)

* You can save a received picture in the “Picture” folder

on the SD card. (p. 14-7)
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Sending the picture

Step 1. Selecting a picture to send

Step 2. Sending the picture

@® You can retransmit the picture in the TX PICT HISTORY
screen. (p. 14-7)

® When you transfer the picture through Bluetooth, it is
set to “TX Picture.” If it is not necessary to change, go to
“Step 2. Sending the picture.”

[MENU] > PICTURE

1. Push [MENU].
. Select “PICTURE.”
3. Push D-pad($) to select the TX Picture zone, and
then push [ENT].
® 5 12:00]

(MAIN] DV

1 46.01 0 PSKIP

B

Push [ENT] again.
5. Select “TX Picture.”

TX Picture N

Picture Size R
320X240

Picture Quality ,
Standard (50%) |

v

6. Rotate [DIAL] to select a picture.

® You cannot view a picture if it is not in a supported
format (p. 14-2), or is corrupted.

7. Push [ENT].

8. Set “Picture Size,” “Picture Quality,” and
“‘Receiver.”
® See page 14-6 about each setting item.

9. To close the TX PICTURE SET screen, push
[MENUL.

1. Push [QUICK].
2. Select “Picture TX.”
5

i Picture TX - »

<<TX All>> P
<<Back To 1st>> g
<<Exit Picture Screen

3. Select “Single TX” or “Repeat TX.”
{OFF R
Single X

Repeat TX b

DY == Displayed while the Share
146.010 o Plictures function is ON.

440.000 PSKIP
[VFOJ

4. Hold down [PTT] to transmit.
® The picture is sent while transmitting.
5. Release [PTT] to receive.

Sending a picture using the DV Fast Data
function

Select “<<TX All>>” in step 2 to send a picture using
the DV Fast Data function.

Picture TX ) »

<<TX All>>

<<Back To 1st>>
<<Exit Picture Screen

Will transmitting
remaining blocks. 3
OK
CANCEL

@® DO NOT select “<<TX All>>" when you send a picture
to other transceivers that can receive only slow speed
data.

® While transmitting voice audio by holding down [PTT] on
the microphone, the transceiver automatically changes
to the Slow Speed Data mode.
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Sending the picture

¢ Moving the TX block marker

You can select the block to start sending.
® While sending a picture, you cannot move the TX block
marker.

1. Push D-pad(5) to select the TX Picture zone, and
then push [ENT].

2. Push [QUICK].

3. Select “TX Picture Block Select.”

Picture TX »
TX Picture Set

TX Picture Block Seleq

<<TX All>>
TX Picture History

4. Rotate [DIAL] or push D-pad to move the TX block
marker.

® To move the TX block marker back to 1st block, push
[QUICK], and then select “BACK TO 1ST.”

Push [ENT].

To close the TX PICTURE screen, push [MENU].

oo
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OTXPICTURE SET

This screen is used to set a picture, size, quality, and
its intended destination to send.
® While sending a picture, you cannot change the settings.

1. Push D-pad(5) to select the TX Picture zone, and
then push [ENT].

2. Push [ENT] again.

3. Select the setting item.

Picture Size 3
320X240

Picture Quality R
Standard (50%) |l

TX Picture

v

4. Select an option.

160X120

320X240
640X480

5. To close the TX PICTURE SET screen, push
[MENUI.

TIP: You can set each item to its default by pushing
[QUICK], and then selecting “Default” on the Quick
Menu window.

TX Picture

Select the picture to send, saved in the “Picture” folder

(“ID-52” > “Picture”) on the microSD card.

® When you set the TX Picture in the TX PICT HISTORY
screen, “(RE TX)” is displayed before the file name.

Picture Size (Default: 320 x 240)

Set the desired size of a picture to send to “160 x

120,” “320 x 240,” or “640 x 480.”

@ You cannot select a size larger than the size of the
picture.

Picture Quality (Default: Standard (50%))

Set the quality of a picture to send to “Low (25%),”
“Standard (50%),” or “High (75%).”

Receiver (Default:

Enter the receiver’s call sign to let all stations that receive
the picture know the picture’s intended destination.

NOTE: All stations that receive the signal can see
the picture, even if they are not set as the receiver.
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Viewing the pictures

< Viewing the RX Picture History

When you receive a DV call that has picture data, a
received picture log is saved. Up to 50 history data
can be saved. When you receive the 51st picture, the
oldest history data is deleted.

NOTE: Confirm a microSD card is in the card slot.

[MENU] > PICTURE

1. Push [MENU].

2. Select “PICTURE.”

3. Push D-pad($) to select the RX Picture zone, and
then push [ENT].

® @ 12:00

152404 MIZICR

4. Rotate [DIAL] to select an RX picture history data.
5. Push [ENT].

No. 15

u 640x480
High Quality
From: IM1ZLK

Receiver: ------
(2021/11/01 15:54:04)

» The RX picture history number, picture size, picture
quality, the caller’s call sign, receiver set by the caller,
and RX date and time are displayed.

TIP: In the Quick Menu window, you can select the
following options.
+ Zoom Picture: Changes to enlarged display.
+ Save: Saves the displayed picture onto the
microSD card.
® The file name is automatically set in
the following format:
Picyyyymmdd_callsign_xx
(yyyy: Year, mm: month, dd: day,
callsign: the caller’s call sign,
xx: serial number).
* Delete: Deletes the selected RX picture history data.
* Delete All: Deletes all RX picture history data.
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< Viewing the TX Picture History

When you send a picture, the picture log is saved. Up
to 50 history data can be saved. When you send the
51st picture, the oldest history data is deleted.

NOTE: Confirm a microSD card is in the card slot.

[MENU] > PICTURE

1. Push [MENU].

2. Select “PICTURE.”

3. Push D-pad($) to select the TX Picture zone, and
then push [ENT].
’%@v % 5 12:00

146.010

440.000

I
Rl Bp
v

PSKIP|

PSKIP|

B

Rotate [DIAL] to select a TX picture history data.
5. Push [ENT].

k High Quality

From: JA3YUA
Receiver: ------
(2021/11/01 16:14:07)

No. 2
640x480

» The TX picture history number, picture size, picture
quality, the caller’s call sign, receiver, and TX date
and time are displayed.

TIP: In the Quick Menu window, you can select the
following options.
* Retransmit:  Sets the picture to “TX Picture.”
« Zoom Picture: Changes to enlarged display.
* Delete: Deletes the selected TX picture history data.
* Delete All: Deletes all TX picture history data.
® You cannot delete when the selected TX picture
history data is set to “TX Picture” (RE TX).
® You cannot set the picture to “TX Picture” while
transmitting a picture.
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Viewing the pictures

< Viewing the pictures in the “Picture”

folder

You can view the pictures saved in the “Picture” folder

on the microSD card.

® You cannot view the pictures while sending a picture.

® To save the received picture onto the microSD card,
push [QUICK], and then select “Save” on the RX PICT
HISTORY screen. (p. 14-7) Otherwise, the received
picture is not saved in the “Picture” folder on the card.

[MENU] > SET > SD Card > TX/RX Picture View

1. Push [MENU].
2. Select “SD Card” in the “SET” menu.
3. Select “TX/RX Picture View.”

Screen Capture View »
Firmware Update »
Format

Unmount

4. Select a picture to view.

200w _055638

v
20 _162919 ’
20 _164803 ’
20211101_154337 ’

® You cannot view a picture if it is not in a supported
format (p. 14-2) or it is corrupted.
® To exit the MENU screen, push [MENU].

TIP: In the Quick Menu window, you can select the

following options.
* File Information: Displays the file name, size, and

saved date.
* Delete: Deletes the selected picture.
* Delete All: Deletes all pictures.
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Band Scope function

Use the Band Scope function to visually search a
specified frequency range around the displayed
frequency. You can use this function to search for a
signal, and see the relative received signal strength
level.

On the single band display, you can confirm the signal
strengths over time by the waterfall function.

On the single band display within 137 ~ 174 MHz

and 375 ~ 479 MHz, you can hear the displayed
frequency’s audio during a sweep.

The Band Scope function has 2 sweep types.

+ Single Sweep: Searches the specified
frequency range only once.
The Single Sweep starts from
the lower frequency, and the
sweep stops after reaching the
upper frequency.

» Continuous Sweep: Repeatedly searches the
specified frequency range.

The transceiver’s sweep bandwidth is + 15* x the
tuning step number, centered on the operating

frequency.
* You can change the displayed steps to + 20 steps.
(IMENU] > SET > Scope > Displayed Steps)

During a sweep in the Center mode

Center frequency
(Example: 146.010 MHz)

&% 5 12:00

146.1910

Bnn epplin| o ool i -

=n=- oille--E0

PSKIP

Band Scope —[
display

When selecting a
Band Scope zone
(with a line in orange)

Strong level

-

Weak level

Sweep marker

While stopping a sweep

&% B 12:00

(MAIN]FM

146.000

PSKIP
----- EEEEE (VFO)

|llll.lll--ll|_l,l--l-.l| lil_.x

Operating frequency (moves)
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You can select the Band Scope display mode from
three modes, the Center mode, the FIX mode, and the
Scroll (FIX) mode.

Center mode
Displays signals around the operating frequency
within the selected span.

% 5 12:.00

il
(MAIN]FM

146. 010

PSKIP
SLO

[ FEE— -lll--_ll

|=m=l mEE.EE

FIX mode
Displays signals within a specified frequency range.
® Set the displayed frequency range on the MENU screen.
(p. 12-7)
(IMENU] > SET > Scope > FIX Mode Center Frequency)

* 12:00

(MAIN]FM

146.010

f— PSKIP Edge
Mode icon —Tﬂm&a& nba. |1 sl Bie035 <—(Upper frequency)
(FIX mode) i
Edge
(Lower frequency)

Operating frequency
(moves)

When the operating frequency moves
outside the upper or lower Edge frequency,
) <— “P” or “«” is displayed in the upper side
corners of the Band Scope screen.

st 05085,

Scroll (FIX) mode
Displays signals within a specified frequency range.
When the operating frequency moves outside of the
screen, the displayed frequency range is automatically
shifted.
® Set the displayed frequency range on the MENU screen.
(p. 12-7)
(IMENU] > SET > Scope > FIX Mode Center Frequency)

&% 5 12:00 ® 8 12:00

(MAIN]FM

146. 010

PSKIP
SLO

’—> |m&§ﬂ_.lull_i=,_._n|!h@_&5_

£ 040.0800n e Ml 2235

Mode icon |
(Scroll (FIX) mode) Operating frequency (moves)
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Band Scope function

NOTE: During the continuous sweep, the noise may
occur if you bring your hand or body close to the
screen.

< Using the Band Scope function

[MENU] > SCOPE

1. Push [MENU].
Select “SCOPE.”

RECORD FMRADIO

SCDPEI @  DvGw

VOICE

=]

PICTURE

X

SET

GPS

* Returns to the standby screen, and starts the
continuous sweep.

Push [QUICK].

Select “Scope Mode.”

(1] % = 00|

NScope OFF

Single Sweep P

B w

Istop Sweeping

VFO

5. Select the Band Scope display mode.
« Displays the selected display mode, and starts the
continuous sweep.
6. Push [ENT].
» Stops the sweep.
® Push [ENT] again, to resume the sweep for the
Continuous Sweep function.
7. When the sweeping stops, rotate [DIAL] to move
the sweep marker to a detected signal.
* You can hear the signal audio.
® While the sweep is paused, push [CLR] to turn OFF
the Band Scope function.

Band Scope screen operation

Key Action
[DIAL] Rotate to select an operating frequency.
D-pad(1) Push Fo cancel the Band Scope zone
selection.
D-pad(l) E’ush to select the Band Scope zone (with a
line in orange).
[ENT] Push to start or stop a sweep.
Push to open the Quick Menu window.
[QUICK] | ® When selecting the Band Scope zone,
only the Band Scope menu is displayed.
When selecting the Band Scope zone:
[CLR] » Push to stop the sweep during a sweep.
» Push to turn OFF the Band Scope
function while stopping a sweep.
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¢ Using the Waterfall display

On the single band display, you can turn the waterfall
display ON or OFF.

146.010

SLO

PSKIP

<+—\When selecting a
. Band Scope zone
(with a line in orange)

Waterfall ~[ -
zone

Scale

® Information

« Higher signal levels are Red, Yellow, Green, Light-blue,
Blue, and Black (no signal), in that order.

» During a sweep, the scales on both sides of the waterfall
zone are moved with the waterfall. While stopping a
sweep, the scales and the waterfall also freeze.

* You can select the Waterfall speed.

(IMENU] > SET > Scope > Waterfall Speed)

TIP:

« If the tuning step is set too wide, the signals in the

sweep range may not be displayed (they may be

skipped), even if they are strong signals. Therefore,

we recommend that you set the tuning step to 20 kHz

or less to use the Band Scope function. See the Basic

manual Section 3 for details on how to set the tuning
step.

On the AIR band, you cannot hear the displayed

frequency’s audio during a sweep. When “AF Output

(DUAL/AIR Band)” is set to ON, the received audio is

momentarily output during a sweep, and you will know

that a signal is received without looking at the display.

- You can turn “AF Output (DUAL/AIR Band)” ON or
OFF on the MENU screen. (p. 12-30)

- The FM Radio audio output may be interrupted due to
the AF Output (DUAL/AIR Band) function. In that case,
set “AF Output (DUAL/AIR Band)” to OFF, or set “Auto
Mute” to OFF.

(IMENU] > SET > Scope > AF Output (DUAL/AIR Band))

(IMENU] > FM RADIO > FM Radio Set > Auto Mute)
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Home Channel function

You can set an often-used frequency, Memory
channel, or repeater as a Home Channel in VFO
mode, Memory mode, and DR screen.

¢ Setting a Home Channel

1.

B w

Select the VFO or Memory mode, or the DR
screen to set a Home Channel.
Select a frequency, Memory channel, or an access
repeater to be set as a Home Channel.
Push [QUICK].
Select “Home CH Set.”

00|

Voice TX »
GPS Information
GPS Position
Weather Alert 4

Home CH Set »

Voltage

VFO

Select “Set Frequency” (VFO mode), “Set
Channel” (Memory mode), or “Set Repeater” (DR
screen).

:00)

Set Frequency

d

» Sets a Home Channel, then returns to the standby
screen.

TIP: Selecting “Clear” in Step 4 clears the Home
channel setting.

: 00
Set Frequency

Clear (146.010)

P
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<o Home CH Beep function

When a Home CH is selected by rotating [DIAL], a
beep sounds. You will know the Home CH selection
without looking at the display.

You can assign the [Home CH] key function to
an optional microphone key or optional Bluetooth
headset. (pp. 12-18, 12-34)
® You can turn OFF the Home CH Beep function on the
MENU screen.
(IMENU] > SET > Sounds > Home CH Beep)
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Using the DTMF memory

The transceiver can save up to 16 memories of a 24
digit DTMF code.

< Entering DTMF code

[MENU] > SET > DTMF/T-CALL > DTMF Memory

1. Push [MENU].
2. Select “DTMF/T-CALL” in the “SET” menu.
3. Select “DTMF Memory.”

DTMF Memory »

DTMF Speed 4

4. Selecta DTMF Memory to enter.

® DO NOT push [ENT].
5. Push [QUICK].
6. Select “Edit.”

Clear

G=

7. Enter a DTMF code, then push [ENT].
(Example: 123456A)

123456A

» Saves the Memory, and returns to the DTMF
MEMORY screen.

® See page iii on how to enter characters.

® To exit the MENU screen, push [MENU].

TIP: To clear the entered DTMF code, push [QUICK]
on the DTMF MEMORY screen, then select “Clear.”

15-5

< Monitoring the entered DTMF code

You can check and hear the entered DTMF code.

[MENU] > SET > DTMF/T-CALL > DTMF Memory

Push [MENU].

Select “DTMF/T-CALL” in the “SET” menu.
Select “DTMF Memory.”

Select a DTMF Memory to monitor.

PN =

T-CALL
di:
d2:
d3:
da:

® DO NOT push [ENT].
5. Push [SQL].

us.

da:

* The DTMF code sounds.

« After sounding, returns to the DTMF MEMORY
screen.

® To exit the MENU screen, push [MENU].

TIP: You can also check the DTMF code by pushing
[QUICK] and select “DTMF Monitor” on the DTMF
MEMORY screen in step 4.

DTMF Monitor
Edit
Clear
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Transmitting the DTMF code

< Transmitting the entered DTMF code < Transmitting a DTMF code (Direct Input)

[MENU] > SET > DTMF/T-CALL > DTMF Memory

1. Push [MENU].
2. Select “DTMF/T-CALL” in the “SET” menu.
3. Select “DTMF Memory.”

DTMF Memory »

DTMF Speed »

4. Select a DTMF Memory to transmit.

T-CALL
d1:
d2:
d3:
da4:

* The selected DTMF channel is set to transmit.
5. Push [MENU].

« Exits the MENU screen.
6. While holding down [PTT], push [SQL].

o x5 12:

[MAIN ]

146.010

----- TCCTTTLL]]
123456A

FM

440.000

VFO

» The selected DTMF code in step 4 is transmitted.
» Even if you release [PTT], the transceiver keeps

PSKIP|

transmitting the code until all the code is transmitted.

TIP: In the standby screen, you can transmit a
DTMF code by pushing [QUICK], selecting “DTMF
TX,” and selecting a code.

Direct Input
d0: 123456A

15-6

1. Push [QUICK].
Select “DTMF TX.”

¥Band Select )

3. Select “Direct Input.

d0: 123456A

4. Enter a DTMF code, then push [ENT].

(Example: 012345%#)

@ x5 12
(MANEY]
0123454#
440-000 PSKIP|
VFO

» Transmits the entered DTMF code.
® The DTMF code scrolls during transmission.
® See page iii on how to enter characters.

TIP: About the 1750 Hz tone
When you select “T-CALL” on the DTMF MEMORY
screen, a 1750 Hz tone can be transmitted.

d0: 123456A
d1:
d2:
ds3:
da:

While holding down [PTT], push [SQL].
» The 1750 Hz tone is transmitted.
@ You can hear the 1750 Hz tone from a speaker.
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Transmitting the DTMF code

< Selecting the DTMF transmit speed

You can select the DTMF transmit speed.

[MENU] > SET > DTMF/T-CALL > DTMF Speed

1. Push [MENU].

2. Select “DTMF/T-CALL” in the “SET” menu.

3. Select “DTMF Speed.”

DTMF Memory »

4. Select a transmit speed. (Default: 100ms)

200ms

500ms

® To exit the MENU screen, push [MENU].

15-7

The image of transmitting the DTMF code

— —
Pi, Po, Pa Pi-, Po—, Pa—
\ \

When “100ms” is selected, When “500ms” is selected,

the DTMF transmit speed the DTMF transmit speed

is fast. is slow.



1 5 oTHER FUNCTIONS

Tone squelch operation

The tone squelch opens only when you receive a

signal that includes a matching subaudible tone in the
FM or FM narrow (FM-N) mode. You can silently wait

for calls from other stations using the same tone.
Also, the reversed tone squelch function mutes
the squelch when a signal including a matching
subaudible tone.

Step 1. Setting the tone squelch frequency

[MENU] > SET > DUP/TONE... > TSQL Freq

Push [VFO/MHZz] to enter the VFO mode.
Push [MODE] to select the FM or FM-N mode.
Rotate [DIAL] to set an operating frequency.
Push [MENU].

Select “DUP/TONE...” in the “SET” menu.
Select “TSQL Freq.”

ok wN =

Offset Freq

Repeater Tone
Tone Burst
DTCS Code
DTCS Polarity

v v w

7. Rotate [DIAL] to set a Tone Squelch frequency,
then push [ENT].

® Set to between 67.0 and 254.1 Hz.
® To exit the MENU screen, push [MENU].

15-8

Step 2. Using the tone squeich

1. Push [QUICK].
2. Select “TONE.”

Band Select 4
DUP »
»

TONE

VFO

[iae] — 12:00|
(o lﬂlﬂ

FM

440-000 PSKIP|

4. Operate normally.
* You will only hear the audio of stations that are using
the same Tone Squelch frequency. All other signals

will be muted.

About the Tone squelch types indication
« TSQL: Enables the Tone Squelch function.

« TSQL-R: Enables the Reverse Tone Squelch function.

» TONE(T)/DTCS(R)
(“T-DTCS” is displayed, “T” blinks.):

- DTCS(T)/TSQL(R)
(“D-TSQL" is displayed, “D” blinks.):

« TONE(T)/TSQL(R)
(“T-TSQL” is displayed, “T” blinks.):

When you transmit, the selected subaudible
tone is superimposed on your normal signal.
When you receive, the DTCS squelch opens
only for a signal that includes a matching
DTCS code and polarity. (Audio is heard)

When you transmit, the selected DTCS code
is superimposed on your normal signal.
When you receive, the tone squelch opens
only for a signal that includes a matching tone
frequency. (Audio is heard)

When you transmit, the selected subaudible
tone is superimposed on your normal signal.
When you receive, the tone squelch opens
only for a signal that includes a matching tone
frequency. (Audio is heard)
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DTCS code squelch operation

The tone squelch opens only when you receive a
signal that includes a matching DTCS code in the

FM or FM narrow (FM-N) mode. You can silently

wait for calls from others using the same tone. Also,

a reversed tone squelch function mutes the squelch
when you receive a signal including a matching DTCS
code.

Step 1. Setting the DTCS code

[MENU] > SET > DUP/TONE... > DTCS Code

Push [VFO/MHZz] to enter the VFO mode.
Push [MODE] to select the FM or FM-N mode.
Rotate [DIAL] to set an operating frequency.
Push [MENU].

Select “DUP/TONE...” in the “SET” menu.
Select “DTCS Code.”

ok wN =

Offset Freq
Repeater Tone

TSQL Freq
Tone Burst

DTCS Code

DTCS Polarity

7. Rotate [DIAL] to set a DTCS code, then push
[ENT].

023

® Set to between 023 and 754.
® To exit the MENU screen, push [MENU].

15-9

Step 2. Using the DTCS code squelch

1. Push [QUICK].
2. Select “TONE.”

? % B 120

Band Select 4
DUP »

TS

TATT

DTMF TX

v v v

3. Select the DTCS code type.
gOFF B

TONE
TSQL
| TsQLR
DTCS-R

[iann] > 5 12:00]
|ﬁnw| DTCS 2

146.010

PSKIP|

FM

440.000

VFO

PSKIP|

4. Operate normally.

* You will only hear the audio of stations that are using
the same DTCS code. All other signals will be muted.

About the DTCS code types indication

« DTCS: Enables the DTCS Squelch function.

+ DTCS-R: Enables the Reverse DTCS Squelch function.

* DTCS(T) (“DTCS” blinks):
When you transmit, the selected DTCS code
is superimposed on your normal signal.
When you receive, the function is OFF.

* TONE(T)/DTCS(R)

(“T-DTCS” is displayed, “T” blinks.):

When you transmit, the selected subaudible
tone is superimposed on your normal signal.
When you receive, the DTCS squelch opens
only for a signal that includes a matching
DTCS code and polarity. (Audio is heard)

* DTCS(T)/TSQL(R)

(“D-TSQL” is displayed, “D” blinks.):

When you transmit, the selected DTCS code
is superimposed on your normal signal.
When you receive, the tone squelch opens
only for a signal that includes a matching tone
frequency. (Audio is heard)
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VOX function

The Voice Operated eXchange (VOX) function toggles
the transceiver between transmit and receive by your
voice. This function provides hands-free operation.
You can use the VOX function with the optional
HS-94, HS-95, or HS-97 HEADSET and the
OPC-2006LS PLUG ADAPTER CABLE.

<O Selecting the headset type

[MENU] > SET > Function > VOX > Headset Select

1. Push [MENU].
. Select “Function” in the “SET” menu.
3.

Select “VOX.”

Cl-v »
USB Connect »
USB Serialport Functi »
Heterodyne »

Battery Pack Select )|l

Select “Headset Select.”

VOX

VOX Level
VOX Delay
VOX Time-Out Timer »

Headset Select »

v v -

5. Select an option.

HS-95

+ HS-95: Select when using the HS-95.

» Other: Select when using the HS-94 or the HS-97.
® To exit the MENU screen, push [MENU]I.

15-10

NOTE: BE SURE to turn OFF the transceiver when
plugging or unplugging the OPC-2006LS into or from
the [MIC/SP] jack.

TIP: You can also use the VOX function with the
Bluetooth headset.

(IMENU] > SET > Bluetooth Set > Headset Set > VOX)
See page 13-5 for details.

OPC-2006LS
(Option)

To the
(Option)

*You can also use this function with the optional HS-95 or HS-97.
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VOX function

¢ Using the VOX function

[MENU] > SET > Function > VOX > VOX

1. Push [MENU].
2. Select “Function” in the “SET” menu.
3. Select “VOX.”

Cl-v »
USB Connect »
USB Serialport Functi »
Heterodyne »
Battery Pack Select i

4. Select “VOX.”

VOX Level

VOX Delay
VOX Time-Out Timer »
Headset Select »

5. Select “ON.”

OFF

6. To exit the MENU screen, push [MENU].
%Mvou] ® 5 12:00]

146.010

PSKIP
VFO

FM

440 -000 PSKIP

* When you connect the HS-94, HS-95, or HS-97

headset, “VOX” is displayed on the standby screen.

NOTE: While receiving a signal, or sounding a beep,

the transceiver does not switch to transmit by your
voice.

O Setting the VOX level

NOTE: We recommend you set the Microphone
Gain level to 3, before setting the VOX level.
(IMENU] > SET > Function > MIC Gain (External))

[MENU] > SET > Function > VOX > VOX Level

1. Push [MENU].
2. Select “Function” in the “SET” menu.
3. Select “VOX.”

Cl-v »
USB Connect »
USB Serialport Functi »
Heterodyne »

Battery Pack Select [

4. Select “VOX Level.”

VOX Time-Out Timer »
Headset Select »

5. While speaking into the microphone, rotate [DIAL]
to adjust the VOX level.

—:

« Displays “VOX” when the TX level audio is input.

® The VOX level can be adjusted between 1 (minimum)
and 10 (maximum), or turned OFF. (Default: 5)

® Higher values make the VOX function more sensitive
to your voice.

6. To exit the MENU screen, push [MENU].

@ If the S-meter does not display the output power
level, and the transceiver does not transmit, adjust
the VOX delay time.

(IMENU] > SET > Function > VOX > VOX Delay)

® When the VOX function is ON, you can adjust the

VOX level by rotating [DIAL] while transmitting.

15-11
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VOX function

OVOX-related settings

You can set the “VOX Delay” and “VOX Time-Out
Timer” on the MENU screen.

VOX Delay
[MENU] > SET > Function > VOX > VOX Delay

The VOX delay is the amount of time the transmitter
stays ON after you stop speaking. It enables normal
pauses in speaking. (p. 12-22)

1.0sec

1.5sec
2.0sec
2.5sec
3.0sec

VOX Time-Out Timer

[MENU] > SET > Function > VOX >
VOX Time-Out Timer

The VOX Time-Out Timer prevents prolonged
accidental transmission. (p. 12-22)

Tmin

2min
4min
5min

15-12
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Weather channel operation (USA version only)

There are 10 weather channels for monitoring <O Weather alert function
the National Oceanographic and Atmospheric

Administration (NOAA) weather broadcasts. NOAA broadcast stations transmit weather alert tones

before important weather announcements.
When the weather alert function is turned ON, the

OSeIecting a Weather channel selected weather channel is monitored every 5

seconds for an announcement.
1. Push [MR] to enter the Weather Channel mode. When an alert signal is detected, the “ALT” and
® Pushing [MR] each time selects the Memory and

the WX channel are alternately displayed, and a
Weather Channel modes. )
beep sounds until you change the mode or weather

(e R channel, turn OFF the Weather Alert function, or turn
WX-01 OFF the transceiver.
The previously selected (used) weather channel
- [ WX ] is checked periodically during standby, or while
440.000 PSKIP| scanning.

1. Push [QUICK].

2. Rotate [DIAL] to select a weather channel. > Select “Weather Alert”

« Displays the selected weather channel number

(‘WX-01"~ "WX-10") Voice TX o
GPS Information
GPS Position
P
Home CH Set I
Voltage P
3. Select “ON.”

VFO

v

[ % & 12:00

rrrrr

FM

440-000 PSKIP|

* Turns ON the Weather Alert function, and “WX” is
displayed.

15-13
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Screen Capture function

You can capture the transceiver display onto a < Viewing the captured screen
microSD card. Most of the screens used in this )
manual are captured using this function. [MENU] > SET > SD Card > Screen Capture View
However, some displays cannot be captured. 1. Push [MENU].
. . 2. Select “SD Card” in the “SET” menu.

< Setting the Screen Capture function 3. Select “Screen Capture View.”

[MENU] > SET > Function > -

Screen Capture [PWR] Key TX/RX Picture View »
1. Push [MENU]. Firmware Update
2. Select “Function” in the “SET” menu. Format
3. Select “Screen Capture [PWR] Key.” Unmount

» The capture list is displayed.

Battery Pack Confirm»

Charging (Power ON » » The latest screen capture is at the bottom of the list.
USB Power Input (Ph » 4. Select the desired screen capture to display it.
Screen Capture [PWR»
Screen Capture File T » 20211101_133238.brr»
LO/CALL Key Actions? ||
4. Select “ON.”
OFF I
OoN | » The screen capture is displayed.

® While a screen capture is displayed, you can scroll
through all the screen captures by rotating [DIAL].
® To exit the MENU screen, push [MENU].

® To exit the MENU screen, push [MENU].

Checking the file information and deleting a file
1. Select the screen capture that you want to view
< Capturing a screen or delete.

® DO NOT push [ENT].

Push [QUICK].

Select an item from “File Information,” “Delete,”
and “Delete All.”

1. Display the desired screen to capture.
2. Push [(] to capture the screen.
* The captured screen is saved onto the card.

wn

File Information

Delete
Delete All

[&]

* File Information: Displays the file name, size,
and date of the selected screen

000
© E
1000

capture.
* Delete: Deletes the selected file.
* Delete All: Deletes all files.

15-14
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Setting the Opening picture

You can set a picture that is displayed at power ON. Step 2. Setting the displayed picture
(Transceiver)

NOTE: To set the displayed picture, a microSD card
(user supplied) is required. [MENU] > SET > SD Card > Opening Picture

1. Push [MENU]I.
2. Select “SD Card” in the “SET” menu.
3. Select “Opening Picture.”

About a picture file to use
* File type: 24 bit bitmap
(The file extension is “bmp.”)
* Picture size: 320 x 280 (px)
* File name: Up to 23 characters
(except the filename extension)

Load Setting
Save Setting

v v v v

Save Form
Import/Export
Step 1. Saving a picture on the microSD card
(PC) SD Card Info P'
1. Copy a picture file into the “OpeningPicture” folder 4. Select a picture to display.
(“ID-52” > “OpeningPicture”) on the microSD card.
® See page 2-5 for detail.

2. Insert the microSD card into the transceiver.

» The selected picture is displayed.
5. Push [ENT].
@ To select the picture again, push [CLR].
» The confirmation dialog is displayed.
6. Select “YES.”
* The transceiver will automatically restart, and the
selected picture is displayed.

To hide the picture at power ON
Select “<<Cancel Opening Picture Setting>>" in step 4.

<<Cancel Opening Picty

ID-52_Opening »

® The selected picture can be displayed even if:
* No microSD card is inserted.
* You do a Partial Reset or All Reset.

15-15
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The transceiver has a data cloning capability. This
function is useful when you want to copy all of the
settings and entered contents from one
ID-52A/ID-52E to another. This section describes the
cloning method using a microSD card.

Step 1. Saving the master transceiver’s setting
data onto the microSD card.

[MENU] > SET > SD Card > Save Setting

1. Push [MENU].
2. Select “SD Card” in the “SET” menu.
3. Select “Save Setting.”

Load Setting

Save Form

- Rd

Import/Export
Opening Picture
SD Card Info

v v v | w
4

Select “<<New File>>.”

S —

MY DATA

v

5et20211101_01

EIRNCHAR TYPE  ABC

® The file name is automatically set in the following
format: Setyyyymmdd_xx
(yyyy: Year, mm: month, dd: day, xx: serial number).

» The confirmation dialog is displayed.
Select “YES.”

FILENAME |

CatdNP11101 N1

Save file?

NO

EERCHAR TYPE ABC

* While saving, a progress bar is displayed, then
returns to the SD CARD screen after the saving is
completed.

@ To exit the MENU screen, push [MENU].

Push [ENT] to save the file with the displayed name.

15-16

® Recorded voice memories are not included in the cloning
data. To play back the master transceiver’s voice memory,
insert the microSD card into a sub transceiver, or make a
copy onto the sub transceiver’s microSD card using a PC.

® Assumes that the microSD card has already been
inserted into the transceiver.

Step 2. Remove the microSD card from the master
transceiver, then insert it into the sub
transceiver.

1. Turn OFF the master transceiver.

2. Remove the microSD card from the master
transceiver.

3. Insert the card into the sub transceiver, then turn
ON the sub transceiver.

NOTE:

» Turn OFF the transceiver before you insert or remove
the microSD card.

* DO NOT turn OFF the transceiver while saving or
loading the setting data. Otherwise, the data may be
corrupted or deleted.

TIP: The setting data is saved in the “icf” file format
that is used in the CS-52 PROGRAMMING SOFTWARE.
When the saved data on a card is copied to a PC,
you can edit it with the programming software.

For details, refer to the CS-52 instructions that can
be downloaded from the lcom website.

(Continue the steps on the next page.)
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Step 3. Loading the setting data into the sub
transceiver.

[MENU] > SET > SD Card > Load Setting

1. Push [MENU].
2. Select “SD Card” in the “SET” menu.
3. Select “Load Setting.”

Save Setting
Save Form

-

Import/Export
Opening Picture
SD Card Info

v v v v | w
0

4. Select a data file to load into the transceiver.

MY DATA »
5e120211101_01 4

5. Select the loading content.

ALL
Except My Station
Repeater List Only

* ALL:
Loads all Memory channels, settings on the MENU
screen, and the Repeater List into the transceiver.
» Except My Station:
Loads all Memory channels, setting on the MENU
screen except MY call signs, and the Repeater List
into the transceiver.
* Repeater List Only:
Loads only the Repeater List into the transceiver.
6. Select “YES” or “NO.”

Keep 'SKIP' settings

in Repeater List?
YES
NO

* YES:
The skip settings of the Repeater List are retained.
(p. 5-39)

* NO:
The skip settings of the Repeater List are cleared.

15-17

7. Select “YES.”

Load file?

NO

« Starts checking and loading the data file.
* After loading, “COMPLETED!” is displayed.

8. Restart the transceiver to operate with the new
setting.
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Resetting

Occasionally, erroneous information may be
displayed. This may be caused by static electricity or
by other factors.

If this problem occurs, turn OFF the transceiver. After
waiting a few seconds, turn ON the transceiver again.
If the problem still exists, perform a Partial reset.

If the problem still exists after performing a Partial
reset, perform an All reset.

<O Partial Reset

A Partial Reset resets the operating settings to their
defaults without clearing the following:
* Memory Channel contents

« Call Channel contents

* Radio Memory contents

Scan Edge contents

Message data

GPS memory contents

Call sign memories

« DTMF memory contents

* Repeater list

* Bluetooth pairing list

» Opening picture

[MENU] > SET > Others > Reset > Partial Reset

1. Push [MENU].
2. Select “Others” in the “SET” menu.
3. Select “Reset.”

v

Information
Clone
Reset

- Rd

4. Select “Partial Reset.”

Partial Reset

All Reset

» The confirmation dialog is displayed.
5. Select “YES.”

3 Partial Reset?

NO

* “PARTIAL RESET” is displayed, and then the display
automatically returns to the default screen.

NOTE for the All reset: After performing an All
reset, you cannot use the DR function because

the Repeater List contents are also cleared. We
recommend you save the setting data onto a
microSD card, or to your PC using the CS-52
PROGRAMMING SOFTWARE before performing an All
reset. After the All reset is finished, load or write the
saved data into your transceiver.

<O All Reset

An All reset clears all data and returns all settings to

their factory defaults. Memory channel contents, filter

settings, and so on will all be cleared, so you will need

to rewrite your operating settings unless you have a

backup.

® The Bluetooth pairing list and opening picture are not
deleted.

[MENU] > SET > Others > Reset > All Reset

1. Push [MENU].
. Select “Others” in the “SET” menu.
3. Select “Reset.”

Information 4
Clone »
Reset »

4. Select “All Reset.”

Partial Reset

All Reset

» The confirmation dialog is displayed.
5. Select “YES.”

ﬂ All Reset?

NO

* “ALL RESET” is displayed, and then the display
automatically returns to the default screen.
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< About updating the firmware

You can update the ID-52A/E’s firmware using a
microSD card. Updating the firmware adds new
functions and/or improves performance parameters.
You can download the latest firmware from the lcom
website.

https://www.icomjapan.com/support/

IMPORTANT: To update the firmware, first format
your microSD card using the ID-52A/E.

Then copy the downloaded firmware data from your
PC into the “ID-52” folder on the card.

16-2

< Checking the firmware version
Check the firmware version on the VERSION screen.

[MENU] > SET > Others > Information > Version
1. Push [MENUI.

2. Select “Others” in the “SET” menu.
3. Select “Information.”

Information 4

Clone »
Reset »

4. Select “Version.”

Voltage »

VERSION
CPU M:
S:

DSP:

GPS: -

Bluetooth:

» The VERSION screen is displayed.
® To exit the VERSION screen, push [MENU].

TIP: You can also check the firmware version when
you turn ON the transceiver.

The firmware version is displayed.
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General

< Preparation

Access the following URL and download the firmware
file.

https://www.icomjapan.com/support/
® These instructions are based on Microsoft® Windows® 10.

1. Click the “Firmware/Software” link.

. Firmware / o . Instruction
] fa__i s - CLi
‘ Software e UI'Ck
- Guides
EU Declaration 5 B Catalogs / 5
of Conformity 'E Brochures

2. Enter “ID-52” into the Search box, and then click
[Search].

Please fill the model name or part of the model name, and click the *Search button

D5 @ 0 Enter
@ Click

3. Click the desired firmware file link.
4. Carefully read “Regarding this Download Service.”
Click “Agree,” and then click [Download].

Regarding this Download Service.

When using this download service, the implementation, use and/or results of use are the sole respansibillty

of the person making the download

Firmiware is important data for the b

downloading or @ malfunction may c:

functioning normally. If such a failure of the fmware rewriting resuls in your equipment nat functioning

normaly, lcom Inc. expressly denles and is free from any and all responsibility arising from the result of

damage from such an event

I tully understand the above, and agree not 1o hold lcom Inc. responsible for any damage to my equipment
lnss.n{data as.a.esult0fthis dawnioarl

=1 —@ Click
@ Click

5. Click “Save as” in the displayed File Download
dialog.

6. Select the location where you want to save the
firmware, and then click [Save] in the displayed
File Download dialog.

2 Save s X
« v B Desktop v O
Organize = New folder E- @
s Quick access . OneDrive
& OneDrive
manual
B This PC a
USB Drive ()
- [‘a This PC
i Network =
== Libraries
| USB Drive (E)
-
J|  UsB Drive (F)
- )
Fileneme: |52 zip v|
Save astype: Compressed (zipped) Folder (".zip) v
 HideFoider [C=_}——-"Click

» The file starts downloading.
» The firmware and the firm utility are compressed in a
“zip” format folder. Unzip it before use.

<& Unzipping the firmware folder

1. Right-click the downloaded firmware folder (zip

format).
» The right-click menu is displayed.

2. Click “Extract All...”

Open

i ——Click

Pin to Start

« After unzipping, a folder is created in the same
location as the downloaded folder.

@ In the “562*” folder, “52*.dat” is created.
* Represents the release number.
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1 6 UPDATING THE FIRMWARE

Updating the firmware

CAUTION: NEVER turn OFF the transceiver

while updating the firmware. If you turn OFF the
transceiver, or if a power failure occurs while
updating, the transceiver firmware may be damaged,
and, if so, you will have to send the transceiver back
to the nearest Icom distributor for repair. This type

of repair is out of warranty, even if the transceiver
warranty period is still valid.

Recommendation!

Fully charging of battery pack before starting the
firmware update is strongly recommended.

This is to avoid failure during the update, caused by
an unexpected power failure.

TIP: BE SURE to unzip the downloaded file.

See the previous page for details.

1. Copy the downloaded firmware data into the
“ID-52” folder on to a microSD card.

(i s | ID-52
Home Share View
« v 4 » USB Drive (Hz) » ID-32 »
MName
# Quick access
Capture
@ OneDrive Csv
I This PC Gps
. OpeningPicture
) 30 Objects .
Picture
[ Desktop Qsolog
|=| Documents Reply
; Downloads Rxleg
D Music Setting
| Pictures Voice
m Videos VoiceRec
. Local Disk (CY) VoiceTx
= o e (52 dat Copy

Insert the microSD card into the transceiver.
Display the SD CARD screen.

[MENU] > SET > SD Card
Select “Firmware Update.”

Screen Capture View »
TX/RX Picture View »

Firmware Update 4

Format
Unmount
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5. After you read and agree with all the precautions,
select “YES.”

D CARD

Firmware updating
has risks, and you
do so at your own
risk and
responsibility.

If you make a

v

D CARD
Do you agree to all
of the above?

NO

» Scroll the screen and read all the precautions.
» The confirmation dialog is displayed.
When you select “YES,” the backup file is made on
the microSD card, and then the Firmware selection
screen is displayed.
6. Select the Firmware (Example: 52%).
* Represents the release number.

» The final confirmation screen is displayed.
® Carefully read all the displayed precautions.

7. After you read and agree with all the precautions,
select “YES.”

Do you want to

start updating?

NO

* The updating starts.

8. When the update is completed, “Firmware
updating has completed.” is displayed in the
dialog.

* The transceiver will automatically restart.
@ After the updating finishes, the operating screen is
displayed.

TIP: When “USB Connect” is set to “SD Card Mode,”
and the transceiver is connected to the PC through a
USB data cable, you can directly access the microSD
card that is set in the transceiver from the PC.
(IMENU] > SET > Function > USB Connect)
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17/ opPTIONs

You can find information for these options on the Icom
website.
https://lwww.icomjapan.com/support/

® Some options may not be available, depending on the
transceiver version.

Batteries/Chargers

BC-167SA/BC-167SD BATTERY CHARGER

The same as supplied.

The shape may be different, depending on the charger
version.

BC-202IP2 RAPID CHARGER
+ BC-123SA/BC-123SE (L-shaped type plug)
AC ADAPTER

BC-202IP3L RAPID CHARGER

+ BC-123SA/BC-123SE (Straight type plug)
AC ADAPTER (For single unit)

+ BC-228 AC ADAPTER (For multiple units)

BP-271 Li-ion BATTERY PACK

Voltage: 7.4V

Discharge capacity: 1150 mAh (minimum), 1200 mAh (typical)
Battery life: Approximately 4.25 hours (FM)

BP-272 Li-ion BATTERY PACK

The same as supplied.

Voltage: 7.4V

Discharge capacity: 1880 mAh (minimum), 2000 mAh (typical)
Battery life: Approximately 7.25 hours (FM)

BP-273 BATTERY CASE
Uses 3 LR6 (AA) alkaline batteries.

BP-307 Li-ion BATTERY PACK

Voltage: 7.2V

Discharge capacity: 3050 mAh (minimum), 3150 mAh (typical)
Battery life: Approximately 12 hours (FM)

Headsets/Earphones

HS-94/HS-95/HS-97 HEADSET
+ OPC-2006LS PLUG ADAPTER CABLE

HS-94: Ear hook type
HS-95: Neck and arm type
HS-97 Throat microphone

OPC-2006LS: Connects the HS-94/HS-95/HS-97 to the
transceiver for the VOX function.

HM-153LS EARPHONE MICROPHONE

HM-166LS EARPHONE MICROPHONE
Smaller than the HM-153LS.

SP-40 EARPHONE

+ OPC-2144 PLUG ADAPTER CABLE

When using the SP-40, you need the OPC-2144 slim L type
conversion cable.
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Speaker microphones

HM-75LS REMOTE CONTROL SPEAKER MICROPHONE

HM-183LS SPEAKER MICROPHONE
Meets IPX7 requirements for waterproof protection
(1 meter, 3.3 ft depth for 30 minutes).

HM-186LS SPEAKER MICROPHONE
Meets IPX4 requirements for waterproof protection
(Splashing water from any direction).

Cables

CP-12L CIGARETTE LIGHTER CABLE
With noise filter.

Fuse Coding: FUSE 125V 3A
Fuse Voltage Rating: 125 Volts

Fuse Current Rating: 3 Amperes

OPC-254L DC POWER CABLE
Directly connects to a DC power source.
Fuse Coding: FUSE 250V 3A
Fuse Voltage Rating: 250 Volts

Fuse Current Rating: 3 Amperes

CP-23L CIGARETTE LIGHTER CABLE
For BC-202IP2, 12V
® You cannot connect to the transceiver’s [DC IN] jack.

OPC-515L DC POWER CABLE
For BC-202I1P2
® You cannot connect to the transceiver’s [DC IN] jack.

CP-25H CIGARETTE LIGHTER CABLE
For BC-202IP3L, 12V
® You cannot connect to the transceiver’s [DC IN] jack.

OPC-2417 pATA cABLE (USB micro-B/USB micro-B)
OPC-2418 DATA cABLE (USB micro-B/USB Type-C)

Others

AD-92SMA ANTENNA CONNECTOR ADAPTER
Connects an antenna or antenna cable that has a BNC
connector.

FA-S270C VHF/UHF ANTENNA
The same as supplied.

LC-193 CARRYING CASE
® You cannot use when the BP-307 is attached to the
transceiver.

MB-127 BELT CLIP
The same as supplied.

VS-3 Bluetooth® HEADSET
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Option List

About the free download software

CS-52 PROGRAMMING SOFTWARE

RS-MS1A (For Android devices) Android APPLICATION

RS-MS1I (For iOS™ devices) iOS™ APPLICATION

RS-MS3A (For Android devices) TERMINAL MODE/ACCESS POINT MODE SOFTWARE
RS-MS3W (For Windows) TERMINAL MODE/ACCESS POINT MODE SOFTWARE
ST-4001A (For Android devices) PICTURE UTILITY SOFTWARE

ST-40011 (For iOS devices) PICTURE UTILITY SOFTWARE

ST-4001W (For Windows) PICTURE UTILITY SOFTWARE

You can download each manual and guide from the Icom website.
https://www.icomjapan.com/support/

® Before using, read each manual and guide, and use it according to the instructions.
To add or expand a function, or to improve the performance, the software version may be upgraded.
Before you update your software version, see the instructions and cautions described on the lcom website.
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Optional HM-75LS REMOTE CONTROL SPEAKER MICROPHONE

The optional HM-75LS enables you to remotely select
operating frequencies, Memory channels, and other
functions.

You can assign some functions to the keys on the
HM-75LS for simple remote control operation.

(p. 12-18)

The HM-75LS has a lock switch on the back to
prevent accidental frequency changes.

NOTE:

» BE SURE to turn OFF the transceiver when plugging or
unplugging the HM-75LS into or from the [MIC/SP] jack.

* Firmly plug the HM-75LS into the transceiver.

< Assigning a Remote Control function
Example: Assigning the “TO (DR)” function to the [A]
key.
[MENU] > SET > Function > Remote MIC Key
1. Push [MENU].

2. Select “Function” in the “SET” menu.
3. Select “Remote MIC Key.”

Power Save

Monitor
Dial Speed-UP
Auto Repeater

Remote MIC Key

Key Lock
4. Select “During RX/Standby.”

il v v v w

-

During RX/Standby »

During TX »
5. Select “[A].”
[B]: VFO/MR 3
[A]:UP »
[V]: DOWN 3
v

FROM (DR)
TO (DR)
Home CH

BAND

» The Assignable function list is displayed.
® About the functions, see pages 12-19 and 12-20.
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Microphone —1 [T]/\[?]
TX indicator———%+-0 [‘”\ /O VAN
A
PTT— D|° gy =
oY \O v
. i
Speaker Bl [VI]
OFFON
LOCK
Lock switch Earphone jack

6. Select “TO (DR).”

FROM (DR)

Home CH

BAND

v

-

[A]: TO (DR)
[B]: VFO/MR
[A]:UP

[V]: DOWN

v v v

* The “TO (DR)” function is assigned.
@ To exit the MENU screen, push [MENU].

TIP: To return to the default settings

* On the “During RX/Standby” screen or “During TX”
screen, push [QUICK] and select “Default All.”

» On the each key screen, push [QUICK] and select
“Default.”
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When using an application

The following applications are compatible with the Android or iOS device.

See each application’s manual for details.
Download the applications from your device.

<& About compatible applications

The following applications are compatible with ID-52A/
ID-52E. (As of November 2021)

Android device
RS-MS1A: You can use the extended D-STAR
functions to exchange pictures or
messages or display the received
D-PRS station data on a map
application.

You can use the DV Gateway function.
You can make an image to be used
for the Share Picture function, and
transfer it to the transceiver.

RS-MS3A:
ST-4001A:

iOS device
RS-MS1I: You can use the extended D-STAR
functions to exchange pictures or
messages or display the received
D-PRS station data on a map
application.

You can make an image to be used
for the Share Picture function, and
transfer it to the transceiver.

ST-40011:

¢ Required items

Android device

You can use the RS-MS1A/RS-MS3A/ST-4001A with

devices that have Android 5.0 or later installed.

® The applications have been tested with the Android 5.x.x,
6.x.X, 7.X.X, 8.x.x, 9.0, and 10.0. (As of November 2021)

iOS device

You can use the RS-MS11/ST-40011 with devices that

have iOS version 12 or later, iPadOS version 13 or

later installed.

® The ST-4001I has been tested with iOS 12 and 13, and
iPadOS 13. (As of November 2021)

Disclaimer

» The application may not work properly, depending on the
OS version, installed applications, or other reasons.

 The indications or items may differ, depending on the OS
version or settings.

17-5

When using a USB cable
* Android device
Android 5.0 or later with the USB host function.

» Cable (purchase separately)
OPC-2417 data cable (USB micro-B/USB micro-B)
or
OPC-2418 data cable (USB micro-B/USB Type-C)

TIP: The USB host function is needed to use a USB
device with an Android device. To check whether or
not your Android device has the USB host system,
ask the Android device’s manufacturer.

When using the Bluetooth function
« Android device or iOS device
Android 5.0 or later with the Bluetooth function.
or
iOS version 12 or later, iPadOS version 13 or later
with the Bluetooth function.
® When using the RS-MS3A, you cannot connect an
Android device to the transceiver through Bluetooth.

NOTE: Some functions may not work correctly,

» depending on other applications installed in the Android
device.

» depending on the memory capacity.
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When using an application

< Download procedures (Android device)

1. Turn ON your Android device.
2. Touch “Play Store.”
3. Enter the application’s name in the search field.
® Do not abbreviate the application name to be sure to
find it.
4. Touch O\

» The application’s name will be displayed as the
search result.

@ If your Android device does not support the
application, its name may not appear on the search
result.

5. Touch the application to install.
« Displays the introduction screen of the application.
6. Touch <INSTALL>.

« Installation starts.

« After finishing the installation, the icon is displayed on
the screen.

<& Download procedures (iOS device)

1. Turn ON your iOS device.
2. Touch “App Store.”
3. Enter the application’s name in the search field.
® Do not abbreviate the application name to be sure to
find it.
4. Touch “.”
» The application’s name will be displayed as the
search result.
@ If your iOS device does not support the application,
its name may not appear on the search result.
5. Touch the application to install.
« Displays the introduction screen of the application.
6. Touch <GET>.
« Installation starts.
« After finishing the installation, the icon is displayed on
the screen.
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< When using a USB cable

Android device
with the USB
host function

USB cable
g]— 0 =
To the [USB] port To a USB port

® Connect the USB micro-B connector (for the OPC-2417:
with the white tube) to the transceiver and the other
connector to an Android device.

NOTE:

» Turn OFF the transceiver before connecting or removing
the cable.

» When an Android device is connected, the USB
connection indicator (&#) is displayed on the
transceiver. If the indicator is not displayed, enable your
Android device to detect the USB device.
® No operation is required on a mobile device that

support automatic detection of the USB devices.

* When using RS-MS1A, confirm the following items are set.
(IMENU] > SET > Function > CI-V)

Set “Cl-V Address” to the value same as the RS-MS1A

side. (Default: A6)

® RS-MS1A side: Application Settings — CI-V settings
(Default: Transceiver[A6])

Set “CI-V Transceive” to “ON.”

(IMENU] > SET > Function > USB Serialport Function)
Set “USB SerialPort Function” to “CI-V (Echo Back OFF).”

(IMENU] > SET > Function > USB Connect)
Set “USB Connect” to “Serialport.”

* When using Access Point mode, RS-MS1A cannot be
used.

» Remove the USB cable when you do not use the cable.
Otherwise, the battery will be quickly exhausted.
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Connecting an Android™ device to the transceiver through Bluetooth®

Before connecting to an Android device, you must
pair with it. See the next page about connecting to
the transceiver with an Android device using the
RS-MS1A application.

< Pairing with an Android device

This section describes how to pair with an Android
device.

NOTE: You may not be able to pair with it,
depending on the Bluetooth device.

Step 1. Entering the Pairing Reception mode
(Transceiver)

[MENU] > SET > Bluetooth Set >
<<Pairing Reception>>
Push [MENU].

1.
2. Select “Bluetooth Set” in the “SET” menu.
3. Select “<<Pairing Reception>>.”

Bluetooth 4

Auto Connect »

Pairing/Connect »

Headset Set »

Data Device Set d
v

Waiting for the
Pairing request
with releasing
status to the
external devices.

Time left:1:59

Data DeyIce S€

Turn ON Bluetooth with your Android device
within the displayed period.

When the time runs out, the transceiver exits
the Pairing Reception mode.

Step 2. Turning ON Bluetooth (Android device)

Turn ON Bluetooth with your Android device.

» The Android device displays the transceiver Bluetooth
unit's name.

® You can confirm the transceiver Bluetooth unit's name on
the BLUETOOTH DEVICE INFO screen.
(Default: ICOM BT(ID-52)) (p. 13-7)

® See the instruction manual of the Android device for
details.
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Step 3. Sending a pairing request to the
transceiver (Android device)

Select the displayed transceiver Bluetooth unit's name
to send a pairing request.
* The Android device starts to send a pairing request.
» The Android device displays, “To pair with: ICOM
BT(ID-52). Make sure it is showing this passkey:
* K ¥ ¥ ¥

Step 4. Receiving a pairing request (Transceiver)

1. When the transceiver receives a pairing request,
confirm the displayed passkey is the same as
yours, and then select “CONFIRM.”

Connection request
received from

Confirm the
| following passkey

« Pairing starts.
2. Select “Pairing/Connect.

Bluetooth 4
Auto Connect 4

Pairing/Connect 4

<<Pairing Reception>>

Headset Set 4
Data Device Set 4

Device Search

Pairing list

1
After the pairing is complete, the
Android device name is displayed
on the pairing list.

NOTE: When you pair with a third party’s data
device, entering a PIN code or passkey may be
required. See the instruction manual of the data
device for details on how to enter a PIN code or
passkey.
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Connecting an Android™ device to the transceiver through Bluetooth®

¢ Connection

This section describes how to connect an Android

device to the transceiver, using the RS-MS1A

application.

Before connecting, pair the transceiver with the

Android device. (p. 17-7)

® When using the ST-4001A application, the transceiver
and Android device are automatically connected while
transferring a picture.

Step 1. Preparing for the connection (Transceiver)

[MENU] > SET > Function > CI-V > CI-V Transceive

Set “CI-V Transceive” to ON to control the transceiver
and the RS-MS1A with CI-V commands.

Step 2. Starting the RS-MS1A (Android device)

Touch the RS-MS1A to start.
® See page 17-6 for details on downloading the RS-MS1A.

Step 3. Connecting to the transceiver
(Android device)

Touch the transceiver’s Bluetooth unit name displayed

on the RS-MS1A.

+ Starts to connect.

® When your call sign has not been entered in the
transceiver, you should enter it before you connect.

@ After the connection has been made, the transceiver
displays “* * * Connected.,” and the Bluetooth icon is
displayed.

146 010

ICOM

Connected.
FM

440 -000 PSKIP

® On the PAIRING/CONNECT screen, “. " is displayed.

Displayed

Device Search 4
E ICOM

1
| Device name
Displayed while connecting

TIP: To connect to the Android device from the
transceiver

When the RS-MS1A is started on the Android device,
you can connect to the device from the transceiver.

[MENU] > SET > Bluetooth Set > Pairing/Connect

Push [MENU].

Select “Bluetooth Set” in the SET menu.

Select “Pairing/Connect.”

Select the Android device name displayed in the

pairing list.

Select “YES.”

* Displays “* * ¥ Connecting...”
(“* * *” js the Bluetooth name of the Android
device.)

® On the PAIRING/CONNECT screen, “.=7" is
displayed on the data device icon.

pPON=

o

NOTE: If you cannot connect, check that the same
CI-V address is set in the transceiver and the RS-
MS1A.

You can see the CI-V setting as described below:
Transceiver

“ClI-V Address” in the MENU screen.

(IMENU] > SET > Function > CI-V > CI-V Address)
(Default: AB)

RS-MS1A:

“Application Settings” — “CI-V settings”

(Default: Transceiver[A6])
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Connecting an iOS device to the transceiver through Bluetooth®

Before connecting to an iOS device, you must pair with it.

< Pairing with an iOS device

This section describes how to pair with an iOS device.

NOTE:

* You cannot pair with an iOS device in its Settings app.
To pair with an iOS device, use lcom application.

* You may not be able to pair with it, depending on the
Bluetooth device.

NOTE: When using the RS-MS1I
Before connecting, check that the following items are
correctly set.
» Set “Cl-V Transceive” to ON in the transceiver.
(IMENU] > SET > Function > CI-V > CI-V Transceive)
» Set the same CI-V address in the transceiver and the
RS-MS1I.
Transceiver:
“Cl-V Address” in the MENU screen.
(IMENU] > SET > Function > CI-V > CI-V Address)
(Default: AB)
RS-MS1I:
» “Application Settings” — “Select the default”
(Default: Auto Select)
 “Application Settings” — “CI-V address”
(Default: Auto Setting)

Step 1. Starting the application (iOS device)

Step 3. Sending a pairing request to the transceiver
(iOS device)

1. On the application, touch “Scan.”

» For the RS-MS11, the item is displayed in “Other” >
“Bluetooth Connection.”

» For the ST-40011, the item is displayed in “Transfer
Device List.”
(“...” > Transfer Settings > Using Bluetooth >
Transfer Device List)

» The iOS device displays the transceiver Bluetooth
unit's name.

® You can confirm the transceiver Bluetooth unit’s
name on the BLUETOOTH DEVICE INFO screen.
(Default: ICOM BT(ID-52)) (p. 13-7)

2. Select the displayed transceiver Bluetooth unit’s

name to send a pairing request.

» The iOS device starts to send a pairing request.

« After the pairing has succeeded, “Pairing is
complete.” is displayed.

1. Turn ON Bluetooth in your iOS device.
@ See the instruction manual of the iOS device for details.
2. Touch the application’s icon to start.

Step 2. Entering the pairing reception mode
(Transceiver)

[MENU] > SET > Bluetooth Set > <<Pairing Reception>>

1. Push [MENU].
2. Select “Bluetooth Set” in the “SET” menu.
3. Select “<<Pairing Reception>>."

Bluetooth »

Auto Connect »

Pairing/Connect 4

Headset Set »

Data Device Set 4
v

Waiting for the
Pairing request
with releasing

status to the

external devices.

Time left:1:59

Send a pairing request to the transceiver (step. 3) within the
displayed period. When the time runs out, the transceiver
exits the Pairing Reception mode.

About the transceiver’s display

After the connection has been made, the transceiver
displays “* * * Connected.” and the Bluetooth icon
is displayed.

(“* * *” is the Bluetooth name of the iOS device.)

T [Bl<=====— Displayed

146 010
ICOM

Connected.
FM

440-000 PSKIP

VFO

® On the PAIRING/CONNECT screen, “.= " is displayed.

Device Search »

1
| Device name
Displayed while connecting
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Connecting an iOS device to the transceiver through Bluetooth®

¢ Connection

This section describes how to connect to a paired

transceiver from an iOS device.

Before connecting, pair the transceiver with the iOS

device. (p. 17-7)

® When using the ST-4001I application, the transceiver
and Android device are automatically connected while
transferring a picture.

Step 1. Starting the RS-MS1I (iOS device)

Touch the RS-MS1I to start.
® See page 17-6 for details on downloading the RS-MS1I.

Step 2. Connecting to the transceiver
(iOS device)

1. Touch “Other.”
2. Touch “Bluetooth Connection.”
3. Touch the displayed transceiver Bluetooth unit’s
name to connect.
« Starts to connect.
® When your call sign has not been entered in the
transceiver, enter it before you connect.
@ If the connection has been made, the transceiver
displays “* * ¥ Connected.,” and the Bluetooth icon
is displayed.

Displayed

[ FM

146 010
ICOM

Connected.
Y

440.000

VFO

® On the PAIRING/CONNECT screen, “.7” is displayed.

PSKIP

Device Search 4

1
| Device name
Displayed while connecting
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TIP: To connect to the iOS device from the
transceiver

When the RS-MS11 is started on the iOS device, you
can connect to the device from the transceiver.

[MENU] > SET > Bluetooth Set > Pairing/Connect

Push [MENU].
Select “Bluetooth Set” in the SET menu.
Select “Pairing/Connect.”
Select the iOS device name displayed in the
pairing list.
Select “YES.”
* Displays “* * ¥ Connecting...”
(“* * *” is the Bluetooth name of the iOS device.)
® On the PAIRING/CONNECT screen, “ " is
displayed on the data device icon.

pPON=

o
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